Note

CHAPTER

Alarm Troubleshooting

The terms “Unidirectional Path Switched Ring” and “UPSR” may appear in Cisco literature. These terms
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as “Path Protected Mesh Network” and “PPMN,” refer generally to Cisco’s
path protection feature, which may be used in any topological network configuration. Cisco does not
recommend using its path protection feature in any particular topological network configuration.

This chapter gives a description, severity, and troubleshooting procedure for each commonly
encountered Cisco ONS 15454 alarm and condition. Tables 2-1 through 2-5 provide lists of ONS 15454
alarms organized by severity. Table 2-6 on page 2-9 provides a list of alarms organized alphabetically.
Table 2-7 gives definitions of all ONS 15454 alarm logical objects, which are the basis of the alarm
profile list in Table 2-8 on page 2-19. For a comprehensive list of all conditions and instructions for
using TL1 commands, refer to the Cisco SONET TL1 Command Guide .

An alarm’s troubleshooting procedure applies to both the Cisco Transport Controller (CTC) and TL1
version of that alarm. If the troubleshooting procedure does not clear the alarm, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or call the Cisco Technical
Assistance Center (1 800 553-2447).

For more information about alarm profiles, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

2.1 Alarm Indexes by Default Severity

The following tables group alarms and conditions by their default severities in the ONS 15454 system.
These severities are the same whether they are reported in the CTC Alarms window severity (SEV)
column or in TL1.

The CTC default alarm profile contains some alarms or conditions that are not currently implemented
but are reserved for future use.

The CTC default alarm profile in some cases contains two severities for one alarm (for example,
MIJ/MN). The ONS 15454 platform default severity comes first (in this example, MJ), but the alarm can
be demoted to the second severity in the presence of a higher-ranking alarm. This is in accordance with
Telcordia GR-474.
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W 2.1.1 Critical Alarms (CR)

2.1.1 Critical Alarms (CR)

Table 2-1 alphabetically lists ONS 15454 Critical (CR) alarms.

Table 2-1

ONS 15454 Critical Alarm List

AUTOLSROFF (OCN)

LOF (TRUNK)

OPWR-HFAIL (OTS)

AUTOLSROFF (TRUNK)

LOM (STSMON)

OPWR-LFAIL (AOTS)

AWG-FAIL (OTS)

LOM (TRUNK)

OPWR-LFAIL (OCH)

AWG-OVERTEMP (OTS)

LOP-P (STSMON)

OPWR-LFAIL (OMS)

BKUPMEMP (EQPT)

LOP-P (STSTRM)

OPWR-LFAIL (OTS)

COMIOXC (EQPT) LOS (2R) OTUK-LOF (TRUNK)
CONTBUS-DISABLED (EQPT) LOS (DS3) OTUK-TIM (TRUNK)
CTNEQPT-PBPROT (EQPT) LOS (EC1) PLM-P (STSMON)
CTNEQPT-PBWORK (EQPT) LOS (ESCON) PLM-P (STSTRM)
ENCAP-MISMATCH-P (STSTRM) LOS (ISC) PORT-ADD-PWR-FAIL-HIGH (OCH)
EQPT (AICI-AEP) LOS (OCN) PORT-ADD-PWR-FAIL-LOW (OCH)
EQPT (AICI-AIE) LOS (OTS) PORT-FAIL (OCH)

EQPT (EQPT) LOS (TRUNK) SQM (STSTRM)

EQPT (PPM) LOS-P (OCH) SWMTXMOD-PROT (EQPT)
EQPT-MISS (FAN) LOS-P (OMS) SWMTXMOD-WORK (EQPT)

FAN (FAN) LOS-P (OTS) TIM (OCN)

GAIN-HFAIL (AOTS) LOS-P (TRUNK) TIM (TRUNK)

GAIN-LFAIL (AOTS) MEA (AIP) TIM-P (STSTRM)

GE-OOSYNC (FC) MEA (BIC) TIM-S (EC1)

GE-OOSYNC (GE) MEA (EQPT) TIM-S (OCN)

GE-OOSYNC (ISC) MEA (FAN) UNEQ-P (STSMON)

GE-OOSYNC (TRUNK) MEA (PPM) UNEQ-P (STSTRM)

HITEMP (NE)

MFGMEM (AICI-AEP)

VOA-HFAIL (AOTS)

I-HITEMP (NE)

MFGMEM (AICI-AIE)

VOA-HFAIL (OCH)

IMPROPRMVL (EQPT)

MFGMEM (AIP)

VOA-HFAIL (OMS)

IMPROPRMVL (PPM) MFGMEM (BPLANE) VOA-HFAIL (OTS)
LOA (VCG) MFGMEM (FAN) VOA-LFAIL (AOTS)
LOF (DS3) MFGMEM (PPM) VOA-LFAIL (OCH)
LOF (EC1) OPWR-HFAIL (AOTS) VOA-LFAIL (OMS)
LOF (OCN) OPWR-HFAIL (OCH) VOA-LFAIL (OTS)

LOF (STSTRM)

OPWR-HFAIL (OMS)
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2.1.2 Major Alarms (MJ)

2.1.2 Major Alarms (MJ)

Table 2-2 alphabetically lists ONS 15454 Major (MJ) alarms.

Table 2-2 ONS 15454 Major Alarm List

APSCM (OCN)

GFP-EX-MISMATCH (FCMR)

PRC-DUPID (OCN)

APSCNMIS (OCN)

GFP-EX-MISMATCH (GFP-FAC)

PTIM (TRUNK)

BAT-FAIL (PWR)

GFP-LFD (CE100T)

RCVR-MISS (DS1)

BLSROSYNC (OCN)

GFP-LFD (FCMR)

RCVR-MISS (E1)

BLSR-SW-VER-MISM (OCN)

GFP-LFD (GFP-FAC)

RING-ID-MIS (OCN)

CARLOSS (CE100T)

GFP-LFD (ML1000)

RING-ID-MIS (OSC-RING)

CARLOSS (E1000F)

GFP-LFD (ML100T)

RING-MISMATCH (OCN)

CARLOSS (E100T)

GFP-LFD (MLFX)

SIGLOSS (FC)

CARLOSS (EQPT)

GFP-NO-BUFFERS (FCMR)

SIGLOSS (FCMR)

CARLOSS (FC)

GFP-NO-BUFFERS (GFP-FAC)

SIGLOSS (GE)

CARLOSS (G1000)

GFP-UP-MISMATCH (CE100T)

SIGLOSS (ISC)

CARLOSS (GE)

GFP-UP-MISMATCH (FCMR)

SIGLOSS (TRUNK)

CARLOSS (ISC)

GFP-UP-MISMATCH (GFP-FAC)

SQM (VT-TERM)

CARLOSS (ML1000)

GFP-UP-MISMATCH (ML1000)

SYNCLOSS (FC)

CARLOSS (ML100T)

GFP-UP-MISMATCH (ML100T)

SYNCLOSS (FCMR)

CARLOSS (MLFX)

GFP-UP-MISMATCH (MLFX)

SYNCLOSS (GE)

CARLOSS (TRUNK)

HIBATVG (PWR)

SYNCLOSS (ISC)

DBOSYNC (NE)

INVMACADR (AIP)

SYNCLOSS (TRUNK)

DSP-COMM-FAIL (TRUNK)

LASERBIAS-FAIL (AOTS)

SYNCPRI (NE-SREF)

DSP-FAIL (TRUNK)

LOF (DS1)

SYSBOOT (NE)

EHIBATVG (PWR)

LOF (E1)

TIM-V (VI-TERM)

ELWBATVG (PWR)

LOM (STSTRM)

TPTFAIL (CE100T)

E-W-MISMATCH (OCN)

LOM (VT-TERM)

TPTFAIL (FCMR)

EXTRA-TRAF-PREEMPT (OCN)

LOP-V (VT-MON)

TPTFAIL (G1000)

FC-NO-CREDITS (FC)

LOP-V (VI-TERM)

TPTFAIL (ML1000)

FC-NO-CREDITS (FCMR) LOS (DS1) TPTFAIL (ML100T)
FC-NO-CREDITS (TRUNK) LOS (E1) TPTFAIL (MLFX)
FEC-MISM (TRUNK) LWBATVG (PWR) TRMT (DS1)
GFP-CSF (CE100T) MEM-GONE (EQPT) TRMT (El)

GFP-CSF (FCMR)

ODUK-TIM-PM (TRUNK)

TRMT-MISS (DS1)

GFP-CSF (GFP-FAC)

OPTNTWMIS (NE)

TRMT-MISS (E1)

GFP-CSF (ML1000)

OUT-OF-SYNC (FC)

UNEQ-V (VIT-MON)

GFP-CSF (ML100T)

OUT-OF-SYNC (GE)

UNEQ-V (VT-TERM)

GFP-CSF (MLFX)

OUT-OF-SYNC (TRUNK)

UT-COMM-FAIL (TRUNK)
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Table 2-2

ONS 15454 Major Alarm List (continued)

GFP-DE-MISMATCH (FCMR)

PEER-NORESPONSE (EQPT)

UT-FAIL (TRUNK)

GFP-DE-MISMATCH (GFP-FAC)

PLM-V (VT-TERM)

WVL-MISMATCH (TRUNK)

2.1.3 Minor Alarms (MN)

Table 2-3 alphabetically lists ONS 15454 Minor (MN) alarms.

Table 2-3 ONS 15454 Minor Alarm List
APSB (OCN) HI-RXPOWER (FC) LO-TXPOWER (OCN)
APSCDFLTK (OCN) HI-RXPOWER (GE) LO-TXPOWER (PPM)

APSC-IMP (OCN)

HI-RXPOWER (ISC)

LO-TXPOWER (TRUNK)

APSCINCON (OCN)

HI-RXPOWER (OCN)

MEM-LOW (EQPT)

APSIMP (OCN)

HI-RXPOWER (TRUNK)

OPWR-HDEG (AOTS)

APS-INV-PRIM (OCN)

HITEMP (EQPT)

OPWR-HDEG (OCH)

APSMM (OCN)

HI-TXPOWER (2R)

OPWR-HDEG (OMS)

APS-PRIM-SEC-MISM (OCN)

HI-TXPOWER (EQPT)

OPWR-HDEG (OTS)

AUTORESET (EQPT)

HI-TXPOWER (ESCON)

OPWR-LDEG (AOTS)

AUTOSW-UNEQ (VI-MON)

HI-TXPOWER (FC)

OPWR-LDEG (OCH)

AWG-DEG (OTS)

HI-TXPOWER (GE)

OPWR-LDEG (OMS)

BPV (BITS)

HI-TXPOWER (ISC)

OPWR-LDEG (OTS)

CASETEMP-DEG (AOTS)

HI-TXPOWER (OCN)

OTUK-IAE (TRUNK)

COMM-FAIL (EQPT)

HI-TXPOWER (PPM)

PORT-ADD-PWR-DEG-HI (OCH)

CONTBUS-A-18 (EQPT)

HI-TXPOWER (TRUNK)

PORT-ADD-PWR-DEG-LOW (OCH)

CONTBUS-B-18 (EQPT)

ISIS-ADJ-FAIL (OCN)

PROTNA (EQPT)

CONTBUS-IO-A (EQPT)

KBYTE-APS-CHANNEL-FAILURE
(OCN)

PROV-MISMATCH (PPM)

CONTBUS-IO-B (EQPT)

LASERBIAS-DEG (AOTS)

PWR-FAIL-A (EQPT)

DATAFLT (NE)

LASERBIAS-DEG (OTS)

PWR-FAIL-B (EQPT)

DUP-IPADDR (NE)

LASEREOL (OCN)

PWR-FAIL-RET-A (EQPT)

DUP-NODENAME (NE)

LASERTEMP-DEG (AOTS)

PWR-FAIL-RET-B (EQPT)

ENVALRM)EXT LOF (BITS) SFTWDOWN (EQPT)

EOC (OCN) LO-LASERBIAS (EQPT) SH-INS-LOSS-VAR-DEG-HIGH (OTS)
EOC (TRUNK) LO-LASERBIAS (OCN) SH-INS-LOSS-VAR-DEG-LOW (OTS)
EOC-L (OCN) LO-LASERBIAS (PPM) SNTP-HOST (NE)

EOC-L (TRUNK)

LO-LASERTEMP (EQPT)

SSM-FAIL (BITS)

ERROR-CONFIG (EQPT)

LO-LASERTEMP (OCN)

SSM-FAIL (DS1)

EXCCOL (EQPT)

LO-LASERTEMP (PPM)

SSM-FAIL (E1)

FEPRLF (OCN)

LO-RXPOWER (2R)

SSM-FAIL (OCN)
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Table 2-3

ONS 15454 Minor Alarm List (continued)

2.1.4 NA Conditions H

FIBERTEMP-DEG (AOTS)

LO-RXPOWER (ESCON)

SSM-FAIL (TRUNK)

GAIN-HDEG (AOTS)

LO-RXPOWER (FC)

SYNCPRI (EXT-SREF)

GAIN-LDEG (AOTS)

LO-RXPOWER (GE)

SYNCSEC (EXT-SREF)

GCC-EOC (TRUNK)

LO-RXPOWER (ISC)

SYNCSEC (NE-SREF)

HELLO (OCN)

LO-RXPOWER (OCN)

SYNCTHIRD (EXT-SREF)

HI-LASERBIAS (2R)

LO-RXPOWER (TRUNK)

SYNCTHIRD (NE-SREF)

HI-LASERBIAS (EQPT) LOS (BITS) TIM-MON (OCN)

HI-LASERBIAS (ESCON) LOS (FUDC) TIM-MON (TRUNK)

HI-LASERBIAS (FC) LOS (MSUDC) TIM-P (STSMON)

HI-LASERBIAS (GE) LOS-O (OCH) UNREACHABLE-TARGET-POWER
(OCH)

HI-LASERBIAS (ISC) LOS-O (OMS) VOA-HDEG (AOTS)

HI-LASERBIAS (OCN) LOS-O (OTS) VOA-HDEG (OCH)

HI-LASERBIAS (PPM)

LO-TXPOWER (2R)

VOA-HDEG (OMS)

HI-LASERBIAS (TRUNK)

LO-TXPOWER (EQPT)

VOA-HDEG (OTS)

HI-LASERTEMP (EQPT)

LO-TXPOWER (ESCON)

VOA-LDEG (AOTS)

HI-LASERTEMP (OCN)

LO-TXPOWER (FC)

VOA-LDEG (OCH)

HI-LASERTEMP (PPM)

LO-TXPOWER (GE)

VOA-LDEG (OMS)

HI-RXPOWER (2R)

LO-TXPOWER (ISC)

VOA-LDEG (OTS)

HI-RXPOWER (ESCON)

2.1.4 NA Conditions

Table 2-4 alphabetically lists ONS 15454 Not Alarmed (NA) conditions.

Table 2-4

ONS 15454 NA Conditions List

(LCAS-RX-FAIL (VTI-TERM)

FORCED-REQ-SPAN (ISC)

SD-L (OCN)

)SSM-SETS (TRUNK)

FORCED-REQ-SPAN (OCN)

SD-P (STSMON)

ALS (2R) FORCED-REQ-SPAN (TRUNK) SD-P (STSTRM)
ALS (AOTS) FRCDSWTOINT (NE-SREF) SD-V (VT-MON)
ALS (ESCON) FRCDSWTOPRI (EXT-SREF) SD-V (VT-TERM)
ALS (FC) FRCDSWTOPRI (NE-SREF) SF (DS1)

ALS (GE) FRCDSWTOSEC (EXT-SREF) SF (DS3)

ALS (ISC) FRCDSWTOSEC (NE-SREF) SF (E1)

ALS (OCN) FRCDSWTOTHIRD (EXT-SREF) SF (TRUNK)

ALS (TRUNK) FRCDSWTOTHIRD (NE-SREF) SF-L (EC1)
AMPLI-INIT (AOTS) FRNGSYNC (NE-SREF) SF-L (OCN)

APC-CORRECTION-SKIPPED (AOTS)

FSTSYNC (NE-SREF)

SF-P (STSMON)
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Il 2.1.4 NA Conditions

Table 2-4 ONS 15454 NA Conditions List (continued)

APC-CORRECTION-SKIPPED (OCH)

FULLPASSTHR-BI (OCN)

SF-P (STSTRM)

APC-CORRECTION-SKIPPED (OMS)

HI-CCVOLT (BITS)

SF-V (VT-MON)

APC-CORRECTION-SKIPPED (OTS)

HLDOVRSYNC (NE-SREF)

SF-V (VT-TERM)

APC-DISABLED (NE)

INC-ISD (DS3)

SHUTTER-OPEN (OTS)

APC-END (NE)

INHSWPR (EQPT)

SPAN-SW-EAST (OCN)

APC-OUT-OF-RANGE (AOTS)

INHSWWKG (EQPT)

SPAN-SW-WEST (OCN)

APC-OUT-OF-RANGE (OCH)

INTRUSION-PSWD (NE)

SQUELCH (OCN)

APC-OUT-OF-RANGE (OMS)

IOSCFGCOPY (EQPT)

SQUELCHED (2R)

APC-OUT-OF-RANGE (OTS)

KB-PASSTHR (OCN)

SQUELCHED (ESCON)

APS-PRIM-FAC (OCN)

LAN-POL-REV (NE)

SQUELCHED (FC)

AS-CMD (2R)

LASER-APR (AOTS)

SQUELCHED (GE)

AS-CMD (AOTS)

LCAS-CRC (STSTRM)

SQUELCHED (ISC)

AS-CMD (BPLANE)

LCAS-CRC (VT-TERM)

SQUELCHED (OCN)

AS-CMD (CE100T)

LCAS-RX-FAIL (STSTRM)

SQUELCHED (TRUNK)

AS-CMD (DS1)

LCAS-TX-ADD (STSTRM)

SSM-DUS (BITS)

AS-CMD (DS3)

LCAS-TX-ADD (VT-TERM)

SSM-DUS (DS1)

AS-CMD (El)

LCAS-TX-DNU (STSTRM)

SSM-DUS (E1)

AS-CMD (E1000F)

LCAS-TX-DNU (VT-TERM)

SSM-DUS (OCN)

AS-CMD (E100T)

LKOUTPR-S (OCN)

SSM-DUS (TRUNK)

AS-CMD (EC1)

LOCKOUT-REQ (2R)

SSM-LNC (TRUNK)

AS-CMD (EQPT)

LOCKOUT-REQ (EQPT)

SSM-OFF (BITS)

AS-CMD (ESCON)

LOCKOUT-REQ (ESCON)

SSM-OFF (DS1)

AS-CMD (FC)

LOCKOUT-REQ (FC)

SSM-OFF (E1)

AS-CMD (FCMR)

LOCKOUT-REQ (GE)

SSM-OFF (OCN)

AS-CMD (G1000)

LOCKOUT-REQ (ISC)

SSM-OFF (TRUNK)

AS-CMD (GE)

LOCKOUT-REQ (OCN)

SSM-PRC (TRUNK)

AS-CMD (GFP-FAC)

LOCKOUT-REQ (STSMON)

SSM-PRS (BITS)

AS-CMD (ISC)

LOCKOUT-REQ (TRUNK)

SSM-PRS (DS1)

AS-CMD (ISC)

LOCKOUT-REQ (VI-MON)

SSM-PRS (E1)

AS-CMD (ML100T)

LPBKCRS (STSMON)

SSM-PRS (NE-SREF)

AS-CMD (MLFX)

LPBKCRS (STSTRM)

SSM-PRS (OCN)

AS-CMD (NE)

LPBKDS1FEAC-CMD (DS1)

SSM-PRS (TRUNK)

AS-CMD (OCH)

LPBKDS3FEAC (DS3)

SSM-RES (BITS)

AS-CMD (OCN)

LPBKDS3FEAC-CMD (DS3)

SSM-RES (DS1)

AS-CMD (OMS)

LPBKFACILITY (CE100T)

SSM-RES (E1)

AS-CMD (OTS)

LPBKFACILITY (DS1)

SSM-RES (NE-SREF)

AS-CMD (PPM)

LPBKFACILITY (DS3)

SSM-RES (OCN)
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Table 2-4 ONS 15454 NA Conditions List (continued)

2.1.4 NA Conditions

AS-CMD (PWR)

LPBKFACILITY (E1)

SSM-RES (TRUNK)

AS-CMD (TRUNK)

LPBKFACILITY (EC1)

SSM-SDH-TN (TRUNK)

AS-MT (2R)

LPBKFACILITY (ESCON)

SSM-SMC (BITS)

AS-MT (AOTS)

LPBKFACILITY (FC)

SSM-SMC (DS1)

AS-MT (CE100T)

LPBKFACILITY (FCMR)

SSM-SMC (E1)

AS-MT (DS1) LPBKFACILITY (G1000) SSM-SMC (NE-SREF)
AS-MT (DS3) LPBKFACILITY (GE) SSM-SMC (OCN)
AS-MT (El) LPBKFACILITY (ISC) SSM-SMC (TRUNK)
AS-MT (EC1) LPBKFACILITY (OCN) SSM-ST2 (BITS)

AS-MT (EQPT)

LPBKFACILITY (TRUNK)

SSM-ST2 (DS1)

AS-MT (ESCON)

LPBKTERMINAL (CE100T)

SSM-ST2 (El)

AS-MT (FC)

LPBKTERMINAL (DS1)

SSM-ST2 (NE-SREF)

AS-MT (FCMR)

LPBKTERMINAL (DS3)

SSM-ST2 (OCN)

AS-MT (G1000)

LPBKTERMINAL (E1)

SSM-ST2 (TRUNK)

AS-MT (GE) LPBKTERMINAL (EC1) SSM-ST3 (BITS)
AS-MT (GFP-FAC) LPBKTERMINAL (ESCON) SSM-ST3 (DS1)
AS-MT (ISC) LPBKTERMINAL (FC) SSM-ST3 (E1)
AS-MT (ISC) LPBKTERMINAL (FCMR) SSM-ST3 (NE-SREF)

AS-MT (ML100T)

LPBKTERMINAL (G1000)

SSM-ST3 (OCN)

AS-MT (MLFX)

LPBKTERMINAL (GE)

SSM-ST3 (TRUNK)

AS-MT (OCH) LPBKTERMINAL (ISC) SSM-ST3E (BITS)
AS-MT (OCN) LPBKTERMINAL (OCN) SSM-ST3E (DS1)
AS-MT (OMS) LPBKTERMINAL (TRUNK) SSM-ST3E (E1)
AS-MT (OTS) MAN-REQ (EQPT) SSM-ST3E (NE-SREF)
AS-MT (PPM) MAN-REQ (STSMON) SSM-ST3E (OCN)

AS-MT (TRUNK)

MAN-REQ (VT-MON)

SSM-ST3E (TRUNK)

AS-MT-O0G (STSTRM)

MANRESET (EQPT)

SSM-ST4 (BITS)

AS-MT-OOG (VT-TERM)

MANSWTOINT (NE-SREF)

SSM-ST4 (DS1)

AUD-LOG-LOSS (NE)

MANSWTOPRI (EXT-SREF)

SSM-ST4 (E1)

AUD-LOG-LOW (NE)

MANSWTOPRI (NE-SREF)

SSM-ST4 (NE-SREF)

AUTOSW-LOP (STSMON)

MANSWTOSEC (EXT-SREF)

SSM-ST4 (OCN)

AUTOSW-LOP (VI-MON)

MANSWTOSEC (NE-SREF)

SSM-ST4 (TRUNK)

AUTOSW-PDI (STSMON)

MANSWTOTHIRD (EXT-SREF)

SSM-STU (BITS)

AUTOSW-SDBER (STSMON)

MANSWTOTHIRD (NE-SREF)

SSM-STU (DS1)

AUTOSW-SFBER (STSMON)

MANUAL-REQ-RING (OCN)

SSM-STU (E1)

AUTOSW-UNEQ (STSMON)

MANUAL-REQ-SPAN (2R)

SSM-STU (NE-SREF)

AWG-WARM-UP (OTS)

MANUAL-REQ-SPAN (ESCON)

SSM-STU (OCN)
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Il 2.1.4 NA Conditions

Table 2-4 ONS 15454 NA Conditions List (continued)

CLDRESTART (EQPT)

MANUAL-REQ-SPAN (FC)

SSM-STU (TRUNK)

CTNEQPT-MISMATCH (EQPT)

MANUAL-REQ-SPAN (GE)

SSM-TNC (BITS)

DS3-MISM (DS3)

MANUAL-REQ-SPAN (ISC)

SSM-TNC (NE-SREF)

ETH-LINKLOSS (NE)

MANUAL-REQ-SPAN (OCN)

SSM-TNC (OCN)

EXERCISE-RING-FAIL (OCN)

MANUAL-REQ-SPAN (TRUNK)

SSM-TNC (TRUNK)

EXERCISE-SPAN-FAIL (OCN)

NO-CONFIG (EQPT)

SWTOPRI (EXT-SREF)

FAILTOSW (2R)

OCHNC-INC (OCHNC-CONN)

SWTOPRI (NE-SREF)

FAILTOSW (EQPT)

ODUK-SD-PM (TRUNK)

SWTOSEC (EXT-SREF)

FAILTOSW (ESCON)

ODUK-SF-PM (TRUNK)

SWTOSEC (NE-SREF)

FAILTOSW (FC)

OOU-TPT (STSTRM)

SWTOTHIRD (EXT-SREF)

FAILTOSW (GE)

OOU-TPT (VT-TERM)

SWTOTHIRD (NE-SREF)

FAILTOSW (ISC)

OPEN-SLOT (EQPT)

SYNC-FREQ (BITS)

FAILTOSW (OCN)

OSRION (AOTS)

SYNC-FREQ (DS1)

FAILTOSW (TRUNK)

OSRION (OTS)

SYNC-FREQ (E1)

FAILTOSW-PATH (STSMON)

OTUK-SD (TRUNK)

SYNC-FREQ (OCN)

FAILTOSW-PATH (VT-MON)

OTUK-SF (TRUNK)

SYNC-FREQ (TRUNK)

FAILTOSWR (OCN)

OUT-OF-SYNC (ISC)

TEMP-MISM (NE)

FAILTOSWS (OCN)

PARAM-MISM (AOTS)

TX-RAI (DS1)

FE-AIS (DS3)

PARAM-MISM (OCH)

TX-RAI (DS3)

FE-DS1-MULTLOS (DS3)

PARAM-MISM (OMS)

TX-RAI (E1)

FE-DS1-NSA (DS3)

PARAM-MISM (OTS)

UNC-WORD (TRUNK)

FE-DS1-SA (DS3)

PDI-P (STSMON)

VCG-DEG (VCG)

FE-DS1-SNGLLOS (DS3)

PDI-P (STSTRM)

VCG-DOWN (VCG)

FE-DS3-NSA (DS3)

PORT-MISMATCH (FCMR)

VOLT-MISM (PWR)

FE-DS3-SA (DS3)

RAI (DS1)

WKSWPR (2R)

FE-EQPT-NSA (DS3)

RAI (DS3)

WKSWPR (EQPT)

FE-FRCDWKSWBK-SPAN (OCN)

RAI (E1)

WKSWPR (ESCON)

FE-FRCDWKSWPR-RING (OCN)

RING-SW-EAST (OCN)

WKSWPR (FC)

FE-FRCDWKSWPR-SPAN (OCN)

RING-SW-WEST (OCN)

WKSWPR (GE)

FE-IDLE (DS3)

ROLL (STSMON)

WKSWPR (ISC)

FE-LOCKOUTOFPR-SPAN (OCN)

ROLL (STSTRM)

WKSWPR (OCN)

FE-LOF (DS3)

ROLL (VT-MON)

WKSWPR (STSMON)

FE-LOS (DS3)

ROLL-PEND (STSMON)

WKSWPR (TRUNK)

FE-MANWKSWBK-SPAN (OCN) ROLL-PEND (VT-MON) WKSWPR (VT-MON)
FE-MANWKSWPR-RING (OCN) RPRW (CE100T) WTR (2R)
FE-MANWKSWPR-SPAN (OCN) RPRW (ML1000) WTR (EQPT)

FORCED-REQ (EQPT)

RPRW (ML100T)

WTR (ESCON)
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2.1.5 NR Conditions

Table 2-4 ONS 15454 NA Conditions List (continued)

FORCED-REQ (STSMON) RPRW (MLFX) WTR (FC)
FORCED-REQ (VT-MON) RUNCFG-SAVENEED (EQPT) WTR (GE)
FORCED-REQ-RING (OCN) SD (DS1) WTR (ISC)
FORCED-REQ-SPAN (2R) SD (DS3) WTR (OCN)
FORCED-REQ-SPAN (ESCON) SD (El) WTR (STSMON)
FORCED-REQ-SPAN (FC) SD (TRUNK) WTR (TRUNK)
FORCED-REQ-SPAN (GE) SD-L (EC1) WTR (VT-MON)

2.1.5 NR Conditions

Table 2-5 alphabetically lists ONS 15454 Not Reported (NR) conditions.

Table 2-5 ONS 15454 NR Conditions List

AIS (BITS) ERFI-P-CONN (STSMON) OTUK-AIS (TRUNK)
AIS (DS1) ERFI-P-CONN (STSTRM) OTUK-BDI (TRUNK)
AIS (DS3) ERFI-P-PAYLD (STSMON) RFI (TRUNK)

AIS (El) ERFI-P-PAYLD (STSTRM) RFI-L (EC1)

AIS (FUDC) ERFI-P-SRVR (STSMON) RFI-L (OCN)

AIS (MSUDC)

ERFI-P-SRVR (STSTRM)

RFI-P (STSMON)

AIS (TRUNK)

ODUK-1-AIS-PM (TRUNK)

RFI-P (STSTRM)

AIS-L (EC1)

ODUK-2-AIS-PM (TRUNK)

RFI-V (VT-TERM)

AIS-L (OCN)

ODUK-3-AIS-PM (TRUNK)

ROLL-PEND (STSTRM)

AIS-P (STSMON)

ODUK-4-AIS-PM (TRUNK)

TX-AIS (DS1)

AIS-P (STSTRM)

ODUK-AIS-PM (TRUNK)

TX-AIS (DS3)

AIS-V (VI-MON) ODUK-BDI-PM (TRUNK) TX-AIS (E1)
AIS-V (VT-TERM) ODUK-LCK-PM (TRUNK) TX-LOF (DS1)
AUTOSW-AIS (STSMON) ODUK-OCI-PM (TRUNK) TX-LOF (E1)

AUTOSW-AIS (VI-MON)

2.2 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6 alphabetically lists all ONS 15454 alarms and conditions.

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List

APSB (OCN)

GFP-LFD (ML1000)

PLM-P (STSMON)

LCAS-RX-FAIL (VT-TERM)

GFP-LFD (ML100T)

PLM-P (STSTRM)

AIS (BITS)

GFP-LFD (MLFX)

PLM-V (VI-TERM)
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I 2.2 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

AIS (DS1) GFP-NO-BUFFERS (FCMR) PORT-ADD-PWR-DEG-HI (OCH)
AIS (DS3) GFP-NO-BUFFERS (GFP-FAC) PORT-ADD-PWR-DEG-LOW (OCH)
AIS (El) GFP-UP-MISMATCH (CE100T) PORT-ADD-PWR-FAIL-HIGH (OCH)
AIS (FUDC) GFP-UP-MISMATCH (FCMR) PORT-ADD-PWR-FAIL-LOW (OCH)

AIS (MSUDC)

GFP-UP-MISMATCH (GFP-FAC)

PORT-FAIL (OCH)

AIS (TRUNK)

GFP-UP-MISMATCH (ML1000)

PORT-MISMATCH (FCMR)

AIS-L (EC1)

GFP-UP-MISMATCH (ML100T)

PRC-DUPID (OCN)

AIS-L (OCN)

GFP-UP-MISMATCH (MLFX)

PROTNA (EQPT)

AIS-P (STSMON)

HELLO (OCN)

PROV-MISMATCH (PPM)

AIS-P (STSTRM)

HIBATVG (PWR)

PTIM (TRUNK)

AIS-V (VT-MON)

HI-CCVOLT (BITS)

PWR-FAIL-A (EQPT)

AIS-V (VT-TERM)

HI-LASERBIAS (2R)

PWR-FAIL-B (EQPT)

ALS (2R) HI-LASERBIAS (EQPT) PWR-FAIL-RET-A (EQPT)
ALS (AOTS) HI-LASERBIAS (ESCON) PWR-FAIL-RET-B (EQPT)
ALS (ESCON) HI-LASERBIAS (FC) RAI (DS1)

ALS (FC) HI-LASERBIAS (GE) RAI (DS3)

ALS (GE) HI-LASERBIAS (ISC) RAI (E1)

ALS (ISC) HI-LASERBIAS (OCN) RCVR-MISS (DS1)

ALS (OCN) HI-LASERBIAS (PPM) RCVR-MISS (E1)

ALS (TRUNK) HI-LASERBIAS (TRUNK) RFI (TRUNK)
AMPLL-INIT (AOTS) HI-LASERTEMP (EQPT) RFI-L (EC1)
APC-CORRECTION-SKIPPED (AOTS) |HI-LASERTEMP (OCN) RFI-L (OCN)

APC-CORRECTION-SKIPPED (OCH)

HI-LASERTEMP (PPM)

RFI-P (STSMON)

APC-CORRECTION-SKIPPED (OMS)

HI-RXPOWER (2R)

RFI-P (STSTRM)

APC-CORRECTION-SKIPPED (OTS)

HI-RXPOWER (ESCON)

RFI-V (VT-TERM)

APC-DISABLED (NE)

HI-RXPOWER (FC)

RING-ID-MIS (OCN)

APC-END (NE)

HI-RXPOWER (GE)

RING-ID-MIS (OSC-RING)

APC-OUT-OF-RANGE (AOTS)

HI-RXPOWER (ISC)

RING-MISMATCH (OCN)

APC-OUT-OF-RANGE (OCH)

HI-RXPOWER (OCN)

RING-SW-EAST (OCN)

APC-OUT-OF-RANGE (OMS)

HI-RXPOWER (TRUNK)

RING-SW-WEST (OCN)

APC-OUT-OF-RANGE (OTS)

HITEMP (NE)

ROLL (STSMON)

APSCDFLTK (OCN)

HITEMP (EQPT)

ROLL (STSTRM)

APSC-IMP (OCN)

HI-TXPOWER (2R)

ROLL (VT-MON)

APSCINCON (OCN)

HI-TXPOWER (EQPT)

ROLL-PEND (STSMON)

APSCM (OCN)

HI-TXPOWER (ESCON)

ROLL-PEND (STSTRM)

APSCNMIS (OCN)

HI-TXPOWER (FC)

ROLL-PEND (VT-MON)

APSIMP (OCN)

HI-TXPOWER (GE)

RPRW (CE100T)
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Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

2.2 Alarms and Conditions Listed By Alphabetical Entry ||

APS-INV-PRIM (OCN)

HI-TXPOWER (ISC)

RPRW (ML1000)

APSMM (OCN)

HI-TXPOWER (OCN)

RPRW (ML100T)

APS-PRIM-FAC (OCN)

HI-TXPOWER (PPM)

RPRW (MLFX)

APS-PRIM-SEC-MISM (OCN)

HI-TXPOWER (TRUNK)

RUNCFG-SAVENEED (EQPT)

AS-CMD (2R) HLDOVRSYNC (NE-SREF) SD (DS1)
AS-CMD (AOTS) I-HITEMP (NE) SD (DS3)
AS-CMD (BPLANE) IMPROPRMVL (EQPT) SD (El)
AS-CMD (CE100T) IMPROPRMVL (PPM) SD (TRUNK)
AS-CMD (DS1) INC-ISD (DS3) SD-L (EC1)
AS-CMD (DS3) INHSWPR (EQPT) SD-L (OCN)

AS-CMD (E1)

INHSWWKG (EQPT)

SD-P (STSMON)

AS-CMD (E1000F)

INTRUSION-PSWD (NE)

SD-P (STSTRM)

AS-CMD (E100T)

INVMACADR (AIP)

SD-V (VT-MON)

AS-CMD (EC1)

IOSCFGCOPY (EQPT)

SD-V (VI-TERM)

AS-CMD (EQPT) ISIS-ADJ-FAIL (OCN) SF (DS1)

AS-CMD (ESCON) KB-PASSTHR (OCN) SF (DS3)

AS-CMD (FC) KBYTE-APS-CHANNEL-FAILURE |SF (El)
(OCN)

AS-CMD (FCMR) LAN-POL-REV (NE) SF (TRUNK)

AS-CMD (G1000) LASER-APR (AOTS) SF-L (EC1)

AS-CMD (GE) LASERBIAS-DEG (AOTS) SF-L (OCN)

AS-CMD (GFP-FAC)

LASERBIAS-DEG (OTS)

SF-P (STSMON)

AS-CMD (ISC)

LASERBIAS-FAIL (AOTS)

SF-P (STSTRM)

AS-CMD (ISC)

LASEREOL (OCN)

SFTWDOWN (EQPT)

AS-CMD (ML100T)

LASERTEMP-DEG (AOTS)

SF-V (VT-MON)

AS-CMD (MLFX)

LCAS-CRC (STSTRM)

SF-V (VI-TERM)

AS-CMD (NE)

LCAS-CRC (VT-TERM)

SH-INS-LOSS-VAR-DEG-HIGH (OTS)

AS-CMD (OCH)

LCAS-RX-FAIL (STSTRM)

SH-INS-LOSS-VAR-DEG-LOW (OTS)

AS-CMD (OCN)

LCAS-TX-ADD (STSTRM)

SHUTTER-OPEN (OTS)

AS-CMD (OMS)

LCAS-TX-ADD (VT-TERM)

SIGLOSS (FC)

AS-CMD (OTS)

LCAS-TX-DNU (STSTRM)

SIGLOSS (FCMR)

AS-CMD (PPM)

LCAS-TX-DNU (VT-TERM)

SIGLOSS (GE)

AS-CMD (PWR)

LKOUTPR-S (OCN)

SIGLOSS (ISC)

AS-CMD (TRUNK)

LOA (VCG)

SIGLOSS (TRUNK)

AS-MT (2R)

LOCKOUT-REQ (2R)

SNTP-HOST (NE)

AS-MT (AOTS)

LOCKOUT-REQ (EQPT)

SPAN-SW-EAST (OCN)

AS-MT (CE100T)

LOCKOUT-REQ (ESCON)

SPAN-SW-WEST (OCN)
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I 2.2 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

AS-MT (DS1) LOCKOUT-REQ (FC) SQM (STSTRM)
AS-MT (DS3) LOCKOUT-REQ (GE) SQM (VT-TERM)
AS-MT (El) LOCKOUT-REQ (ISC) SQUELCH (OCN)
AS-MT (EC1) LOCKOUT-REQ (OCN) SQUELCHED (2R)

AS-MT (EQPT)

LOCKOUT-REQ (STSMON)

SQUELCHED (ESCON)

AS-MT (ESCON)

LOCKOUT-REQ (TRUNK)

SQUELCHED (FC)

AS-MT (FC)

LOCKOUT-REQ (VT-MON)

SQUELCHED (GE)

AS-MT (FCMR)

LOF (DS1)

SQUELCHED (ISC)

AS-MT (G1000) LOF (DS3) SQUELCHED (OCN)
AS-MT (GE) LOF (El) SQUELCHED (TRUNK)
AS-MT (GFP-FAC) LOF (EC1) SSM-DUS (BITS)
AS-MT (ISC) LOF (OCN) SSM-DUS (DS1)
AS-MT (ISC) LOF (STSTRM) SSM-DUS (E1)
AS-MT (ML100T) LOF (TRUNK) SSM-DUS (OCN)
AS-MT (MLFX) LOF (BITS) SSM-DUS (TRUNK)
AS-MT (OCH) LO-LASERBIAS (EQPT) SSM-FAIL (BITS)
AS-MT (OCN) LO-LASERBIAS (OCN) SSM-FAIL (DS1)
AS-MT (OMS) LO-LASERBIAS (PPM) SSM-FAIL (E1)
AS-MT (OTS) LO-LASERTEMP (EQPT) SSM-FAIL (OCN)
AS-MT (PPM) LO-LASERTEMP (OCN) SSM-FAIL (TRUNK)

AS-MT (TRUNK)

LO-LASERTEMP (PPM)

SSM-LNC (TRUNK)

AS-MT-O0G (STSTRM)

LOM (STSMON)

SSM-OFF (BITS)

AS-MT-O0G (VT-TERM)

LOM (TRUNK)

SSM-OFF (DS1)

AUD-LOG-LOSS (NE)

LOM (STSTRM)

SSM-OFF (E1)

AUD-LOG-LOW (NE)

LOM (VT-TERM)

SSM-OFF (OCN)

AUTOLSROFF (OCN)

LOP-P (STSMON)

SSM-OFF (TRUNK)

AUTOLSROFF (TRUNK)

LOP-P (STSTRM)

SSM-PRC (TRUNK)

AUTORESET (EQPT)

LOP-V (VI-MON)

SSM-PRS (BITS)

AUTOSW-AIS (STSMON)

LOP-V (VT-TERM)

SSM-PRS (DS1)

AUTOSW-AIS (VI-MON)

LO-RXPOWER (2R)

SSM-PRS (E1)

AUTOSW-LOP (STSMON)

LO-RXPOWER (ESCON)

SSM-PRS (NE-SREF)

AUTOSW-LOP (VI-MON)

LO-RXPOWER (FC)

SSM-PRS (OCN)

AUTOSW-PDI (STSMON)

LO-RXPOWER (GE)

SSM-PRS (TRUNK)

AUTOSW-SDBER (STSMON)

LO-RXPOWER (ISC)

SSM-RES (BITS)

AUTOSW-SFBER (STSMON)

LO-RXPOWER (OCN)

SSM-RES (DS1)

AUTOSW-UNEQ (STSMON)

LO-RXPOWER (TRUNK)

SSM-RES (E1)

AUTOSW-UNEQ (VT-MON)

LOS (2R)

SSM-RES (NE-SREF)
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2.2 Alarms and Conditions Listed By Alphabetical Entry ||

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

AWG-DEG (OTS) LOS (DS1) SSM-RES (OCN)
AWG-FAIL (OTS) LOS (DS3) SSM-RES (TRUNK)
AWG-OVERTEMP (OTS) LOS (E1) SSM-SDH-TN (TRUNK)
AWG-WARM-UP (OTS) LOS (EC1) SSM-SETS (TRUNK)
BAT-FAIL (PWR) LOS (ESCON) SSM-SMC (BITS)
BKUPMEMP (EQPT) LOS (ISC) SSM-SMC (DS1)
BLSROSYNC (OCN) LOS (OCN) SSM-SMC (E1)
BLSR-SW-VER-MISM (OCN) LOS (OTS) SSM-SMC (NE-SREF)
BPV (BITS) LOS (TRUNK) SSM-SMC (OCN)
CARLOSS (CE100T) LOS (BITS) SSM-SMC (TRUNK)
CARLOSS (E1000F) LOS (FUDC) SSM-ST2 (BITS)
CARLOSS (E100T) LOS (MSUDC) SSM-ST2 (DS1)
CARLOSS (EQPT) LOS-0 (OCH) SSM-ST2 (E1)
CARLOSS (FC) LOS-O (OMS) SSM-ST2 (NE-SREF)
CARLOSS (G1000) LOS-0 (OTS) SSM-ST2 (OCN)
CARLOSS (GE) LOS-P (OCH) SSM-ST2 (TRUNK)
CARLOSS (ISC) LOS-P (OMS) SSM-ST3 (BITS)
CARLOSS (ML1000) LOS-P (OTS) SSM-ST3 (DS1)

CARLOSS (ML100T)

LOS-P (TRUNK)

SSM-ST3 (El)

CARLOSS (MLFX)

LO-TXPOWER (2R)

SSM-ST3 (NE-SREF)

CARLOSS (TRUNK)

LO-TXPOWER (EQPT)

SSM-ST3 (OCN)

CASETEMP-DEG (AOTS)

LO-TXPOWER (ESCON)

SSM-ST3 (TRUNK)

CLDRESTART (EQPT)

LO-TXPOWER (FC)

SSM-ST3E (BITS)

COMIOXC (EQPT)

LO-TXPOWER (GE)

SSM-ST3E (DS1)

COMM-FAIL (EQPT)

LO-TXPOWER (ISC)

SSM-ST3E (E1)

CONTBUS-A-18 (EQPT)

LO-TXPOWER (OCN)

SSM-ST3E (NE-SREF)

CONTBUS-B-18 (EQPT)

LO-TXPOWER (PPM)

SSM-ST3E (OCN)

CONTBUS-DISABLED (EQPT)

LO-TXPOWER (TRUNK)

SSM-ST3E (TRUNK)

CONTBUS-IO-A (EQPT)

LPBKCRS (STSMON)

SSM-ST4 (BITS)

CONTBUS-IO-B (EQPT)

LPBKCRS (STSTRM)

SSM-ST4 (DS1)

CTNEQPT-MISMATCH (EQPT)

LPBKDS1FEAC-CMD (DS1)

SSM-ST4 (El)

CTNEQPT-PBPROT (EQPT)

LPBKDS3FEAC (DS3)

SSM-ST4 (NE-SREF)

CTNEQPT-PBWORK (EQPT)

LPBKDS3FEAC-CMD (DS3)

SSM-ST4 (OCN)

DATAFLT (NE)

LPBKFACILITY (CE100T)

SSM-ST4 (TRUNK)

DBOSYNC (NE)

LPBKFACILITY (DS1)

SSM-STU (BITS)

DS3-MISM (DS3)

LPBKFACILITY (DS3)

SSM-STU (DS1)

DSP-COMM-FAIL (TRUNK)

LPBKFACILITY (E1)

SSM-STU (E1)
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I 2.2 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6

ONS 15454 Alarm and Condition Alphabetical List (continued)

DSP-FAIL (TRUNK)

LPBKFACILITY (EC1)

SSM-STU (NE-SREF)

DUP-IPADDR (NE)

LPBKFACILITY (ESCON)

SSM-STU (OCN)

DUP-NODENAME (NE)

LPBKFACILITY (FC)

SSM-STU (TRUNK)

EHIBATVG (PWR)

LPBKFACILITY (FCMR)

SSM-TNC (BITS)

ELWBATVG (PWR)

LPBKFACILITY (G1000)

SSM-TNC (NE-SREF)

ENCAP-MISMATCH-P (STSTRM)

LPBKFACILITY (GE)

SSM-TNC (OCN)

ENVALRM)EXT LPBKFACILITY (ISC) SSM-TNC (TRUNK)

EOC (OCN) LPBKFACILITY (OCN) SWMTXMOD-PROT (EQPT)
EOC (TRUNK) LPBKFACILITY (TRUNK) SWMTXMOD-WORK (EQPT)
EOC-L (OCN) LPBKTERMINAL (CE100T) SWTOPRI (EXT-SREF)

EOC-L (TRUNK)

LPBKTERMINAL (DS1)

SWTOPRI (NE-SREF)

EQPT (AICI-AEP)

LPBKTERMINAL (DS3)

SWTOSEC (EXT-SREF)

EQPT (AICI-AIE)

LPBKTERMINAL (EI)

SWTOSEC (NE-SREF)

EQPT (EQPT)

LPBKTERMINAL (EC1)

SWTOTHIRD (EXT-SREF)

EQPT (PPM)

LPBKTERMINAL (ESCON)

SWTOTHIRD (NE-SREF)

EQPT-MISS (FAN)

LPBKTERMINAL (FC)

SYNC-FREQ (BITS)

ERFI-P-CONN (STSMON)

LPBKTERMINAL (FCMR)

SYNC-FREQ (DS1)

ERFI-P-CONN (STSTRM)

LPBKTERMINAL (G1000)

SYNC-FREQ (E1)

ERFI-P-PAYLD (STSMON)

LPBKTERMINAL (GE)

SYNC-FREQ (OCN)

ERFI-P-PAYLD (STSTRM)

LPBKTERMINAL (ISC)

SYNC-FREQ (TRUNK)

ERFI-P-SRVR (STSMON)

LPBKTERMINAL (OCN)

SYNCLOSS (FC)

ERFI-P-SRVR (STSTRM)

LPBKTERMINAL (TRUNK)

SYNCLOSS (FCMR)

ERROR-CONFIG (EQPT)

LWBATVG (PWR)

SYNCLOSS (GE)

ETH-LINKLOSS (NE)

MAN-REQ (EQPT)

SYNCLOSS (ISC)

E-W-MISMATCH (OCN)

MAN-REQ (STSMON)

SYNCLOSS (TRUNK)

EXCCOL (EQPT)

MAN-REQ (VT-MON)

SYNCPRI (EXT-SREF)

EXERCISE-RING-FAIL (OCN)

MANRESET (EQPT)

SYNCPRI (NE-SREF)

EXERCISE-SPAN-FAIL (OCN)

MANSWTOINT (NE-SREF)

SYNCSEC (EXT-SREF)

EXTRA-TRAF-PREEMPT (OCN)

MANSWTOPRI (EXT-SREF)

SYNCSEC (NE-SREF)

FAILTOSW (2R)

MANSWTOPRI (NE-SREF)

SYNCTHIRD (EXT-SREF)

FAILTOSW (EQPT)

MANSWTOSEC (EXT-SREF)

SYNCTHIRD (NE-SREF)

FAILTOSW (ESCON)

MANSWTOSEC (NE-SREF)

SYSBOOT (NE)

FAILTOSW (FC)

MANSWTOTHIRD (EXT-SREF)

TEMP-MISM (NE)

FAILTOSW (GE)

MANSWTOTHIRD (NE-SREF)

TIM (OCN)

FAILTOSW (ISC)

MANUAL-REQ-RING (OCN)

TIM (TRUNK)

FAILTOSW (OCN)

MANUAL-REQ-SPAN (2R)

TIM-MON (OCN)

FAILTOSW (TRUNK)

MANUAL-REQ-SPAN (ESCON)

TIM-MON (TRUNK)
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2.2 Alarms and Conditions Listed By Alphabetical Entry ||

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

FAILTOSW-PATH (STSMON) MANUAL-REQ-SPAN (EC) TIM-P (STSTRM)
FAILTOSW-PATH (VT-MON) MANUAL-REQ-SPAN (GE) TIM-P (STSMON)
FAILTOSWR (OCN) MANUAL-REQ-SPAN (ISC) TIM-S (EC1)
FAILTOSWS (OCN) MANUAL-REQ-SPAN (OCN) TIM-S (OCN)
FAN (FAN) MANUAL-REQ-SPAN (TRUNK) TIM-V (VT-TERM)
FC-NO-CREDITS (FC) MEA (AIP) TPTFAIL (CE100T)
FC-NO-CREDITS (FCMR) MEA (BIC) TPTFAIL (FCMR)
FC-NO-CREDITS (TRUNK) MEA (EQPT) TPTFAIL (G1000)
FE-AIS (DS3) MEA (FAN) TPTFAIL (ML1000)
FEC-MISM (TRUNK) MEA (PPM) TPTFAIL (ML100T)
FE-DS1-MULTLOS (DS3) MEM-GONE (EQPT) TPTFAIL (MLFX)
FE-DS1-NSA (DS3) MEM-LOW (EQPT) TRMT (DS1)
FE-DS1-SA (DS3) MFGMEM (AICI-AEP) TRMT (E1)
FE-DS1-SNGLLOS (DS3) MFGMEM (AICI-AIE) TRMT-MISS (DS1)
FE-DS3-NSA (DS3) MFGMEM (AIP) TRMT-MISS (E1)
FE-DS3-SA (DS3) MFGMEM (BPLANE) TX-AIS (DS1)
FE-EQPT-NSA (DS3) MFGMEM (FAN) TX-AIS (DS3)
FE-FRCDWKSWBK-SPAN (OCN) MFGMEM (PPM) TX-AIS (E1)
FE-FRCDWKSWPR-RING (OCN) NO-CONFIG (EQPT) TX-LOF (DS1)
FE-FRCDWKSWPR-SPAN (OCN) NOT-AUTHENTICATED TX-LOF (E1)
FE-IDLE (DS3) OCHNC-INC (OCHNC-CONN) TX-RAI (DS1)
FE-LOCKOUTOFPR-SPAN (OCN) ODUK-1-AIS-PM (TRUNK) TX-RAI (DS3)
FE-LOF (DS3) ODUK-2-AIS-PM (TRUNK) TX-RAI (E1)
FE-LOS (DS3) ODUK-3-AIS-PM (TRUNK) UNC-WORD (TRUNK)
FE-MANWKSWBK-SPAN (OCN) ODUK-4-AIS-PM (TRUNK) UNEQ-P (STSMON)
FE-MANWKSWPR-RING (OCN) ODUK-AIS-PM (TRUNK) UNEQ-P (STSTRM)
FE-MANWKSWPR-SPAN (OCN) ODUK-BDI-PM (TRUNK) UNEQ-V (VI-MON)
FEPRLF (OCN) ODUK-LCK-PM (TRUNK) UNEQ-V (VI-TERM)
FIBERTEMP-DEG (AOTS) ODUK-OCI-PM (TRUNK) UNREACHABLE-TARGET-POWER
(OCH)
FORCED-REQ (EQPT) ODUK-SD-PM (TRUNK) UT-COMM-FAIL (TRUNK)
FORCED-REQ (STSMON) ODUK-SF-PM (TRUNK) UT-FAIL (TRUNK)
FORCED-REQ (VT-MON) ODUK-TIM-PM (TRUNK) VCG-DEG (VCG)
FORCED-REQ-RING (OCN) OOU-TPT (STSTRM) VCG-DOWN (VCG)
FORCED-REQ-SPAN (2R) OOU-TPT (VT-TERM) VOA-HDEG (AOTS)
FORCED-REQ-SPAN (ESCON) OPEN-SLOT (EQPT) VOA-HDEG (OCH)
FORCED-REQ-SPAN (FC) OPTNTWMIS (NE) VOA-HDEG (OMS)

Cisco ONS 15454 Troubleshooting Guide, R6.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

I 2.2 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6 ONS 15454 Alarm and Condition Alphabetical List (continued)

FORCED-REQ-SPAN (GE)

OPWR-HDEG (AOTS)

VOA-HDEG (OTS)

FORCED-REQ-SPAN (ISC)

OPWR-HDEG (OCH)

VOA-HFAIL (AOTS)

FORCED-REQ-SPAN (OCN)

OPWR-HDEG (OMS)

VOA-HFAIL (OCH)

FORCED-REQ-SPAN (TRUNK)

OPWR-HDEG (OTS)

VOA-HFAIL (OMS)

FRCDSWTOINT (NE-SREF)

OPWR-HFAIL (AOTS)

VOA-HFAIL (OTS)

FRCDSWTOPRI (EXT-SREF)

OPWR-HFAIL (OCH)

VOA-LDEG (AOTS)

FRCDSWTOPRI (NE-SREF)

OPWR-HFAIL (OMS)

VOA-LDEG (OCH)

FRCDSWTOSEC (EXT-SREF)

OPWR-HFAIL (OTS)

VOA-LDEG (OMS)

FRCDSWTOSEC (NE-SREF)

OPWR-LDEG (AOTS)

VOA-LDEG (OTS)

FRCDSWTOTHIRD (EXT-SREF)

OPWR-LDEG (OCH)

VOA-LFAIL (AOTS)

FRCDSWTOTHIRD (NE-SREF)

OPWR-LDEG (OMS)

VOA-LFAIL (OCH)

FRNGSYNC (NE-SREF)

OPWR-LDEG (OTS)

VOA-LFAIL (OMS)

FSTSYNC (NE-SREF)

OPWR-LFAIL (AOTS)

VOA-LFAIL (OTS)

FULLPASSTHR-BI (OCN)

OPWR-LFAIL (OCH)

VOLT-MISM (PWR)

GAIN-HDEG (AOTS)

OPWR-LFAIL (OMS)

WKSWPR (2R)

GAIN-HFAIL (AOTS)

OPWR-LFAIL (OTS)

WKSWPR (EQPT)

GAIN-LDEG (AOTS)

OSRION (AOTS)

WKSWPR (ESCON)

GAIN-LFAIL (AOTS)

OSRION (OTS)

WKSWPR (FC)

GCC-EOC (TRUNK)

OTUK-AIS (TRUNK)

WKSWPR (GE)

GE-OOSYNC (FC)

OTUK-BDI (TRUNK)

WKSWPR (ISC)

GE-OOSYNC (GE)

OTUK-IAE (TRUNK)

WKSWPR (OCN)

GE-OOSYNC (ISC)

OTUK-LOF (TRUNK)

WKSWPR (STSMON)

GE-OOSYNC (TRUNK)

OTUK-SD (TRUNK)

WKSWPR (TRUNK)

GFP-CSF (CE100T)

OTUK-SF (TRUNK)

WKSWPR (VT-MON)

GFP-CSF (FCMR)

OTUK-TIM (TRUNK)

WTR (2R)

GFP-CSF (GFP-FAC) OUT-OF-SYNC (FC) WTR (EQPT)
GFP-CSF (ML1000) OUT-OF-SYNC (GE) WTR (ESCON)
GFP-CSF (ML100T) OUT-OF-SYNC (ISC) WTR (FC)
GFP-CSF (MLFX) OUT-OF-SYNC (TRUNK) WTR (GE)
GFP-DE-MISMATCH (FCMR) PARAM-MISM (AOTS) WTR (ISC)
GFP-DE-MISMATCH (GFP-FAC) PARAM-MISM (OCH) WTR (OCN)

GFP-EX-MISMATCH (FCMR)

PARAM-MISM (OMS)

WTR (STSMON)

GFP-EX-MISMATCH (GFP-FAC)

PARAM-MISM (OTS)

WTR (TRUNK)

GFP-LFD (CE100T)

PDI-P (STSMON)

WTR (VT-MON)

GFP-LFD (FCMR)

PDI-P (STSTRM)

WVL-MISMATCH (TRUNK)

GFP-LFD (GFP-FAC)

PEER-NORESPONSE (EQPT)

R6.0
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2.3 Alarm Logical Objects

The CTC alarm profile list organizes all alarms and conditions according to the logical objects they are
raised against. These logical objects represent physical objects such as cards, logical objects such as
circuits, or transport and signal monitoring entities such as the SONET or ITU-T G.709 optical overhead
bits. One alarm can appear in multiple entries. It can be raised against multiple objects. For example, the
loss of signal (LOS) alarm can be raised against the optical signal (OC-N) or the optical transport layer
overhead (OTN) as well as other objects. Therefore, both OCN: LOS and OTN: LOS appear in the list
(as well as the other objects).

Alarm profile list objects are defined in Table 2-7.

Note  Alarm logical object names can appear as abbreviated versions of standard terms used in the system and
the documentation. For example, the “OCN” logical object refers to the OC-N signal. Logical object
names or industry-standard terms are used within the entries as appropriate.

Table 2-7 Alarm Logical Object Type Definitions

Logical Object Definition

2R Reshape and retransmit (used for transponder [TXP] cards).

AICI-AEP Alarm Interface Controller—International/alarm expansion panel. A combination
term that refers to this platform’s AIC-I card.

AICI-AIE Alarm Interface Controller-International/Alarm Interface Extension. A
combination term that refers to this platform's AIC-I card.

AOTS Amplified optical transport section.

BIC Backplane interface connector.

BITS Building integrated timing supply incoming references (BITS-1, BITS-2).

BPLANE The backplane.

CE100T CE-100T-8 card.

DS1 A DS-1 line on a DS-1 or DS-3 electrical card (DS1-14, DS3N-12E, DS3XM-6,
DS3XM-12).

DS3 A DS-3 line on a DS3-12, DS3N-12, DS3-12E, DS3XM-6, DS3XM-12,
DS3/EC1-48 card.

E1 An E1 line on a DS1/E1-56 card.

E1000F An E1000 Ethernet card (E1000-2, E1000-2G).

E100T An E100 Ethernet card (E100T-12, E100T-G).

EC1 Any EC-1 port (including EC1-12 card ports).

ENVALRM An environmental alarm port.

EQPT A card, its physical objects, and its logical objects as they are located in any of the
eight noncommon card slots. The EQPT object is used for alarms that refer to the
card itself and all other objects on the card including ports, lines, synchronous
transport signals (STS), and virtual tributaries (VT).

ESCON Enterprise System Connection fiber optic technology, referring to the following
TXP cards: TXP_MR_2.5G, TXPP_MR_2.5G.
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Table 2-7 Alarm Logical Object Type Definitions (continued)

Logical Object Definition

EXT-SREF BITS outgoing references (SYNC-BITS1, SYNC-BITS2).

FAN Fan-tray assembly.

FC Fibre channel data transfer architecture, referring to the following muxponder
(MXP) or TXP cards: MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E.

FCMR An FC_MR-4 Fibre Channel card.

FUDC SONET F1 byte user data channel for ONS 15454 ML-Series Ethernet cards.

G1000 A G-Series Ethernet card.

GE Gigabit Ethernet, referring to the following MXP or TXP cards: MXP_MR_2.5G,
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_I10E,
TXP_MR_10G.

GFP-FAC Generic framing procedure facility port, referring to all MXP and TXP cards.

ISC Inter-service channel, referring to TXPP_MR_2.5G or TXP_MR_2.5G cards.

ML1000 An ML1000 Ethernet card (ML1000-2).

ML100T An ML100 Ethernet card (ML100T-12).

MLFX An ML100X-8 Ethernet card.

MSuUDC Multiplex section user data channel.

NE The entire network element.

NE-SREF The timing status of the NE.

O0CH The optical channel, referring to dense wavelength division multiplexing (DWDM)
cards.

OCHNC-CONN The optical channel network connection, referring to DWDM cards.

OCN An OC-N line on any OC-N card.

oMs Optical multiplex section.

0SC-RING Optical service channel ring.

0TS Optical transport section.

PPM Pluggable port module (PPM), referring to MXP and TXP cards.

PWR Power equipment.

STSMON STS alarm detection at the monitor point (upstream from the cross-connect).

STSTRM STS alarm detection at termination (downstream from the cross-connect).
The optical or DWDM card carrying the high-speed signal; referring to MXP or

TRUNK TXP cards.

VCG A virtual concatenation group of VTs.

VT-MON VT1 alarm detection at the monitor point (upstream from the cross-connect).

VT-TERM VT1 alarm detection at termination (downstream from the cross-connect).
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2.4 Alarm List by Logical Object Type

Table 2-8 lists all ONS 15454 Release 6.0 alarms and logical objects as they are given in the system
alarm profile. The list entries are organized by logical object name and then by alarm or condition name.
Where appropriate, the alarm entries also contain troubleshooting procedures.

Note  In a mixed network containing different types of nodes (such as ONS 15310-CL, ONS 15454, and
ONS 15600), the initially displayed alarm list in the Provisioning > Alarm Profiles > Alarm Profile
Editor tab lists all conditions that are applicable to all nodes in the network. However, when you load
the default severity profile from a node, only applicable alarms will display severity levels.
Nonapplicable alarms can display “use default” or “unset.”

~

Note In some cases this list does not follow alphabetical order, but it does reflect the order shown in CTC.

Table 2-8 Alarm List by Logical Object in Alarm Profile
2R: ALS EXT-SREF: SYNCPRI OCN: RFI-L
2R: AS-CMD EXT-SREF: SYNCSEC OCN: RING-ID-MIS
2R: AS-MT EXT-SREF: SYNCTHIRD OCN: RING-MISMATCH
2R: FAILTOSW FAN: EQPT-MISS OCN: RING-SW-EAST
2R: FORCED-REQ-SPAN FAN: FAN OCN: RING-SW-WEST
2R: HI-LASERBIAS FAN: MEA OCN: SD-L
2R: HI-RXPOWER FAN: MFGMEM OCN: SF-L
2R: HI-TXPOWER FC: ALS OCN: SPAN-SW-EAST
2R: LO-RXPOWER FC: AS-CMD OCN: SPAN-SW-WEST
2R: LO-TXPOWER FC: AS-MT OCN: SQUELCH
2R: LOCKOUT-REQ FC: CARLOSS OCN: SQUELCHED
2R: LOS FC: FAILTOSW OCN: SSM-DUS
2R: MANUAL-REQ-SPAN FC: FCC-NO-EDITS OCN: SSM-FAIL
2R: SQUELCHED FC: FORCED-REQ-SPAN OCN: SSM-OFF
2R: WKSWPR FC: GE-OOSYNC OCN: SSM-PRS
2R: WTR FC: HI-LASERBIAS OCN: SSM-RES
AICI-AEP: EQPT FC: HI-RXPOWER OCN: SSM-SMC
AICI-AEP: MFGMEM FC: HI-TXPOWER OCN: SSM-ST2
AICI-AIE: EQPT FC: LO-RXPOWER OCN: SSM-ST3
AICI-AIE: MFGMEM FC: LO-TXPOWER OCN: SSM-ST3E
AIP: INVMACADR FC: LOCKOUT-REQ OCN: SSM-ST4
AIP: MEA FC: LPBKFACILITY OCN: SSM-STU
AIP: MFGMEM FC: LPBKTERMINAL OCN: SSM-TNC
AOTS: ALS FC: MANUAL-REQ-SPAN OCN: SYNC-FREQ
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

AOTS: AMPLI-INIT FC: OUT-OF-SYNC OCN: TIM

AOTS: FC: SIGLOSS OCN: TIM-MON
APC-CORRECTION-SKIPPED

AOTS: APC-OUT-OF-RANGE FC: SQUELCHED OCN: TIM-S

AOTS: AS-CMD FC: SYNCLOSS OCN: WKSWPR
AOTS: AS-MT FC: WKSWPR OCN: WTR

AOTS: CASETEMP-DEG FC: WTR OMS: APC-CORRECTION-SKIPPED
AOTS: FIBERTEMP-DEG FCMR: AS-CMD OMS: APC-OUT-OF-RANGE
AOTS: GAIN-HDEG FCMR: AS-MT OMS: AS-CMD
AOTS: GAIN-HFAIL FCMR: FC-NO-EDITS OMS: AS-MT

AOTS: GAIN-LDEG FCMR: GFP-CSF OMS: LOS-0O

AOTS: GAIN-LFAIL FCMR: GFP-DE-MISMATCH OMS: LOS-P

AOTS: LASER-APR FCMR: GFP-EX-MISMATCH OMS: OPWR-HDEG
AOTS: LASERBIAS-DEG FCMR: GFP-LFD OMS: OPWR-HFAIL
AOTS: LASERBIAS-FAIL FCMR: GFP-NO-BUFFERS OMS: OPWR-LDEG
AOTS: LASERTEMP-DEG FCMR: GFP-UP-MISMATCH OMS: OPWR-LFAIL
AOTS: OPWR-HDEG FCMR: LPBKFACILITY OMS: PARAM-MISM
AOTS: OPWR-HFAIL FCMR: LPBKTERMINAL OMS: VOA-HDEG
AOTS: OPWR-LDEG FCMR: PORT-MISMATCH OMS: VOA-HFAIL
AOTS: OPWR-LFAIL FCMR: SIGLOSS OMS: VOA-LDEG
AOTS: OSRION FCMR: SYNCLOSS OMS: VOA-LFAIL

AOTS: PARAM-MISM

FCMR: TPTFAIL

OSC-RING: RING-ID-MIS

AOTS: VOA-HDEG FUDC: AIS OTS: APC-CORRECTION-SKIPPED
AOTS: VOA-HFAIL FUDC: LOS OTS: APC-OUT-OF-RANGE
AOTS: VOA-LDEG G1000: AS-CMD OTS: AS-CMD

AOTS: VOA-LFAIL G1000: AS-MT OTS: AS-MT

BIC: MEA G1000: CARLOSS OTS: AWG-DEG

BITS: AIS G1000: LPBKFACILITY OTS: AWG-FAIL

BITS: BPV G1000: LPBKTERMINAL OTS: AWG-OVERTEMP
BITS: HI-CCVOLT G1000: TPTFAIL OTS: AWG-WARM-UP
BITS: LOF GE: ALS OTS: LASERBIAS-DEG
BITS: LOS GE: AS-CMD OTS: LOS

BITS: SSM-DUS GE: AS-MT OTS: LOS-O

BITS: SSM-FAIL GE: CARLOSS OTS: LOS-P

BITS: SSM-OFF GE: FAILTOSW OTS: OPWR-HDEG

BITS: SSM-PRS GE: FORCED-REQ-SPAN OTS: OPWR-HFAIL

BITS: SSM-RES GE: AGE-OOSYNC OTS: OPWR-LDEG
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

BITS: SSM-SMC GE: HI-LASERBIAS OTS: OPWR-LFAIL

BITS: SSM-ST2 GE: HI-RXPOWER OTS: OSRION

BITS: SSM-ST3 GE: HI-TXPOWER OTS: PARAM-MISM

BITS: SSM-ST3E GE: LO-RXPOWER OTS: SH-INS-LOSS-VAR-DEG-HIGH
BITS: SSM-ST4 GE: LO-TXPOWER OTS: SH-INS-LOSS-VAR-DEG-LOW
BITS: SSM-STU GE: LOCKOUT-REQ OTS: SHUTTER-OPEN
BITS: SSM-TNC GE: LPBKFACILITY OTS: VOA-HDEG

BITS: SYNC-FREQ GE: LPBKTERMINAL OTS: VOA-HFAIL
BPLANE: AS-CMD GE: MANUAL-REQ-SPAN OTS: VOA-LDEG

BPLANE: MFGMEM GE: OUT-OF-SYNC OTS: VOA-LFAIL

CE100T: AS-CMD GE: SIGLOSS PPM: AS-CMD

CE100T: AS-MT GE: SQUELCHED PPM: AS-MT

CE100T: CARLOSS GE: SYNCLOSS PPM: EQPT

CE100T: GFP-CSF GE: WKSWPR PPM: HI-LASERBIAS
CE100T: GFP-LFD GE: WTR PPM: HI-LASERTEMP
CE100T: GFP-UP-MISMATCH GFP-FAC: AS-CMD PPM: HI-TXPOWER
CE100T: LPBKFACILITY GFP-FAC: AS-MT PPM: IMPROPRMVL
CE100T: LPBKTERMINAL GFP-FAC: GFP-CSF PPM: LO-LASERBIAS
CE100T: RPRW GFP-FAC: GFP-DE-MISMATCH PPM: LO-LASERTEMP
CE100T: TPTFAIL GFP-FAC: GFP-EX-MISMATCH PPM: LO-TXPOWER

DSI1: AIS GFP-FAC: GFP-LFD PPM: MEA

DS1: AS-CMD GFP-FAC: GFP-NO-BUFFERS PPM: MFGMEM

DS1: AS-MT GFP-FAC: GFP-UP-MISMATCH PPM: PROV-MISMATCH
DS1: LOF ISC: ALS PWR: AS-CMD

DS1: LOS ISC: AS-CMD PWR: BAT-FAIL

DS1: LPBKDSIFEAC-CMD ISC: AS-MT PWR: EHIBATVG

DS1: LPBKFACILITY ISC: CARLOSS PWR: ELWBATVG

DS1: LPBKTERMINAL ISC: FAILTOSW PWR: HIBATVG

DSI1: RAI ISC: FORCED-REQ-SPAN PWR: LWBATVG

DS1: RCVR-MISS ISC: GE-OOSYNC PWR: VOLT-MISM

DS1: SD ISC: HI-LASERBIAS STSMON: AIS-P

DS1: SF ISC: HI-RXPOWER STSMON: AUTOSW-AIS
DS1: SSM-DUS ISC: HI-TXPOWER STSMON: AUTOSW-LOP
DS1: SSM-FAIL ISC: LO-RXPOWER STSMON: AUTOSW-PDI
DS1: SSM-OFF ISC: LO-TXPOWER STSMON: AUTOSW-SDBER
DS1: SSM-PRS ISC: LOCKOUT-REQ STSMON: AUTOSW-SFBER
DS1: SSM-RES ISC: LOS STSMON: AUTOSW-UNEQ
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

DS1: SSM-SMC ISC: LPBKFACILITY STSMON: ERFI-P-CONN
DS1: SSM-ST2 ISC: LPBKTERMINAL STSMON: ERFI-P-PAYLD
DS1: SSM-ST3 ISC: MANUAL-REQ-SPAN STSMON: ERFI-P-SRVR
DS1: SSM-ST3E ISC: OUT-OF-SYNC STSMON: FAILTOSW-PATH
DS1: SSM-ST4 ISC: SIGLOSS STSMON: FORCED-REQ
DS1: SSM-STU ISC: SQUELCHED STSMON: LOCKOUT-REQ
DS1: SYNC-FREQ ISC: SYNCLOSS STSMON: LOM

DS1: TRMT ISC: WKSWPR STSMON: LOP-P

DS1: TRMT-MISS ISC: WTR STSMON: LPBKS

DS1: TX-AIS ML1000: AS-CMD STSMON: MAN-REQ
DS1: TX-LOF ML1000: AS-MT STSMON: PDI-P

DS1: TX-RAI ML1000: CARLOSS STSMON: PLM-P

DS3: AIS ML1000: GFP-CSF STSMON: RFI-P

DS3: AS-CMD ML1000: GFP-LFD STSMON: ROLL

DS3: AS-MT ML1000: GFP-UP-MISMATCH STSMON: ROLL-PEND
DS3: DS3-MISM ML1000: RPRW STSMON: SD-P

DS3: FE-AIS ML1000: TPTFAIL STSMON: SF-P

DS3: FE-DS1-MULTLOS ML100T: AS-CMD STSMON: TIM-P

DS3: FE-DS1-NSA MLI100T: AS-MT STSMON: UNEQ-P

DS3: FE-DS1-SA ML100T: CARLOSS STSMON: WKSWPR
DS3: FE-DS1-SNGLLOS ML100T: GFP-CSF STSMON: WTR

DS3: FE-DS3-NSA ML100T: GFP-LFD STSTRM: AIS-P

DS3: FE-DS3-SA ML100T: GFP-UP-MISMATCH STSTRM: AS-MT-O0G
DS3: FE-EQPT-NSA ML100T: RPRW STSTRM: ENCAP-MISMATCH-P
DS3: FE-IDLE ML100T: TPTFAIL STSTRM: ERFI-P-CONN
DS3: FE-LOF MLFX: AS-CMD STSTRM: ERFI-P-PAYLD
DS3: FE-LOS MLFX: AS-MT STSTRM: ERFI-P-SRVR
DS3: INC-ISD MLFX: CARLOSS STSTRM: LCAS-C

DS3: LOF MLFX: GFP-CSF STSTRM: LCAS-RX-FAIL
DS3: LOS MLEFX: GFP-LFD STSTRM: LCAS-TX-ADD
DS3: LPBKDS3FEAC MLFX: GFP-UP-MISMATCH STSTRM: LCAS-TX-DNU
DS3: LPBKDS3FEAC-CMD MLFX: RPRW STSTRM: LOF

DS3: LPBKFACILITY MLFX: TPTFAIL STSTRM: LOM

DS3: LPBKTERMINAL MSUDC: AIS STSTRM: LOP-P

DS3: RAI MSUDC: LOS STSTRM: LPBKS

DS3: SD NE-SREF: FRCDSWTOINT STSTRM: OOU-TPT

DS3: SF NE-SREF: FRCDSWTOPRI STSTRM: PDI-P
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

DS3: TX-AIS NE-SREF: FRCDSWTOSEC STSTRM: PLM-P

DS3: TX-RAI NE-SREF: FRCDSWTOTHIRD STSTRM: RFI-P

E1000F: AS-CMD NE-SREF: FRNGSYNC STSTRM: ROLL

E1000F: CARLOSS NE-SREF: FSTSYNC STSTRM: ROLL-PEND
E100T: AS-CMD NE-SREF: HLDOVRSYNC STSTRM: SD-P

E100T: CARLOSS NE-SREF: MANSWTOINT STSTRM: SF-P

El: AIS NE-SREF: MANSWTOPRI STSTRM: SQM

El: AS-CMD NE-SREF: MANSWTOSEC STSTRM: TIM-P

El: AS-MT NE-SREF: MANSWTOTHIRD STSTRM: UNEQ-P

El: LOF NE-SREF: SSM-PRS TRUNK: AIS

El: LOS NE-SREF: SSM-RES TRUNK: ALS

El: LPBKFACILITY NE-SREF: SSM-SMC TRUNK: AS-CMD

El: LPBKTERMINAL NE-SREF: SSM-ST2 TRUNK: AS-MT

El: RAI NE-SREF: SSM-ST3 TRUNK: AUTOLSROFF
El: RCVR-MISS NE-SREF: SSM-ST3E TRUNK: CARLOSS

El: SD NE-SREF: SSM-ST4 TRUNK: DSP-COMM-FAIL
El: SF NE-SREF: SSM-STU TRUNK: DSP-FAIL

El: SSM-DUS NE-SREF: SSM-TNC TRUNK: EOC

El: SSM-FAIL NE-SREF: SWTOPRI TRUNK: EOC-L

E1l: SSM-OFF NE-SREF: SWTOSEC TRUNK: FAILTOSW

E1l: SSM-PRS NE-SREF: SWTOTHIRD TRUNK: FC-NO-EDITS
El: SSM-RES NE-SREF: SYNCPRI TRUNK: FEC-MISM

El: SSM-SMC NE-SREF: SYNCSEC TRUNK: FORCED-REQ-SPAN
El: SSM-ST2 NE-SREF: SYNCTHIRD TRUNK: GCC-EOC

E1l: SSM-ST3 NE: APC-DISABLED TRUNK: GE-OOSYNC
El: SSM-ST3E NE: APC-END TRUNK: HI-LASERBIAS
El: SSM-ST4 NE: AS-CMD TRUNK: HI-RXPOWER
El: SSM-STU NE: AUD-LOG-LOSS TRUNK: HI-TXPOWER
El: SYNC-FREQ NE: AUD-LOG-LOW TRUNK: LO-RXPOWER
El: TRMT NE: DATAFLT TRUNK: LO-TXPOWER
El: TRMT-MISS NE: DBOSYNC TRUNK: LOCKOUT-REQ
El: TX-AIS NE: DUP-IPADDR TRUNK: LOF

El: TX-LOF NE: DUP-NODEME TRUNK: LOM

El: TX-RAI NE: ETH-LINKLOSS TRUNK: LOS

EC1: AIS-L NE: HITEMP TRUNK: LOS-P

EC1: AS-CMD NE: I-HITEMP TRUNK: LPBKFACILITY
EC1: AS-MT NE: INTRUSION-PSWD TRUNK: LPBKTERMINAL
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

ECI1: LOF NE: LAN-POL-REV TRUNK: MANUAL-REQ-SPAN
EC1: LOS NE: OPTNTWMIS TRUNK: ODUK-1-AIS-PM
EC1: LPBKFACILITY NE: SNTP-HOST TRUNK: ODUK-2-AIS-PM
ECI1: LPBKTERMINAL NE: SYSBOOT TRUNK: ODUK-3-AIS-PM
ECI1: RFI-L NE: TEMP-MISM TRUNK: ODUK-4-AIS-PM
EC1: SD-L OCH: APC-CORRECTION-SKIPPED | TRUNK: ODUK-AIS-PM
EC1: SF-L OCH: APC-OUT-OF-RANGE TRUNK: ODUK-BDI-PM
ECI1: TIM-S OCH: AS-CMD TRUNK: ODUK-LCK-PM
ENVALRM: EXT OCH: AS-MT TRUNK: ODUK-OCI-PM
EQPT: AS-CMD OCH: LOS-O TRUNK: ODUK-SD-PM
EQPT: AS-MT OCH: LOS-P TRUNK: ODUK-SF-PM
EQPT: AUTORESET OCH: OPWR-HDEG TRUNK: ODUK-TIM-PM
EQPT: BKUPMEMP OCH: OPWR-HFAIL TRUNK: OTUK-AIS
EQPT: CARLOSS OCH: OPWR-LDEG TRUNK: OTUK-BDI
EQPT: CLDRESTART OCH: OPWR-LFAIL TRUNK: OTUK-IAE
EQPT: COMIOXC OCH: PARAM-MISM TRUNK: OTUK-LOF
EQPT: COMM-FAIL OCH: PORT-ADD-PWR-DEG-HI TRUNK: OTUK-SD

EQPT: CONTBUS-A-18 OCH: PORT-ADD-PWR-DEG-LOW TRUNK: OTUK-SF

EQPT: CONTBUS-B-18 OCH: PORT-ADD-PWR-FAIL-HIGH TRUNK: OTUK-TIM
EQPT: CONTBUS-DISABLED OCH: PORT-ADD-PWR-FAIL-LOW TRUNK: OUT-OF-SYNC
EQPT: CONTBUS-IO-A OCH: PORT-FAIL TRUNK: PTIM

EQPT: CONTBUS-IO-B OCH: UEACHABLE-TARGET-POWER |TRUNK: RFI

EQPT: CTNEQPT-MISMATCH OCH: VOA-HDEG TRUNK: SD

EQPT: CTNEQPT-PBPROT OCH: VOA-HFAIL TRUNK: SF

EQPT: CTNEQPT-PBWORK OCH: VOA-LDEG TRUNK: SIGLOSS

EQPT: EQPT OCH: VOA-LFAIL TRUNK: SQUELCHED
EQPT: ERROR-CONFIG OCHNC-CONN: OCHNC-INC TRUNK: SSM-DUS

EQPT: EXCCOL OCN: AIS-L TRUNK: SSM-FAIL
EQPT: FAILTOSW OCN: ALS TRUNK: SSM-LNC

EQPT: FORCED-REQ OCN: APS-INV-PRIM TRUNK: SSM-OFF

EQPT: HI-LASERBIAS OCN: APS-PRIM-FAC TRUNK: SSM-PRC

EQPT: HI-LASERTEMP OCN: APS-PRIM-SEC-MISM TRUNK: SSM-PRS

EQPT: HI-TXPOWER OCN: APSB TRUNK: SSM-RES

EQPT: HITEMP OCN: APSC-IMP TRUNK: SSM-SDH-TN
EQPT: IMPROPRMVL OCN: APSCDFLTK TRUNK: SSM-SETS
EQPT: INHSWPR OCN: APSCINCON TRUNK: SSM-SMC

EQPT: INHSWWKG OCN: APSCM TRUNK: SSM-ST2
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

EQPT: IOSCFGCOPY OCN: APSCNMIS TRUNK: SSM-ST3

EQPT: LO-LASERBIAS OCN: APSIMP TRUNK: SSM-ST3E

EQPT: LO-LASERTEMP OCN: APSMM TRUNK: SSM-ST4

EQPT: LO-TXPOWER OCN: AS-CMD TRUNK: SSM-STU

EQPT: LOCKOUT-REQ OCN: AS-MT TRUNK: SSM-TNC

EQPT: MAN-REQ OCN: AUTOLSROFF TRUNK: SYNC-FREQ

EQPT: MAESET OCN: BLSR-SW-VER-MISM TRUNK: SYNCLOSS

EQPT: MEA OCN: BLSROSYNC TRUNK: TIM

EQPT: MEM-GONE OCN: E-W-MISMATCH TRUNK: TIM-MON

EQPT: MEM-LOW OCN: EOC TRUNK: UNC-WORD

EQPT: NO-CONFIG OCN: EOC-L TRUNK: UT-COMM-FAIL

EQPT: OPEN-SLOT OCN: EXERCISE-RING-FAIL TRUNK: UT-FAIL

EQPT: PEER-NORESPONSE OCN: EXERCISE-SPAN-FAIL TRUNK: WKSWPR

EQPT: PROT OCN: EXTRA-TRAF-PREEMPT TRUNK: WTR

EQPT: PWR-FAIL-A OCN: FAILTOSW TRUNK: WVL-MISMATCH

EQPT: PWR-FAIL-B OCN: FAILTOSWR VCG: LOA

EQPT: PWR-FAIL-RET-A OCN: FAILTOSWS VCG: VC-DEG

EQPT: PWR-FAIL-RET-B OCN: FE-FRCDWKSWBK-SPAN VCG: VC-DOWN

EQPT: RUNCFG-SAVENEED OCN: FE-FRCDWKSWPR-RING VT-MON: AIS-V

EQPT: SFTWDOWN OCN: FE-FRCDWKSWPR-SPAN VT-MON: AUTOSW-AIS

EQPT: SWMTXMOD-PROT OCN: FE-LOCKOUTOFPR-SPAN VT-MON: AUTOSW-LOP

EQPT: SWMTXMOD-WORK OCN: FE-MANWKSWBK-SPAN VT-MON: AUTOSW-UNEQ

EQPT: WKSWPR OCN: FE-sMANWKSWPR-RING VT-MON: FAILTOSW-PATH

EQPT: WTR OCN: FE-sMANWKSWPR-SPAN VT-MON: FORCED-REQ

ESCON: ALS OCN: FEPRLF VT-MON: LOCKOUT-REQ

ESCON: AS-CMD OCN: FORCED-REQ-RING VT-MON: LOP-V

ESCON: AS-MT OCN: FORCED-REQ-SPAN VT-MON: MAN-REQ

ESCON: FAILTOSW OCN: FULLPASSTHR-BI VT-MON: ROLL

ESCON: FORCED-REQ-SPAN OCN: HELLO VT-MON: ROLL-PEND

ESCON: HI-LASERBIAS OCN: HI-LASERBIAS VT-MON: SD-V

ESCON: HI-RXPOWER OCN: HI-LASERTEMP VT-MON: SF-V

ESCON: HI-TXPOWER OCN: HI-RXPOWER VT-MON: UNEQ-V

ESCON: LO-RXPOWER OCN: HI-TXPOWER VT-MON: WKSWPR

ESCON: LO-TXPOWER OCN: ISIS-ADJ-FAIL VT-MON: WTR

ESCON: LOCKOUT-REQ OCN: KB-PASSTHR VT-TERM: AIS-V

ESCON: LOS OCN: VT-TERM: AS-MT-O0G
KBYTE-APS-CHANNEL-FAILURE
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

ESCON: LPBKFACILITY OCN: LASEREOL VT-TERM: LCAS-C
ESCON: LPBKTERMINAL OCN: LKOUTPR-S VT-TERM: LCAS-RX-FAIL
ESCON: MANUAL-REQ-SPAN OCN: LO-LASERBIAS VT-TERM: LCAS-TX-ADD
ESCON: SQUELCHED OCN: LO-LASERTEMP VT-TERM: LCAS-TX-DNU
ESCON: WKSWPR OCN: LO-RXPOWER VT-TERM: LOM

ESCON: WTR OCN: LO-TXPOWER VT-TERM: LOP-V
EXT-SREF: FRCDSWTOPRI OCN: LOCKOUT-REQ VT-TERM: OOU-TPT
EXT-SREF: FRCDSWTOSEC OCN: LOF VT-TERM: PLM-V
EXT-SREF: FRCDSWTOTHIRD OCN: LOS VT-TERM: RFI-V
EXT-SREF: MANSWTOPRI OCN: LPBKFACILITY VT-TERM: SD-V
EXT-SREF: MANSWTOSEC OCN: LPBKTERMINAL VT-TERM: SF-V
EXT-SREF: MANSWTOTHIRD OCN: MANUAL-REQ-RING VT-TERM: SQM
EXT-SREF: SWTOPRI OCN: MANUAL-REQ-SPAN VT-TERM: TIM-V
EXT-SREF: SWTOSEC OCN: PRC-DUPID VT-TERM: UNEQ-V
EXT-SREF: SWTOTHIRD — —

2.5 DS3-12 E Line Alarms

Unlike the standard DS-3 card, which uses the unframed format exclusively, the DS3-12E card’s ports
provide three choices: unframed, M13, or C Bit. The choice of framing format determines the line alarms
that the DS3-12E card reports. The following table lists the line alarms reported under each format.

The choice of framing format does not affect the reporting of STS alarms. Regardless of format, the
DS3-12E card reports the same STS alarms and conditions, listed in Table 2-9, as the standard DS-3 card

reports.

Table 2-9 DS3-12E Line Alarms

Alarm UNFRAMED M13 CBIT
LOS (DS1 or DS3) Yes Yes Yes
AIS Yes Yes Yes
LOF (DS1 or DS3) No Yes Yes
FE-IDLE No Yes Yes
RAI No Yes Yes
Terminal Lpbk Yes Yes Yes
(LPBKTERMINAL for DS1 or

DS3)

Facility Lpbk (LPBKFACILITY |Yes Yes Yes
for DS1 or DS3)

LPBKDSI1FEAC or No No Yes
LPBKDS3FEAC
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Table 2-9 DS3-12E Line Alarms (continued)

Alarm UNFRAMED M13 CBIT
FE Common Equipment No No Yes
Failure-NSA (FE-DS1-NSA or

FE-DS3-NSA)

FE Equipment Failure-SA No No Yes
(FE-DS3-SA)

FE-LOS No No Yes
FE-LOF No No Yes
FE-AIS No No Yes
FE-IDLE No No Yes
FE Equipment Failure-NSA No No Yes
(FE-EQPT-NSA)

2.6 Trouble Notifications

The ONS 15454 system reports trouble by utilizing standard alarm and condition characteristics,
standard severities following the rules in Telcordia GR-253-CORE, and graphical user interface (GUI)
state indicators.These notifications are described in the following paragraphs.

The ONS 15454 uses standard Telcordia categories to characterize levels of trouble. The system reports
trouble notifications as alarms and status or descriptive notifications (if configured to do so) as
conditions in the CTC Alarms window. Alarms typically signify a problem that the user needs to remedy,
such as a loss of signal. Conditions do not necessarily require troubleshooting.

2.6.1 Alarm Characteristics

The ONS 15454 uses standard alarm entities to identify what is causing trouble. All alarms stem from
hardware, software, environment, or operator-originated problems whether or not they affect service.
Current alarms for the network, CTC session, node, or card are listed in the Alarms tab. (In addition,
cleared alarms are also found in the History tab.)

2.6.2 Condition Characteristics

Conditions include any problem detected on an ONS 15454 shelf. They can include standing or transient
notifications. A snapshot of all current raised, standing conditions on the network, node, or card can be
retrieved in the CTC Conditions window or using TL1's set of RTRV-COND commands. (In addition,
some but not all cleared conditions are also found in the History tab.)

For a comprehensive list of all conditions, refer to the Cisco SONET TL1 Command Guide .

2.6.3 Severities

The ONS 15454 uses Telcordia-devised standard severities for alarms and conditions: Critical (CR),
Major (MJ), Minor (MN), Not Alarmed (NA) and Not Reported (NR). These are described below:
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Cisco ONS 15454 Troubleshooting Guide, R6.0 gy



Chapter2  Alarm Troubleshooting |

I 26.4 Alarm Hierarchy

e A Critical (CR) alarm generally indicates severe, Service-Affecting (SA) trouble that needs
immediate correction. Loss of traffic on an STS-1, which can hold 28 DS-1 circuits, would be a
Critical (CR), Service-Affecting (SA) alarm.

e A Major (MJ) alarm is a serious alarm, but the trouble has less impact on the network. For example,
loss of traffic on more than five DS-1 circuits is Critical (CR), but loss of traffic on one to four DS-1
circuits is Major (MJ).

e Minor (MN) alarms generally are those that do not affect service. For example, the automatic
protection switching (APS) byte failure (APSB) alarm indicates that line terminating equipment
(LTE) detects a byte failure on the signal that could prevent traffic from properly executing a traffic
switch.

e Not Alarmed (NA) conditions are information indicators, such as for free-run synchronization state
(FRNGSYNC) or a forced-switch to primary (FRCSWTOPRI) timing event. They could or could
not require troubleshooting, as indicated in the entries.

¢ Not Reported (NR) conditions occur as a secondary result of another event. For example, the alarm
indication signal (AIS), with severity NR, is inserted by a downstream node when an LOS (CR or
MJ) alarm occurs upstream. These conditions do not in themselves require troubleshooting, but are
to be expected in the presence of primary alarms.

Severities can be customized for an entire network or for single nodes, from the network level down to
the port level by changing or downloading customized alarm profiles. These custom severities are
subject to the standard severity-demoting rules given in Telcordia GR-474-CORE and shown in the
2.6.4 Alarm Hierarchy section. Procedures for customizing alarm severities are located in the “Manage
Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

2.6.4 Alarm Hierarchy

All alarm, condition, and unreported event severities listed in this manual are default profile settings.
However in situations when traffic is not lost, such as when the alarm occurs on protected ports or
circuits, alarms having Critical (CR) or Major (MJ) default severities can be demoted to lower severities
such as Minor (MN) or Non-Service-Affecting (NSA) as defined in Telcordia GR-474-CORE.

A path alarm can be demoted if a higher-ranking alarm is raised for the same object. For example, If a
path trace identifier mismatch (TIM-P) is raised on a circuit path and then a loss of pointer on the path
(LOP-P) is raised on the path, the LOP-P alarm stands and the TIM-P closes. The path alarm hierarchy
used in the ONS 15454 system is shown in Table 2-10.

Table 2-10 Path Alarm Hierarchy

Priority Condition Type
Highest AIS-P

— LOP-P

_ UNEQ-P
Lowest TIM-P

Facility (port) alarms also follow a hierarchy, which means that lower-ranking alarms are closed by
higher-ranking alarms. The facility alarm hierarchy used in the ONS 15454 is shown in Table 2-11.
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Table 2-11

Facility Alarm Hierarchy

Priority

Condition Type

Highest

LOS

LOF

AIS-L

SF-L

SD-L

RFI-L

TIM-S

AIS-P

LOP-P

SF-P

SD-P

UNEQ-P

TIM-P

Lowest

PLM-P

2.6.4 Alarm Hierarchy

Near-end failures and far-end failures follow different hierarchies. Near-end failures stand according to
whether they are for the entire signal (LOS, LOF), facility (AIS-L), path (AIS-P, etc.) or VT (AIS-V,
etc.). The full hierarchy for near-end failures is shown in Table 2-12. This table is taken from

Telcordia GR-253-CORE.

Table 2-12 Near-End Alarm Hierarchy

Priority

Condition Type

Highest

LOS

LOF

AIS-L

AIS-P!

LOP-P?

UNEQ-P

TIM-P

PLM-P

AIS-V!

LOP-V?

UNEQ-V

PLM-V

Lowest

DS-N AIS (if reported for
outgoing DS-N signals)
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1. Although itis not defined as a defect or failure, all-ones STS pointer relay is also
higher priority than LOP-P. Similarly, all-ones VT pointer relay is higher priority
than LOP-V.

2. LOP-Pis also higher priority than the far-end failure RFI-P, which does not affect
the detection of any near-end failures. Similarly, LOP-V is higher priority than
RFI-V.

The far-end failure alarm hierarchy is shown in Table 2-13, as given in Telcordia GR-253-CORE.

Table 2-13 Far-End Alarm Hierarchy

Priority Condition Type
Highest RFI-L
— RFI-P
Lowest RFI-V

2.6.5 Service Effect

Service-Affecting (SA) alarms—those that interrupt service—could be Critical (CR), Major (MJ), or
Minor (MN) severity alarms. Service-Affecting (SA) alarms indicate service is affected.
Non-Service-Affecting (NSA) alarms always have a Minor (MN) default severity.

2.6.6 States

The Alarms or History tab State (ST) column indicate the disposition of the alarm or condition as
follows:

e A raised (R) event is one that is active.
e A cleared (C) event is one that is no longer active.

e A transient (T) event is one that is automatically raised and cleared in CTC during system changes
such as user login, logout, loss of connection to node view, etc. Transient events do not require user
action. These are listed in Chapter 3, “Transients Conditions.”

2.7 Safety Summary

This section covers safety considerations designed to ensure safe operation of the ONS 15454. Personnel
should not perform any procedures in this chapter unless they understand all safety precautions,
practices, and warnings for the system equipment. Some troubleshooting procedures require installation
or removal of cards; in these instances users should pay close attention to the following caution.

A

Caution = Hazardous voltage or energy could be present on the backplane when the system is operating. Use
caution when removing or installing cards.

Some troubleshooting procedures require installation or removal of OC-192 cards; in these instances
users should pay close attention to the following warnings.
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Warning
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Warning

A

Warning

A

Warning

A

Warning

2.8 Alarm Procedures Il

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Class 1 laser product. Statement 1008

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

2.8 Alarm Procedures

Note

Note

This section list alarms alphabetically and includes some conditions commonly encountered when
troubleshooting alarms. The severity, description, and troubleshooting procedure accompany each alarm
and condition.

When you check the status of alarms for cards, ensure that the alarm filter icon in the lower right corner
of the GUI is not indented. If it is, click it to turn it off. When you are done checking for alarms, you can
click the alarm filter icon again to turn filtering back on. For more information about alarm filtering,
refer to the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

When checking alarms, ensure that alarm suppression is not enabled on the card or port. For more
information about alarm suppression, refer to the “Manage Alarms” chapter in the Cisco ONS 15454
Procedure Guide.
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2.8.1 AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, DS3, E1, FUDC, MSUDC
DWDM Logical Object: TRUNK

The Alarm Indication Signal (AIS) condition indicates that this node is detecting an alarm indication
signal in the incoming signal SONET overhead.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Note  ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS Condition

Step 1 Determine whether there are alarms on the upstream nodes and equipment, especially the “LOS (OCN)”
alarm on page 2-147, or if there are out-of-service (OOS,MT or OOS,DSBLD) ports.

Step2  Clear the upstream alarms using the applicable procedures in this chapter.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

282 AIS-L

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN

The AIS Line condition indicates that this node is detecting line-level AIS in the incoming signal. This
alarm is secondary to another alarm occurring simultaneously in an upstream node.

This condition can also be raised in conjunction with the “TIM-S” alarm on page 2-217 if AIS-L is
enabled.

Note  ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS-L Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-32.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.3 AIS-P

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The AIS Path condition means that this node is detecting AIS in the incoming path. This alarm is
secondary to another alarm occurring simultaneously in an upstream node.

Clear the AIS-P Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-32.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

284 AIS-V

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: VI-MON, VI-TERM
The AIS VT condition means that this node is detecting AIS in the incoming VT-level path.

See the “1.13.2 AIS-V on DS3XM-6 or DS3XM-12 Unused VT Circuits” section on page 1-141 for
more information.

Clear the AIS-V Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-32.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

285 ALS

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.8.6 AMPLI-INIT

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.7 APC-CORRECTION-SKIPPED

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.8 APC-DISABLED

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.9 APC-END

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.10 APC-OUT-OF-RANGE

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.11 APSB

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The APS Channel Byte Failure alarm occurs when LTE detects protection switching byte failure or an
invalid switching code in the incoming APS signal. Some older SONET not manufactured by Cisco send
invalid APS codes if they are configured in a 1+1 protection group with newer SONET nodes, such as
the ONS 15454. These invalid codes cause an APSB alarm on an ONS 15454.

Step 1 Use an optical test set to examine the incoming SONET overhead to confirm inconsistent or invalid
K bytes. For specific procedures to use the test set equipment, consult the manufacturer. If corrupted
K bytes are confirmed and the upstream equipment is functioning properly, the upstream equipment
might not interoperate effectively with the ONS 15454.

Step2  If the alarm does not clear and the overhead shows inconsistent or invalid K bytes, you could need to
replace the upstream cards for protection switching to operate properly. Complete the “Physically
Replace a Traffic Card” procedure on page 2-242.
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If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.12 APSCDFLTK

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The APS Default K Byte Received alarm occurs during bidirectional line switched ring (BLSR)
provisioning or when a BLSR is not properly configured, for example, when a four-node BLSR has one
node configured as a path protection. When this misconfiguration occurs, a node in a path protection or
1+1 configuration does not send the two valid K1/K2 APS bytes anticipated by a system configured for
BLSR. One of the bytes sent is considered invalid by the BLSR configuration. The K1/K2 byte is
monitored by receiving equipment for link-recovery information.

Troubleshooting for APSCDFLTK is often similar to troubleshooting for the “BLSROSYNC” alarm on
page 2-51.

Clear the APSCDFLTK Alarm

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-230 to verify that
each node has a unique node ID number.

Repeat Step 1 for all nodes in the ring.

If two nodes have the same node ID number, complete the “Change a BLSR Node ID Number” procedure
on page 2-230 to change one node ID number so that each node ID is unique.

If the alarm does not clear, verify correct configuration of east port and west port optical fibers. (See the
“E-W-MISMATCH” alarm on page 2-82.) West port fibers must connect to east port fibers and east port
fibers must connect to west port fibers. The “Install Cards and Fiber-Optic Cable” chapter in the

Cisco ONS 15454 Procedure Guide provides procedures for fibering BLSRs.

If the alarm does not clear and the network is a four-fiber BLSR, ensure that each protect fiber is
connected to another protect fiber and each working fiber is connected to another working fiber. The
software does not report any alarm if a working fiber is incorrectly attached to a protect fiber.

If the alarm does not clear, complete the “Verify Node Visibility for Other Nodes” procedure on

page 2-231.

If nodes are not visible, complete the “Verify or Create Node Section DCC Terminations” procedure on
page 2-244 to ensure that section data communications channel (SDCC) terminations exist on each node.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.13 APSC-IMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
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Warning

A

Warning

An Improper SONET APS Code alarm indicates three consecutive, identical frames containing:
e Unused code in bits 6 through 8 of byte K2.
¢ Codes that are irrelevant to the specific protection switching operation being requested.

e Requests that are irrelevant to the ring state of the ring (such as a span protection switch request in
a two-fiber ring NE).

e ET code in K2 bits 6 through 8 received on the incoming span, but not sourced from the outgoing
span.

This alarm can occur on a VT tunnel when it does not have VT circuits provisioned on it. It can also
occur when the exercise command or a lockout is applied to a span. An externally switched span does
not raise this alarm because traffic is preempted.

The APSC-IMP alarm may be raised on a BLSR or MS-SPRing when a drop connection is part of a
cross-connect loopback.

The APSC-IMP alarm may be momentarily raised on BLSR spans during PCA circuit creation or
deletion across multiple nodes using CTC.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the APSC-IMP Alarm

Step 1

A

Use an optical test set to determine the validity of the K byte signal by examining the received signal.
For specific procedures to use the test set equipment, consult the manufacturer.

Caution

Step 2

Step 3

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the K byte is invalid, the problem lies with upstream equipment and not with the reporting ONS 15454.
Troubleshoot the upstream equipment using the procedures in this chapter, as applicable. If the upstream
nodes are not ONS 15454s, consult the appropriate user documentation.

If the K byte is valid, verify that each node has a ring name that matches the other node ring names.
Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-230.

Repeat Step 2 for all nodes in the ring.
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Step 4

Step 5

2.8.14 Arscincon H

If a node has a ring name that does not match the other nodes, make that node’s ring name identical to
the other nodes. Complete the “Change a BLSR Ring Name” procedure on page 2-230.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.14 APSCINCON

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

An APS Inconsistent alarm means that an inconsistent APS byte is present. The SONET overhead
contains K1/K2 APS bytes that notify receiving equipment, such as the ONS 15454, to switch the
SONET signal from a working to a protect path when necessary. An inconsistent APS code occurs when
three consecutive frames contain nonidentical APS bytes, which in turn give the receiving equipment
conflicting commands about switching.

Clear the APSCINCON Alarm

Step 1

Step 2

Look for other alarms, especially the “LOS (OCN)” alarm on page 2-147, the “LOF (OCN)” alarm on
page 2-134, or the “AIS” condition on page 2-32. Clearing these alarms clears the APSCINCON alarm.

If an APSINCON alarm occurs with no other alarms, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.15 APSCM

>

Warning

>

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The APS Channel Mismatch alarm occurs when the ONS 15454 expects a working channel but receives
a protect channel. In many cases, the working and protect channels are crossed and the protect channel
is active. If the fibers are crossed and the working line is active, the alarm does not occur. The APSCM
alarm occurs only on the ONS 15454 when bidirectional protection is used on OC-N cards in a 1+1
protection group configuration. The APSCM alarm does not occur in an optimized 1+1 protection
configuration.

On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
Cisco ONS 15454 Troubleshooting Guide, R6.0
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A

Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the APSCM Alarm
A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step1  Verify that the working-card channel fibers are physically connected directly to the adjoining node’s
working-card channel fibers.

Step2  If the fibers are correctly connected, verify that the protection-card channel fibers are physically
connected directly to the adjoining node’s protection-card channel fibers.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.16 APSCNMIS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The APS Node ID Mismatch alarm occurs when the source node ID contained in the incoming APS
channel K2 byte is not present in the ring map. The APSCNMIS alarm could occur and clear when a
BLSR is being provisioned. If so, you can disregard the temporary occurrence. If the APSCNMIS
remains, the alarm clears when a K byte with a valid source node ID is received.

Clear the APSCNMIS Alarm

Step 1 Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-230 to verify that
each node has a unique node ID number.

Step2  If the Node ID column contains any two nodes with the same node ID listed, record the repeated node ID.
Step3  Click Close in the Ring Map dialog box.

Step4  If two nodes have the same node ID number, complete the “Change a BLSR Node ID Number” procedure
on page 2-230 to change one node ID number so that each node ID is unique.

>

Note  If the node names shown in the network view do not correlate with the node IDs, log into each
node and click the Provisioning > BLSR tabs. The BLSR window shows the node ID of the
login node.
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~

Note Applying and removing a lockout on a span causes the ONS node to generate a new K byte. The
APSCNMIS alarm clears when the node receives a K byte containing the correct node ID.

Step5  If the alarm does not clear, use the “Initiate a Lockout on a BLSR Protect Span” procedure on page 2-237
to lock out the span.

Step6  Complete the “Clear a BLSR External Switching Command” procedure on page 2-238 to clear the
lockout.

Step7  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.17 APSIMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The APS Invalid Code alarm occurs if a 1+1 protection group is not properly configured at both nodes
to send or receive the correct APS byte. A node that is either configured for no protection or is configured
for path protection or BLSR protection does not send the right K2 APS byte anticipated by a system
configured for 1+1 protection. The 1+1 protect port monitors the incoming K2 APS byte and raises this
alarm if it does not receive the byte.

The alarm is superseded by an APSCM or APSMM alarm, but not by an AIS condition. It clears when
the port receives a valid code for 10 ms.

Clear the APSIMP Alarm

Step1  Check the configuration of the other node in the 1+1 protection group. If the far end is not configured
for 1+1 protection, create the group. For procedures, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step2  If the other end of the group is properly configured or the alarm does not clear after you have provisioned
the group correctly, verify that the working ports and protect ports are cabled correctly.

Step3  Ensure that both protect ports are configured for SONET.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.18 APS-INV-PRIM

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: OCN
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Note

The Optimized 1+1 APS Primary Facility condition occurs on OC-N cards in an optimized 1+1
protection system if the incoming primary section header does not indicate whether it is primary or
secondary.

APS-INV-PRIM is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

2.8.19 APSMM

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

An APS Mode Mismatch failure alarm occurs on OC-N cards when there is a mismatch of the protection
switching schemes at the two ends of the span, such as being bidirectional at one end and unidirectional
at the other. Each end of a span must be provisioned the same way: bidirectional and bidirectional, or
unidirectional and unidirectional. APSMM can also occur if third-party equipment is provisioned as 1:N
and the ONS 15454 is provisioned as 1+1.

If one end is provisioned for 1+1 protection switching and the other is provisioned for path protection
protection switching, an APSMM alarm occurs in the ONS 15454 that is provisioned for 1+1 protection
switching.

Clear the APSMM Alarm

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

For the reporting ONS 15454, display node view and verify the protection scheme provisioning:
a. Click the Provisioning > Protection tabs.
b. Click the 1+1 protection group configured for the OC-N cards.

The chosen protection group is the protection group optically connected (with data communications
channel, or DCC, connectivity) to the far end.

c. Click Edit.

d. Record whether the Bidirectional Switching check box is checked.

Click OK in the Edit Protection Group dialog box.

Log into the far-end node and verify that the OC-N 1+1 protection group is provisioned.

Verify that the Bidirectional Switching check box matches the checked or unchecked condition of the
box recorded in Step 1. If not, change it to match.

Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.20 APS-PRIM-FAC

Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
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Note

2.821 APS-PRIM-SEC-MISM W

SONET Logical Object: OCN

The Optimized 141 APS Invalid Primary Section condition occurs on OC-N cards in an optimized 1+1
protection system if there is an APS status switch between the primary and secondary facilities to
identify which port is primary.

APS-PRIM-FAC is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

Clear the APS-PRIM-FAC Condition

Step 1
Step 2

This condition clears when the card receives a valid primary section indication (1 or 2).

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.21 APS-PRIM-SEC-MISM

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: OCN

The Optimized 1+1 APS Primary Section Mismatch condition occurs on OC-N cards in an optimized
1+1 protection system if there is a mismatch between the primary section of the local node facility and
the primary section of the remote-node facility.

Clear the APS-PRIM-SEC-MISM Alarm

Step 1

Step 2

Ensure that the local node and remote-node ports are correctly provisioned the same way. For more
information about optimized 1+1 configurations, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.22 AS-CMD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: BPLANE, CE100T, DS1, DS3, E1, E100T, E1000F, EC1, EQPT, FCMR,
G1000, GFP-FAC, ML100T, MLFX, NE, OCN, PWR

DWDM Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCH, OMS, OTS, PPM, TRUNK

The Alarms Suppressed by User Command condition applies to the network element (NE object),
backplane, a single card, or a port on a card. It occurs when alarms are suppressed for that object and its
subordinate objects. For example, suppressing alarms on a card also suppresses alarms on its ports.
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>
Note  For more information about suppressing alarms, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the AS-CMD Condition

Step 1 For all nodes, in node view, click the Conditions tab.

Step2  Click Retrieve. If you have already retrieved conditions, look under the Object column and Eqpt Type
column and note what entity the condition is reported against, such as a port, slot, or shelf.

e If the condition is reported against a slot and card, alarms were either suppressed for the entire card
or for one of the ports. Note the slot number and continue with Step 3.

e If the condition is reported against the backplane, go to Step 7.
e If the condition is reported against the NE object, go to Step 8.

Step3  Determine whether alarms are suppressed for a port and if so, raise the suppressed alarms:
a. Double-click the card to open the card view.

b. Click the Provisioning > Alarm Profiles > Alarm Behavior tabs and complete one of the following
substeps:

e If the Suppress Alarms column check box is checked for a port row, deselect it and click Apply.

e If the Suppress Alarms column check box is not checked for a port row, from the View menu
choose Go to Previous View.

Stepd  If the AS-CMD condition is reported for a card and not an individual port, in node view click the
Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step5 Locate the row number for the reported card slot.
Step6  Click the Suppress Alarms column check box to deselect the option for the card row.

Step7  If the condition is reported for the backplane, the alarms are suppressed for cards such as the ONS 15454
AIP that are not in the optical or electrical slots. To clear the alarm, complete the following steps:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs.
b. In the backplane row, uncheck the Suppress Alarms column check box.
c. Click Apply.

Step8  If the condition is reported for the shelf, cards and other equipment are affected. To clear the alarm,
complete the following steps:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tabs if you have not
already done so.

b. Click the Suppress Alarms check box located at the bottom of the window to deselect the option.
¢. Click Apply.

Step9  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.8.23 AS-MT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

SONET Logical Objects: CE100T, DS1, DS3, E1, EC1, EQPT, FCMR, G1000, GFP-FAC, ML100T,
MLFX, OCN

DWDM Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC,O0CH, OMS, OTS, PPM, TRUNK

The Alarms Suppressed for Maintenance Command condition applies to OC-N and electrical cards and
occurs when a port is placed in the Out-of-Service and Management, Maintenance (OOS-MA,MT)
service state for loopback testing operations.

Clear the AS-MT Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-245.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.24 AS-MT-00G

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The Alarms Suppressed on an Out-Of-Group VCAT Member condition is raised on an STS or VT
member of a VCAT group whenever the member is in the IDLE (AS-MT-OOG) admin state. This
condition can be raised when a member is initially added to a group. In the IDLE (AS-MT-OOG) state,
all other alarms for the STS or VT are suppressed.

The AS-MT-OOG condition clears when an STS or VT member transitions to a different state from IDLE
(AS-MT-0O0G) or when the member is removed completely from the VCAT group. The condition does
not require troubleshooting unless it does not clear.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.25 AUD-LOG-LOSS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Audit Trail Log Loss condition occurs when the log is 100 percent full and the oldest entries are
being replaced while new entries are generated. The log capacity is 640 entries. The log must be
off-loaded using the following procedure to make room for more entries.

Clear the AUD-LOG-LOSS Condition

Step 1 In node view, click the Maintenance > Audit tabs.
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Step2  Click Retrieve.
Step3  Click Archive.

Stepd  In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to
save the file.

Step5  Enter a name in the File Name field.

You do not have to assign an extension to the file. It is readable in any application that supports text files,
such as WordPad, Microsoft Word (imported), etc.

Step6  Click Save.

The 640 entries are saved in this file. New entries continue with the next number in the sequence, rather
than starting over.

Step7  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.26 AUD-LOG-LOW

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE
The Audit Trail Log Low condition occurs when the audit trail log is 80 percent full.

~

Note AUD-LOG-LOW is an informational condition and does not require troubleshooting.

2.8.27 AU-LOF

The Administrative Unit Loss of Multiframe alarm is not supported in this platform release. It is reserved
for future development.

2.8.28 AUTOLSROFF

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The Auto Laser Shutdown alarm occurs when the OC-192 card temperature exceeds 194 degrees F
(90 degrees C). The internal equipment automatically shuts down the OC-192 laser when the card
temperature rises to prevent the card from self-destructing.

>

Warning  On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293
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Warning

A

Warning

2.8.29 AUTORESET M

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the AUTOLSROFF Alarm

Step 1

Step 2

Step 3

Step 4

View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-1).

Figure 2-1 Shelf LCD Panel

o
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97758

If the temperature of the shelf exceeds 194 degrees F (90 degrees C), the alarm should clear if you solve
the ONS 15454 temperature problem. Complete the “Clear the HITEMP Alarm” procedure on
page 2-115.

If the temperature of the shelf is under 194 degrees F (90 degrees C), the HITEMP alarm is not the cause
of the AUTOLSROFF alarm. Complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the OC-192 card.

If card replacement does not clear the alarm, call Cisco TAC (1 800 553-2447) to discuss the case and if
necessary open a returned materials authorization (RMA) on the original OC-192 card.

2.8.29 AUTORESET

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Automatic System Reset alarm occurs when you change an IP address or perform any other
operation that causes an automatic card-level reboot.

AUTORESET typically clears after a card reboots (up to ten minutes). If the alarm does not clear,
complete the following procedure.
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Clear the AUTORESET Alarm

Step1  Determine whether there are additional alarms that could have triggered an automatic reset. If there are,
troubleshoot these alarms using the applicable section of this chapter.

Step2  If the card automatically resets more than once a month with no apparent cause, complete the “Physically
Replace a Traffic Card” procedure on page 2-242.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.30 AUTOSW-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, VI-MON

The Automatic path protection Switch Caused by an AIS condition indicates that automatic path
protection protection switching occurred because of an AIS condition. If the path protection is
configured for revertive switching, it reverts to the working path after the fault clears. The AIS also
clears when the upstream trouble is cleared.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS Condition

Step1  Complete the “Clear the AIS Condition” procedure on page 2-32.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.31 AUTOSW-LOP (STSMON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic path protection Switch Caused by LOP condition for the STS monitor (STSMON)
indicates that automatic path protection protection switching occurred because of the “LOP-P”” alarm on
page 2-137. If the path protection is configured for revertive switching, it reverts to the working path
after the fault clears.

Cisco ONS 15454 Troubleshooting Guide, R6.0
m. November 2009 |



| Chapter2 Alarm Troubleshooting

2.8.32 AUTOSW-LOP (VT-MoN) W

Clear the AUTOSW-LOP (STSMON) Condition

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-138.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.32 AUTOSW-LOP (VT-MON)

Default Severity: Not Alarmed (NA), Service-Affecting (SA)
SONET Logical Object: VI-MON

The AUTOSW-LOP alarm for the VT monitor (VIT-MON) indicates that automatic path protection
switching occurred because of the “LLOP-V” alarm on page 2-138. If the path protection is configured
for revertive switching, it reverts to the working path after the fault clears.

Clear the AUTOSW-LOP (VT-MON) Condition

Step 1 Complete the “Clear the LOP-V Alarm” procedure on page 2-138.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.33 AUTOSW-PDI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic Path Protection Switch Caused by Payload Defect Indication (PDI) condition indicates
that automatic path protection protection switching occurred because of a “PDI-P” alarm on page 2-174.
If the path protection is configured for revertive switching, it reverts to the working path after the fault
clears.

Clear the AUTOSW-PDI Condition

Step 1 Complete the “Clear the PDI-P Condition” procedure on page 2-175.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.8.34 AUTOSW-SDBER

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic Path Protection Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition
indicates that a signal degrade (SD) caused automatic path protection switching to occur. (See the
“SD-L” condition on page 2-193.) If the path protection is configured for revertive switching, it reverts
to the working path when the SD is resolved.

Clear the AUTOSW-SDBER Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.35 AUTOSW-SFBER

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic USPR Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates that a
signal failure (SF) caused automatic path protection switching to occur. If the path protection is
configured for revertive switching, it reverts to the working path when the SF is resolved.

Clear the AUTOSW-SFBER Condition

Step 1 Complete the “Clear the SF (DS1, DS3) Condition” procedure on page 2-195.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.36 AUTOSW-UNEQ (STSMON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: STSMON

The Automatic Path Protection Switch Caused by Unequipped condition indicates that a UNEQ alarm
caused automatic path protection switching to occur. If the path protection is configured for revertive
switching, it reverts to the working path after the fault clears.
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Clear the AUTOSW-UNEQ (STSMON) Condition

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-223.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.37 AWG-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.38 AWG-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.39 AWG-OVERTEMP

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.40 AWG-WARM-UP

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.41 BAT-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Battery Fail alarm occurs when one of the two power supplies (A or B) is not detected. This could
be because the supply is removed or is not operational. The alarm does not distinguish between the
individual power supplies, so onsite information about the conditions is necessary for troubleshooting.

Clear the BAT-FAIL Alarm

Step1 At the site, determine which battery is not present or operational.

Step2  Remove the power cable from the faulty supply. For procedures, refer to the “Install the Shelf and
Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide. Reverse the power cable
installation procedure.
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Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.42 BKUPMEMP

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Primary Nonvolatile Backup Memory Failure alarm refers to a problem with the TCC2/TCC2P flash
memory. The alarm occurs when the TCC2/TCC2P is in use and has one of four problems:

¢ Flash manager fails to format a flash partition.
¢ Flash manager fails to write a file to a flash partition.

e Problem at the driver level.

¢ Code volume fails cyclic redundancy checking (CRC, a method to verify for errors in data
transmitted to the TCC2/TCC2P).

The BKUPMEMP alarm can also cause the “EQPT” alarm on page 2-77. If the EQPT alarm is caused
by BKUPMEMP, complete the following procedure to clear the BKUPMEMP and the EQPT alarm.

A

Caution A software update on a standby TCC2/TCC2P can take up to 30 minutes.

Clear the BKUPMEMP Alarm

Step 1 Verify that both TCC2/TCC2Ps are powered and enabled by confirming lighted ACT/SBY LEDs on the
TCC2/TCC2Ps.

Step2  Determine whether the active or standbyTCC2/TCC2P has the alarm.

Step 3 If both TCC2/TCC2Ps are powered and enabled, reset the TCC2/TCC2P where the alarm is raised. If the
card is the active TCC2/TCC2P, complete the “Reset an Active TCC2/TCC2P Card and Activate the
Standby Card” procedure on page 2-239. If the card is the standby TCC2/TCC2P:

a. Right-click the standby TCC2/TCC2P in CTC.

b. Choose Reset Card from the shortcut menu.

¢. Click Yes in the Are You Sure dialog box. The card resets, the FAIL LED blinks on the physical card.
d. Wait ten minutes to verify that the card you reset completely reboots.

Step4  If the TCC2/TCC2P you reset does not reboot successfully, or the alarm has not cleared, call Cisco TAC
(1 800 553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241. If the Cisco TAC

technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-242.
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2.8.43 BLSROSYNC

>

Warning

A

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The BLSR Out Of Synchronization alarm occurs during BLSR setup when you attempt to add or delete
a circuit, and a working ring node loses its DCC connection because all transmit and receive fiber has
been removed. CTC cannot generate the ring table and causes the BLSROSYNC alarm.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

~

Note

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

This alarm can also be expected when upgrading to Release 6.0 if the ring identifier is updated.

Clear the BLSROSYNC Alarm

Step 1

Step 2
Step 3

Reestablish cabling continuity to the node reporting the alarm. Refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide for cabling information to
reestablish the DCC. To verify cable continuity, follow site practices.

When the DCC is established between the node and the rest of the BLSR, it becomes visible to the BLSR
and should be able to function on the circuits.

If alarms occur when you have provisioned the DCCs, see the “EOC” alarm on page 2-74.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.44 BLSR-SW-VER-MISM

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The BLSR Software Version Mismatch alarm is raised by the TCC2/TCC2P when it checks all software
versions for all nodes in a ring and discovers a mismatch in versions.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R6.0 gy



Chapter2  Alarm Troubleshooting |

W 2845 BPV

Clear the BLSR-SW-VER-MISM Alarm

Step1  Clear the alarm by loading the correct software version on the TCC2/TCC2P with the incorrect load. To
download software, refer to the release-specific software download document.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) condition.

2.8.45 BPV

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The 64K Clock Bipolar Density Violation alarm is raised on the TCC2P card if there is a frequency
variation in the 8K BITS clock.

The TCC2P card contains an 8K clock and a 64K clock. Each has some bipolar variation, which is
normal. This alarm is raised on the 8K clock if that variation discontinues. The BPV alarm is demoted
by an LOF or LOS against the BITS clock.

~

m This alarm is not raised on the TCC2 card.

Clear the BPV Alarm

Step1  Reestablishing a normal BITS input signal clears the alarm. Clear any alarms on the incoming signal or
against the BITS timing sources.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.46 CARLOSS (CE100T)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE100T

The Carrier Loss alarm is raised on CE-100T-8 cards in Mapper mode when there is a circuit failure due
to link integrity. It does not get raised when a user simply puts the port in the In-Service and Normal
(IS-NR) state. It has to be IS-NR with a circuit or loopback.

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |



| Chapter2 Alarm Troubleshooting

2.8.47 CARLOSS (E100T, E1000F) W

Clear the CARLOSS (CE100T) Alarm

Step 1

Step 2

Complete the “Clear the CARLOSS (G1000) Alarm” procedure on page 2-57. However, rather than
checking for a TPTFAIL (G1000) at the end of the procedure, check for a “TPTFAIL (CE100T)” alarm
on page 2-218.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.47 CARLOSS (E100T, E1000F)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: E100T, E1000F

A Carrier Loss alarm on the LAN E-Series Ethernet card is the data equivalent of the “LOS (OCN)”
alarm on page 2-147. The Ethernet card has lost its link and is not receiving a valid signal. The most
common causes of the CARLOSS alarm are a disconnected cable, an Ethernet Gigabit Interface
Converter (GBIC) fiber connected to an optical card rather than an Ethernet device, or an improperly
installed Ethernet card. Ethernet card ports must be enabled for CARLOSS to occur. CARLOSS is
declared after no signal is received for approximately 2.5 seconds.

The CARLOSS alarm also occurs after a node database is restored. After restoration, the alarm clears in
approximately 30 seconds after the node reestablishes Spanning Tree Protocol (STP).

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (E100T, E1000F) Alarm

Step 1

A

Verify that the fiber cable is properly connected and attached to the correct port. For more information
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in
the Cisco ONS 15454 Procedure Guide.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.

Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the fiber cable is properly connected and attached to the port, verify that the cable connects the card
to another Ethernet device and is not misconnected to an OC-N card. For more information about fiber
connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

Step3  If no misconnection to an OC-N card exists, verify that the transmitting device is operational. If not,
troubleshoot the device.

Step4  If the alarm does not clear, use an Ethernet test set to determine whether a valid signal is coming into
the Ethernet port. For specific procedures to use the test set equipment, consult the manufacturer.
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Step 5

Step 6

Step 7

Step 8

Step 9

If a valid Ethernet signal is not present and the transmitting device is operational, replace the fiber cable
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

If a valid Ethernet signal is present, complete the “Remove and Reinsert (Reseat) Any Card” procedure
on page 2-242 for the Ethernet card.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the Ethernet card.

If a CARLOSS alarm repeatedly appears and clears, use the following steps to examine the layout of
your network to determine whether the Ethernet circuit is part of an Ethernet manual cross-connect.

An Ethernet manual cross-connect is used when another vendor’s equipment sits between ONS 15454
nodes, and the open systems interconnect/target identifier address resolution protocol
(OSI/TARP)-based equipment does not allow tunneling of the ONS 15454 TCP/IP-based DCC. To
circumvent a lack of continuous DCC, the Ethernet circuit is manually cross connected to an STS
channel riding through the non-ONS network.

If the reporting Ethernet circuit is part of an Ethernet manual cross-connect, complete the following
steps. The reappearing alarm could be a result of mismatched STS circuit sizes in the set up of the manual
cross-connect. If the Ethernet circuit is not part of a manual cross-connect, the following steps do not
apply.

a. Right-click anywhere in the row of the CARLOSS alarm.

b. Click Select Affected Circuits in the shortcut menu that appears.

¢. Record the information in the type and size columns of the highlighted circuit.

d. From the examination of the layout of your network, determine which ONS 15454 and card and card
are hosting the Ethernet circuit at the other end of the Ethernet manual cross-connect and complete
the following substeps:

e Loginto the ONS 15454 at the other end of the Ethernet manual cross-connect.
e Double-click the Ethernet card that is part of the Ethernet manual cross-connect.
e Click the Circuits tab.

e Record the information in the type and size columns of the circuit that is part of the Ethernet
manual cross-connect. The Ethernet manual cross-connect circuit connects the Ethernet card to
an OC-N card at the same node.

e. Use the information you recorded to determine whether the two Ethernet circuits on each side of the
Ethernet manual cross-connect have the same circuit size.

If one of the circuit sizes is incorrect, complete the “Delete a Circuit” procedure on page 2-244 and
reconfigure the circuit with the correct circuit size. For more information, refer to the “Create
Circuits and VT Tunnels” chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.48 CARLOSS (EQPT)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: EQPT

Cisco ONS 15454 Troubleshooting Guide, R6.0
m. November 2009 |



| Chapter2 Alarm Troubleshooting

>

Warning
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Warning

Note
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A Carrier Loss on the LAN Equipment alarm generally occurs on OC-N cards when the ONS 15454 and
the workstation hosting CTC do not have a TCP/IP connection. The problem involves the LAN or data
circuit used by the RJ-45 (LAN) connector on the TCC2/TCC2P or the LAN backplane pin connection.
This CARLOSS alarm does not involve an Ethernet circuit connected to an Ethernet port. The problem
is in the connection and not CTC or the node.

On TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G or MXP_2.5G_10G cards, CARLOSS is also
raised against trunk ports when ITU-T G.709 monitoring is turned off.

A TXP_MR_2.5G card can raise a CARLOSS alarm when the payload is incorrectly configured for the
10 Gigabit Ethernet or 1 Gigabit Ethernet payload data types.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter. For more
information about MRC-12 and OC192-XFP/STM64-XFP cards, refer to the “Change Card Settings”
chapter of the Cisco ONS 15454 Procedure Guide. For more information about Ethernet cards, refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454,

Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (EQPT) Alarm

Step 1 If the reporting card is an MXP or TXP card in an ONS 15454 node, verify the data rate configured on
the pluggable port module (PPM):

a. Double-click the reporting MXP or TXP card.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. View the Pluggable Port Modules area port listing in the Actual Equipment Type column and
compare this with the contents of the Selected PPM area Rate column for the MXP or TXP multirate
port.

d. If the rate does not match the actual equipment, you must delete and recreate the selected PPM.
Select the PPM, click Delete, then click Create and choose the correct rate for the port rate.

Step2  If the reporting card is an OC-N card, verify connectivity by pinging the ONS 15454 that is reporting
the alarm by completing the procedure in the “Verify PC Connection to the ONS 15454 (ping)”
procedure on page 1-124.

Step3  If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC:

a. Exit from CTC.

b. Reopen the browser.
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c¢. Log into CTC.

Step4  Using optical test equipment, verify that proper receive levels are achieved. (For instructions to use
optical test equipment, refer to the manufacturer documentation.)

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step5  Verify that the optical LAN cable is properly connected and attached to the correct port. For more
information about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable”
chapter in the Cisco ONS 15454 Procedure Guide.

Step6  If the fiber cable is properly connected and attached to the port, verify that the cable connects the card
to another Ethernet device and is not misconnected to an OC-N card.

Step7  If you are unable to establish connectivity, replace the fiber cable with a new known-good cable. To do
this, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure
Guide.

Step8  If you are unable to establish connectivity, perform standard network or LAN diagnostics. For example,
trace the IP route, verify cable continuity, and troubleshoot any routers between the node and CTC. To
verify cable continuity, follow site practices.

Step9  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.49 CARLOSS (FC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.50 CARLOSS (G1000)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: G1000

A Carrier Loss alarm on the LAN G-Series Ethernet card is the data equivalent of the “LOS (OCN)”
alarm on page 2-147. The Ethernet card has lost its link and is not receiving a valid signal.

CARLOSS on the G1000-4 card is caused by one of two situations:

e The G1000-4 port reporting the alarm is not receiving a valid signal from the attached Ethernet
device. The CARLOSS can be caused by an improperly connected Ethernet cable or a problem with
the signal between the Ethernet device and the G1000-4 port.

e [If a problem exists in the end-to-end path (including possibly the far-end G1000-4 card), it causes
the reporting card to turn off the Gigabit Ethernet transmitter. Turning off the transmitter typically
causes the attached device to turn off its link laser, which results in a CARLOSS on the reporting
G1000-4 card. The root cause is the problem in the end-to-end path. When the root cause is cleared,
the far-end G1000-4 port turns the transmitter laser back on and clears the CARLOSS on the
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2.8.50 CARLOSS (G1000) I

reporting card. If a turned-off transmitter causes the CARLOSS alarm, other alarms such as the
“TPTFAIL (G1000)” alarm on page 2-219 or OC-N alarms or conditions on the end-to-end path
normally accompany the CARLOSS (G1000s) alarm.

Refer to the Cisco ONS 15454 Reference Manual for a description of the G1000-4 card’s end-to-end
Ethernet link integrity capability. Also see the “TRMT” alarm on page 2-221 for more information about
alarms that occur when a point-to-point circuit exists between two cards.

Ethernet card ports must be enabled for CARLOSS to occur. CARLOSS is declared after no signal is
received for approximately 2.5 seconds.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (G1000) Alarm

Step 1

A

Verify that the fiber cable is properly connected and attached to the correct port. For more information
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in
the Cisco ONS 15454 Procedure Guide.

Caution

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the fiber cable is correctly connected and attached, verify that the cable connects the card to another
Ethernet device and is not misconnected to an OC-N card.

If no misconnection to the OC-N card exists, verify that the attached transmitting Ethernet device is
operational. If not, troubleshoot the device.

Verify that optical receive levels are within the normal range. The correct specifications are listed in the
“1.14.3 OC-N Card Transmit and Receive Levels” section on page 1-154.

If the alarm does not clear, use an Ethernet test set to determine whether a valid signal is coming into
the Ethernet port. For specific procedures to use the test set equipment, consult the manufacturer.

If a valid Ethernet signal is not present and the transmitting device is operational, replace the fiber cable
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, and link autonegotiation is enabled on the port but the autonegotiation process
fails, the card turns off its transmitter laser and reports a CARLOSS alarm. If link autonegotiation has
been enabled for the port, determine whether there are conditions that could cause autonegotiation to
fail:

a. Confirm that the attached Ethernet device has autonegotiation enabled and is configured for
compatibility with the asymmetric flow control on the card.

b. Confirm that the attached Ethernet device configuration allows reception of flow control frames.

If the alarm does not clear, disable and reenable the Ethernet port to attempt to remove the CARLOSS
condition. (The autonegotiation process restarts.)

If the alarm does not clear and the “TPTFAIL (G1000)” alarm on page 2-219 is also reported, complete
the “Clear the TPTFAIL (G1000) Alarm” procedure on page 2-219. If the TPTFAIL alarm is not raised,
continue to the next step.
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Step 10

Step 11

Step 12

)

Note  When the CARLOSS and the TPTFAIL alarms are reported, the reason for the condition could
be the G1000-4 card's end-to-end link integrity feature taking action on a remote failure
indicated by the TPTFAIL alarm.

If the TPTFAIL alarm was not raised, determine whether a terminal (inward) loopback has been
provisioned on the port:

a. In node view, click the card to go to card view.
b. Click the Maintenance > Loopback tabs.
c. If the service state is listed as OOS-MA,LPBK&MT, a loopback is provisioned. Go to Step 11.

If a loopback was provisioned, complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card
Loopbacks” procedure on page 2-246.

On the G1000-4, provisioning a terminal (inward) loopback causes the transmit laser to turn off. If an
attached Ethernet device detects the loopback as a loss of carrier, the attached Ethernet device shuts off
the transmit laser to the G1000-4 card. Terminating the transmit laser could raise the CARLOSS alarm
because the loopbacked G1000-4 port detects the termination.

If the does not have a loopback condition, continue to Step 12.

If a CARLOSS alarm repeatedly appears and clears, the reappearing alarm could be a result of
mismatched STS circuit sizes in the setup of the manual cross-connect. Perform the following steps if
the Ethernet circuit is part of a manual cross-connect:

>

Note  An ONS 15454 Ethernet manual cross-connect is used when another vendor’s equipment sits
between ONS nodes, and the OSI/TARP-based equipment does not allow tunneling of the
ONS 15454 TCP/IP-based DCC. To circumvent a lack of continuous DCC, the Ethernet circuit
is manually cross connected to an STS channel riding through the non-ONS network.

a. Right-click anywhere in the row of the CARLOSS alarm.
b. Right-click or left-click Select Affected Circuits in the shortcut menu that appears.
c. Record the information in the type and size columns of the highlighted circuit.

d. Examine the layout of your network and determine which ONS 15454 and card are hosting the
Ethernet circuit at the other end of the Ethernet manual cross-connect and complete the following
substeps:

e Log into the node at the other end of the Ethernet manual cross-connect.
e Double-click the Ethernet card that is part of the Ethernet manual cross-connect.
¢ Click the Circuits tab.

e Record the information in the type and size columns of the circuit that is part of the Ethernet
manual cross-connect. The cross-connect circuit connects the Ethernet card to an OC-N card at
the same node.

e. Determine whether the two Ethernet circuits on each side of the Ethernet manual cross-connect have
the same circuit size from the circuit size information you recorded.

f. If one of the circuit sizes is incorrect, complete the “Delete a Circuit” procedure on page 2-244 and
reconfigure the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.
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Step 13

Step 14

Step 15

2.851 CARLOSS (GE) W

If a valid Ethernet signal is present, complete the “Remove and Reinsert (Reseat) Any Card” procedure
on page 2-242.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the Ethernet card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.51 CARLOSS (GE)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.52 CARLOSS (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.53 CARLOSS (ML100T, ML1000, MLFX)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: ML100T, ML1000, MLFX

A Carrier Loss alarm on an ML-Series Ethernet card is the data equivalent of the “LOS (OCN)” alarm
on page 2-147. The Ethernet port has lost its link and is not receiving a valid signal.

A CARLOSS alarm occurs when the Ethernet port has been configured from the Cisco IOS command
line interface (CLI) as a no-shutdown port and one of the following problems also occurs:

e The cable is not properly connected to the near or far port.
e Autonegotiation is failing.

e The speed (10/100 ports only) is set incorrectly.

For information about provisioning ML-Series Ethernet cards from the Cisco IOS interface, refer to the
Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH,
and Cisco ONS 15327.

Clear the CARLOSS (ML100T, ML1000, MLFX) Alarm

Step1  Verify that the LAN cable is properly connected and attached to the correct port on the ML-Series card
and on the peer Ethernet port. For more information about fiber connections and terminations, refer to
the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Step2  If the alarm does not clear, verify that autonegotiation is set properly on the ML-Series card port and the
peer Ethernet port.
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Step3  If the alarm does not clear, verify that the speed is set properly on the ML-Series card port and the peer
Ethernet port if you are using 10/100 ports.

Step4  If the alarm does not clear, the Ethernet signal is not valid, but the transmitting device is operational,
replace the LAN cable connecting the transmitting device to the Ethernet port.

Step5  If the alarm does not clear, disable and reenable the Ethernet port by performing a “shutdown” and then
a “no shutdown” on the Cisco IOS CLI. Autonegotiation restarts.

Step 6 If the alarm does not clear, complete the “Create the Facility (Line) Loopback on the Source DS-1, DS-3,
DS3N-12, DS3i-N-12, or EC1 Port” procedure on page 1-11 and test the loopback.

Step7  If the problem persists with the loopback installed, complete the “Remove and Reinsert (Reseat) Any
Card” procedure on page 2-242.

Step8  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242.

Step9  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.54 CARLOSS (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.55 CASETEMP-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.56 CLDRESTART

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Cold Restart condition occurs when a card is physically removed and inserted, replaced, or when
the ONS 15454 power is initialized.

Clear the CLDRESTART Condition

Step1  Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on
page 2-241.

Step2  If the condition fails to clear after the card reboots, complete the “Remove and Reinsert (Reseat) Any
Card” procedure on page 2-242.

Step3  If the condition does not clear, complete the “Physically Replace a Traffic Card” procedure on
page 2-242 for the card.
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Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.57 COMIOXC

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Input/Output Slot To Cross-Connect Communication Failure alarm is caused by the XC10G or
XC-VXC-10G cross-connect card when there is a communication failure for a traffic slot.

Clear the COMIOXC Alarm

Step 1 Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 on the card in which the alarm is
reported. For the LED behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section
on page 2-229.

Step2  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step3  If the CTC reset does not clear the alarm, move traffic off the reporting cross-connect card. Complete
the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-240.

Step4  Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-242 on the card in which
the alarm is reported.

Step5  If the alarm does not clear, complete the “Physically Replace an In-Service Cross-Connect Card”
procedure on page 2-243 for the reporting cross-connect card or complete the “Physically Replace a
Traffic Card” procedure on page 2-242 on the card in which the alarm is reported.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.58 COMM-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Plug-In Module (card) Communication Failure indicates that there is a communication failure
between the TCC2/TCC2P and the traffic card. The failure could indicate a broken card interface.

Clear the COMM-FAIL Alarm

Step1  Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting card.

Step2  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the card.
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Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.59 CONTBUS-A-18

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A Communication Failure from Controller Slot to Controller Slot alarm for the TCC2/TCC2P slot to
TCC2/TCC2P slot occurs when the main processor on the TCC2/TCC2P in the first slot (TCC A) loses
communication with the coprocessor on the same card. This applies to the TCC2/TCC2P in Slot 7.

Clear the CONTBUS-A-18 Alarm

Step1  Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241
to make the TCC2/TCC2P in Slot 11 active.

Step2  Wait approximately 10 minutes for the TCC2/TCC2P in Slot 7 to reset as the standby TCC2/TCC2P.
Verify that the ACT/SBY LED is correctly illuminated before proceeding to the next step. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step3  Position the cursor over the TCC2/TCC2P in Slot 11 and complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-239 to return the card to the active state.

Step 4 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-239. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-242.

2.8.60 CONTBUS-B-18

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A Communication Failure from Controller Slot to Controller Slot alarm for the TCC2/TCC2P slot to
TCC2/TCC2P slot occurs when the main processor on the TCC2/TCC2P in the second slot (TCC B)
loses communication with the coprocessor on the same card. This applies to the Slot 11 TCC2/TCC2P.

Clear the CONTBUS-B-18 Alarm

Step 1 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-239 to make the Slot 7 TCC2/TCC2P active.

Step2  Wait approximately 10 minutes for the Slot 11 TCC2/TCC2P to reset as the standby TCC2/TCC2P.
Verify that the ACT/SBY LED is correctly illuminated before proceeding to the next step. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
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Step 3

Step 4

2.8.61 CONTBUS-DISABLED W

Position the cursor over the Slot 7 TCC2/TCC2P and complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-239 to return the Slot 11 TCC2/TCC2P to the active
state.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-242.

2.8.61 CONTBUS-DISABLED

A

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The CONTBUS-DISABLED alarm is a function of the Release 6.0 enhanced cell bus verification
feature. This alarm occurs when a defective card is installed in the shelf assembly or when a card already
installed in the shelf assembly becomes defective (that is, the card fails the enhanced cell bus verification
test). The alarm persists as long as the defective card remains in the chassis. When the card is removed,
CONTBUS-DISABLED will remain raised for a one-minute wait time. This wait time is designed as a
guard period so that the system can distinguish this outage from a briefer card reset communication
outage.

If no card is reinserted into the original slot during the wait time, the alarm clears. After this time, a
different, nondefective card (not the original card) should be inserted.

When CONTBUS-DISABLED is raised, no message-oriented communication is allowed to or from this
slot to the TCC2/TCC2P (thus avoiding node communication failure).

Caution

CONTBUS-DISABLED clears only when the faulty card is removed for one minute. If any card at all is
reinserted before the one-minute guard period expires, the alarm does not clear.

CONTBUS-DISABLED overrides the IMPROPRMVL alarm during the one-minute wait period, but
afterward IMPROPRMVL can be raised because it is no longer suppressed. IMPROPRMVL is raised
after CONTBUS-DISABLED clears if the card is in the node database. If CONTBUS-DISABLED has
cleared but IMPROPRMVL is still active, inserting a card will clear the IMPROPRMVL alarm.

Clear the CONTBUS-DISABLED Alarm

Step 1 If the IMPROPRMVL alarm is raised, complete the “Physically Replace a Traffic Card” procedure on
page 2-242. (For general information about card installation, refer to the “Install Cards and Fiber-Optic
Cable” chapter in the Cisco ONS 15454 Procedure Guide.)
Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.8.62 CONTBUS-I0-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A TCCA to Shelf A Slot Communication Failure alarm occurs when the active Slot 7 TCC2/TCC2P
(TCC A) has lost communication with another card in the shelf. The other card is identified by the Object
column in the CTC alarm window.

The CONTBUS-IO-A alarm can appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P. In the case of a TCC2/TCC2P protection switch, the alarm clears after the other cards
establish communication with the newly active TCC2/TCC2P. If the alarm persists, the problem lies with
the physical path of communication from the TCC2/TCC2P to the reporting card. The physical path of
communication includes the TCC2/TCC2P, the other card, and the backplane.

Clear the CONTBUS-I0-A Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm on
page 2-164 for the reporting card.

If the alarm object is any single card slot other than the standby Slot 11 TCC2/TCC2P, perform a CTC
reset of the object card. Complete the “Reset a Traffic Card in CTC” procedure on page 2-239. For the
LED behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

If the alarm object is the standby Slot 11 TCC2/TCC2P, complete the “Reset a Traffic Card in CTC”
procedure on page 2-239 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

If CONTBUS-IO-A is raised on several cards at the same time, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-239.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-242 for the reporting card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

(1 800 553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-242.

2.8.63 CONTBUS-10-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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2.8.64 CTNEQPT-MISMATCH W

A TCC B to Shelf Communication Failure alarm occurs when the active Slot 11 TCC2/TCC2P (TCC B)
has lost communication with another card in the shelf. The other card is identified by the Object column
in the CTC alarm window.

The CONTBUS-IO-B alarm could appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P. In the case of a TCC2/TCC2P protection switch, the alarm clears after the other cards
establish communication with the newly active TCC2/TCC2P. If the alarm persists, the problem lies with
the physical path of communication from the TCC2/TCC2P to the reporting card. The physical path of
communication includes the TCC2/TCC2P, the other card, and the backplane.

Clear the CONTBUS-10-B Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm on
page 2-164 for the reporting card.

If the alarm object is any single card slot other than the standby Slot 7 TCC2/TCC2P, perform a CTC
reset of the object card. Complete the “Reset a Traffic Card in CTC” procedure on page 2-239. For the
LED behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

If the alarm object is the standby Slot 7 TCC2/TCC2P, complete the “Reset a Traffic Card in CTC”
procedure on page 2-239 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

If CONTBUS-IO-B is raised on several cards at the same time, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-239.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-242 for the reporting card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

(1 800 553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-242.

2.8.64 CTNEQPT-MISMATCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Connection Equipment Mismatch condition is raised when there is a mismatch between the
cross-connect card preprovisioned in the slot and the card actually installed in the shelf. For example,
one type of cross-connect card could be preprovisioned in Slot 10, but another could be physically
installed. It can also be caused by a card that is mismatched with the card. For example,
CTNEQPT-MISMATCH is raised when an XCVT card is replaced with a XC10G card.
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Cisco does not support configurations of unmatched cross-connect cards in Slot 8 and Slot 10, although
this situation could briefly occur during the upgrade process.

The cross-connect card you are replacing should not be the active card. (It can be in SBY state or
otherwise not in use.)

Note  During an upgrade, this condition occurs and is raised as its default severity, Not Alarmed (NA).
However, after the upgrade has occurred, if you wish to change the condition’s severity so that it is
Not Reported (NR), you can do this by modifying the alarm profile used at the node. For more
information about modifying alarm severities, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the CTNEQPT-MISMATCH Condition

Step1  Determine what kind of card is preprovisioned in the slot:
a. In node view, click the Inventory tab.
b. View the information for the slot in the Eqpt Type and Actual Eqpt Type columns.

The Eqpt Type column contains the equipment that is provisioned in the slot. The Actual Eqpt Type
contains the equipment that is physically present in the slot. For example, Slot 8 could be
provisioned for an XCVT card, which is shown in the Eqpt Type column, but an XC10G XC10G
card could be physically present in the slot. The XC10G would be shown in the Actual Eqpt Type
column.

Step2  Complete the “Physically Replace a Traffic Card” procedure on page 2-242 for the mismatched card.

Step3  If the condition does not clear, log onto http://www.cisco.com/techsupport for more information or call
Cisco TAC (1 800 553-2447).

2.8.65 CTNEQPT-PBPROT

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Interconnection Equipment Failure Protect Cross-Connect Card Payload Bus Alarm indicates a
failure of the main payload between the protect ONS 15454 Slot 10 XC10G card and the reporting traffic
card. The cross-connect card and the reporting card are no longer communicating through the backplane.
The problem exists in the cross-connect card and the reporting traffic card, or the TCC2/TCC2P and the
backplane.

~

Note  This alarm automatically raises and clears when the Slot 8 XC10G card is reseated.

A

Caution A software update on a standby TCC2/TCC2P can take up to 30 minutes.
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Clear the CTNEQPT-PBPROT Alarm

Step 1

A

If all traffic cards show CTNEQPT-PBPROT alarm, complete the following steps:

a. Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on
page 2-241 for the standby TCC2/TCC2P.

b. If the reseat fails to clear the alarm, complete the “Physically Replace a Traffic Card” procedure on
page 2-242 for the standby TCC2/TCC2P.

Caution

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10
Step 11

Step 12

Do not physically reseat an active TCC2/TCC2P. Doing so disrupts traffic.

If not all cards show the alarm, perform a CTC reset on the standby XC10G card. Complete the “Reset
a Traffic Card in CTC” procedure on page 2-239. For the LED behavior, see the “2.9.2 Typical Traffic
Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the cross-connect reset is not complete and error-free or if the TCC2/TCC2P reboots automatically,
call Cisco TAC (1 800 553-2447).

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242 for the standby OC-192 card.

Determine whether the card is an active card or standby card in a protection group. Click the node view
Maintenance > Protection tabs, then click the protection group. The cards and their status are displayed
in the list.

If the reporting traffic card is the active card in the protection group, complete the “Initiate a 1:1 Card
Switch Command” procedure on page 2-234. After you move traffic off the active card, or if the
reporting card is standby, continue with the following steps.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 on the reporting card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242 for the reporting card.

Complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-234 to switch traffic back.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting traffic card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.66 CTNEQPT-PBWORK

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT
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~

Note

The Interconnection Equipment Failure Working Cross-Connect Card Payload Bus alarm indicates a
failure in the main payload bus between the ONS 15454 Slot 8 XC10G card and the reporting traffic
card. The cross-connect card and the reporting card are no longer communicating through the backplane.
The problem exists in the cross-connect card and the reporting traffic card, or the TCC2/TCC2P and the
backplane.

This alarm automatically raises and clears when the ONS 15454 Slot 10 XC10G card is reseated.

Clear the CTNEQPT-PBWORK Alarm

Step 1

A

If all traffic cards show CTNEQPT-PBWORK alarm, complete the following steps:

a. Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-239 for the active TCC2/TCC2P and then complete the “Remove and Reinsert (Reseat) the
Standby TCC2/TCC2P Card” procedure on page 2-241.

b. If the reseat fails to clear the alarm, complete the “Physically Replace a Traffic Card” procedure on
page 2-242 for the TCC2/TCC2P.

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Do not physically reseat an active TCC2/TCC2P; it disrupts traffic.

If all cards do not show the alarm, complete the “Side Switch the Active and Standby Cross-Connect
Cards” procedure on page 2-240 for the active XC10G card.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242 for the standby cross-connect card.

If the alarm does not clear and the reporting traffic card is the active card in the protection group,
complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-234. If the card is standby, or
if you have moved traffic off the active card, proceed with the following steps.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-242 for the reporting card.

If you switched traffic, complete the “Initiate a 1:1 Card Switch Command” procedure on page 2-234 to
revert the traffic.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the OC-192 card.
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Step12 If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting traffic card.

Step 13  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.67 DATAFLT

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Software Data Integrity Fault alarm occurs when the TCC2/TCC2P exceeds its flash memory
capacity.

A

Caution = When the system reboots, the last configuration entered is not saved.

Clear the DATAFLT Alarm

Step 1 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-239.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.68 DBOSYNC

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: NE

The Standby Database Out Of Synchronization alarm occurs when the standby TCC2/TCC2P database
does not synchronize with the active database on the active TCC2/TCC2P.

A

Caution  If you reset the active TCC2/TCC2P while this alarm is raised, you lose current provisioning.

Clear the DBOSYNC Alarm

Step 1 Save a backup copy of the active TCC2/TCC2P database. Refer to the “Maintain the Node” chapter in
the Cisco ONS 15454 Procedure Guide for procedures.

Step2  Make a minor provisioning change to the active database to see if applying a provisioning change clears
the alarm:

a. Innode view, click the Provisioning > General > General tabs.
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b. In the Description field, make a small change such as adding a period to the existing entry.

The change causes a database write but does not affect the node state. The write could take up to a
minute.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.69 DS3-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The DS-3 Frame Format Mismatch condition indicates a frame format mismatch on a signal transiting
the ONS 15454 DS3XM-6, DS3XM-12, or DS3/EC1-48 card. The condition occurs when the
provisioned line type and incoming signal frame format type do no match. For example, if the line type
for a DS3XM-6 card is set to C Bit and the incoming signal frame format is detected as M 13, then the
ONS 15454 reports a DS3-MISM condition.

Clear the DS3-MISM Condition

Step 1 Display the CTC card view for the reporting DS3XM-6, DS3XM-12, or DS3/EC1-48 card.
Step2  Click the Provisioning > Line tabs.

Step3  For the row on the appropriate port, verify that the Line Type column is set to match the expected
incoming signal (C Bit or M13).

Step4  If the Line Type field does not match the expected incoming signal, select the correct Line Type in the
drop-down list.

Step5  Click Apply.

Step6  If the condition does not clear after the user verifies that the provisioned line type matches the expected
incoming signal, use an optical test set to verify that the actual signal coming into the ONS 15454
matches the expected incoming signal. For specific procedures to use the test set equipment, consult the
manufacturer.

Step7  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.70 DSP-COMM-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.8.711 DSP-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.72 DUP-IPADDR

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: NE

The Duplicate IP Address alarm indicates that the alarmed node IP address is already in use within the
same DCC area. When this happens, CTC no longer reliably connects to either node. Depending on how
the packets are routed, CTC could connect to either node (having the same IP address). If CTC has
connected to both nodes before they shared the same address, it has two distinct NodeModel instances
(keyed by the node ID portion of the MAC address).

Clear the DUP-IPADDR Alarm

Step1  Isolate the alarmed node from the other node having the same address:
a. Connect to the alarmed node using the Craft port on the TCC2/TCC2P card.
b. Begin a CTC session.
c. In the login dialog window, uncheck the Network Discovery check box.
Step2 In node view, click the Provisioning > Network > General tabs.
Step3  In the IP Address field, change the IP address to a unique number.
Stepd  Click Apply.

Step5  Restart any CTC sessions that are logged into either of the duplicate IP addresses. (For procedures to log
in or log out, refer to the “Set Up PC and Log Into the GUI” chapter in the Cisco ONS 15454 Procedure
Guide.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.73 DUP-NODENAME

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Duplicate Node Name alarm indicates that the alarmed node alphanumeric name is already being
used within the same DCC area.

Clear the DUP-NODENAME Alarm

Step 1 In node view, click the Provisioning > General > General tabs.
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Step 2
Step 3
Step 4

In the Node Name field, enter a unique name for the node.
Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.74 EHIBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Extreme High Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input
voltage exceeds the extreme high power threshold. This threshold, with a default value of -56.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains under the threshold for

120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.)

Clear the EHIBATVG Alarm

Step 1
Step 2

The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.75 ELWBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Extreme Low Voltage Battery alarm occurs in a —-48 VDC environment when a battery lead input
voltage falls below the extreme low power threshold. This threshold, with a default value of —40.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains over the threshold for

120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the ELWBATVG Alarm

Step 1
Step 2

The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.
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2.8.76 ENCAP-MISMATCH-P

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: STSTRM

The Encapsulation C2 Byte Mismatch Path alarm applies to ML-Series Ethernet cards. It occurs when
the first three following conditions are met and one of the last two is false:

e The received C2 byte is not 0x00 (unequipped).

e The received C2 byte is not a PDI value.

e The received C2 does not match the expected C2.

e The expected C2 byte is not 0x01 (equipped unspecified).
e The received C2 byte is not 0x01 (equipped unspecified).

(This is in contrast to the “PLM-P” alarm on page 2-176, which must meet all five criteria.) For an
ENCAP-MISMATCH-P to be raised, there is a mismatch between the received and expected C2 byte,
with either the expected byte or received byte value being 0x01.

For example, an ENCAP-MISMATCH-P alarm is raised if a circuit created between two ML-Series
cards has generic framing procedure (GFP) framing provisioned on one end and high-level data link
control (HDLC) framing with LEX encapsulation provisioned on the other. The GFP framing card
transmits and expects a C2 byte of 0x1B, while the HDLC framing card transmits and expects a C2 byte
of 0x01.

A mismatch between the transmit and receive cards on any of the following parameters can cause the
alarm:

e Mode (HDLC, GFP-F)

e Encapsulation (LEX, HDLC, PPP)
e CRCssize (16 or 32)

e Scrambling state (on or off)

This alarm is demoted by a PLM-P or PLM-V condition.

By default, an ENCAP-MISMATCH-P alarm causes an ML-Series card data link to go down. This
behavior can be modified using the command line interface (CLI) command no pos trigger defect
encap.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the ENCAP-MISMATCH-P Alarm

Step 1 Ensure that the correct framing mode is in use on the receive card:
a. Innode view, double-click the receive ML-Series card to open the card view.
b. Click the Provisioning > Card tabs.
c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.
Cisco ONS 15454 Troubleshooting Guide, R6.0
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Step 2 Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the receiving
card:
a. Innode view, double-click the transmit ML-Series card to open the card view.
b. Click the Provisioning > Card tabs.
c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.
Step3  If the alarm does not clear, use the CLI to ensure that the remaining settings are correctly configured on
the ML-Series card:
e Encapsulation
e CRCsize
e Scrambling state
To open the interface, click the IOS tab and click Open IOS Command Line Interface (CLI). Refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454
SDH, and Cisco ONS 15327 entries on all three of these topics to obtain the full configuration command
sequences.
Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

2.8.77 EOC

>

Warning

>

Warning

for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The SONET DCC Termination Failure alarm occurs when the ONS 15454 loses its DCC. Although this
alarm is primarily SONET, it can apply to DWDM. For example, the OSCM card can raise this alarm on
its OC-3 section overhead.

The SDCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS 15454
uses the DCC on the SONET section layer to communicate network management information.

On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial state when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.
Clear the EOC Alarm
Step 1 If the “LOS (DS1)” alarm on page 2-140 is also reported, complete the “Clear the LOS (OCN) Alarm”

A

procedure on page 2-147.

Caution

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the “SF-L” condition on page 2-196 is reported, complete the “Clear the SF-L Condition” procedure
on page 2-196.

If the alarm does not clear on the reporting node, verify the physical connections between the cards and
that the fiber-optic cables are configured to carry SDCC traffic. For more information about fiber
connections and terminations, refer to the “Install Cards and Fiber-Optic Cable” chapter in the

Cisco ONS 15454 Procedure Guide.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the
fiber span have in-service (IS-NR) ports. Verify that the ACT/SBY LED on each OC-N card is green.

When the LEDs on the OC-N cards are correctly illuminated, complete the “Verify or Create Node
Section DCC Terminations” procedure on page 2-244 to verify that the DCC is provisioned for the ports
at both ends of the fiber span.

Repeat Step 4 at the adjacent nodes.
If DCC is provisioned for the ends of the span, verify that the port is active and in service:
a. Confirm that the OC-N card shows a green LED in CTC or on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
b. To determine whether the port is in service, double-click the card in CTC to open the card view.
¢. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and click IS
in the drop-down list. Click Apply.

For all nodes, if the card is in service, use an optical test set to determine whether signal failures are
present on fiber terminations. For specific procedures to use the test set equipment, consult the
manufacturer.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R6.0 gy



Chapter2  Alarm Troubleshooting |

W 23878 EOC-L

A

Caution

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13
Step 14

2.8.78 EOC-L

Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231 for commonly used switching procedures.

If no signal failures exist on terminations, measure power levels to verify that the budget loss is within
the parameters of the receiver. See the “1.14.3 OC-N Card Transmit and Receive Levels” section on
page 1-154 for non-DWDM card levels.

If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly
terminated. For more information refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-239.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Resetting the active TCC2/TCC2P switches control to the standby TCC2/TCC2P. If the alarm clears
when the ONS 15454 node switches to the standby TCC2/TCC2P, the user can assume that the
previously active card is the cause of the alarm.

If the TCC2/TCC2P reset does not clear the alarm, delete the problematic SDCC termination:

a. From the View menu in card view, choose Go to Previous View if you have not already done so.
b. Click the Provisioning > Comm Channels > SDCC tabs.

c. Highlight the problematic DCC termination.

d. Click Delete.

e. Click Yes in the Confirmation Dialog box.

Recreate the SDCC termination. Refer to the “Turn Up Network” chapter in the Cisco ONS 15454
Procedure Guide for procedures.

Verify that both ends of the DCC have been recreated at the optical ports.

If the alarm has not cleared, call Cisco TAC (1 800 553-2447). If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-241. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Traffic Card” procedure on page 2-242.

Default Severity: Minor (MN), Non-Service-Affecting (NSA) for OCN
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The Line DCC (LDCC) Termination Failure alarm occurs when the ONS 15454 loses its line data
communications channel (LDCC) termination. For example, the OSCM card can raise this alarm on its
OC-3 line overhead.

The LDCC consists of nine bytes, D4 through D12, in the SONET overhead. The bytes convey
information about OAM&P. The ONS 15454 uses the LDCCs on the SONET line layer to communicate
network management information.
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On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial status when the EOC or EOC-L alarm is raised, it occurs when the logical
circuit is in place. The circuit is able to carry traffic when the DCC termination issue is resolved. You
do not need to delete the circuit when troubleshooting this alarm.

Clear the EOC-L Alarm

Step 1
Step 2

2.8.79 EQPT

Complete the “Clear the EOC Alarm” procedure on page 2-75.

If the alarm has not cleared, call Cisco TAC (1 800 553-2447). If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-241. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Traffic Card” procedure on page 2-242.

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: AICI-AEP, AICI-AIE, EQPT
DWDM Logical Object: PPM

An Equipment Failure alarm indicates that a hardware failure has occurred on the reporting card. If the
EQPT alarm occurs with a BKUPMEMP alarm, refer to the “2.8.42 BKUPMEMP” section on
page 2-50. The BKUPMEMP procedure also clears the EQPT alarm.

This alarm is also invoked if a diagnostic circuit detects a card application-specific integrated circuit
(ASIC) failure. In this case, if the card is part of a protection group, an APS switch occurs. If the card is
the protect card, switching is inhibited and a“PROTNA” alarm on page 2-179 is raised. The standby path
generates a path-type alarm.
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Clear the EQPT Alarm

Step1  If traffic is active on the alarmed port, you could need to switch traffic away from it. See the
“2.10.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-231 for commonly used
traffic-switching procedures.

Step2  Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Step3  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED status. A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a
standby card.

Stepd  If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-242 for the reporting card.

Step5  If the physical reseat of the card fails to clear the alarm, complete the “Physically Replace a Traffic Card”
procedure on page 2-242 for the reporting card.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.80 EQPT-DIAG

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

An Equipment-Diagnostic Failure alarm indicates that a software or hardware failure has occurred on
the reporting card. This alarm can be raised against a traffic card or a cross-connect card.

Clear the EQPT-DIAG Alarm

Step 1 If traffic is active on the alarmed card, you could need to switch traffic away from it. Refer to the
“2.10.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-231 for procedures.

Step2  Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-242 for the alarmed card

Step3  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
if it is raised against a traffic card, or complete the “Physically Replace an In-Service Cross-Connect
Card” procedure on page 2-243 if the alarm is raised against the cross-connect card.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.81 EQPT-MISS

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: FAN
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The Replaceable Equipment or Unit Missing alarm is reported against the fan-tray assembly unit. It
indicates that the replaceable fan-tray assembly is missing or not fully inserted. It could also indicate
that the ribbon cable connecting the AIP to the system board is bad.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the EQPT-MISS Alarm

Step 1 If the alarm is reported against the fan, verify that the fan-tray assembly is present.

Step2  If the fan-tray assembly is present, complete the “Replace the Fan-Tray Assembly” procedure on
page 2-249.

Step3  If no fan-tray assembly is present, obtain a fan-tray assembly and refer to the “Install the Fan-Tray
Assembly,” procedure in the Cisco ONS 15454 Procedure Guide.

Step4  If the alarm does not clear, replace the ribbon cable from the AIP to the system board with a known-good
ribbon cable.

Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.82 ERFI-P-CONN

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Three-Bit (Enhanced) Remote Failure Indication (ERFI) Path Connectivity condition is triggered on
DS-1, DS-3, or VT circuits when the “UNEQ-P” alarm on page 2-223 and the “TIM-P” alarm on
page 2-216 are raised on the transmission signal.

Clear the ERFI-P-CONN Condition

Step1  Complete the “Clear the UNEQ-P Alarm” procedure on page 2-223. This should clear the ERFI
condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.83 ERFI-P-PAYLD

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM
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The Three-Bit ERFI Path Payload condition is triggered on DS-1, DS-3, or VT circuits when the
“PLM-P” alarm on page 2-176 is raised on the transmission signal.

Clear the ERFI-P-PAYLD Condition

Step1  Complete the “Clear the PLM-P Alarm” procedure on page 2-177. This should clear the ERFI condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.84 ERFI-P-SRVR

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Three-Bit ERFI Path Server condition is triggered on DS-1, DS-3, or VT circuits when the “AIS-P”
condition on page 2-33 or the “LOP-P” alarm on page 2-137 is raised on the transmission signal.

Clear the ERFI-P-SRVR Condition

Step1  Complete the “Clear the LOP-P Alarm” procedure on page 2-138. This should clear the ERFI condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.85 ERROR-CONFIG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Error in Startup Configuration alarm applies to the ML-Series Ethernet cards. These cards process
startup configuration files line by line. If one or more lines cannot be executed, the error causes the
ERROR-CONFIG alarm. ERROR-CONFIG is not caused by hardware failure.

The typical reasons for an errored startup file are:

e The user stored the configuration for one type of ML-Series card in the database and then installed
another type in its slot.

e The configuration file contained a syntax error on one of the lines.

Note  For information about provisioning the ML-Series Ethernet cards from the Cisco IOS interface, refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454
SDH, and Cisco ONS 15327.
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2.8.86 ETH-LINKLOSS W

Clear the ERROR-CONFIG Alarm

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

If you have a different type of ML-Series card specified in the startup configuration file than what you
have installed, create the correct startup configuration.

Follow the card provisioning instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Upload the configuration file to the TCC2/TCC2P:

a. In node view, right-click the ML-Series card graphic.

b. Choose I0OS Startup Config from the shortcut menu.

c. Click Local > TCC and navigate to the file location in the Open dialog box.
Complete the “Reset a Traffic Card in CTC” procedure on page 2-239.

If the alarm does not clear or if your configuration file was correct according to the installed card, start
a Cisco IOS CLI for the card:

a. Right click the ML-Series card graphic in node view.
b. Choose Open IOS Connection from the shortcut menu.
A

Note  Open IOS Connection is not available unless the ML-Series card is physically installed in
the shelf.

Follow the card provisioning instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327 to correct the errored
configuration file line.

Execute the CLI command:

copy run start

The command copies the new card configuration into the database and clears the alarm.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.86 ETH-LINKLOSS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Rear Panel Ethernet Link Removed condition, if enabled in the network defaults, is raised under the
following conditions:

¢ The node.network.general. AlarmMissingBackplaneLAN field in NE default is enabled.
¢ The node is configured as a gateway network element (GNE).

e The backplane LAN cable is removed.
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~

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the ETH-LINKLOSS Condition

Step 1

Step 2

To clear this condition, reconnect the backplane LAN cable. Refer to the “Install the Shelf and Backplane
Cable” chapter in the Cisco ONS 15454 Procedure Guide for procedures to install this cable.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.87 E-W-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

A Procedural Error Misconnect East/West Direction alarm occurs during BLSR setup, or when nodes in
aring have slots misconnected. An east slot can be misconnected to another east slot, or a west slot can
be misconnected to another west slot. In most cases, the user did not connect the fibers correctly or the
ring provisioning plan was flawed. You can physically reconnect the cable to the correct slots to clear
the E-W-MISMATCH alarm. Alternately, you can delete and recreate the span in CTC to change the west
line and east line designations. The CTC method clears the alarm, but could change the traditional
east-west node connection pattern of the ring.

The E-W-MISMATCH alarm also appears during the initial set up of a ring with its east-west slots
configured correctly. If the alarm appears during the initial setup, the alarm clears itself shortly after the
ring setup is complete.

The lower-numbered slot at a node is traditionally labeled the west slot and the higher numbered slot is
labeled the east slot. For example, Slot 6 is west and Slot 12 is east.

The physical switch procedure is the recommend method of clearing the E-W-MISMATCH alarm. The
physical switch method reestablishes the logical pattern of connection in the ring. However, you can also
use CTC to recreate the span and identify the misconnected slots as east and west. The CTC method is
useful when the misconnected node is not geographically near the troubleshooter.

Clear the E-W-MISMATCH Alarm with a Physical Switch

Step 1

Step 2

Diagram the ring setup, including nodes and spans, on a piece of paper or white board.

In node view, click View > Go to Network View.
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Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9

A

Warning

A

Warning

>

Warning

Step 10

2.8.87 E-W-MISMATCH W

Click the circuit and click Edit. The network map detailed view window appears. This window contains
the node name, slot, and port for each end of each span.

Label each of the nodes on the diagram with the same name that appears on the network map.

Label the span ends on the diagram with the same information. For example, with

Node 1/Slot 12/Port 1—Node 2/Slot 6/Port 1 (2F BLSR OC48, ring name=0), label the end of the span
that connects Node 1 and Node 2 at the Node 1 end as Slot 12/Port 1. Label the Node 2 end of that same
span Slot 6/Port 1.

Repeat Steps 4 and 5 for each span on your diagram.
Label the highest slot at each node east and the lowest slot at each node west.

Examine the diagram. You should see a clockwise pattern of west slots connecting to east slots for each
span. Refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure
Guide for more information about cabling the system.

If any span has an east-to-east or west-to-west connection, physically switching the fiber connectors
from the card that does not fit the pattern to the card that continues the pattern should clear the alarm.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

Clear the E-W-MISMATCH Alarm in CTC

Step1  Log into the misconnected node. A misconnected node has both ring fibers connecting it to its neighbor
nodes misconnected.

Step2  Click the Maintenance > BLSR tabs.

Step3  From the row of information for the fiber span, complete the “Identify a BLSR Ring Name or Node ID
Number” procedure on page 2-230 to identify the node ID, ring name, and the slot and port in the
East Line column and West Line column. Record the above information.

Stepd  Click View > Go to Network View.

Step5  Delete and recreate the BLSR:
a. Click the Provisioning > BLSR tabs.
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Step 6
Step 7
Step 8
Step 9
Step 10

b. Click the row from Step 3 to select it and click Delete.

c. Click Create.

d. Fill in the ring name and node ID from the information collected in Step 3.
e. Click Finish.

Display node view and click the Maintenance > BLSR tabs.

Change the West Line field to the slot you recorded for the East Line in Step 3.
Change the East Line field to the slot you recorded for the West Line in Step 3.
Click OK.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.88 EXCCOL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Excess Collisions on the LAN alarm indicates that too many collisions are occurring between data
packets on the network management LAN, and communications between the ONS 15454 and CTC could
be affected. The network management LAN is the data network connecting the workstation running the
CTC software to the TCC2/TCC2P. The problem causing the alarm is external to the ONS 15454.

Troubleshoot the network management LAN connected to the TCC2/TCC2P for excess collisions. You
might need to contact the system administrator of the network management LAN to accomplish the
following steps.

Clear the EXCCOL Alarm
Step 1 Verify that the network device port connected to the TCC2/TCC2P has a flow rate set to 10 Mb,
half-duplex.
Step2  If the port has the correct flow rate and duplex setting, troubleshoot the network device connected to the
TCC2/TCC2P and the network management LAN.
Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1 800 553-2447).

2.8.89 EXERCISE-RING-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Exercise Ring command issues ring protection switching of the requested channel without
completing the actual bridge and switch. The EXERCISE-RING-FAIL condition is raised if the
command was issued and accepted but the exercise did not take place.
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>
Note  If the exercise command gets rejected due to the existence of a higher-priority condition in the ring,
EXERCISE-RING-FAIL is Not Reported (NR).

Clear the EXERCISE-RING-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (OCN)” alarm on page 2-134, the “LOS (OCN)” alarm on
page 2-147, or a BLSR alarm.

Step2  Complete the “Initiate an Exercise Ring Switch on a BLSR” procedure on page 2-238.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.90 EXERCISE-SPAN-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Exercise Span command issues span switching of the requested channel without completing the
actual bridge and switch. The EXERCISE-SPAN-FAIL condition is raised if the command was issued
and accepted but the exercise did not take place.

Note If the exercise command gets rejected due to the existence of a higher-priority condition in the span or
ring, EXERCISE-SPAN-FAIL is Not Reported (NR).

Clear the EXERCISE-SPAN-FAIL Condition

Step 1 Look for and clear, if present, the “LOF (OCN)” alarm on page 2-134, the “LOS (OCN)” alarm on
page 2-147, or a BLSR alarm.

Step2  Complete the “Initiate an Exercise Ring Switch on a BLSR” procedure on page 2-238.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.91 EXT

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: ENVALRM

A Failure Detected External to the NE alarm occurs because an environmental alarm is present. For
example, a door could be open or flooding could have occurred.
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Clear the EXT Alarm

Step1  In node view double-click the AIC-I card to open the card view.
Step2  Double-click the Maintenance > External Alarms tab.

Step3  Follow your standard operating procedure to remedy environmental conditions that cause alarms. The
alarm clears when the situation is remedied.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.92 EXTRA-TRAF-PREEMPT

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

An Extra Traffic Preempted alarm occurs on OC-N cards in two-fiber and four-fiber BLSRs when
low-priority traffic directed to the protect system has been preempted by a working system protection
switch.

Clear the EXTRA-TRAF-PREEMPT Alarm

Step1  Verify that the protection switch has occurred by checking the Conditions tab.

Step2 If aring switch has occurred, clear the ring switch on the working system by following the appropriate
alarm in this chapter. For more information about protection switches, refer to the “2.10.2 Protection
Switching, Lock Initiation, and Clearing” section on page 2-231 or the “Maintain the Node” chapter in
the Cisco ONS 15454 Procedure Guide.

Step3  If the alarm occurred on a four-fiber BLSR and the span switch occurred on this OC-N, clear the span
switch on the working system.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.93 FAILTOSW

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Failure to Switch to Protection Facility condition occurs when a working or protect electrical or
optical facility switches to its companion port by using a MANUAL command. For example, if you
attempt to manually switch traffic from an unused protect port to an in-service working port, the switch
will fail (because traffic is already present on the working port) and you will see the FAILTOSW
condition.
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Clear the FAILTOSW Condition

Step 1

Step 2

Step 3

Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card
and clears the FAILTOSW.

>
Note A higher-priority alarm is an alarm raised on the working DS-N card using the 1:N card

protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW
condition.

If the condition does not clear, replace the working electrical or optical card that is reporting the
higher-priority alarm by following the “Physically Replace a Traffic Card” procedure on page 2-242.
This card is the working electrical or optical card using the protect card and not reporting FAILTOSW.

Replacing the working electrical or optical card that is reporting the higher-priority alarm allows traffic
to revert to the working slot and the card reporting the FAILTOSW to switch to the protect card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.94 FAILTOSW-PATH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, VI-MON

The Fail to Switch to Protection Path condition occurs when the working circuit does not switch to the
protection circuit on a path protection. Common causes of the FAILTOSW-PATH alarm include a
missing or defective protect port, a lockout set on one of the path protection nodes, or path-level alarms
that would cause a path protection switch to fail including the “AIS-P” condition on page 2-33, the
“LOP-P” alarm on page 2-137, the “SD-P” condition on page 2-193, the “SF-P” condition on

page 2-196, and the “UNEQ-P” alarm on page 2-223.

The “LOF (OCN)” alarm on page 2-134, the “LOS (OCN)” alarm on page 2-147, the “SD-L” condition
on page 2-193, or the “SF-L” condition on page 2-196 can also occur on the failed path.

Clear the FAILTOSW-PATH Condition in a Path Protection Configuration

Step 1

Look up and clear the higher-priority alarm. Clearing this alarm frees the standby card and clears the
FAILTOSW-PATH condition. If the “AIS-P” condition on page 2-33, the “LOP-P” alarm on page 2-137,
the “UNEQ-P” alarm on page 2-223, the “SF-P” condition on page 2-196, the “SD-P” condition on
page 2-193, the “LOF (OCN)” alarm on page 2-134, the “LOS (OCN)” alarm on page 2-147, the “SD-L”
condition on page 2-193, or the “SF-L” condition on page 2-196 are also occurring on the reporting port,
complete the applicable alarm clearing procedure.

~

Note A higher-priority alarm is an alarm raised on the working electrical card using the 1:N card
protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW
condition.
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Step 2

Step 3

If the condition does not clear, replace the active OC-N card that is reporting the higher-priority alarm.
Complete the “Physically Replace a Traffic Card” procedure on page 2-242. Replacing the active OC-N
card that is reporting the higher-priority alarm allows traffic to revert to the active slot. Reverting frees
the standby card, which can then take over traffic from the card reporting the lower-priority alarm and
the FAILTOSW-PATH condition.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.95 FAILTOSWR

>

Warning

>

Warning

A

Warning

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Fail to Switch to Protection Ring condition occurs when a ring switch did not complete because of
internal APS problems.

FAILTOSWR clears in any of the following situations:
¢ A physical card pull of the active TCC2/TCC2P (done under Cisco TAC supervision).
e A node power cycle.
e A higher-priority event such as an external switch command.
e The next ring switch succeeds.

e The cause of the APS switch (such as the “SD (DS1, DS3)” condition on page 2-190 or the “SF
(DS1, DS3)” condition on page 2-194) clears.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the FAILTOSWR Condition in a BLSR Configuration

Step 1

Perform the Exercise Ring command on the reporting card:
a. Click the Maintenance > BLSR tabs.
b. Click the row of the affected ring under the West Switch column.

c. Select Exercise Ring in the drop-down list.
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Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Step 8

A

2.8.96 FAILTOSWS H

If the condition does not clear, from the view menu, choose Go to Network View.

Look for alarms on OC-N cards that make up the ring or span and troubleshoot these alarms.
If clearing other alarms does not clear the FAILTOSWR condition, log into the near-end node.
Click the Maintenance > BLSR tabs.

Record the OC-N cards listed under West Line and East Line. Ensure that these OC-N cards and ports
are active and in service:

a. Verify the LED status: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED
indicates a standby card.

b. Double-click the card in CTC to open the card view.
c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

If the OC-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. To
verify fiber continuity, follow site practices.

If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close
to the receiving card as possible.

Caution

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231 for commonly used switching procedures.

If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within
the OC-N card receiver specifications. The “1.14.3 OC-N Card Transmit and Receive Levels” section
on page 1-154 lists these specifications.

Repeat Steps 7 through 10 for any other ports on the card.

If the optical power level for all OC-N cards is within specifications, complete the “Physically Replace
a Traffic Card” procedure on page 2-242 for the protect standby OC-N card.

If the condition does not clear after you replace the BLSR cards on the node one by one, repeat
Steps 4 through 12 for each of the nodes in the ring.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.96 FAILTOSWS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
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The Failure to Switch to Protection Span condition signals an APS span switch failure. For a four-fiber
BLSR, a failed span switch initiates a ring switch. If the ring switch occurs, the FAILTOSWS condition
does not appear. If the ring switch does not occur, the FAILTOSWS condition appears. FAILTOSWS
clears when one of the following situations occurs:

e A physical card pull of the active TCC2/TCC2P done under Cisco TAC supervision.
e A node power cycle.

¢ A higher-priority event such as an external switch command occurs.

e The next span switch succeeds.

e The cause of the APS switch (such as the “SD (DS1, DS3)” condition on page 2-190 or the “SF
(DS1, DS3)” condition on page 2-194) clears.

Clear the FAILTOSWS Condition

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Step 8

A

Perform the Exercise Span command on the reporting card:

a. Click the Maintenance > BLSR tabs.

b. Determine whether the card you would like to exercise is the west card or the east card.
c. Click the row of the affected span under the East Switch or West Switch column.

d. Select Exercise Span in the drop-down list.

If the condition does not clear, from the view menu, choose Go to Network View.

Look for alarms on OC-N cards that make up the ring or span and troubleshoot these alarms.
If clearing other alarms does not clear the FAILTOSWS condition, log into the near-end node.
Click the Maintenance > BLSR tabs.

Record the OC-N cards listed under West Line and East Line. Ensure that these OC-N cards are active
and in service:

a. Verify the LED status: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED
indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

If the OC-N cards are active and in service, verify fiber continuity to the ports on the recorded cards. To
verify fiber continuity, follow site practices.

If fiber continuity to the ports is good, use an optical test set to verify that a valid signal exists on the
line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close
to the receiving card as possible.

Caution

Using an optical test set disrupts service on the OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231 for commonly used switching procedures.
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Step 9

Step 10

Step 11
Step 12

Step 13

Step 14

2.8.97 FAN

A

2897 FAN H

If the signal is valid, clean the fiber according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If cleaning the fiber does not clear the condition, verify that the power level of the optical signal is within
the OC-N card receiver specifications. The “1.14.3 OC-N Card Transmit and Receive Levels” section
on page 1-154 lists these specifications.

Repeat Steps 7 through 10 for any other ports on the card.

If the optical power level for all OC-N cards is within specifications, complete the “Physically Replace
a Traffic Card” procedure on page 2-242 for the protect standby OC-N card.

If the condition does not clear after you replace the BLSR cards on the node one by one, follow
Steps 4 through 12 for each of the nodes in the ring.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: FAN

The Fan Failure alarm indicates a problem with the fan-tray assembly. When the fan-tray assembly is not
fully functional, the temperature of the ONS 15454 can rise above its normal operating range.

The fan-tray assembly contains six fans and needs a minimum of five working fans to properly cool the
shelf. However, even with five working fans, the fan-tray assembly could need replacement because a
sixth working fan is required for extra protection against overheating.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Clear the FAN Alarm
Step 1 Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the
Reusable Air Filter” procedure on page 2-247.
Step2  If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-248.
Step3  If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-249. The fan should run immediately when correctly inserted.
Step4  If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1 800 553-2447).
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2.8.98 FC-NO-CREDITS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR
DWDM Logical Objects: FC, TRUNK

The Fibre Channel Distance Extension Credit Starvation alarm occurs on storage access networking
(SAN) Fibre Channel/Fiber Connectivity (FICON) FC_MR-4 cards when the congestion prevents the
GFP transmitter from sending frames to the FC_MR-4 card port. For example, the alarm can be raised
when an operator configures a card to autodetect framing credits but the card is not connected to an
interoperable FC-SW-standards-based Fibre Channel/FICON port.

FC-NO-CREDITS is raised only if transmission is completely prevented. (If traffic is slowed but still
passing, this alarm is not raised.) The alarm is raised in conjunction with the GFP-NO-BUFFERS alarm.
For example, if the FC-NO-CREDITS alarm is generated at an FC_MR-4 data port, a
GFP-NO-BUFFERS alarm could be raised at the upstream remote FC_MR-4 data port.

Clear the FC-NO-CREDITS Alarm

Step 1 If the port is connected to a Fibre Channel/FICON switch, make sure it is configured for interoperation
mode using the manufacturer’s instructions.

Step 2 If the port is not connected to a switch, turn off Autodetect Credits:

a. Double-click the FC_MR-4 card.

b. Click Provisioning > Port > General.

¢. Under Admin State, click the cell and choose OOS,MT.
d. Click Apply.

e. Click the Provisioning > Port > Distance Extension tabs.
f. Uncheck the Autodetect Credits column check box.

g. Click Apply.

h. Click Provisioning > Port > General.

i. Under Admin State, click the cell and choose IS.

j. Click Apply.

Step3  Program the Credits Available value based on the buffers available on the connected equipment:

~

Note  The NumCredits must be provisioned to a value smaller than or equal to the receive buffers or
credits available on the connected equipment.

a. Double-click the FC_MR-4 card.
b. Click the Provisioning > Port > Distance Extension tabs.
¢. Enter a new value in the Credits Available column.

d. Click Apply.
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Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.8.99 FE-AIS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far-End AIS condition occurs when an AIS has occurred at the far-end node. FE-AIS usually occurs
in conjunction with a downstream LOS alarm (see the “LOS (OCN)” alarm on page 2-147).

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the FE-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-32.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.100 FEC-MISM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.101 FE-DS1-MULTLOS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far-End Multiple DS-1 LOS Detected condition occurs when multiple DS-1 signals are lost on a
far-end DS-1 card.

The prefix FE means the main alarm is occurring at the far-end node and not at the node reporting the
FE-DS1-MULTLOS condition. Troubleshoot the FE alarm or condition by troubleshooting the main
alarm at its source. The secondary alarms or conditions clear when the main alarm clears.
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Clear the FE-DS1-MULTLOS Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an ONS 15454 FE condition on a card in Slot 12 of Node 1 could relate to a
main alarm from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.102 FE-DS1-NSA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-1 Equipment Failure Non-Service-Affecting (NSA) condition occurs when a far-end
DS-1 equipment failure occurs, but does not affect service because the port is protected and traffic is able
to switch to the protect port.

Clear the FE-DS1-NSA Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in an ONS 15454 Slot 12 of Node 1 could link to an alarm
from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.103 FE-DS1-SA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-1 Equipment Failure Service Affecting condition occurs when there is a far-end
equipment failure on a DS-1 card that affects service because traffic is unable to switch to the protect
port.
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Clear the FE-DS1-SA Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in
Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.104 FE-DS1-SNGLLOS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far-End Single DS-1 LOS condition occurs when a single DS-1 signal is lost on far-end DS-1
equipment (within a DS3). Signal loss also causes the “LOS (OCN)” alarm on page 2-147.

Clear the FE-DS1-SNGLLOS Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could link to an alarm from
a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.105 FE-DS3-NSA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-3 Equipment Failure Non-Service-Affecting (NSA) condition occurs when a far-end
ONS 15454 DS-3 equipment failure occurs in C-bit framing mode, but does not affect service because
the port is protected and traffic is able to switch to the protect port.
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Clear the FE-DS3-NSA Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in
Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.

Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.106 FE-DS3-SA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End DS-3 Equipment Failure Service Affecting condition occurs when there is a far-end
equipment failure on an ONS 15454 DS-3 card in C-bit framing mode that affects service because traffic
is unable to switch to the protect port.

Clear the FE-DS3-SA Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an alarm from a card in Slot 12 of Node 1 could link to an alarm from a card in
Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.

Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.107 FE-EQPT-NSA

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End Common Equipment Failure condition occurs when a Non-Service-Affecting (NSA)
equipment failure is detected on far-end DS-3 equipment.
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Clear the FE-EQPT-NSA Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.

Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter for troubleshooting
instructions.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.108 FE-FRCDWKSWBK-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Forced Switch Back to Working—Span condition is raised on a far-end 1+1 working port
when it is Force switched to the working port.

~

Note @ WKSWBK-type conditions apply only to revertive circuits.

Clear the FE-FRCDWKSWBK-SPAN Condition

Step 1 Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-232 for the far-end
port.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.109 FE-FRCDWKSWPR-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Ring Working Facility Forced to Switch to Protection condition occurs from a far-end node
when a BLSR is forced from working to protect using the Force Ring command. This condition is only
visible on the network view Conditions tab.
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Clear the FE-FRCDWKSWPR-RING Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Clear the main alarm.

Step4  If the FE-FRCDWKSWPR-RING condition does not clear, complete the “Clear a BLSR External
Switching Command” procedure on page 2-238.

Step5  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.110 FE-FRCDWKSWPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Working Facility Forced to Switch to Protection Span condition occurs from a far-end node
when a span on a four-fiber BLSR is forced from working to protect using the Force Span command.
This condition is only visible on the network view Conditions tab. The port where the Force Switch
occurred is indicated by an “F” on the network view detailed circuit map. This condition is accompanied
by WKSWPR.

Clear the FE-FRCDWKSWPR-SPAN Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Clear the main alarm.

Step 4 If the FE-FRCDWKSWPR-SPAN condition does not clear, complete the “Clear a BLSR External
Switching Command” procedure on page 2-238 for procedures.

Step5  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.111 FE-IDLE

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End Idle condition occurs when a far-end node detects an idle DS-3 signal in C-bit framing
mode.
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Clear the FE-IDLE Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot the FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Clear the main alarm by clearing the protection switch. See the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231 for commonly used traffic-switching procedures.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.112 FE-LOCKOUTOFPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far-End Lock Out of Protection Span condition occurs when a BSLR span is locked out of the
protection system from a far-end node using the Lockout Protect Span command. This condition is only
seen on the network view Conditions tab and is accompanied by LKOUTPR-S. The port where the
lockout originated is marked by an “L” on the network view detailed circuit map.

Clear the FE-LOCKOUTOFPR-SPAN Condition

Step 1

Step 2
Step 3

Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.

Ensure there is no lockout set. Complete the “Clear a BLSR External Switching Command” procedure
on page 2-238.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.113 FE-LOF

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End LOF condition occurs when a far-end node reports the “LOF (DS3)” alarm on page 2-132
in C-bit framing mode.
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Clear the FE-LOF Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Complete the “Clear the LOF (DS1) Alarm” procedure on page 2-132. It also applies to FE-LOF.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.114 FE-LOS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The Far End LOS condition occurs in C-bit framing mode when a far-end node reports the “LOS (DS3)”
alarm on page 2-142.

Clear the FE-LOS Condition

Step1  To troubleshoot the FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Complete the “Clear the LOS (DS1) Alarm” procedure on page 2-141.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.115 FE-MANWKSWBK-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Manual Switch Back to Working—Span condition occurs when a far-end span with a
Manual switch reverts to working.

~

Note = WKSWBK-type conditions apply only to nonrevertive circuits.
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Clear the FE-EMANWKSWBK-SPAN Condition

Step 1

Step 2
Step 3
Step 4

To troubleshoot the FE condition, determine which node and card link directly to the card reporting the
FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm
from a card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.
Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.116 FE-MANWKSWPR-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Ring Manual Switch of Working Facility to Protect condition occurs when a BLSR working
ring is switched from working to protect at a far-end node using the Manual Ring command.

Clear the FEEMANWKSWPR-RING Condition

Step 1

Step 2
Step 3
Step 4

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Log into the node that links directly to the card reporting the FE condition.
Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.117 FE-MANWKSWPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far-End Span Manual Switch Working Facility to Protect condition occurs when a four-fiber BLSR
span is switched from working to protect at the far-end node using the Manual Span command. This
condition is only visible on the network view Conditions tab and is accompanied by WKSWPR. The port
where the Manual Switch occurred is indicated by an “M” on the network view detailed circuit map.
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Clear the FE-FMANWKSWPR-SPAN Condition

Step1  To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Complete the “Clear a BLSR External Switching Command” alarm on page 2-238.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.118 FEPRLF

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Far End Protection Line Failure alarm occurs when an APS channel “SF-L” condition on page 2-196
occurs on the protect card coming into the node.

Note  The FEPRLF alarm occurs when bidirectional protection is used on optical cards in a 1+1 protection
group configuration or four-fiber BLSR configuration.

Clear the FEPRLF Alarm on a Four-Fiber BLSR

Step1  To troubleshoot the FE alarm, determine which node and card link directly to the card reporting the FE
alarm. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main alarm from a
card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Clear the main alarm. Refer to the appropriate alarm section in this chapter in this chapter for procedures.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.119 FIBERTEMP-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.120 FORCED-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, STSMON, VI-MON
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2.8.121 FORCED-REQ-RING

The Force Switch Request on Facility or Port condition occurs when you enter the Force command on a
port to force traffic from a working port to a protect port or protection span (or from a protect port to a
working port or span). You do not need to clear the condition if you want the Force switch to remain.

Clear the FORCED-REQ Condition

Step 1 Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-232.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.121 FORCED-REQ-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Force Switch Request Ring condition applies to optical trunk cards when the Force Ring command
is applied to BLSRs to move traffic from working to protect. This condition is visible on the network
view Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port where the
FORCE RING command originated is marked with an “F” on the network view detailed circuit map.

Clear the FORCED-REQ-RING Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.122 FORCED-REQ-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Force Switch Request Span condition applies to optical trunk cards in two-fiber or four-fiber BLSRs
when the Force Span command is applied to a BLSR SPAN to force traffic from working to protect or
from protect to working. This condition appears on the network view Alarms, Conditions, and History
tabs. The port where the FORCE SPAN command was applied is marked with an “F” on the network
view detailed circuit map.

This condition can also be raised in 1+1 facility protection groups. If traffic is present on a working port
and you use the FORCE command to prevent it from switching to the protect port (indicated by
“FORCED TO WORKING”), FORCED-REQ-SPAN indicates this force switch. In this case, the force
is affecting not only the facility, but the span.
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Clear the FORCED-REQ-SPAN Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.123 FRCDSWTOINT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Force Switch to Internal Timing condition occurs when the user issues a Force command to switch
to an internal timing source.

~

Note FRCDSWTOINT is an informational condition and does not require troubleshooting.

2.8.124 FRCDSWTOPRI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Primary Timing Source condition occurs when the user issues a Force command to
switch to the primary timing source.

~

Note FRCDSWTOPRI is an informational condition and does not require troubleshooting.

2.8.125 FRCDSWTOSEC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Second Timing Source condition occurs when the user issues a Force command to
switch to the second timing source.

~

Note FRCDSWTOSEC is an informational condition and does not require troubleshooting.

2.8.126 FRCDSWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF
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The Force Switch to Third Timing Source condition occurs when the user issues a Force command to
switch to a third timing source.

S

Note FRCDSWTOTHIRD is an informational condition and does not require troubleshooting.

2.8.127 FRNGSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Free Running Synchronization Mode condition occurs when the reporting ONS 15454 is in free-run
synchronization mode. External timing sources have been disabled and the node is using its internal
clock, or the node has lost its designated building integrated timing supply (BITS) timing source. After
the 24-hour holdover period expires, timing slips could begin to occur on an ONS 15454 node relying
on an internal clock.

~

Note  If the ONS 15454 is configured to operate from its internal clock, disregard the FRNGSYNC condition.

Clear the FRNGSYNC Condition

Step 1 If the ONS 15454 is configured to operate from an external timing source, verify that the BITS timing
source is valid. Common problems with a BITS timing source include reversed wiring and bad timing
cards. Refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual for more information.

Step2  If the BITS source is valid, clear alarms related to the failures of the primary and secondary reference
sources, such as the “SYNCPRI” alarm on page 2-212 and the “SYNCSEC” alarm on page 2-212.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.128 FSTSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

A Fast Start Synchronization Mode condition occurs when the node is choosing a new timing reference.
The previous timing reference has failed.

The FSTSYNC alarm disappears after approximately 30 seconds. If the condition does not clear, log into
the Technical Support Website at http://www.cisco.com/techsupport for more information or call
Cisco TAC (1 800 553-2447).

Note FSTSYNC is an informational condition. It does not require troubleshooting.
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2.8.129 FULLPASSTHR-BI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Bidirectional Full Pass-Through Active condition occurs on a nonswitching node in a BLSR when
the protect channels on the node are active and carrying traffic and there is a change in the receive K byte
from No Request.

Clear the FULLPASSTHR-BI Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.130 GAIN-HDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.131 GAIN-HFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.132 GAIN-LDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.133 GAIN-LFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.134 GCC-EOC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

Cisco ONS 15454 Troubleshooting Guide, R6.0
m. November 2009 |



| Chapter2 Alarm Troubleshooting

28135 GE-00SYNC W

2.8.135 GE-O0SYNC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.136 GFP-CSF

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE100T, FCMR, GFP-FAC, ML100T, ML1000, MLFX

The GFP Client Signal Fail Detected alarm is a secondary alarm raised on local GFP data ports when a
remote Service-Affecting (SA) alarm causes invalid data transmission. The alarm is raised locally on
FC_MR-4, ML100T, ML1000, ML100X-8, MXP_MR_25G, and MXPP_MR_25G GFP data ports and
does not indicate that a Service-Affecting (SA) failure is occurring at the local site, but that a CARLOSS,
LOS, or SYNCLOSS alarm caused by an event such as a pulled receive cable is affecting a remote data
port's transmission capability. This alarm can be demoted when a facility loopback is placed on the
FC_MR-4 port.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-CSF Alarm

Step 1
Step 2

Clear the Service-Affecting (SA) alarm at the remote data port.

If the GFP-CSF alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.8.137 GFP-DE-MISMATCH

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: FCMR, GFP-FAC

The GFP Fibre Channel Distance Extension Mismatch alarm indicates that a port configured for
Distance Extension is connected to a port that is not operating in Cisco's proprietary Distance Extension
mode. It is raised on Fibre Channel and FICON card GFP ports supporting distance extension. The alarm
occurs when distance extension is enabled on one side of the transport but not on the other. To clear,
distance extension must be enabled on both ports connected by a circuit.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Clear the GFP-DE-MISMATCH Alarm

Step1  Ensure that the distance extension protocol is configured correctly on both sides:

a. Double-click the card to open the card view.

b. Click the Provisioning > Port > General tabs.

¢. Under Admin State, click the cell and choose OOS,MT.
d. Click Apply.

e. Click the Provisioning > Port > Distance Extension tabs.

f. Check the check box in the Enable Distance Extension column.
g. Click Apply.

h. Click the Provisioning > Port > General tabs.

i. Under Admin State, click the cell and choose IS-NR.

j. Click Apply.

Step2  If the GFP-DE-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a

Service-Affecting (SA) problem.

2.8.138 GFP-EX-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: FCMR, GFP-FAC

The GFP Extension Header Mismatch alarm is raised on Fibre Channel/FICON cards when it receives
frames with an extension header that is not null. The alarm occurs when a provisioning error causes all

GFP frames to be dropped for 2.5 seconds.

Ensure that both end ports are sending a null extension header for a GFP frame. The FC_MR-4 card
always sends a null extension header, so if the equipment is connected to other vendors’ equipment,

those need to be provisioned appropriately.

Wte For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-EX-MISMATCH Alarm

Step 1 Ensure that the vendor equipment is provisioned to send a null extension header in order to interoperate
with the FC_MR-4 card. (The FC_MR-4 card always sends a null extension header.)

Step2  If the GFP-EX-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a

Service-Affecting (SA) problem.
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2.8.139 GFP-LFD

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE100T, FCMR, GFP-FAC, ML100T, ML1000, MLFX

The GFP Loss of Frame Delineation alarm applies to Fibre Channel, FICON GFP, and Ethernet ports.
This alarm occurs if there is a bad SONET connection, if SONET path errors cause GFP header errors
in the check sum calculated over payload length (PLI/cHEC) combination, or if the GFP source port
sends an invalid PLI/cHEC combination. The loss causes traffic stoppage.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-LFD Alarm

Step 1

Step 2

Look for and clear any associated SONET path errors such as LOS or AIS-L originating at the transmit
node.

If the GFP-LFD alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.8.140 GFP-NO-BUFFERS

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: FCMR, GFP-FAC

The GFP Fibre Channel Distance Extension Buffer Starvation alarm is raised on Fibre Channel/FICON
card ports supporting GFP and the distance extension protocol when the GFP transmitter cannot send
GFP frames due to lack of remote GFP receiver buffers. This occurs when the remote GFP-T receiver
experiences congestion and is unable to send frames over the Fibre Channel/FICON link.

This alarm could be raised in conjunction with the FC-NO-CREDITS alarm. For example, if the
FC-NO-CREDITS alarm is generated at an FC_MR-4 data port, a GFP-NO-BUFFERS alarm could be
raised at the upstream remote FC_MR-4 data port.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-NO-BUFFERS Alarm

Step 1

Complete the “Clear the FC-NO-CREDITS Alarm” procedure on page 2-92.
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Step 2

If the GFP-CSF alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.8.141 GFP-UP-MISMATCH

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE100T, FCMR, GFP-FAC, ML100T, ML1000, MLFX

The GFP User Payload Mismatch is raised against Fibre Channel/FICON ports supporting GFP. It occurs
when the received frame user payload identifier (UPI) does not match the transmitted UPI and all frames
are dropped. The alarm is caused by a provisioning error, such as the port media type not matching the
remote port media type. For example, the local port media type could be set to Fibre Channel—1 Gbps
ISL or Fibre Channel—2 Gbps ISL and the remote port media type could be set to FICON—1 Gbps ISL
or FICON—2 Gbps ISL.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-UP-MISMATCH Alarm

Step 1

Step 2

Step 3

Ensure that the transmit port and receive port are identically provisioned for distance extension by
completing the following steps:

a. Double-click the card to open the card view.

b. Click the Provisioning > Port > Distance Extension tabs.

c. Check the check box in the Enable Distance Extension column.

d. Click Apply.

Ensure that both ports are set for the correct media type. For each port, complete the following steps:
a. Double-click the card to open the card view (if you are not already in card view).

b. Click the Provisioning > Port > General tabs.

c. Choose the correct media type (Fibre Channel - 1Gbps ISL, Fibre Channel - 2 Gbps ISL,
FICON - 1 Gbps ISL, or FICON - 2 Gbps ISL) from the drop-down list.

d. Click Apply.

If the GFP-UP-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.8.142 HELLO

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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SONET Logical Object: OCN

The Open Shortest Path First (OSPF) Hello alarm is raised when the two end nodes cannot bring an
OSPF neighbor up to the full state. Typically, this problem is caused by an area ID mismatch, and/or an
OSPF HELLO packet loss over the DCC.

Clear the HELLO Alarm

Step 1

Step 2

Ensure that the area ID is correct on the missing neighbor:

a. In node view, click the Provisioning > Network > OSPF tabs.

b. Ensure that the IP address in the Area ID column matches the other nodes.
c. If the address does not match, click the incorrect cell and correct it.

d. Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.143 HIBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The High Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input voltage
exceeds the high power threshold. This threshold, with a default value of —52 VDC, is
user-provisionable. The alarm remains raised until the voltage remains under the threshold for

120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the HIBATVG Alarm

Step 1
Step 2

The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.144 HI-CCVOLT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The 64K Composite Clock High NE Voltage alarm occurs when the 64K signal peak voltage exceeds
1.1 VDC.
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Clear the HI-CCVOLT Condition

Step1  Lower the source voltage to the clock.
Step 2 If the condition does not clear, add more cable length or add a 5 dBm attenuator to the cable.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.145 HI-LASERBIAS

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM, TRUNK

The Equipment High Transmit Laser Bias Current alarm is raised against TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, and OC192-XFP card laser
performance. The alarm indicates that the card laser has reached the maximum laser bias tolerance.

Laser bias typically starts at about 30 percent of the manufacturer maximum laser bias specification and
increases as the laser ages. If the HI-ILASERBIAS alarm threshold is set at 100 percent of the maximum,
the laser usability has ended. If the threshold is set at 90 percent of the maximum, the card is still usable
for several weeks or months before it needs to be replaced.

Note  For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter.

Clear the HI-LASERBIAS Alarm

Step 1 Complete the “Clear the LASEREOL Alarm” procedure on page 2-126, which can include replacing the
card. Replacement is not urgent and can be scheduled during a maintenance window.

Caution  Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.10.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-231 for commonly used traffic-switching procedures.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.146 HI-LASERTEMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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SONET Logical Objects: EQPT, OCN
DWDM Logical Object: PPM

The Equipment High Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards.
HI-LASERTEMP occurs when the internally measured transceiver temperature exceeds the card setting
by 35.6 degrees F (2 degrees C). A laser temperature change affects the transmitted wavelength.

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The “LOS (OCN)”
alarm on page 2-147 is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-71 is raised
at the near end.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter.

Clear the HI-LASERTEMP Alarm

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

In node view, double-click the TXP or MXP card to open the card view.
Click the Performance > Optics PM > Current Values tabs.

Verify the card laser temperature levels. Maximum, minimum, and average laser temperatures are shown
in the Current column entries in the Laser Temp rows.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the MXP or TXP card.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting MXP or TXP card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.147 HI-RXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Equipment High Receive Power alarm is an indicator of the optical signal power that is transmitted
to the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, or
OC192-XFP card. HI-RXPOWER occurs when the measured optical power of the received signal
exceeds the threshold. The threshold value is user-provisionable.

For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.
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Note

When you upgrade a node to Software Release 6.0 or later, this enables received optical power PMs for
the OC3-8, OC192-SR, OC192-IR, OC192-ITU, OC-192-XFP, MRC-12, and MRC25G-4 cards. The
newly enabled HI-RXPOWER and LO-RXPOWER alarms require that you initialize a site-accepted
optical power (OPRO) nominal value after the upgrade. (To do this, refer to the procedure in the “Turn
Up a Node” chapter in the Cisco ONS 15454 Procedure Guide.) When you apply the value change, CTC
uses the new OPRO value to calculate PM percentage values. If you do not change the nominal value, the
HI-RXPOWER or LO-RXPOWER may be raised in response to the unmodified setting.

Clear the HI-RXPOWER Alarm

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Find out whether gain (the amplification power) of any amplifiers has been changed. This change also
causes channel power to need adjustment.

Find out whether channels have been dropped from the fiber. Increasing or decreasing channels can
affect power. If channels have been dropped, the power levels of all channels have to be adjusted.

a~

Note  If the card is part of an amplified DWDM system, dropping channels on the fiber affects the
transmission power of each channel more than it would in an unamplified system.

At the transmit end of the errored circuit, decrease the transmit power level within safe limits.

If neither of these problems cause the HI-RXPOWER alarm, there is a slight possibility that another
wavelength is drifting on top of the alarmed signal. In this case, the receiver gets signals from two
transmitters at the same time and data alarms would be present. If wavelengths are drifting, the data is
garbled and receive power increases by about +3 dBm.

If the alarm does not clear, add fiber attenuators to the receive ports. Start with low-resistance attenuators
and use stronger ones as needed, depending on factors such as the transmission distance, according to
standard practice.

If the alarm does not clear and no faults are present on the other port(s) of the transmit or receive card,
use a known-good loopback cable to complete the “Perform a Facility (Line) Loopback on a
Source-Node MXP/TXP/FC_MR-4 Port” procedure on page 1-90 and test the loopback.

If a port is bad and you need to use all the port bandwidth, complete the “Physically Replace a Traffic
Card” procedure on page 2-242. If the port is bad but you can move the traffic to another port, replace
the card at the next available maintenance window.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.148 HITEMP

Default Severity: Critical (CR), Service-Affecting (SA) for NE; Default Severity: Minor (MN),
Non-Service-Affecting (NSA) for EQPT

SONET Logical Objects: EQPT, NE

The High Temperature alarm occurs when the temperature of the ONS 15454 is above 122 degrees F
(50 degrees C).
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Clear the HITEMP Alarm

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-2).

Figure 2-2 Shelf LCD Panel
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Verify that the environmental temperature of the room is not abnormally high.

If the room temperature is not abnormal, physically ensure that nothing prevents the fan-tray assembly
from passing air through the ONS 15454 shelf.

If airflow is not blocked, physically ensure that blank faceplates fill the ONS 15454 shelf empty slots.
Blank faceplates help airflow.

If faceplates fill the empty slots, determine whether the air filter needs replacement. Refer to the
“Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-247.

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-249.

“~

Note  The fan should run immediately when correctly inserted.

If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1 800 553-2447) if it applies to the NE, or a

Non-Service-Affecting (NSA) problem if it applies to equipment.

2.8.149 HI-TXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM, TRUNK

The Equipment High Transmit Power alarm is an indicator on the TXP_MR_E, TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, or OC192-XFP card transmitted optical signal
power. HI-TXPOWER occurs when the measured optical power of the transmitted signal exceeds the
threshold.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter.
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Clear the HI-TXPOWER Alarm

Step 1

Step 2
Step 3
Step 4

Step 5

In node view, double-click the card view for the TXP_MR_10E, TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_2.5G_10G, or OC192-XFP card.

Click the Provisioning > Optics Thresholds > Current Values tabs.
Decrease (change toward the negative direction) the OPT-HIGH column value by 0.5 dBm.

If the card transmit power setting cannot be lowered without disrupting the signal, complete the
“Physically Replace a Traffic Card” section on page 2-242.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.150 HLDOVRSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Holdover Synchronization Mode condition is caused by loss of the primary and second timing
references in the node. Timing reference loss occurs when line coding on the timing input is different
from the configuration on the node, and it often occurs during the selection of a new node reference
clock. The condition clears when primary or second timing is reestablished. After the 24-hour holdover
period expires, timing slips could begin to occur on an ONS 15454 relying on an internal clock.

Clear the HLDOVRSYNC Condition

Step 1

Clear additional alarms that relate to timing, such as:
e 2.8.127 FRNGSYNC, page 2-105
e 2.8.128 FSTSYNC, page 2-105
e 2.8.175 LOF (BITS), page 2-131
e 2.8.190 LOS (BITS), page 2-140
e 2.8.236 MANSWTOINT, page 2-161
e 2.8.237 MANSWTOPRI, page 2-161
e 2.8.2383 MANSWTOSEC, page 2-161
e 2.8.239 MANSWTOTHIRD, page 2-162
e 2.8.354 SWTOPRI, page 2-209
e 2.8.355 SWTOSEC, page 2-210
e 2.8.356 SWTOTHIRD, page 2-210
e 2.8.357 SYNC-FREQ, page 2-210
e 2.8.359 SYNCPRI, page 2-212
e 2.8.360 SYNCSEC, page 2-212
e 2.8.361 SYNCTHIRD, page 2-213
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Step2  Reestablish a primary and secondary timing source according to local site practice. If none exists, refer
to the “Change Node Settings” chapter in the Cisco ONS 15454 Procedure Guide.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a Service-Affecting (SA) problem.

2.8.151 I-HITEMP

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: NE

The Industrial High Temperature alarm occurs when the temperature of the ONS 15454 is above 149
degrees F (65 degrees C) or below —40 degrees F (—40 degrees C). This alarm is similar to the HITEMP
alarm but is used for the industrial environment. If this alarm is used, you can customize your alarm
profile to ignore the lower-temperature HITEMP alarm.

Clear the I-HITEMP Alarm

Step 1 Complete the “Clear the HITEMP Alarm” procedure on page 2-115.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.8.152 IMPROPRMVL

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT
DWDM Logical Object: PPM
The Improper Removal equipment IMPROPRMVL) alarm occurs under the following conditions:

e A card is removed when the card was rebooting. It is recommended that after the card completely
reboots, delete the card in CTC and only then remove the card physically. When you delete the card,
CTC loses connection with the node view (single-shelf mode) or shelf view (multishelf mode), and
goes to network view.

e When a card is physically removed from its slot before it is deleted from CTC. It is recommended
that any card be deleted in CTC before physically removing the card from the chassis.

~

Note  CTC provides the user approximately 15 seconds to physically remove the card before it begins
rebooting the card.
It can take up to 30 minutes for software to be updated on a standby TCC2/TCC2P card.

e A card is inserted into a slot but is not fully plugged into the backplane.
e A PPM (SFP) is provisioned but the physical module is not inserted into the port.
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e FElectrical issues such as short circuit or failure of DC-DC conversion.

An IMPROPRMVL alarm can also occur if a card is failing because of a shorted circuit or an electrical
component failure. This kind of failure can only be resolved by card replacement. In an MSTP network,
such an electrical failure (on an amplifier, multiplexer, demultiplexer, or 32WSS card) and the resulting
IMRPROPRMVL alarm can be the root cause of many subsequent circuit alarms. If an alarm storm
occurs on an MSTP network, finding an IMPROPRMVL equipment alarm within the generated alarms
is a good indicator for troubleshooting purposes.

Clear the IMPROPRMVL Alarm

Step 1
Step 2

Step 3

A

In node view, right-click the card reporting the IMPROPRMVL.

Choose Delete from the shortcut menu.

S

Note

CTC does not allow you to delete the reporting card if the card is in service, does have circuits
mapped to it, is paired in a working protection scheme, has DCC enabled, or is used as a timing
reference.

If any ports on the card are in service, place them out of service (OOS,MT):

Caution

Step 4

Before placing a port out of service (OOS,MT or OOS,DSBLD), ensure that no live traffic is present.

a. In node view, double-click the reporting card to open the card view.
b. Click the Provisioning > Line tab.

c. Click the Admin State column of any in-service (IS) ports.

d. Choose OOS,MT to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-244.

Caution

Step 5

Step 6

Step 7

Before deleting the circuit, ensure that the circuit does not carry live traffic.

If the card is paired in a protection scheme, delete the protection group:

a. Click View > Go to Previous View to return to node view.

b. If you are already in node view, click the Provisioning > Protection tabs.
c. Click the protection group of the reporting card.

d. Click Delete.

If the card is provisioned for DCC, delete the DCC provisioning:

a. Click the ONS 15454 Provisioning > Comm Channels > SDCC tabs.
b. Click the slots and ports listed in DCC terminations.

c. Click Delete and click Yes in the dialog box that appears.

If the card is used as a timing reference, change the timing reference:

a. Click the Provisioning > Timing > General tabs.

b. Under NE Reference, click the drop-down arrow for Ref-1.
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Step 8

Step 9

Step 10

Step 11

28153 INC-1IsSD H

c. Change Ref-1 from the listed OC-N card to Internal Clock.
d. Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem. If the TAC technician tells you to, complete the following procedures:

Under TAC’s supervision, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242.

If the alarm does not clear, under TAC’s supervision complete the “Physically Replace a Traffic Card”
procedure on page 2-242.

With TAC’s direction, determine whether to RMA the faulty card.

2.8.153 INC-ISD

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The DS-3 Idle condition indicates that the DS-3 card is receiving an idle signal, meaning that the payload
of the signal contains a repeating pattern of bits. The INC-ISD condition occurs when the transmitting
port has an OOS-MA,MT service state. It is resolved when the OOS-MA,MT state ends.

INC-ISD is a condition and not an alarm. It is for information only and does not require troubleshooting.

2.8.154 INHSWPR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Inhibit Switch To Protect Request on Equipment condition occurs on traffic cards when the ability
to switch to protect has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the working system. If the card is part of a 1:N protection scheme, traffic can be
switched between working cards when the switch to protect is disabled.

Clear the INHSWPR Condition

Step1  If the condition is raised against a 1+1 port, complete the “Initiate a 1+1 Manual Switch Command”
section on page 2-232.

Step2  If the condition is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command”
procedure on page 2-234 to switch it back.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

Cisco ONS 15454 Troubleshooting Guide, R6.0
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2.8.155 INHSWWKG

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Inhibit Switch To Working Request on Equipment condition occurs on traffic cards when the ability
to switch to working has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the protect system. If the card is part of a 1:N protection scheme, traffic can be
switched between protect cards when the switch to working is disabled.

Clear the INHSWWHKG Condition

Step 1

Step 2

Step 3

If the condition is raised against a 1+1 port, complete the “Initiate a 14+1 Manual Switch Command”
section on page 2-232.

If it is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on
page 2-234 to switch traffic back.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.156 INTRUSION-PSWD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Security Intrusion Incorrect Password condition occurs after a user attempts a provisionable (by
Superuser) number of unsuccessful logins, a login with an expired password, or an invalid password. The
alarmed user is locked out of the system, and INTRUSION-PSWD condition is raised. This condition is
only shown in Superuser login sessions, not in login sessions for lower-level users. The
INTRUSION-PSWD condition is automatically cleared when a provisionable lockout timeout expires,
or it can be manually cleared in CTC by the Superuser if the lockout is permanent.

Clear the INTRUSION-PSWD Condition

Step 1
Step 2
Step 3

Click the Provisioning > Security > Users tabs.
Click Clear Security Intrusion Alarm.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.157 INVMACADR

Default Severity: Major (MJ), Non-Service Affecting (NSA)
SONET Logical Object: AIP
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The Equipment Failure Invalid MAC Address alarm occurs when the ONS 15454 MAC address is
invalid. Each ONS 15454 has a unique, permanently assigned MAC address. The address resides on an
AIP EEPROM. The TCC2/TCC2P reads the address value from the AIP chip during boot-up and keeps
this value in its synchronous dynamic RAM (SDRAM).

Under normal circumstances, the read-only MAC address can be viewed in the Provisioning/Network
tab in CTC.

The ONS 15454 uses both IP and MAC addresses for circuit routing. When an INVMACADR alarm
exists on a node, you see a PARTIAL circuit in the CTC circuit status column. The circuit works and is
able to carry traffic, but CTC cannot logically display the circuit end-to-end information.

An invalid MAC address can be caused when:

e There is a read error from the AIP during bootup; in this case, the reading TCC2/TCC2P uses the
default MAC address (00-10-cf-ff-ff-ff).

e There is a read error occurring on one of the redundant TCC2/TCC2Ps that read the address from
the AIP; these cards read the address independently and could therefore each read different address
values.

e An AIP component failure causes a read error.

e The ribbon cable connecting the AIP card to the backplane is bad.

Clear the INVMACADR Alarm

Step1  Check for any outstanding alarms that were raised against the active and standby TCC2/TCC2P and
resolve them.
Step2  If the alarm does not clear, determine whether the LCD display on the fan tray (Figure 2-2 on
page 2-115) is blank or if the text is garbled. If so, proceed to Step 8. If not, continue with Step 3.
Step 3 At the earliest maintenance window, reset the standby TCC2/TCC2P:
>
Note  The reset requires approximately five minutes. Do not perform any other step until the reset is
complete.
a. Log into a node on the network. If you are already logged in, continue with Step b.
b. Identify the active TCC2/TCC2P.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
c. Right-click the standby TCC2/TCC2P in CTC.
d. Choose Reset Card from the shortcut menu.
e. Click Yes in the Are You Sure dialog box.
The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.
f. Verify that the reset is complete and error-free, and that no new related alarms appear in CTC. A
green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
g. Double-click the node and ensure that the reset TCC2/TCC2P is still in standby mode and that the
other TCC2/TCC2P is active.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
h. Ensure that no new alarms associated with this reset appear in the CTC Alarms window.
| November 2009
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Step 4

Step 5
Step 6

Step 7

Step 8

Step 9
Step 10
Step 11

If the standby TCC2/TCC2P fails to boot into standby mode and reloads continuously, the AIP is
probably defective. In this case, the standby TCC2/TCC2P is unsuccessfully attempting to read the
EEPROM located on the AIP. The TCC2/TCC2P reloads until it reads the EEPROM. Proceed to Step 8.

If the standby TCC2/TCC2P rebooted successfully into standby mode, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241.

Resetting the active TCC2/TCC2P causes the standby TCC2/TCC2P to become active. The standby
TCC2/TCC2P keeps a copy of the chassis MAC address. If its stored MAC address is valid, the alarm
should clear.

After the reset, note whether or not the INVMACADR alarm has cleared or is still present.

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-239 again to place the standby TCC2/TCC2P back into active mode.

After the reset, note whether or not the INVMACADR alarm has cleared or is still present. If the
INVMACADR alarm remains standing through both TCC2/TCC2P resets, this indicates that the AIP is
probably defective. Proceed to Step 8.

If the INVMACADR was raised during one TCC2/TCC2P reset and cleared during the other, the
TCC2/TCC2P that was active while the alarm was raised needs to be replaced. Continue with Step 7.

If the faulty TCC2/TCC2P is currently in standby mode, complete the “Physically Replace a Traffic
Card” procedure on page 2-242 for this card. If the faulty TCC2/TCC2P is currently active, during the
next available maintenance window complete the “Reset an Active TCC2/TCC2P Card and Activate the
Standby Card” procedure on page 2-239 and then complete the “Physically Replace a Traffic Card”
procedure on page 2-242.

)

Note  If the replacement TCC2/TCC2P is loaded with a different software version from the current
TCC2/TCC2P, the card bootup could take up to 30 minutes. During this time, the card LEDs
flicker between Fail and Act/Sby as the active TCC2/TCC2P version software is copied to the
new standby card.

Open a case with Cisco TAC (1 800 553-2447) for assistance with determining the node’s previous MAC
address.

Replace the ribbon cable between the system board and the AIP with a known-good cable.
If the alarm persists, complete the “Replace the Alarm Interface Panel” procedure on page 2-250.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.158 10SCFGCOPY

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The IOS Configuration Copy in Progress condition occurs on ML-Series Ethernet cards when a
Cisco IOS startup configuration file is being uploaded or downloaded to or from an ML-Series card.
(This condition is very similar to the “SFTWDOWN?” condition on page 2-197 but it applies to
ML-Series Ethernet cards rather than to the TCC2/TCC2P.)

The condition clears after the copy operation is complete. (If it does not complete correctly, the
“NO-CONFIG” condition on page 2-169 could be raised.)
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IOSCFGCOPY is an informational condition.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

2.8.159 ISIS-ADJ-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Open System Interconnection (OSI) Intermediate System to Intermediate-System (IS-IS) Adjacency
Failure alarm is raised by an intermediate system (node routing IS Level 1 or Level 1 and 2) when no IS
or end system (ES) adjacency is established on a point-to-point subnet. The Intermediate-System
Adjacency Failure alarm is not supported by ES. It is also not raised by IS for disabled routers.

The alarm is typically caused by a misconfigured router manual area adjacency (MAA) address. For
more information about IS-IS OSI routing and MAA configuration, refer to the “Management Network
Connectivity” chapter in the Cisco ONS 15454 Reference Manual. For more information about
configuring OSI, refer to the “Turn Up Node” chapter in the Cisco ONS 15454 Procedure Guide.

Clear the ISIS-ADJ-FAIL Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Ensure that both ends of the communication channel are using the correct Layer 2 protocol and settings
(LAPD or PPP). To do this, complete the following steps:

a. At the local node, in node view, click the Provisioning > Comm Channels > SDCC tabs.
b. Click the row of the circuit. Click Edit.

c¢. Inthe Edit SDCC termination dialog box, view and record the following selections: Layer 2 protocol
(LAPD or PPP); Mode radio button selection (AITS or UITS); Role radio button selection (Network
or User); MTU value; T200 value, and T203 selections.

d. Click Cancel.

e. Login to the remote node and follow the same steps, also recording the same information for this
node.

If both nodes do not use the same Layer 2 settings, you will have to delete the incorrect termination and
recreate it. To delete it, click the termination and click Delete. To recreate it, refer to the “Turn Up Node”
chapter in the Cisco ONS 15454 Procedure Guide for the procedure.

If the nodes use PPP Layer 2, complete the “Clear the EOC Alarm” procedure on page 2-75. If the alarm
does not clear, go to Step 7.

If both nodes use the LAPD Layer 2 protocol but have different Mode settings, change the incorrect
node’s entry by clicking the correct setting radio button in the Edit SDCC termination dialog box and
clicking OK.

If the Layer 2 protocol and Mode settings are correct, ensure that one node is using the Network role and
the other has the User role. If not (that is, if both have the same mode settings), correct the incorrect one
by clicking the correct radio button in the Edit SDCC termination dialog box and clicking OK.
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Step6  If the Layer 2, Mode, and Role settings are correct, compare the MTU settings for each node. If one is
incorrect, choose the correct value in the Edit SDCC dialog box and click OK.

Step7  If all of the preceding settings are correct, ensure that OSI routers are enabled for the communications
channels at both ends:

a. Click Provisioning > OSI > Routers > Setup tabs.

b. View the router entry under the Status column. If the status is Enabled, check the other end.
c. If the Status is Disabled, click the router entry and click Edit.

d. Check the Enabled check box and click OK.

Step 8 If the routers on both ends are enabled and the alarm still has not cleared, ensure that both ends of the
communications channel have a common MAA:

a. Click the Provisioning > OSI > Routers > Setup tabs.

b. Record the primary MAA and secondary MAAs, if configured.

ﬁ You can record long strings of information such as the MAA address by using the CTC export and print
functions. Export it by choosing File > Export > html. Print it by choosing File > Print.

c. Log into the other node and record the primary MAA and secondary MAAs, if configured.

d. Compare this information. There should be at least one common primary or secondary MAA in
order to establish an adjacency.

e. If there is no common MAA, one must be added to establish an adjacency. Refer to the “Turn Up
Node” chapter in the Cisco ONS 15454 Procedure Guide for procedures.

Step9  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.160 KB-PASSTHR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The K Bytes Pass Through Active condition occurs on a nonswitching node in a BLSR when the protect
channels on the node are not active and the node is in K Byte pass-through state. It also occurs when a
BLSR ring is being exercised using the Exercise Ring command.

Clear the KB-PASSTHR Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.8.161 KBYTE-APS-CHANNEL-FAILURE

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: OCN

The APS Channel Failure alarm is raised when a span is provisioned for different APS channels on each
side. For example, the alarm is raised if K3 is selected on one end and F1, E2, or Z2 is selected on the
other end.

This alarm is also raised during checksum failure if the K1 and K2 bytes are overwritten by test
equipment. It is not raised in bidirectional full pass-through or K-byte pass-through states. The alarm is
overridden by the “AIS-P” alarm on page 2-33, the “LOF (OCN)” alarm on page 2-134, the “LOS
(OCN)” alarm on page 2-147 or the “SF-P” alarm on page 2-196.

Clear the KBYTE-APS-CHANNEL-FAILURE Alarm

Step 1

Step 2

Step 3

Step 4

The alarm is most frequently raised due to mismatched span provisioning. In this case, reprovision one
side of the span with the same parameters. To do this, refer to the “Turn Up Network” chapter in the
Cisco ONS 15454 Procedure Guide.

If the error is not caused by misprovisioning, it is due to checksum errors within an OC-N, cross-connect,
or TCC2/TCC2P. In this case, complete the “Side Switch the Active and Standby Cross-Connect Cards”
procedure on page 2-240 to allow CTC to resolve the issue.

If third-party equipment is involved, ensure that it is configured for the same APS channel as the
Cisco ONS equipment.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.162 LAN-POL-REV

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The LAN Connection Polarity Reversed condition is not raised in shelves that contain TCC2 cards. It is
raised during a software upgrade when the card detects that a connected Ethernet cable has reversed
receive wire pairs. The card automatically compensates for this reversal, but LAN-POL-REV stays
active.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LAN-POL-REV Condition

Step1  Replace the connected Ethernet cable with a cable that has the correct pinout. For correct pin mapping,
refer to the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.
Cisco ONS 15454 Troubleshooting Guide, R6.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

I 238163 LASER-APR

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.163 LASER-APR

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.164 LASERBIAS-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.165 LASERBIAS-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.166 LASEREOL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Laser Approaching End of Life alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_10E, and MXP_2.5G_10G cards. It is typically accompanied by the “HI-LASERBIAS” alarm
on page 2-112. It is an indicator that the laser in the card must be replaced. How soon the replacement
must happen depends upon the HI-LASERBIAS threshold. If the threshold is set under 100 percent, the
laser replacement can usually be done during a maintenance window. But if the HI-LASERBIAS
threshold is set at 100 percent and is accompanied by data errors, the card must be replaced sooner.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.

Clear the LASEREOL Alarm

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-242.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |



| Chapter2 Alarm Troubleshooting

2.8.167 LASERTEMP-DEG W

2.8.167 LASERTEMP-DEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.168 LCAS-CRC

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The Link Capacity Adjustment Scheme (LCAS) Control Word CRC Failure condition is raised against
ML-Series Ethernet cards and CE-series cards. It occurs when there is an equipment, path, or
provisioning error on the virtual concatenation group (VCG) that causes consecutive 2.5 second CRC
failures in the LCAS control word.

Transmission errors would be reflected in CV-P, ES-P, or SES-P performance monitoring statistics. If
these errors do not exist, an equipment failure is indicated.

If LCAS is not supported on the peer node, the condition does not clear.

LCAS-CRC can also occur if the VCG source node is not LCAS-enabled, but the receiving node does
have the capability enabled. Both source and destination nodes must have LCAS enabled. Otherwise, the
LCAS-CRC condition persists on the VCG.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LCAS-CRC Condition

Step 1

Step 2
Step 3

Step 4

Step 5

Look for and clear any associated equipment failures, such as the EQPT alarm, on the receive node or
transmit node.

Look for and clear any bit error rate alarms at the transmit node.

If no equipment or SONET path errors exist, ensure that the remote node has LCAS enabled on the
circuit:

a. In node view, click the Circuits tab.

b. Choose the VCAT circuit and click Edit.

c. In the Edit Circuit window, click the General tab.
d. Verify that the Mode column says LCAS.

If the column does not say LCAS, complete the “Delete a Circuit” procedure on page 2-244 and recreate
it in LCAS mode using the instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.8.169 LCAS-

RX-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The LCAS VCG Member Receive-Side-In Fail condition is raised against CE-series cards, FC_MR-4
cards and ML-Series Ethernet cards with LCAS-enabled VCG.

LCAS VCGs treat failures unidirectionally, meaning that failures of the transmit or receive points occur
independently of each other. The LCAS-RX-FAIL condition can occur on the receive side of an LCAS
VCG member for the following reasons:

¢ SONET path failure (a unidirectional failure as seen by the receive side)
e VCAT member is set out of group at the transmit side, but is set in group at the receive side
e VCAT member does not exist at the transmit side but does exist and is in group at the receive side

The condition can be raised during provisioning operations on LCAS VCGs but should clear when the
provisioning is completed.

Software-enabled LCAS VCGs treat failure bidirectionally, meaning that both directions of a VCG
member are considered failed if either transmit or receive fails. The LCAS-RX-FAIL condition is raised
on these VCG members when a member receive side fails due to a SONET path failure.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

ML-Series cards are LCAS-enabled. ML-Series and FC_MR-4 cards are SW-LCAS enabled.

Clear the LCAS-RX-FAIL Condition

Step 1
Step 2

Check for and clear any line or path alarms.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.170 LCAS-TX-ADD

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The LCAS VCG Member Transmit-Side-In Add State condition is raised against ML-Series Ethernet
cards and CE-series cards when the transmit side of an LCAS VCG member is in the add state. The
condition clears after provisioning is completed. The remote likely reports a path condition such as the
“AIS-P” condition on page 2-33 or the “UNEQ-P” alarm on page 2-223.

LCAS-TX-ADD is an informational condition and does not require troubleshooting.
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~

m For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

2.8.171 LCAS-TX-DNU

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VI-TERM

The LCAS VCG Member Transmit-Side-In Do Not Use condition is raised on FC_MR-4 cards,
ML-Series Ethernet cards, and CE-series cards when the transmit side of an LCAS VCG member is in
the do-not use state. For a unidirectional failure, this condition is only raised at the source node. The
LCAS-TX-DNU condition is raised when the cable is unplugged.

The node reporting this condition likely reports an “RFI-P” alarm on page 2-184, and the remote node
likely reports a path alarm such as the “AIS-P” alarm on page 2-33 or the “UNEQ-P” alarm on
page 2-223.

Note LCAS-TX-DNU is an informational condition and does not require troubleshooting.

Note For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

2.8.172 LKOUTPR-S

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Lockout of Protection Span condition occurs when span traffic is locked out of a protect span using
the Lockout of Protect command. This condition is visible on the network view Alarms, Conditions, and
History tabs after the lockout has occurred and accompanies the FE-LOCKOUTPR-SPAN condition.
The port where the lockout originated is marked by an “L” on the network view detailed circuit map.

Clear the LKOUTPR-S Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.173 LOA

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: VCG
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The Loss of Alignment on a VCG is a VCAT member alarm. (VCAT member circuits are independent
circuits that are concatenated from different time slots into a higher-rate signal.) The alarm occurs when
members of a VCG travel over different paths in the network (due to initial operator provisioning or to
protection or restoration events) and the differential delays between the paths cannot be recovered by
terminating hardware buffers.

S

Note  This alarm occurs only if you provision circuits outside of CTC, such as by using TL1.

Clear the LOA Alarm

Step 1 In network view, click the Circuits tab.
Step2  Click the alarmed VCG and then click Edit.
Step 3 In the Edit Circuit window, view the source and destination circuit slots, ports, and STSs.

Stepd  Identify whether the STS travels across different fibers. If it does, complete the “Delete a Circuit”
procedure on page 2-244.

Step5  Recreate the circuit using the procedure in the “Create Circuits and VT Tunnels” chapter in the
Cisco ONS 15454 Procedure Guide.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.174 LOCKOUT-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN, STSMON, VT-MON
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Lockout Switch Request on Facility or Equipment condition occurs when a user initiates a lockout
switch request for an OC-N port in a 1+1 facility protection group. This can be accomplished by locking
traffic onto the working port with the LOCK ON command (thus locking it off the protect port), or
locking it off the protect port with the LOCK OUT command. In either case, the protect port will show
“Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ condition.

A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.

Clear the LOCKOUT-REQ Condition

Step 1 Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-233.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

Cisco ONS 15454 Troubleshooting Guide, R6.0
m. November 2009 |



| Chapter2 Alarm Troubleshooting

2.8.175 LOF (BITS) W

2.8.175 LOF (BITS)

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The Loss of Frame (LOF) BITS alarm occurs when a port on theTCC2/TCC2P BITS input detects an
LOF on the incoming BITS timing reference signal. LOF indicates that the receiving ONS 15454 has
lost frame delineation in the incoming data.

The procedure assumes that the BITS timing reference signal is functioning properly. It also assumes the
alarm is not appearing during node turn-up.

Clear the LOF (BITS) Alarm

Step 1

Step 2

Step 3

Verify that the line framing and line coding match between the BITS input and the TCC2/TCC2P:
a. Innode or card view, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the external BITS timing source. The formats should be in
the user documentation for the external BITS timing source or on the timing source itself.

c. Click the Provisioning > Timing > BITS Facilities tabs.
d. Verify that the Coding setting matches the coding of the BITS timing source, either BS§ZS or AMI.

e. If the coding does not match, click Coding and choose the appropriate coding from the drop-down
list.

f. Verify that Framing matches the framing of the BITS timing source, either ESF or SF (D4).

g. If the framing does not match, click Framing and choose the appropriate framing from the
drop-down list.

~

Note  On the timing subtab, the B8ZS coding field is normally paired with ESF in the Framing
field and the AMI coding field is normally paired with SF (D4) in the Framing field.

If the alarm does not clear when the line framing and line coding match between the BITS input and the
TCC2/TCC2P, complete the “Physically Replace a Traffic Card” procedure on page 2-242 for the
TCC2/TCC2P.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.176 LOF (DS1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: DS1

The DS-1 LOF alarm indicates that the receiving ONS 15454 has lost frame delineation in an incoming
DS-1 data stream.
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Clear the LOF (DS1) Alarm

Step1  Verify that the line framing and line coding match between the DS1 port and the signal source:

a.

b.

In CTC, note the slot and port reporting the alarm.

Find the coding and framing formats of the signal source for the card reporting the alarm. You could
need to contact your network administrator for the format information.

Display the card view of the reporting card.
Click the Provisioning > Line tabs.

Verify that the line type of the reporting port matches the line type of the signal source (DS4 and
DS4, unframed and unframed, or ESF and ESF). If the signal source line type does not match the
reporting port, click the Line Type cell to reveal a drop-down list and choose the matching type.

Verify that the reporting Line Coding matches the signal source line coding (AMI and AMI or B8ZS
and B8ZS). If the signal source line coding does not match the reporting port, click the Line Coding
cell and choose the correct type from the drop-down list.

Click Apply.

~

Note  On the Line tab, the B8ZS coding field is normally paired with ESF in the Framing field.
AMI coding is normally paired with SF (D4) in the Framing field.

)

Note When you replace a card with the identical type of card, you do not need to make any
changes to the database.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.177 LOF (DS3)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: DS3

The DS-3 LOF alarm indicates that the receiving ONS 15454 has lost frame delineation in the incoming
DS-3 data stream on DS3XM-6, DS3XM-12, or add DS3/EC1-48 cards. The framing of the transmitting
equipment could be set to a format that differs from the receiving system. On DS3XM-6 cards, the alarm
occurs only on cards with the provisionable framing format set to C Bit or M13 and not on cards with
the provisionable framing format is set to unframed.

Clear the LOF (DS3) Alarm

Step 1 Change the line type of the non-ONS equipment attached to the reporting card to C Bit:

b.

Display the card view of the reporting card.

Click the Provisioning > Line tabs.
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Verify that the line type of the reporting port matches the line type of the signal source.

If the signal source line type does not match the reporting port, click Line Type and choose C Bit
from the drop-down list.

Click Apply.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.178 LOF (E1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: El

The E1 LOF alarm appears on the DS1/E1-56 card when the card is placed in All E1 mode. It indicates
that the receiving ONS 15454 has lost frame delineation in an incoming E1 data stream. The transmitting
equipment could possibly have its framing set to a format that differs from the receiving node. For more
information about the DS1/E1-56 card, refer to the “Electrical Cards” chapter in the Cisco ONS 15454
Reference Manual.

~

Note  The DS1/E1-56 card only carries an E1 signal within an STS-3¢/VT?2 circuit.

Clear the LOF (E1) Alarm

Step1  Verify that the line framing and line coding match between the DS1/E1-56 port and the signal source:

a.

b.

In CTC, note the slot and port reporting the alarm.

Find the coding and framing formats of the signal source for the card reporting the alarm. You could
need to contact your network administrator for this information.

Double-click the DS1/E1-56 card to open the card view.
Click the Provisioning > Line tabs.

Verify that the line type of the reporting port matches the line type (E1_MF, E1_CRCMF,
AUTOFRAMED, UNFRAMED) of the signal source. If the signal source line type does not match
the reporting port, click the Line Type cell to reveal a drop-down list and choose the matching type.

Verify that the reporting Line Coding matches the signal source line coding. If the signal source line
coding does not match the reporting port, click the Line Coding cell and choose the correct type
from the drop-down list.

Click Apply.

~

Note When you replace a card with the identical type of card, you do not need to make any
changes to the database.
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Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.179 LOF (EC1)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EC1

The EC1/EC1-12 LOF alarm occurs when a port on the reporting EC1/EC1-12 or DS3/EC1-48 card has
an LOF condition. LOF indicates that the receiving ONS 15454 has lost frame delineation in the
incoming data. LOF occurs when the SONET overhead loses a valid framing pattern for 3 milliseconds.
Receiving two consecutive valid A1/A2 framing patterns clears the alarm.

Clear the LOF (EC1) Alarm

Step 1 Verify cabling continuity to the port reporting the alarm. To verify cable continuity, follow site practices.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If cabling continuity is good, clean the fiber according to site practice. If no site practice exists, complete
the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step3  If the alarm does not clear, see the loopback procedures in Chapter 1, “General Troubleshooting” to
isolate the fault causing the LOF alarm.

Step4  If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem (1 800 553-2447).

2.8.180 LOF (OCN)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN

The LOF alarm occurs when a port on the reporting card has an LOF condition. It can also occur on
ONS 15454 MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G,TXP_MR_10E, or TXPP_MR_2.5G
cards reporting LOF. The alarm indicates that the receiving ONS 15454 has lost frame delineation in the
incoming data. LOF occurs when the SONET overhead loses a valid framing pattern for 3 milliseconds.
Receiving two consecutive valid A1/A2 framing patterns clears the alarm.

When the alarm is raised on an OC-N card, it is sometimes an indication that the OC-N card expects a
specific line rate and the input line rate source does not match the input line rate of the optical receiver.

Note For information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.
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Clear the LOF (OCN) Alarm

Step1  Verify cabling continuity to the port reporting the alarm.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To
verify cable continuity, follow site practices.

Step2  If cabling continuity is good, clean the fiber according to site practice. If no site practice exists, complete
the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Step3  If the alarm does not clear, see the loopback procedures in Chapter 1, “General Troubleshooting” to
isolate the fault causing the LOF alarm.

Step4  If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem (1 800 553-2447).

2.8.181 LOF (STSTRM)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: STSTRM

A Loss of Frame alarm for an STS circuit termination indicates that the LOF has occurred at the
terminating point of the circuit (such as an OC-N port). It is similar to the “LOF (OCN)” alarm on
page 2-134.

Clear the LOF (STSTRM) Alarm

Step 1 Complete the “Clear the LOF (OCN) Alarm” alarm on page 2-135.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.182 LOF (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.183 LO-LASERBIAS

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Object: PPM
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The Equipment Low Transmit Laser Bias Current alarm is raised against the TXP and MXP card laser
performance. The alarm indicates that the card laser has reached the minimum laser bias tolerance.

If the LO-LASERBIAS alarm threshold is set at O percent (the default), the laser's usability has ended.
If the threshold is set at 5 percent to10 percent, the card is still usable for several weeks or months before
you need to replace it.

Note  For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter.

Clear the LO-LASERBIAS Alarm

Step1  Complete the “Physically Replace a Traffic Card” procedure on page 2-242.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.184 LO-LASERTEMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Object: PPM

The Equipment Low Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards.
LO-LASERTEMP occurs when the internally measured transceiver temperature falls below the card
setting by35.6 degrees F or 2 degrees C. A laser temperature change affects the transmitted wavelength.
(Two degrees Celsius is equivalent to about 200 picometers in the wavelength.)

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The “LOS (OCN)”
alarm on page 2-147 is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-71 is raised
at the near end. To verify the card laser temperature level, double-click the card in node view and click
the Performance > Optics PM > Current Values tabs. Maximum, minimum, and average laser
temperatures are shown in the Current column entries in the Laser Temp rows.

Note  For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter.

Clear the LO-LASERTEMP Alarm

Step1  Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting MXP or TXP
card.

Step2  If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting MXP or TXP card.
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If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

Default Severity: Critical (CR), Service-Affecting (SA) for STSMON, TRUNK; Major (MJ) for
STSTRM, VT-TERM

SONET Logical Objects: STSMON, STSTRM, VI-TERM
DWDM Logical Object: TRUNK

The Optical Transport Unit (OTU) Loss of Multiframe is a VCAT member alarm. (VCAT member
circuits are independent circuits that are concatenated from different time slots into a higher-rate signal.)
The alarm applies to MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, or
TXPP_MR_2.5G cards when the Multi Frame Alignment Signal (MFAS) overhead field is errored for
more than five frames and persists for more than 3 milliseconds.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.
Clear the LOM Alarm
Step 1 Complete the “Clear the SD-L Condition” procedure on page 2-193.
Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

2.8.186 LOP-P

for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: STSMON, STSTRM

A Loss of Pointer Path alarm indicates that the SONET path pointer in the overhead has been lost. LOP
occurs when valid H1/H2 pointer bytes are missing from the overhead. Receiving equipment monitors
the H1/H2 pointer bytes to locate the SONET payload. An LOP-P alarm occurs when eight, nine, or ten
consecutive frames do not have valid pointer values. The alarm clears when three consecutive valid
pointers are received.

The LOP-P alarm can occur when the received payload does not match the provisioned payload. The
alarm is caused by a circuit type mismatch on the concatenation facility. For example, if an STS-1 is sent
across a circuit provisioned for STS-3c, an LOP-P alarm occurs.

For the FC_MR-4 card, an LOP-P is raised if a port is configured for a SONET signal but receives an
SONET signal instead. (This information is contained in the H1 byte bits 5 and 6.)
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Clear the LOP-P Alarm
A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 In node view, click the Circuits tab and view the alarmed circuit.

Step2  Verify the circuit size listed in the Size column. If the size is different from what is expected, such as an
STS3c instead of an STS1, this causes the alarm.

Step3  If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned
circuit size and the size expected by the test set can cause this alarm. For specific procedures to use the
test set equipment, consult the manufacturer. Ensure that the test set monitoring is set up for the same
size as the circuit provisioning.

Refer to the manufacturer’s instructions for test-set use.

Step4  If the error is not due to an incorrectly configured test set, the error is in the provisioned CTC circuit
size. Complete the “Delete a Circuit” procedure on page 2-244.

Step5  Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and VT Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.187 LOP-V

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: VI-MON, VI-TERM
The LOP VT alarm indicates a loss of pointer at the VT level.

The LOP-V alarm can occur when the received payload does not match the provisioned payload. LOP-V
is caused by a circuit size mismatch on the concatenation facility.

Clear the LOP-V Alarm

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-138.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.
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2.8.188 LO-RXPOWER

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Equipment Low Receive Power alarm is an indicator for TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G and OC192-XFP card received optical signal power.
LO-RXPOWER occurs when the measured optical power of the received signal falls below the threshold
value, which is user-provisionable.

For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.

When you upgrade a node to Software Release 6.0 or later, this enables received optical power PMs for
the OC3-8, OC192-SR, OC192-IR, OC192-ITU, OC-192-XFP, MRC-12, and MRC25G-4 cards. The
newly enabled HI-RXPOWER and LO-RXPOWER alarms require that you initialize a site-accepted
optical power (OPRO) nominal value after the upgrade. (To do this, refer to the procedure in the “Turn
Up a Node” chapter in the Cisco ONS 15454 Procedure Guide.) When you apply the value change, CTC
uses the new OPRO value to calculate PM percentage values. If you do not change the nominal value, the
HI-RXPOWER or LO-RXPOWER may be raised in response to the unmodified setting.

Clear the LO-RXPOWER Alarm

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

At the transmit end of the errored circuit, increase the transmit power level within safe limits.

Find out whether new channels have been added to the fiber. Up to 32 channels can be transmitted on
the same fiber, but the number of channels affects power. If channels have been added, power levels of
all channels need to be adjusted.

~

Note  If the card is part of an amplified DWDM system, adding channels on the fiber affects the
transmission power of each channel more than it would in an unamplified system.

Find out whether gain (the amplification power) of any amplifiers has been changed. Changing
amplification also causes channel power to need adjustment.

If the alarm does not clear, remove any receive fiber attenuators or replace them with lower-resistance
attenuators.

If the alarm does not clear, inspect and clean the receive and transmit node fiber connections according
to site practice. If no site practice exists, complete the procedure in the “Maintain the Node” chapter in
the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, ensure that the fiber is not broken or damaged by testing it with an optical

test set. If no test set is available, use the fiber for a facility (line) loopback on a known-good port. The
error reading you get is not as precise, but you generally know whether the fiber is faulty. For specific
procedures to use the test set equipment, consult the manufacturer.
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Step 7

Step 8

Step 9

If the alarm does not clear, and no faults are present on the other port(s) of the transmit or receive card,
do a facility loopback on the transmit and receive ports with known-good loopback cable. Complete the
“Perform a Facility (Line) Loopback on a Source-Node Optical Port” procedure on page 1-49 or the
“Perform a Facility (Line) Loopback on an Intermediate-Node Optical Port” procedure on page 1-58 to
test the loopback.

If a port is bad and you need to use all the port bandwidth, complete the “Physically Replace a Traffic
Card” procedure on page 2-242. If the port is bad but you can move the traffic to another port, replace
the card at the next available maintenance window.

If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.189 LOS (2R)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.190 LOS (BITS)

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: BITS

The LOS (BITS) alarm indicates that the TCC2/TCC2P has an LOS from the BITS timing source. The
LOS (BITS) means the BITS clock or the connection to it failed.

Clear the LOS (BITS) Alarm

A

Caution

Step 1

Step 2
Step 3

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify the wiring connection from the BITS clock pin fields on the ONS 15454 backplane to the timing
source.

If wiring is good, verify that the BITS clock is operating properly.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.191 LOS (DS1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: DS1
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A LOS (DS1) alarm for a DS-1 port occurs when the port on the card is in service but no signal is being
received. A cabling issue or a configuration issue could cause this alarm. If an upstream equipment
failure causes a transmission failure, the LOS (DS1) will likely be demoted by a card-level alarm (to the
DS1/E1-56).

Clear the LOS (DS1) Alarm

A

Caution

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that the fiber cable is properly connected and attached from the correct transmitting port to the
correct receiving port. For more information about fiber connections and terminations, refer to the
“Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Clean the cable ends using site practices or, if none exists, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 Procedure Guide.

If the alarm is raised on a DS1/E1-56 card, verify that the card is placed in the correct service mode by
completing the following steps:

a. Double-click the card to open the card view.
b. Click the Provisioning > Card tabs.
c. Verify that the Operating Mode column says All DS1 for your errored circuit.

For any other DS-1 or DS-3 card, consult site records to determine whether the port raising the alarm
has been assigned.

If the port is not currently assigned, place the port out of service using the following steps:
a. Double-click the card to open the card view.

b. For a DS-1 card, click the Maintenance > Loopback tabs. For a DS-1 line on a DS3XM-6 or
DS3XM-12 card, click the Maintenance > DS1 tabs.

¢. Under Admin State, click OOS,DSBLD.
d. Click Apply.
For any card, if the port is assigned, verify that the correct one is in service:
a. To confirm this physically, confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine this virtually, double-click the card in CTC to open the card view and complete the
following substeps:

e Click the Provisioning > Line tabs.
e Verify that the Admin State column lists the port as IS.

e If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and
choose IS. Click Apply.

Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card
as possible. For specific procedures to use the test set equipment, consult the manufacturer.

Ensure that the transmit and receive outputs from the DSx patch panel to your equipment are properly
connected. For more information about cable connections and terminations, refer to the “Install Cards
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.
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Step 9
Step 10

Step 11
Step 12
Step 13

Step 14

If there is a valid signal but the alarm does not clear, replace the electrical connector on the ONS 15454.

If a valid electrical signal is not present and the transmitting device is operational, replace the fiber cable
connecting the transmitting device to the Ethernet port. To do this, refer to the “Install Cards and
Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Repeat Steps 1 to 10 for any other port on the card that reports the LOS.
If the alarm does not clear, check for any card-level alarm that could affect this port.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.192 LOS (DS3)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: DS3

The LOS (DS3) for a DS-3 port occurs when the port on a DS3XM-6, DS3XM-12, or DS3/EC1-48 card
is in service but no signal is being received. The alarm is caused by incorrect or dirty cabling, a fiber
break, or upstream equipment failure.

If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the LOS (DS3) Alarm

Step 1
Step 2

A

Check for any upstream failures in the transmitting equipment.

Verify that the cable is properly connected from the transmitting port and attached to the correct
receiving port at the node with the LOS. For more information about fiber connections and terminations,
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Caution

Step 3

Step 4
Step 5

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clean the cable ends using site practices or, if none exists, complete the procedure in the “Maintain the
Node” chapter in the Cisco ONS 15454 Procedure Guide.

Consult site records to determine whether the port raising the alarm has been assigned.

If the port is not currently assigned, place the port out of service using the following steps:
a. Double-click the card to open the card view.

b. Click the Maintenance > DS3 tabs.

¢. Under Admin State, click OOS,DSBLD.
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Step 6

Step 7

Step 8

Step 9
Step 10

Step 11
Step 12

Step 13

28193 LOS(E1) W

d. Click Apply.
If the port is assigned, verify that the correct one is in service:
a. To confirm this physically, confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine this virtually, double-click the card in CTC to open the card view and complete the
following substeps:

e Click the Provisioning > Line tabs.
e Verify that the Admin State column lists the port as IS.

e If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and
choose IS. Click Apply.

Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card
as possible. (For specific procedures to use the test set equipment, consult the manufacturer.)

Ensure that the transmit and receive outputs from the DSx patch panel to your equipment are properly
connected. For more information about cable connections and terminations, refer to the “Install Cards
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

If there is a valid signal but the alarm does not clear, replace the electrical connector on the ONS 15454.

If the test set shows signal errors but the cabling is correctly installed and the transmitting device is
operational, the existing cabling could still be faulty. Use the test set to locate the bad cable and replace
it. To do this, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454
Procedure Guide.

Repeat Steps 1 to 10 for any other port on the card that reports the LOS.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.193 LOS (E1)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: E1l

An LOS (E1) alarm for a DS1/E1-56 card port occurs when the card is placed in All E1 mode and is in
service, but the alarmed port is not receiving a signal due to a physical or provisioning problem. The
physical causes for the alarm could be incorrectly connected or faulty cabling. The software causes could
be improperly configured card or circuit size.

For more information about the DS1/E1-56 card, refer to the “Electrical Cards” chapter in the
Cisco ONS 15454 Reference Manual.
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Clear the LOS (E1) Alarm

A

Caution

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that the cable is properly connected and attached to the correct port. For more information about
connecting cable, refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454
Procedure Guide. Also refer to site records for your specific cabling scheme.

Ensure that the transmit and receive outputs from the patch panel to your equipment are properly
connected. For more information about cable connections and terminations, refer to the “Install Cards
and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Clean the cable using your site practices. If none exists, complete the procedure in the “Maintain the
Node” chapter in the Cisco ONS 15454 Procedure Guide.

Confirm that the card is properly provisioned to carry the E1 payload:
a. Double-click the card to open the card view.
b. Click the Provisioning > Card tabs.

c. Under the Operating Mode column, you should see “All E1.” If you see “All DS1,” click the
drop-down to change it and click Apply.

Use a test set to confirm that a valid E1 signal exists on the line. Test the line as close to the receiving
card as possible. (For specific procedures to use the test set equipment, consult the manufacturer.) If the
test set shows errors, the cabling could still be faulty despite being correctly installed. Use the tester to
isolate the bad section of cable and replace it. Refer to the “Install Cards and Fiber-Optic Cable” chapter
in the Cisco ONS 15454 Procedure Guide for procedures.

Repeat Steps 1 to 5 for any other port on the card that reports the LOS (E1).
If the alarm does not clear, look for any card-level alarm that could cause this alarm.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.194 LOS (EC1)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EC1

LOS on an EC1/EC1-12 or DS3/EC1-48 port occurs when a SONET receiver detects an all-zero pattern
for 10 microseconds or longer. An LOS (EC1) most likely means that the upstream transmitter has failed.
If an EC1 LOS alarm is not accompanied by additional alarms, a cabling problem (such as an incorrect
attachment, fiber cut, or other fiber error) usually causes this alarm. The condition clears when the
problem is corrected, allowing two consecutive valid frames to be received.
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If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the LOS (EC1) Alarm

A

Caution

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Step 9
Step 10

Step 11

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Check for any upstream equipment failures that could cause the LOS (EC1) in this node.

If there is no cause upstream, verify cabling continuity from the transmitting port to the receiving port
reporting LOS (EC1) To verify cable continuity, follow site practices.

If the continuity is good, clean the fiber according to site practice. If none exists, complete the procedure
in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If the cabling is good, verify that the correct EC1-12 port is in service:
a. Confirm that the LED is correctly lit on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
b. To determine whether the port is in service, double-click the card in CTC to open the card view.
c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

If the correct port is in service, use an optical test set to confirm that a valid signal exists on the line. For
specific procedures to use the test set equipment, consult the manufacturer. Test the line as close to the
receiving card as possible.

If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment
are properly connected. For more information about fiber connections and terminations, refer to the
“Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

If a valid signal exists but the alarm does not clear, replace the cable connector on the ONS 15454.
Repeat Steps 2 through 6 for any other port on the card that reports the LOS (EC1).

If the alarm does not clear, the cabling could still be faulty despite correct attachments. Use the test set
to locate the bad cable and replace it using the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, look for any card-level alarm that could cause this port alarm.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.
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2.8.195 LOS (ESCON)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.196 LOS (FUDC)

Default Severity: Minor (MN), Non-Service Affecting (NSA)
SONET Logical Object: FUDC

The LOS (FUDC) alarm is raised if there is a UDC circuit created on an AIC-1 UDC port but the port is
not receiving signal input. The downstream node has an AIS condition raised against the AIC-I port
transmitting the UDC. FUDC refers to the 64-kb user data channel using the F1 byte.

Clear the LOS (FUDC) Alarm

Step1  Verify cable continuity to the AIC-I UDC port. To verify cable continuity, follow site practices.

Step2  Verify that there is a valid input signal using a test set. For specific procedures to use the test set
equipment, consult the manufacturer.

Step3  If there is a valid signal, clean the fiber according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

Step4  If the alarm does not clear, verify that the UDC is provisioned:
a. At the network view, click the Provisioning > Overhead Circuits tabs.

b. If no UDC circuit exists, create one. Refer to the “Create Circuits and VT Tunnels” chapter in the
Cisco ONS 15454 Procedure Guide.

c. If a user data circuit exists (shown as User Data F1 under the Type column), check the source and
destination ports. These must be located on AIC-I cards to function.

Step5  If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

Step6  If no other alarms exist that could be the source of the LOS (FUDC), or if clearing another alarm did not
clear the LOS, complete the “Physically Replace a Traffic Card” procedure on page 2-242 for the
reporting card.

Step7  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.197 LOS (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.8.198 LOS (MSUDC)

The LOS (MSUDC) alarm is not used in this platform in this release. It is reserved for future
development.

2.8.199 LOS (OCN)

>

Warning

>

Warning

>

Warning

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN

An LOS alarm on an OC-N port occurs when a SONET receiver detects an all-zero pattern for

10 microseconds or longer. An LOS alarm means the upstream transmitter has failed. If an OC-N LOS
alarm is not accompanied by additional alarms, a fiber break is usually the cause of the alarm. It clears
when two consecutive valid frames are received.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial status when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the LOS (OCN) Alarm

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step1  Using site practices, verify fiber continuity to the port.
Step2  If the cabling is good, verify that the correct port is in service:
a. Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
Cisco ONS 15454 Troubleshooting Guide, R6.0
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Step 3

Step 4

Step 5

Step 6

Step 7
Step 8
Step 9

Step 10

Step 11

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS.

f. Click Apply.

If the correct port is in service, clean the fiber according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Check the incoming optical power through CTC (if available) or with an optical power meter to ensure
that it at the correct level as determined by Cisco MetroPlanner.

If the alarm does not clear, verify that the power level of the optical signal is within the OC-N card
receiver specifications. The “1.14.3 OC-N Card Transmit and Receive Levels” section on page 1-154
lists these specifications for each OC-N card. For DWDM cards, refer to the Cisco ONS 15454 DWDM
Installation and Operations Guide for levels.

If the optical power level is within specifications, use an optical test set to verify that a valid signal exists
on the line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line
as close to the receiving card as possible.

If a valid signal exists, replace the connector on the backplane.
Repeat Steps 1 to 7 for any other port on the card reporting the LOS (OC-N).

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

If no other alarms exist that could be the source of the LOS, or if clearing an alarm did not clear the LOS,
complete the “Physically Replace a Traffic Card” procedure on page 2-242 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.200 LOS (OTS)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.201 LOS (TRUNK)

2.8.202 LOS-0

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.204 LO-TXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, PPM, TRUNK

The Equipment Low Transmit Power (LO-TXPOWER) alarm is an indicator for the TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G and OC192-XFP card transmitted
optical signal power. The LO-TXPOWER alarm occurs when the measured optical power of the
transmitted signal falls under the threshold. The threshold value is user-provisionable.

For more information about provisioning MXP or TXP PPMs, refer to the “Provision Transponder and
Muxponder Cards” chapter of the Cisco ONS 15454 DWDM Installation and Operations Guide. For
more information about the cards themselves, refer to the “Card Reference” chapter.

Clear the LO-TXPOWER Alarm

Step 1

Step 2
Step 3
Step 4

Step 5

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, MXP_2.5G_10G, or OC192-XFP card to display the
card view.

Click the Provisioning > Optics Thresholds > Current Values tabs.
Increase the TX Power Low column value by 0.5 dBm.

If the card transmit power setting cannot be increased without affecting the signal, complete the
“Physically Replace a Traffic Card” procedure on page 2-242.

If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.205 LPBKCRS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

The Loopback Cross-Connect condition indicates that there is a software cross-connect loopback active
between an optical card and an OC-192 card. A cross-connect loopback test occurs below line speed and
does not affect traffic.

For more information on loopbacks, see the “1.5 Troubleshooting Optical Circuit Paths With
Loopbacks” section on page 1-48.
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~

Note

Cross-connect loopbacks occur below line speed. They do not affect traffic.

Clear the LPBKCRS Condition

Step 1

Step 2
Step 3

To remove the loopback cross-connect condition, double-click the optical card in CTC to open the card
view.

Complete the “Clear an OC-N Card Cross-Connect (XC) Loopback Circuit” procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.206 LPBKDS1FEAC-CMD

~

Note

A

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, El

The DS-1 Loopback Command Sent To Far End condition occurs on the near-end node when you send
a DS-1 FEAC loopback on DS3XM-6, DS3XM-12, or DS3/EC1-48 cards. For more information about
FEAC loopbacks, see the “1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With
FEAC Loopbacks” section on page 1-46.

LPBKDSI1FEAC-CMD is an informational condition and does not require troubleshooting.

Caution

CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

2.8.207 LPBKDS3FEAC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

A Loopback Due to FEAC Command DS-3 condition occurs when a DS3XM-6, DS3XM-12, DS3-12E,
or DS3/EC1-48 port loopback signal is received in C-bit framing mode from the far-end node because
of an FEAC command. An FEAC command is often used with loopbacks. LPBKDS3FEAC is only
reported by these DS cards. DS3XM-6, DS3XM-12, and DS3/EC1-48 cards generate and report FEAC
alarms or conditions, but a DS3-12E card only reports FEAC alarms or conditions.

CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

LPBKDS3FEAC is an informational condition and does not require troubleshooting.
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2.8.208 LPBKDS3FEAC-CMD W

Clear the LPBKDS3FEAC Condition

Step 1 In node view, double-click the DS-3 card to open the card view.
Step2  Click the Maintenance > DS3 tabs.
Step3  Click the cell for the port in the Send Code column and click No Code from the drop-down list.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.208 LPBKDS3FEAC-CMD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: DS3

The DS-3 Loopback Command Sent To Far End condition occurs on the near-end node when you send
a DS-3 FEAC loopback on DS3XM-6, DS3XM-12, or DS3/EC1-48 cards. For more information about
FEAC loopbacks, see the “1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With
FEAC Loopbacks” section on page 1-46.

~

Note LPBKDS3FEAC-CMD is an informational condition and does not require troubleshooting.

2.8.209 LPBKFACILITY (CE100T)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: CE100T

A Loopback Facility condition on a CE-100T-8 port occurs when a software facility (line) loopback is
active for a port on the card.

Note  For information about troubleshooting Ethernet circuits with loopbacks, refer to the
“1.6 Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-71.

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKFACILITY (CE100T) Condition

Step1  Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.210 LPBKFACILITY (DS1, DS3)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3

A Loopback Facility condition on a DS-1 or DS-3 port occurs when a software facility (line) loopback
is active for the reporting DS3XM-6 card, DS3XM-12 card, a DS1/E1-56 card operating in All DS1
mode, or a DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

CTC permits loopbacks to be performed on an in-service (IS) circuit. Performing a loopback is
Service-Affecting (SA). If you did not perform a lockout or Force switch to protect traffic, the
LPBKFACILITY condition can be accompanied by a more serious alarms such as LOS.

ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback if desired.

Clear the LPBKFACILITY (DS1, DS3) Condition

Step 1

Step 2

Complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on
page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.211 LPBKFACILITY (E1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: El

A Loopback Facility on an E1 port condition occurs when a software facility (line) loopback is active
for a DS1/E1-56 card port operating in All E1 mode.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.
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Note CTC permits loopbacks to be performed on an in-service (IS) circuit. Performing a loopback is
Service-Affecting (SA). If you did not perform a lockout or Force switch to protect traffic, the
LPBKFACILITY condition can be accompanied by a more serious alarms such as LOS.

Note El facility (line) loopbacks transmit an AIS in the direction away from the loopback, but this is
provisionable.

Clear the LPBKFACILITY (E1) Condition

Step 1 Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.212 LPBKFACILITY (EC1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EC1

A Loopback Facility condition on an EC-1 port occurs when a software facility (line) loopback is active
for a port on the reporting ECI/EC1-12 or DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Clear the LPBKFACILITY (EC1) Condition

Step 1 Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.213 LPBKFACILITY (ESCON)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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W 2.8.214 LPBKFACILITY (FC)

2.8.214 LPBKFACILITY (FC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.215 LPBKFACILITY (FCMR)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: FCMR

A Loopback Facility for FC_MR condition occurs when a facility loopback is provisioned on an
FC_MR-4 card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.7 Troubleshooting
MXP, TXP, or FC_MR-4 Circuit Paths With Loopbacks” section on page 1-90.

Clear the LPBKFACILITY (FCMR) Condition

Step 1 Complete the “Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit” procedure on page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.216 LPBKFACILITY (G1000)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: G1000

A Loopback Facility condition for the G1000 object occurs when a software facility (line) loopback is
active for a port on the reporting G-Series Ethernet card.

For information about troubleshooting Ethernet circuits with loopbacks, refer to the
“1.6 Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-71.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

S

Note For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKFACILITY (G1000) Condition

Step 1 Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.217 LPBKFACILITY (GE)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.218 LPBKFACILITY (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.219 LPBKFACILITY (OCN)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

A Loopback Facility condition for OC-N occurs when a software facility (line) loopback is active for a
port on the reporting OC-N card.

For information about troubleshooting optical circuits with loopbacks, refer to the “1.5 Troubleshooting
Optical Circuit Paths With Loopbacks” section on page 1-48.

~

Note OC-3 facility loopbacks do not transmit an AIS in the direction away from the loopback. Instead of AIS,
a continuance of the signal transmitted to the loopback is provided.

A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

A

Caution  Before performing a facility (line) loopback on an OC-N card, ensure that the card contains at least two
DCC paths to the node where the card is installed. A second DCC path provides a nonlooped path to log
into the node after the loopback is applied, thus enabling you to remove the facility loopback. Ensuring
a second DCC is not necessary if you are directly connected to the ONS 15454 containing the loopback
OC-N.

Clear the LPBKFACILITY (OCN) Condition

Step 1 Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-245.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.8.220 LPBKFACILITY (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.221 LPBKTERMINAL (CE100T)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: CE100T

A Loopback Terminal condition on a CE-100T-8 port occurs when a software terminal loopback is active
for a port on the card.

For information about troubleshooting Ethernet circuits with loopbacks, refer to the
“1.6 Troubleshooting Ethernet Circuit Paths With Loopbacks” section on page 1-71.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKTERMINAL (CE100T) Condition

Step 1

Step 2

Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.222 LPBKTERMINAL (DS1, DS3)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3

A Loopback Terminal condition for a DS-1 or DS-3 occurs when a software terminal (inward) loopback
is active for a DS1 or DS3 port on the reporting DS3XM-6, DS3XM-12, or DS3/EC1-48 card. DS-1 and
DS-3 terminal loopbacks do not typically return an AIS signal, but you can provision one for the
DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section
on page 1-46.

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |



| Chapter2 Alarm Troubleshooting

2.8.223 LPBKTERMINAL (E1) W

Clear the LPBKTERMINAL (DS1, DS3) Condition

Step 1

Step 2

Complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on
page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.223 LPBKTERMINAL (E1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: E1l

A Loopback Terminal condition for an E-1 signal on a DS1/E1-56 card occurs when the card is operating
in All E1 mode and a software terminal (inward) loopback is active for a port.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.3 Troubleshooting DS3XM-6 or DS3XM-12 Card Electrical Paths With FEAC Loopbacks” section
on page 1-46.

Clear the LPBKTERMINAL (E1) Condition

Step 1

Step 2

Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.224 LPBKTERMINAL (EC1)

A

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EC1

A Loopback Terminal condition on an EC-1 signal occurs when a software terminal (inward) loopback
is active for a port on the reporting EC1/EC1-12 or DS3/EC1-48 card.

For information about troubleshooting electrical circuits with loopbacks, refer to the
“1.2 Troubleshooting Electrical Circuit Paths With Loopbacks” section on page 1-9.

Caution

CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

Clear the LPBKTERMINAL (EC1) Condition

Step 1

Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.225 LPBKTERMINAL (ESCON)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.226 LPBKTERMINAL (FC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.227 LPBKTERMINAL (FCMR)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: FCMR

A Loopback Terminal for FCMR condition occurs when a terminal loopback is provisioned on an
FC_MR-4 card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.7 Troubleshooting
MXP, TXP, or FC_MR-4 Circuit Paths With Loopbacks” section on page 1-90.

Clear the LPBKTERMINAL (FCMR) Condition

Step 1 Complete the “Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit” procedure on page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.228 LPBKTERMINAL (G1000)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: G1000

A Loopback Terminal condition for the G1000 occurs when a software terminal (inward) loopback is
active for a port on the reporting G-Series Ethernet card.

When a port in terminal (inward) loopback, its outgoing signal is redirected into the receive direction on
the same port, and the externally received signal is ignored. On the G1000-4 card, the outgoing signal is
not transmitted; it is only redirected in the receive direction.

For more information about troubleshooting Ethernet circuits, refer to the “1.6 Troubleshooting
Ethernet Circuit Paths With Loopbacks” section on page 1-71.
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A

Caution  CTC permits loopbacks on an in-service (IS) circuit. Loopbacks are Service-Affecting (SA).

~

Note  For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the LPBKTERMINAL (G1000) Condition

Step 1 Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.229 LPBKTERMINAL (GE)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.230 LPBKTERMINAL (ISC)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.231 LPBKTERMINAL (OCN)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

A Loopback Terminal condition for OC-N occurs when a software terminal (inward) loopback is active
for a port on the reporting card.

Note OC-N terminal loopbacks do not typically return an AIS.

Note  Performing a loopback on an in-service circuit is Service-Affecting (SA). If you did not perform a
lockout or Force switch to protect traffic, the LPBKTERMINAL condition can also be accompanied by
a more serious alarm such as LOS.

For information about troubleshooting circuits, refer to the loopback procedures in Chapter 1, “General
Troubleshooting.”
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Clear the LPBKTERMINAL (OCN) Condition

Step1  Complete the “Clear an OC-N Card Facility or Terminal Loopback Circuit” procedure on page 2-245.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.232 LPBKTERMINAL (TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.233 LWBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: PWR

The Low Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input voltage falls
below the low power threshold. This threshold, with a default value of —44 VDC, is user-provisionable.
The alarm remains raised until the voltage remains above the threshold for 120 seconds. (For
information about changing this threshold, refer to the “Turn Up Node” chapter in the Cisco ONS 15454
Procedure Guide.

Clear the LWBATVG Alarm

Step 1 The problem is external to the ONS 15454. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.234 MAN-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, STSMON, VI-MON

The Manual Switch Request condition occurs when a user initiates a Manual switch request on an OC-N
port. Clearing the Manual switch clears the MAN-REQ condition. You do not need to clear the switch if
you want the Manual switch to remain.

Clear the MAN-REQ Condition

Step1  Complete the “Initiate a 141 Manual Switch Command” procedure on page 2-232.
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Step 2

2.8.235 MANRESET W

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.235 MANRESET

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A User-Initiated Manual Reset condition occurs when you right-click a card in CTC and choose Reset.
Resets performed during a software upgrade also prompt the condition. The MANRESET condition
clears automatically when the card finishes resetting.

MANRESET is an informational condition and does not require troubleshooting.

2.8.236 MANSWTOINT

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE-SREF

The Manual Switch To Internal Clock condition occurs when the NE timing source is manually switched
to an internal timing source.

MANSWTOINT is an informational condition and does not require troubleshooting.

2.8.237 MANSWTOPRI

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Primary Reference condition occurs when the NE timing source is manually
switched to the primary timing source.

MANSWTOPRI is an informational condition and does not require troubleshooting.

2.8.238 MANSWTOSEC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Second Reference condition occurs when the NE timing source is manually
switched to a second timing source.
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~

Note MANSWTOSEC is an informational condition and does not require troubleshooting.

2.8.239 MANSWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Third Reference condition occurs when the NE timing source is manually
switched to a third timing source.

~

Note MAN SWTOTHIRD is an informational condition and does not require troubleshooting.

2.8.240 MANUAL-REQ-RING

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Manual Switch Request on Ring condition occurs when a user initiates a MANUAL RING command
on BLSR rings to switch from working to protect or protect to working. This condition is visible on the
network view Alarms, Conditions, and History tabs and is accompanied by WKSWPR. The port where
the MANUAL RING command originated is marked with an “M” on the network view detailed circuit
map.

Clear the MANUAL-REQ-RING Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.241 MANUAL-REQ-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Manual Switch Request on Ring condition occurs on BLSRs when a user initiates a Manual Span
command to move BLSR traffic from a working span to a protect span. This condition appears on the
network view Alarms, Conditions, and History tabs. The port where the MANUAL SPAN command was
applied is marked with an “M” on the network view detailed circuit map.
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Clear the MANUAL-REQ-SPAN Condition

Step 1 Complete the “Clear a BLSR External Switching Command” procedure on page 2-238.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.242 MEA (AIP)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: AIP

If the Mismatch of Equipment Attributes (MEA) alarm is reported against the AIP, the fuse in the AIP
board blew or is missing. The MEA alarm also occurs when an old AIP board with a 2-A fuse is installed
in a newer ANSI 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD).

Clear the MEA (AIP) Alarm

Step 1 Complete the “Replace the Alarm Interface Panel” procedure on page 2-250.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.243 MEA (BIC)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: BIC

The Missing Equipment Attributes alarm for the backplane interface connector (BIC) indicates a
compatibility issue in using high-density DS-3 cards with universal backplane interface connectors
(UBIC) and an older shelf backplane. Backplane versions 15454-SA-HD and later are compatible with
the UBIC with horizontal connectors (UBIC-H) and UBIC with vertical connectors (UBIC-V) that the
high-density EC-1, DS-1, and DS-3 electrical connections require. The MEA alarm is raised if you
attempt to install a high-density card into Slot 4, 5, 6, 12, 13, or 14 with an older noncompatible
backplane installed. The card is not usable in this case. It is also raised if you attempt to use an older
BIC with the newer backplane.

Clear the MEA (BIC) Alarm

Step1  Click the Provisioning > Inventory tabs to determine your backplane model. If the backplane is not a
15454-SA-HD, replace the backplane or do not attempt to use high-density DS-3 cards. Table 2-14 lists
the BICs that are compatible with various backplanes.
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Step 2

Table 2-14 BIC Compatibility Matrix

BIC Type Part No.
BICs that work with the current and previous MANUF_EQPT_ID_BIC_A_SMB_HD_BP
backplane MANUF_EQPT_ID_BIC_B_SMB_HD_BP

MANUF_EQPT_ID_BIC_A_BNC_24_HD_BP
MANUF_EQPT_ID_BIC_A_BNC_48_HD_BP
MANUF_EQPT_ID_BIC_B_SMB
MANUF_EQPT_ID_BIC_B_SMB_ALT
MANUF_EQPT_ID_BIC_B_BNC_24
MANUF_EQPT_ID_BIC_B_BNC_48

New HD BICs that work only with the new MANUF_EQPT_ID_BIC_A_UNIV_VERT
backplanes MANUF_EQPT_ID_BIC_B_UNIV_VERT
MANUE_EQPT_ID_BIC_A_UNIV_HORIZ
MANUF_EQPT_ID_BIC_B_UNIV_HORIZ
MANUF_EQPT_ID_BIC_A_MINI_BNC_HD_BP
MANUF_EQPT_ID_BIC_B_MINI_BNC_HD_BP

High-density BICs that work only with MANUF_EQPT_ID_BIC_A_SMB
15454-5A-HD MANUF_EQPT_ID_BIC_A_SMB_ALT
MANUE_EQPT_ID_BIC_A_BNC_24
MANUE_EQPT_ID_BIC_A_BNC_48

If you determine that your BIC type and backplane are compatible despite the MEA alarm, or if the alarm
does not clear after you resolve the incompatibilities, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a Service-Affecting (SA) problem.

2.8.244 MEA (EQPT)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The MEA alarm for equipment is reported against a card slot when the physical card inserted into a slot
does not match the card type that is provisioned for that slot in CTC. The alarm also occurs when certain
cards introduced in Release 3.1 or later are inserted into an older shelf assembly or when older Ethernet
cards (E1000-2 and E100T-12) are used in a newer 10-Gbps-compatible shelf assembly.

Removing the incompatible cards clears the alarm.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Note

2.8.244 MEA (EapT) W

If an OC3-8 card is installed in Slot 5 to 6 and Slot 12 to 13, it does not appear in CTC and raises an
MEA.

Clear the MEA (EQPT) Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Physically verify the type of card that is installed in the slot reporting the MEA alarm. In node view,
click the Inventory tab and compare it to the actual installed card.

Determine whether the ONS 15454 shelf assembly is a newer 10-Gbps-compatible shelf assembly
(15454-SA-ANSI or 15454-SA-HD) or an earlier shelf assembly. Under the HW Part # column, if the
part number is 800-19857-XX or 800-19856-XX, then you have a 15454-SA-ANSI shelf. If the part
number is 800-24848-XX, then you have a 15454-SA-HD shelf. If the number is not one of those listed
above, then you are using an earlier shelf assembly.

~

Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.

Verify the type of card that sits in the slot reported in the object column of the MEA row on the Alarms
window by reading the name at the top of the card faceplate.

e If you have a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and
the card reporting the alarm is not an E1000-2 or E100T-12, proceed to Step 4.

e If you have a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and
the card reporting the alarm is an E1000-2 or E100T-12, then that version of the Ethernet card is
incompatible and must be removed. Proceed to Step 4.

S,

Note The E1000-2-G and E100T-G cards are compatible with the newer ANSI
10-Gbps-compatible shelf assembly and are the functional equivalent of the older,
noncompatible E1000-2 and E100T-12 cards. E1000-2-G and E100T-G cards can be used as
replacements for E1000-2 and E100T-12 cards in a 10-Gbps-compatible shelf assembly.

e If you have an older shelf assembly and the card reporting the alarm is not a card introduced in
Release 3.1 or later, which includes the OC-192, E1000-2-G, E100T-G, or OC-48 any slot (AS),
proceed to Step 4.

e If you have an older shelf assembly and the card reporting the alarm is a card introduced in Release
3.1 or later, which includes the OC-192, E1000-2-G, E100T-G, or OC-48 any slot (AS), the
reporting card is incompatible with the shelf assembly and must be removed Proceed to Step 4.

If you prefer the card type depicted by CTC, complete the “Physically Replace a Traffic Card” procedure
on page 2-242 for the reporting card.

If you prefer the card that physically occupies the slot but the card is not in service, does not have circuits
mapped to it, and is not part of a protection group, place the cursor over the provisioned card in CTC
and right-click to choose Delete Card.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.
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Step 6

A

~

Note  If the cardis in service, does have circuits mapped to it, is paired in a working protection scheme,
has DCC communications turned on, or is used as a timing reference, CTC does not allow you
to delete the card.

If any ports on the card are in service, place them out of service (OOS,MT):

Caution

Step 7

A

Before placing ports out of service, ensure that live traffic is not present.

a. Double-click the reporting card to open the card view.
b. Click the Provisioning tab.

c. Click the admin state of any in-service ports.

d. Choose OOS,MT to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-244.

Caution

Step 8

Step 9
Step 10

Step 11

Before deleting the circuit, ensure that live traffic is not present.

If the card is paired in a protection scheme, delete the protection group:
a. Click the Provisioning > Protection tabs.

b. Choose the protection group of the reporting card.

c. Click Delete.

Right-click the card reporting the alarm.

Choose Delete.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.245 MEA (FAN)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: FAN

The MEA alarm is reported against the fan-tray assembly when a newer fan-tray assembly (15454-FTA3)
with a 5-A fuse is used with an older shelf assembly or when an older fan-tray assembly with a 2-A fuse
is used with a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) that
contains cards introduced in Release 3.1 or later. If a 10-Gbps-compatible shelf assembly contains only
cards introduced before Release 3.1, then an older fan-tray assembly (15454-FTA-2) can be used and
does not report an MEA alarm.
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Clear the MEA (FAN) Alarm

Step 1

Step 2

Step 3

Step 4

Determine whether the shelf assembly is a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI
or 15454-SA-HD) or an earlier shelf assembly. In node view, click the Inventory tab.

Under the HW Part # column, if the part number is 800-19857-XX or 800-19856-XX, then you have a
15454-SA-ANSI shelf. If the part number is 800-24848-XX, you have a 15454-SA-HD shelf.

Under the HW Part # column, if the number is not one of those listed above, then you are using an earlier
shelf assembly.

If you have a 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD), the alarm
indicates that an older incompatible fan-tray assembly is installed in the shelf assembly. Obtain a newer
fan-tray assembly (15454-FTA3) with a 5-A fuse and complete the “Replace the Fan-Tray Assembly”
procedure on page 2-249.

If you are using an earlier shelf assembly, the alarm indicates that you are using a newer fan-tray
assembly (15454-FTA3), which is incompatible with the earlier version of the shelf assembly. Obtain an
earlier version of the fan-tray assembly (15454-FTA2) and complete the “Replace the Fan-Tray
Assembly” procedure on page 2-249.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.246 MEA (PPM)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.247 MEM-GONE

Note

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Memory Gone alarm occurs when data generated by software operations exceeds the memory
capacity of the TCC2/TCC2P. The TCC2/TCC2P cards which exceed the memory capacity reboot to
avoid failure of card operations.

The alarm does not require user intervention. The MEM-LOW alarm always preceeds the MEM-GONE
alarm.

2.8.248 MEM-LOW

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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Note

The Free Memory of Card Almost Gone alarm occurs when data generated by software operations is
close to exceeding the memory capacity of the TCC2/TCC2P. The alarm clears when additional memory
becomes available. If additional memory is not made available and the memory capacity of the card is
exceeded, CTC ceases to function.

The alarm does not require user intervention. If the alarm does not clear, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.249 MFGMEM

Tip

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: AICI-AEP, AICI-AIE, AIP, BPLANE, FAN
DWDM Logical Object: PPM

The Manufacturing Data Memory Failure alarm occurs when the EEPROM fails on a card or component,
or when the TCC2/TCC2P cannot read this memory. EEPROM stores manufacturing data that a system
TCC2/TCC2P uses to determine system compatibility and shelf inventory status. Unavailability of this
information can cause less-significant problems. The AIP EEPROM also stores the system MAC
address. If the MFGMEM alarm indicates EEPROM failure on these panels, IP connectivity could be
disrupted and the system icon is grayed out in CTC network view.

When you lose LAN connectivity with an ONS 15454 due to an MFGMEM alarm on the AIP, you can
reestablish node management by disconnecting the Ethernet cable from the panel and connecting it to
the active TCC2/TCC2P LAN port.

Clear the MFGMEM Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-239.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

(1 800 553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, complete the “Physically Replace a
Traffic Card” procedure on page 2-242.

If the MFGMEM alarm continues to report after replacing the TCC2/TCC2Ps, the problem lies with the
EEPROM.

If the MFGMEM is reported from the fan-tray assembly, obtain a fan-tray assembly and complete the
“Replace the Fan-Tray Assembly” procedure on page 2-249.

If the MFGMEM is reported from the AIP, the backplane, or the alarm persists after the fan-tray
assembly is replaced, log into the Technical Support Website at http://www.cisco.com/techsupport for
more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.
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2.8.250 NO-CONFIG

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The No Startup Configuration condition applies to ML-Series Ethernet cards and occurs when no startup
configuration file has been downloaded to the TCC2/TCC2P, whether or not you preprovision the card
slot. This alarm can be expected during provisioning. When the startup configuration file is copied to the
active TCC2/TCC2P, the alarm clears.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the NO-CONFIG Condition

Step 1

Step 2

Step 3
Step 4

Create a startup configuration for the card in Cisco I0S.

Follow the card provisioning instructions in the Ethernet Card Software Feature and Configuration Guide
for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Upload the configuration file to the TCC2/TCC2P:

a. In node view, right-click the ML-Series card graphic.

b. Choose IOS Startup Config from the shortcut menu.

c. Click Local > TCC and navigate to the file location.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.251 NOT-AUTHENTICATED

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: SYSTEM

The NOT-AUTHENTICATED alarm is raised by CTC (not by the NE) when CTC fails to log into a node.
This alarm only appears in CTC where the login failure occurred. This alarm differs from the
“INTRUSION-PSWD” alarm on page 2-120 because INTRUSION-PSWD occurs when a user exceeds
the login failures threshold.

NOT-AUTHENTICATED is an informational alarm and is resolved when CTC successfully logs into the
node.
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2.8.252 OCHNC-INC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.253 ODUK-1-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.254 ODUK-2-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.255 ODUK-3-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.256 ODUK-4-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.257 ODUK-AIS-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.258 ODUK-BDI-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.259 ODUK-LCK-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.8.260 ODUK-OCI-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.261 ODUK-SD-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.262 ODUK-SF-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.263 ODUK-TIM-PM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.264 00OU-TPT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSTRM, VT-TERM

The Out of Use Transport Failure alarm is a VCAT member alarm. (VCAT member circuits are
independent circuits that are concatenated from different time slots into a higher-rate signal.) This
condition is raised when a member circuit in a VCAT is unused, such as when it is removed by
SW-LCAS. It occurs in conjunction with the “VCG-DEG” condition on page 2-226.

Clear the OOT-TPT Condition

Step 1 Complete the “Clear the VCG-DEG Condition” procedure on page 2-226. Clearing that condition clears
this condition as well.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.265 OPEN-SLOT

Default Severity: Not Alarmed (NA)
SONET Logical Object: EQPT

Cisco ONS 15454 Troubleshooting Guide, R6.0
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The Open Slot condition indicates that there is an open slot in the system shelf. Slot covers assist with
airflow and cooling.

Clear the OPEN-SLOT Condition

Step 1

Step 2

To install a slot cover and clear this condition, refer to the procedures located in the “Install Hardware”
chapter of the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.266 OPTNTWMIS

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.267 OPWR-HDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.268 OPWR-HFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.269 OPWR-LDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.270 OPWR-LFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.271 OSRION

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.8.272 OTUK-AIS

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.273 OTUK-BDI

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.274 OTUK-IAE

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.275 OTUK-LOF

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.276 OTUK-SD

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.277 OTUK-SF

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.278 OTUK-TIM

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.279 OUT-OF-SYNC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.8.280 PARAM-MISM

2.8.281 PDI-P

>

Warning

>

Warning

>

Warning

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

PDI-P is a set of application-specific codes indicating a signal label mismatch failure (SLMF) in the
ONS 15454 STS path overhead. The condition indicates to downstream equipment that there is a defect
in one or more of the directly mapped payloads contained in that STS synchronous payload envelope
(SPE). For example, the mismatch could occur in the overhead to the path selector in a downstream node
configured as part of a path protection. The PDI-P codes appear in the STS Signal Label (C2 byte).

An SLMF often occurs when the payload (for example, ATM) does not match what the signal label is
reporting. The “AIS” condition on page 2-32 often accompanies a PDI-P condition. If the PDI-P is the
only condition reported with the AIS, clearing PDI-P clears the AIS. PDI-P can also occur during an
upgrade, but usually clears itself and is not a valid condition.

A PDI-P condition reported on an OC-N port supporting a G1000-4 card circuit could result from the
end-to-end Ethernet link integrity feature of the G1000-4 card. If the link integrity is the cause of the
path defect, it is typically accompanied by the “TPTFAIL (G1000)” alarm on page 2-219 or the
“CARLOSS (G1000)” alarm on page 2-56 reported against one or both Ethernet ports terminating the
circuit. If this is the case, clear the TPTFAIL and CARLOSS alarms to resolve the PDI-P condition.

A PDI-P condition reported on an OC-N port supporting an ML-Series card circuit could result from the
end-to-end Ethernet link integrity feature of the ML-Series card. If the link integrity is the cause, it is
typically accompanied by the “TPTFAIL (ML100T, ML1000, MLFX)” alarm on page 2-220 reported
against one or both packet-over-SONET (POS) ports terminating the circuit. If TPTFAIL is reported
against one or both of the POS ports, troubleshooting the accompanying alarm clears the PDI-P
condition. Refer to the Ethernet Card Sofiware Feature and Configuration Guide for the Cisco ONS 15454,
Cisco ONS 15454 SDH, and Cisco ONS 15327 for more information about ML-Series cards.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
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Note

2.8.282 PEER-NORESPONSE W

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the PDI-P Condition

Step 1

Step 2

A

Verify that all circuits terminating in the reporting card are DISCOVERED:
a. Click the Circuits tab.
b. Verify that the Status column lists the circuit as active.

c. If the Status column lists the circuit as PARTIAL, wait 10 minutes for the ONS 15454 to initialize
fully. If the PARTIAL status does not change after full initialization, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1 800 553-2447).

After determining that the circuit is DISCOVERED, ensure that the signal source to the card reporting
the alarm is working.

Caution

Step 3

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If traffic is affected, complete the “Delete a Circuit” procedure on page 2-244.

Caution

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Deleting a circuit can affect existing traffic.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.

If circuit deletion and re-creation does not clear the condition, verify that there is no problem stemming
from the far-end OC-N card providing STS payload to the reporting card.

If the condition does not clear, confirm the cross-connect between the OC-N card and the reporting card.

If the condition does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

If the condition does not clear, complete the “Physically Replace a Traffic Card” procedure on
page 2-242 for the optical/electrical cards.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.282 PEER-NORESPONSE

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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The switch agent raises a Peer Card Not Responding alarm if either traffic card in a protection group
does not receive a response to the peer status request message. PEER-NORESPONSE is a software
failure and occurs at the task level, as opposed to a communication failure, which is a hardware failure
between peer cards.

Clear the PEER-NORESPONSE Alarm

Step 1

Step 2

Step 3

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.283 PLM-P

>

Warning

>

Warning

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: STSMON, STSTRM

A Payload Label Mismatch Path alarm indicates that signal does not match its label. The condition is
indicated by a problematic C2 byte value in the SONET path overhead. The alarm is raised if all of the
following conditions are met:

e The received C2 byte is not 0x00 (unequipped).

e The received C2 byte is not a PDI value.

e The received C2 does not match the expected C2.

e The expected C2 byte is not 0x01 (equipped, unspecified).
e The received C2 byte is not 0x01 (equipped, unspecified).

For example, on nodes equipped with CTC Software R4.1 and earlier, this alarm could occur when you
have a DS3XM-6 card connected to a DS-3 card instead of a DS-1 card. The DS3XM-6 card expects a
C2 label byte value of 01. A DS-1 card transmits this value, but a DS-3 card transmits a value of 04. The
mismatch between the sent and expected values causes the PLM-P alarm.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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A

Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the PLM-P Alarm

Step 1 Complete the “Clear the PDI-P Condition” procedure on page 2-175.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.284 PLM-V

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: VI-TERM

A Payload Label Mismatch VT Layer alarm indicates that the content of the V5 byte in the SONET
overhead is inconsistent or invalid. PLM-V occurs when ONS 15454s interoperate with equipment that
performs bit-synchronous mapping for DS-1 signal. The ONS 15454 uses asynchronous mapping.

Clear the PLM-V Alarm

Step1  Verify that your signal source matches the signal allowed by the traffic card. For example, the traffic card
does not allow VT6 or VT9 mapping.

Step2  If the signal source matches the card, verify that the SONET VT path originator is sending the correct
VT label value. You can find the SONET VT path originator using circuit provisioning steps.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.285 PORT-ADD-PWR-DEG-HI

For more information about the PORT-ADD-PWR-DEG-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.
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2.8.286 PORT-ADD-PWR-DEG-LOW

For more information about the PORT-ADD-PWR-DEG-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.8.287 PORT-ADD-PWR-FAIL-HIGH

For more information about the PORT-ADD-PWR-DEG-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.8.288 PORT-ADD-PWR-FAIL-LOW

For more information about the PORT-ADD-PWR-DEG-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.8.289 PORT-FAIL

For more information about the PORT-ADD-PWR-DEG-HIGH alarm, refer to the “Alarm
Troubleshooting” chapter in the Cisco ONS 15454 DWDM Troubleshooting Guide.

2.8.290 PORT-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: CE-MR-10, ML-MR-10, FC_MR-4

The Pluggable PORT-MISMATCH alarm applies to FC_MR-4, ML-MR-10, and CE-MR-10 Ethernet
cards.

For the ML-MR-10 and CE-MR-10 cards the alarm indicates either of the following:

e The provisioned payload, speed, or duplex configured on the port does not match that of the SFP
plugged into the port.

e A non-supported SFP is plugged into the port.
For the FC_MR-4 card the alarm indicates that a non-supported GBIC is plugged into the port.

Clear the PORT-MISMATCH Alarm

To clear the alarm on the CE-MR-10 card, either plug-in a supported SFP into the CE-MR-10 port or
follow these steps to provision the correct payload, speed, or duplex:

1. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the CE-MR-10
card to open the card view.

2. Click the Provisioning > Ether Ports tabs.

3. Specify correct values in the Expected Speed and Expected Duplex fields to match the SFP
configuration.

4. Click Apply.
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To clear the alarm on the FC_MR-4 card, plug-in a supported GBIC into the FC_MR-4 port and follow
these steps to provision the media type:

1. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the FC_MR-4
card graphic to open the card.

2. Click the Provisioning > Port > General tabs.
3. Specify proper payload value in the Media Type field.
4. Click Apply.

For the CE-MR-10 and FC_MR-10 card, the alarm can also be cleared using TL1 commands. For
detailed instructions, refer to the Cisco ONS 15454, Cisco ONS 15600, and Cisco ONS 15310-MA
SONET TL1 Command Guide.

For the ML-MR-10 card, the alarm can be cleared through Cisco IOS commands. For detailed
instructions, refer to the Cisco ONS 15454 and Cisco ONS 15454 SDH Ethernet Card Software Feature
and Configuration Guide.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) to report a
Service-Affecting (SA) problem.

2.8.291 PRC-DUPID

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN

The Procedural Error Duplicate Node ID alarm indicates that two identical node IDs exist in the same
ring. The ONS 15454 requires each node in the ring to have a unique node ID.

Clear the PRC-DUPID Alarm

Step 1
Step 2

Step 3
Step 4

Step 5

Log into a node on the ring.

Find the node ID by completing the “Identify a BLSR Ring Name or Node ID Number” procedure on
page 2-230.
Repeat Step 2 for all the nodes on the ring.

If two nodes have an identical node ID number, complete the “Change a BLSR Node ID Number”
procedure on page 2-230 so that each node ID is unique.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.292 PROTNA

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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The Protection Unit Not Available alarm is caused by an OOS protection card when a TCC2/TCC2P or
XCI10G card that has been provisioned as part of a protection group is not available. Unavailable
protection can occur when a card is reset, but the alarm clears as soon as the card is back in service. The
alarm clears if the device or facility is brought back in service.

Clear the PROTNA Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

If the PROTNA alarm occurs and does not clear, and if it is raised against a controller or cross-connect
card, ensure that there is a redundant TCC2/TCC2P installed and provisioned in the chassis.

If the alarm is raised against a line card, verify that the ports have been taken out of service (OOS,MT):
a. In CTC, double-click the reporting card to open the card view (if the card is not an XC10G card).
b. Click the Provisioning tab.

¢. Click the admin state of any in-service (IS) ports.

d. Choose OOS,MT to take the ports out of service.

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the reporting card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.293 PROV-MISMATCH

2.8.294 PTIM

For information about this alarm or condition, refer to the “Alarm Troubleshooting™ chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.295 PWR-FAIL-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT
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2.8.295 PWR-FAIL-A W

The Equipment Power Failure at Connector A alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-A Alarm

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6
Step 7

If a single card has reported the alarm, take the following actions depending on the reporting card:

e Ifthereporting card is an active traffic line port in a 1+1 protection group or part of a path protection,
ensure that an APS traffic switch has occurred to move traffic to the protect port.

~

Note Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To
avoid this, perform an external switch if a switch has not already occurred. See the
“2.10.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-231 for
commonly used traffic-switching procedures.

e If the alarm is reported against a TCC2/TCC2P, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-239.

e Ifthe alarm is reported against an OC-N card, complete the “Reset a Traffic Card in CTC” procedure
on page 2-239.

e If the alarm is reported against a cross-connect card, complete the “Reset a Traffic Card in CTC”
procedure on page 2-239 for the cross-connect card. (The process is similar.)

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the reporting card.

If the single card replacement does not clear the alarm, or if multiple cards report the alarm, verify the
office power. Refer to the “Install the Shelf and Backplane Cable” chapter in the Cisco ONS 15454
Procedure Guide for procedures. See the “1.15 Power Supply Problems” section on page 1-155 as
necessary.

If the alarm does not clear, reseat the power cable connection to the connector.
If the alarm does not clear, physically replace the power cable connection to the connector.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).
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2.8.296 PWR-FAIL-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Equipment Power Failure at Connector B alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
0OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

>

Warning  The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-B Alarm

Step1  Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-181.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.297 PWR-FAIL-RET-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
0OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step1  Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-181.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.298 PWR-FAIL-RET-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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SONET Logical Object: EQPT

The Equipment Power Failure at Connector B alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA),
15454_MRC-12 Multirate card, MRC-2.5G-4 Multirate card, OC192SR1/STM6410 Short Reach and
OC192/STM64 Any Reach cards (also known as OC192-XFP in CTC), OC12 IR/STM4 SH 1310-4 card,
OC3 IR/STM1 SH 1310-8 card or TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-181.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.299 RAI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3, El

The Remote Alarm Indication condition signifies an end-to-end failure. The error condition is sent from
one end of the SONET path to the other. RAI on a DS3XM-6 card indicates that the far-end node is
receiving a DS-3 AIS.

Clear the RAI Condition

Step1  Complete the “Clear the AIS Condition” procedure on page 2-32.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.300 RCVR-MISS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: DS1, E1

A Facility Termination Equipment Receiver Missing alarm occurs when the facility termination
equipment detects an incorrect amount of impedance on its backplane connector. Incorrect impedance
usually occurs when a receive cable is missing from a DS-1 port, or a possible mismatch of backplane
equipment occurs. For example, an SMB connector or a BNC connector could be misconnected to a
DS-1 card.

Note  DS-1s are four-wire circuits and need a positive (tip) and negative (ring) connection for both transmit
and receive.
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Clear the RCVR-MISS Alarm

Step 1

A

Ensure that the device attached to the DS-1 port is operational.

Caution

Step 2
Step 3
Step 4
Step 5

2.8.301 RFI

2.8.302 RFI-L

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the attachment is good, verify that the cabling is securely connected.
If the cabling is good, verify that the pinouts are correct.
If the pinouts are correct, replace the receive cable.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN

A RFI Line condition occurs when the ONS 15454 detects an RFI in OC-N card SONET overhead
because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-L condition
in the reporting node. RFI-L indicates that the condition is occurring at the line level.

Clear the RFI-L Condition

Step 1
Step 2
Step 3

2.8.303 RFI-P

Log into the node at the far-end node of the reporting ONS 15454.
Identify and clear any alarms, particularly the “LOS (OCN)” alarm on page 2-147.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM
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The RFI Path condition occurs when the ONS 15454 detects an RFI in the an STS-1 signal SONET
overhead because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-P
condition in the reporting node. RFI-P occurs in the terminating node in that path segment.

Clear the RFI-P Condition

Step1  Verify that the ports are enabled and in service (IS-NR) on the reporting ONS 15454:
a. Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

Step2  To find the path and node failure, verify the integrity of the SONET STS circuit path at each of the
intermediate SONET nodes.

Step3  Clear alarms in the node with the failure, especially the “UNEQ-P” alarm on page 2-223 or the
“UNEQ-V” alarm on page 2-224.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.304 RFI-V

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Object: VI-TERM

An RFI VT Layer condition occurs when the ONS 15454 detects an RFI in the SONET overhead because
of a fault in another node. Resolving the fault in the adjoining node clears the RFI-V condition in the
reporting node. RFI-V indicates that an upstream failure has occurred at the VT layer.

Clear the RFI-V Condition

Step1  Verify that the connectors are securely fastened and connected to the correct slot. For more information,
refer to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If connectors are correctly connected, verify that the DS-N
Step3  port is active and in service (IS-NR):

a. Confirm that the LED is correctly illuminated on the physical card:
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Step 4

Step 5
Step 6

Step 7

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

If the ports are active and in service, use an optical test set to verify that the signal source does not have
errors. For specific procedures to use the test set equipment, consult the manufacturer.

If the signal is valid, log into the node at the far-end of the reporting ONS 15454.

Clear alarms in the far-end node, especially the “UNEQ-P” alarm on page 2-223 or the “UNEQ-V” alarm
on page 2-224.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.305 RING-ID-MIS

~

Note

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: OSC-RING

The Ring ID Mismatch condition refers to the ring ID in APC. It occurs when a ring name does not match
other detectable node ring names, and can cause problems with applications that require data exchange
with APC. This alarm is similar to BLSR RING-MISMATCH, but rather than apply to ring protection,
RING-ID-MIS applies to DWDM node discovery within the same network.

For more information about APC, refer to the Cisco ONS 15454 DWDM Installation and Operations
Guide.

Clear the RING-ID-MIS Alarm

Step 1
Step 2

Complete the “Clear the RING-MISMATCH Alarm” procedure on page 2-187.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.306 RING-MISMATCH

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: OCN
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2.8.307 RING-SW-EAST M

A Procedural Error Mismatch Ring alarm occurs when the ring name of the ONS 15454 node that is
reporting the alarm does not match the ring name of another node in the BLSR. Nodes connected in a
BLSR must have identical ring names to function. This alarm can occur during BLSR provisioning.

RING-MISMATCH is somewhat similar to RING-ID-MIS, but it applies to BLSR protection discovery
instead of DWDM node discovery.

For more information about DWDM cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.

Clear the RING-MISMATCH Alarm

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

In node view, click the Provisioning > BLSR tabs.

Note the name in the Ring Name field.

Log into the next ONS 15454 node in the BLSR.

Complete the “Identify a BLSR Ring Name or Node ID Number” procedure on page 2-230.

If the ring name matches the ring name in the reporting node, repeat Step 4 for the next ONS 15454 in
the BLSR.

Complete the “Change a BLSR Ring Name” procedure on page 2-230.
Verify that the ring map is correct.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.307 RING-SW-EAST

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Ring Switch Is Active East Side condition occurs when a ring switch occurs at the east side of a
BLSR using a Force Ring command. The condition clears when the switch is cleared. RING-SW-EAST
is visible on the network view Alarms, Conditions, and History tabs. The port where the Force Ring was
applied shows an “F” on the network view detailed circuit map.

RING-SW-EAST is an informational condition and does not require troubleshooting.

2.8.308 RING-SW-WEST

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
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2.8.309 ROLL

~

Note

The Ring Switch Is Active West Side condition occurs when a ring switch occurs at the west side of a

BLSR using a Force Ring command. The condition clears when the switch is cleared. RING-SW-WEST
is visible on the network view Alarms, Conditions, and History tabs. The port where the Force Ring was
applied shows an “F” on the network view detailed circuit map.

RING-SW-WEST is an informational condition and does not require troubleshooting.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM, VI-MON

The ROLL condition indicates that circuits are being rolled. This is typically carried out to move traffic
for a maintenance operation or to perform bandwidth grooming. The condition indicates that a good
signal has been received on the roll destination leg, but the roll origination leg has not yet been dropped.
The condition clears when the roll origination leg is dropped.

ROLL is an informational condition and does not require troubleshooting.

2.8.310 ROLL-PEND

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM, VI-MON

ROLL-PEND indicates that a roll process has been started, but a good signal has not been received yet
by the roll destination leg. This condition can be raised individually by each path in a bulk circuit roll.

The condition clears when a good signal has been received on the roll destination leg.

ROLL-PEND is an informational condition and does not require troubleshooting.

2.8.311 RPRW

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: CE100T, ML100T, ML1000, MLFX

The Resilient Packet Ring (RPR) Wrapped condition applies to ML-Series card and occurs when the
RPR protocol initiates a ring wrap due to a fiber cut, node failure, node restoration, new node insertion,
or other traffic problem. It can also be raised if the POS port has an Admin down condition. (In this case,
you will not see any SONET-level or TPTFAIL alarms.). The POS port can go down for the following
reason : Deletion of circuit on the POS port.

When the wrap occurs, traffic is redirected to the original destination by sending it in the opposite
direction around the ring after a link state change or after receiving any SONET path-level alarms.
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ML-Series card POS interfaces normally send the “PDI-P” alarm on page 2-174 to the far end when the
POS link goes down or when RPR wraps. ML-Series card POS interfaces do not send a PDI-P alarm to
the far end when this alarm is detected, when the alarm is being sent to the far end, or when the only
defects being detected are the “GFP-LFD” alarm on page 2-109, the “GFP-CSF” alarm on page 2-107,
the VCAT “LOM” alarm on page 2-137, or the VCAT “SQM” alarm on page 2-203.

For more information about CE-100T-8 and ML-Series Ethernet cards, refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the RPRW Condition

Step 1

Step 2

Step 3

Step 4

If a circuit on the POS port part of SPR interface had been deleted, recreate the circuit on the POS port
for this alarm to clear ring wrapping.

Look for and clear any service-affecting SONET path-level alarms on the affected circuit, such as the
“LOP-P” alarm on page 2-137, “PLM-P” alarm on page 2-176, or the “TIM-P” alarm on page 2-216.
Clearing this alarm can also clear RPRW.

If the condition does not clear, look for and clear any service alarms for the ML-Series card itself, such
as the “CARLOSS (CE100T)” alarm on page 2-52, “CARLOSS (ML100T, ML1000, MLFX)” alarm on
page 2-59, “TPTFAIL (CE100T)” alarm on page 2-218, or the “TPTFAIL (ML100T, ML1000, MLFX)”
alarm on page 2-220.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.312 RUNCFG-SAVENEED

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

The Run Configuration Save Needed condition occurs when you change the running configuration file
for ML-Series cards. It is a reminder that you must save the change to the startup configuration file for
it to be permanent.

The condition clears after you save the running configuration to the startup configuration, such as by
entering:

copy run start
at the privileged EXEC mode of the Cisco IOS CLI. If you do not save the change, the change is lost

after the card reboots. If the command “copy run start” is executed in configuration mode and not
privileged EXEC mode, the running configuration will be saved, but the alarm will not clear.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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2.8.313 SD (DS1, DS3)

>

Warning

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3

A Signal Degrade (SD) condition for DS-1 or DS-3 occurs when the quality of an electrical signal on a
DS3XM-6, DS3XM-12, or DS3/EC1-48 card has exceeded the BER signal degrade threshold. Signal
degrade is defined by Telcordia as a soft failure condition. SD and signal fail (SF) both monitor the
incoming BER and are similar, but SD is triggered at a lower bit error rate than SF.

The BER threshold is user-provisionable and has a range for SD from 1E-9 dBm to 1E-5 dBm.

SD can be reported on electrical card ports that are In-Service and Normal (IS-NR); Out-of-Service and
Autonomous, Automatic In-Service (OOS-AU,AIS); or Out-of-Service and Management, Maintenance
(OOS-MA,MT), but not in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service
state. The BER count increase associated with this alarm does not take an IS-NR port out of service, but
if it occurs on an AINS port, the alarm prevents the port from going into service.

The SD condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem such as a faulty fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice. SD can also
be caused by repeated XC10G card switches that in turn can cause switching on the lines or paths.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Some levels of BER errors (such as 1E-9 dBm) take a long period to raise or clear, about 9,000 seconds,
or 150 minutes. If the SD threshold is provisioned at 1E-9 dBm rate, the SD alarm needs at least one
and one-half hours to raise and then another period at least as long to clear.

The recommended test set for use on all SONET ONS electrical cards is the Omniber 718. For specific
procedures to use the test set equipment, consult the manufacturer.

Clear the SD (DS1, DS3) Condition

Step 1

If the condition applies for a DS-3 line on a DS3XM-6, DS3XM-12, DS3E-12, or DS3/EC1-48 card,
complete the “Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit” procedure on
page 2-245. If the condition applies to any other DS-N card (DS3i-N-14, DS3-12, DS3i-N-14, or
DS1/E1-56) complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks”
procedure on page 2-246.
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Caution

Step 2

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8
Step 9
Step 10

Step 11

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, verify that single-mode fiber is used.

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.
Verify that a single-mode laser is used at the far end.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.10.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-241.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.314 SD (E1)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: E1l

An SD condition for an E1 occurs on a DS1/E1-56 card in E1 only mode when the quality of an electrical
signal has exceeded the BER signal degrade threshold.

SD is triggered at a lower bit error rate than SF. The SD BER threshold is user-provisionable and ranges
from 1E-9 dBm to 1E-5 dBm.

SD can be reported on electrical card ports that are In-Service and Normal (IS-NR); Out-of-Service and
Autonomous, Automatic In-Service (OOS-AU,AIS); or Out-of-Service and Management, Maintenance
(OOS-MA,MT) but not in the Out-of-Service and Management, Disabled (OOS-MA,DSBLD) service
state. The BER count increase associated with this alarm does not take an IS-NR port out of service, but
if it occurs on an AINS port, the alarm prevents the port from going into service.

The SD condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem such as a faulty fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice. SD can also
be caused by repeated XC10G card switches that in turn can cause switching on the lines or paths.
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Note

~

Note

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Some levels of BER errors (such as 1E-9 dBm) take a long period to raise or clear, about 9,000 seconds,
or 150 minutes. If the SD threshold is provisioned at 1E-9 dBm rate, the SD alarm needs at least one
and a half hours to raise and then another period at least as long to clear.

The recommended test set for use on all SONET ONS electrical cards is the Omniber 718. For specific
procedures to use the test set equipment, consult the manufacturer.

Clear the SD (E1) Condition

Step 1

A

Complete the “Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks” procedure on
page 2-246.

Caution

Step 2

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8
Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Install Cards and Fiber-Optic Cable” chapter in the
Cisco ONS 15454 Procedure Guide.

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, verify that single-mode fiber is used.
If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.10.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-241.
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If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.315 SD (TRUNK)

2.8.316 SD-L

Note

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN

An SD Line condition is similar to the “SD (DS1, DS3)” condition on page 2-190. It applies to the line
level of the SONET signal and travels on the B2 byte of the SONET overhead.

An SD-L on an Ethernet or OC-N card does not cause a protection switch. If the alarm is reported on a
card that has also undergone a protection switch, the SD BER count continues to accumulate. The
condition is superseded by higher-priority alarms such as the “LOF (EC1)” alarm on page 2-134, the
“LOF (OCN)” alarm on page 2-134, the “LOS (EC1)” alarm on page 2-144, and the “LOS (OCN)” alarm
on page 2-147.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the SD-L Condition

Step 1
Step 2

2.8.317 SD-P

Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

An SD Path condition is similar to the “SD (DS1, DS3)” condition on page 2-190, but it applies to the
path (STS) layer of the SONET overhead. A path or STS-level SD alarm travels on the B3 byte of the
SONET overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD
from 1E-9 dBm to 1E-5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not
user-provisionable and the error rate is hard-coded to 1E-6 dBm.
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On path protection configurations, an SD-P condition causes a switch from the working card to the
protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-P condition does
not cause switching.

The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.
Clear the SD-P Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.318 SD-V

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: VI-MON, VI-TERM

An SD-V condition is similar to the “SD (DS1, DS3)” condition on page 2-190, but it applies to the VT
layer of the SONET overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD
from 1E-9 dBm to 1E-5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not
user-provisionable and the error rate is hard-coded to 1E-6 dBm.

On path protection configurations, an SD-V condition does not cause a switch from the working card to
the protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-V condition
does not cause switching.

The BER increase that causes the alarm is sometimes caused by a physical fiber problem such as a poor
fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD alarm clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the SD-V Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.319 SF(DS1, DS3)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3
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A Signal Fail (SF) condition occurs when the quality of the signal has exceeded the BER signal failure
threshold. Signal failure is defined by Telcordia as a “hard failure” condition. The SD and SF conditions
both monitor the incoming BER error rate and are similar conditions, but SF is triggered at a higher BER
than SD.

The BER threshold is user-provisionable and has a range for SF from 1E-5 dBm to 1E-3 dBm.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the SF (DS1, DS3) Condition

Step 1

A

Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

Caution

Step 2

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.320 SF(E1)

>

Warning

>

Warning

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: E1l

An SF condition for an E1 occurs on a DS1/IE1-56 card in E1 only mode when the quality of the signal
has exceeded the BER signal failure threshold.

SF monitors the incoming BER error rate just as SD does, but SF is triggered at a higher BER than SD.
The SF BER threshold is user-provisionable and has a range for SF from 1E-5 dBm to 1E-3 dBm.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
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Clear the SF (E1) Condition

Step 1 Complete the “Clear the SD (E1) Condition” procedure on page 2-192.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.321 SF(TRUNK)

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.322 SF-L

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EC1, OCN

An SF Line condition is similar to the “SF (DS1, DS3)” condition on page 2-194, but it applies to the
line layer B2 overhead byte of the SONET signal. It can trigger a protection switch.

The SF-L condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The condition is superseded by higher-priority alarms such as the “LOF (EC1)” alarm on page 2-134,
the “LOS (EC1)” alarm on page 2-144, and the “LOS (OCN)” alarm on page 2-147.

Clear the SF-L Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.323 SF-P

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: STSMON, STSTRM

An SF Path condition is similar to the “SF (DS1, DS3)” condition on page 2-194, but it applies to the
path (STS) layer B3 byte of the SONET overhead. It can trigger a protection switch.
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The SF-P condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the SF-P Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.324 SFTWDOWN

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: EQPT

A Software Download in Progress alarm occurs when the TCC2/TCC2P is downloading or transferring
software.

If the active and standby TCC2/TCC2Ps have the same versions of software, it takes approximately three
minutes for software to be updated on a standby TCC2/TCC2P.

If the active and standby TCC2/TCC2Ps have different software versions, the transfer can take up to
30 minutes. Software transfers occur when different software versions exist on the two cards. After the
transfer completes, the active TCC2/TCC2P reboots and goes into standby mode after approximately
three minutes.

No action is necessary. Wait for the transfer or the software download to complete. If the alarm does not
clear, log into the Technical Support Website at http://www.cisco.com/techsupport for more information
or call Cisco TAC (1 800 553-2447).

~

Note SFTWDOWN is an informational alarm.

2.8.325 SF-V

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: VI-MON, VI-TERM

An SF-V condition is similar to the “SF (DS1, DS3)” condition on page 2-194, but it applies to the VT
layer of the SONET overhead.

Clear the SF-V Condition

Step 1 Complete the “Clear the SD (DS1, DS3) Condition” procedure on page 2-190.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.326 SH-INS-LOSS-VAR-DEG-HIGH

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.327 SH-INS-LOSS-VAR-DEG-LOW

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.328 SHUTTER-OPEN

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.329 SIGLOSS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR
DWDM Logical Objects: FC, GE, ISC, TRUNK

The Signal Loss on Data Interface alarm is raised on FC_MR-4 card receive client ports and MXP card
FC and ISC client data ports when there is a loss of signal. (Loss of Gigabit Ethernet client signal results
in a CARLOSS [GE], not SIGLOSS.) SIGLOSS can also be raised on the MXP trunk port.

If the SYNCLOSS alarm was previously raised on the port, the SIGLOSS alarm will demote it.
Clear the SIGLOSS Alarm

Step1  Ensure that the port connection at the near end of the SONET link is operational.
Step2  Verify fiber continuity to the port. To verify fiber continuity, follow site practices.

Step3  Check the physical port LED on the card. The port LED looks clear (that is, not lit green) if the link is
not connected.

Step4  If the alarm does not clear, log onto http://www.cisco.com/techsupport for more information or call
Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA) problem.
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2.8.330 SNTP-HOST

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: NE

The Simple Network Timing Protocol (SNTP) Host Failure alarm indicates that an ONS 15454 serving
as an IP proxy for the other ONS 15454 nodes in the ring is not forwarding SNTP information to the
other nodes in the network. The forwarding failure can result from two causes: either the IP network
attached to the ONS 15454 proxy node is experiencing problems, or the ONS 15454 proxy node itself is
not functioning properly.

Clear the SNTP-HOST Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Ping the SNTP host from a workstation in the same subnet to ensure that communication is possible
within the subnet by completing the “Verify PC Connection to the ONS 15454 (ping)” procedure on
page 1-124.

If the ping fails, contact the network administrator who manages the IP network that supplies the SNTP
information to the proxy and determine whether the network is experiencing problems, which could
affect the SNTP server/router connecting to the proxy ONS 15454 system.

If no network problems exist, ensure that the ONS system proxy is provisioned correctly:

a. In node view for the ONS 15454 serving as the proxy, click the Provisioning > General tabs.
b. Ensure that the Use NTP/SNTP Server check box is checked.

c. If the Use NTP/SNTP Server check box is not checked, click it.

d. Ensure that the Use NTP/SNTP Server field contains a valid IP address for the server.

If proxy is correctly provisioned, refer to the “Timing” chapter in the Cisco ONS 15454 Reference
Manual for more information on SNTP Host.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.331 SPAN-SW-EAST

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Span Switch Is Active East Side condition occurs when a span switch occurs at the east side of a
four-fiber BLSR span using a Force Span command. The condition clears when the switch is cleared.
SPAN-SW-EAST is visible on the network view Alarms, Conditions, and History tabs. The port where
the Force Span was applied shows an “F” on the network view detailed circuit map.

SPAN-SW-EAST is an informational condition and does not require troubleshooting.
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2.8.332 SPAN-SW-WEST

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Span Switch Is Active West Side condition occurs when a span switch occurs at the west side of a
four-fiber BLSR span using a Force Span command. The condition clears when the switch is cleared.
SPAN-SW-WEST is visible on the network view Alarms, Conditions, and History tabs. The port where
the Force Span was applied shows an “F” on the network view detailed circuit map.

~

Note  SPAN-SW-WEST is an informational condition and does not require troubleshooting.

2.8.333 SQUELCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN

The Ring Squelching Traffic condition occurs in a BLSR when a node that originates or terminates STS
circuits fails or is isolated by multiple fiber cuts or maintenance Force Ring commands. The isolation or
failure of the node disables circuits that originate or terminate on the failed node. SQUELCH conditions
appear on one or both of the nodes on either side of the isolated or failed node. The “AIS-P” condition
on page 2-33 also appears on all nodes in the ring except the isolated node.

>

Warning On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293.

>

Warning  Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

A

Warning Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the SQUELCH Condition
A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Determine the isolated node:
a. From the View menu, choose Go to Network View.

b. The grayed out node with red spans is the isolated node.

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |




| Chapter2 Alarm Troubleshooting

Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

Step 8

2.8.334 SQUELCHED W

Verify fiber continuity to the ports on the isolated node. To verify cable continuity, follow site practices.
If fiber continuity is good, verify that the proper ports are in service:
a. Confirm that the LED is correctly illuminated on the physical card.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

¢. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS.

e. If the Admin State column lists the port as OOS,MT or OOS,DSBLD, click the column and choose
IS. Click Apply.

If the correct ports are in service, use an optical test set to verify that a valid signal exists on the line.
For specific procedures to use the test set equipment, consult the manufacturer. Test the line as close to
the receiving card as possible.

If the signal is valid, verify that the power level of the optical signal is within the optical card receiver
specifications. Refer to the Cisco ONS 15454 Reference Manual for card specifications.

If the receiver levels are good, ensure that the optical transmit and receive fibers are connected properly.

If the connectors are good, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the OC-N card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.334 SQUELCHED

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: OCN
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Client Signal Squelched condition is raised by a TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, or MXPP_MR_2.5G card.

The condition can be raised in the following situations:

e An MXP or TXP client facility detects that an upstream receive facility has experienced a loss of
signal (such as an Ethernet CARLOSS, DWDM SIGLOSS, or optical LOS). In response, the
facility’s transmit is turned off (SQUELCHED). The upstream receive facilities are the trunk receive
on the same card as the client, as well as the client receive on the card at the other end of the trunk
span.

e The client will squelch if the upstream trunk receive (on the same card) experiences a SIGLOSS,
Ethernet CARLOSS, LOS, or LOS (TRUNK) alarm. In some transparent modes, the client is
squelched if the trunk detects an AIS condition or a TIM alarm.

e The client will squelch if the upstream client receive (on the card at the other end of the DWDM
span) experiences CARLOSS, SIGLOSS, or LOS.
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In an example situation, an upstream MXP_2.5G_10G client port receive experiences a “loss of light,”
and this port raises CARLOSS, SIGLOSS, or LOS (determined by the payload type) locally. The port
also sends client signal fail (GFP-CSF) to its downstream card. The downstream card raises a GFP-CSF
alarm, turns off the client transmit laser, and raises the SQUELCHED condition.

The local client raises SQUELCHED if it also raises one of the following alarms for the client, all of
which are signalled by the upstream node:

e 2.8.136 GFP-CSF, page 2-107

e 2.8.139 GFP-LFD, page 2-109

e 2.8.140 GFP-NO-BUFFERS, page 2-109

e 2.8.137 GFP-DE-MISMATCH, page 2-107
e 2.8.138 GFP-EX-MISMATCH, page 2-108
e 2.8.253 ODUK-1-AIS-PM, page 2-170

e 2.8.254 ODUK-2-AIS-PM, page 2-170

e 2.8.255 ODUK-3-AIS-PM, page 2-170

e 2.8.256 ODUK-4-AIS-PM, page 2-170

On the MXP_MR_10G, the local client raises a SQUELCHED condition if the upstream client detects
one of the following alarms. Note that no corresponding local alarm is raised to indicate which of these
conditions is present upstream.

e LOS for the clients including the “LOS (2R)” alarm on page 2-140, the “LOS (ESCON)” alarm on
page 2-146, and the “LOS (ISC)” alarm on page 2-146

e CARLOSS for the clients including the “CARLOSS (FC)” alarm on page 2-56, the “CARLOSS
(GE)” alarm on page 2-59, and the “CARLOSS (ISC)” alarm on page 2-59

The local client raises a SQUELCHED condition if the local trunk raises one of the following alarms:
e 2.8.275 OTUK-LOF, page 2-173
e 2.8.272 OTUK-AIS, page 2-173
e 2.8.201 LOS (TRUNK), page 2-148
e 2.8.278 OTUK-TIM, page 2-173 (squelching enabled)
e 2.8.257 ODUK-AIS-PM, page 2-170
e 2.8.259 ODUK-LCK-PM, page 2-170
e 2.8.263 ODUK-TIM-PM, page 2-171 (squelching enabled)
e 2.8.364 TIM, page 2-215 (for the OC-N, squelching enabled)
e 2.8.180 LOF (OCN), page 2-134
e 2.8.199 LOS (OCN), page 2-147
e 2.8.54 CARLOSS (TRUNK), page 2-60
e 2.8.393 WVL-MISMATCH, page 2-228 (client or trunk)

When troubleshooting the SQUELCHED condition locally, look for failures progressing upstream in the
following order. (If you are troubleshooting this alarm remotely, reverse the order of progress.)

e Local client alarms, as above
e Local trunk alarms, as above

e Remote (upstream) client receive alarms, as above

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |



| Chapter2 Alarm Troubleshooting

~

Note

28335 som W

If you see a SQUELCHED condition on the trunk, this can only be caused by a transponder (TXP) card.

Clear the SQUELCHED Condition

Step 1

Step 2

Step 3

Step 4

2.8.335 SOM

If the object is reported against any object besides ESCON, determine whether the remote node and local
node reports and LOF or the LOS alarm (for the client trunk, as listed above). If it does, turn to the
relevant section in this chapter and complete the troubleshooting procedure.

If no LOF or LOS is reported, determine whether any other listed remote node or local node conditions
as listed above has occurred. If so, turn to the relevant section of this chapter and complete the
troubleshooting procedure.

If none of these alarms is reported, determine whether the local port reporting the SQUELCHED
condition is in loopback. (You will see LPBKFACILITY OR LPBKTERMINAL in the condition window
for this port.) If it is in loopback, complete the following steps:

a. Double-click the client card to open the card view.
b. Click the Maintenance > Loopback > Port tabs.

c¢. If the port Admin State column says OOS,MT or OOS,DSBLD, click the cell to highlight it and
choose IS from the drop-down list. Changing the state to IS also clears any loopback provisioned on
the port.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Major (MJ),
Service-Affecting (SA) for VI-TERM

SONET Logical Objects: STSTRM, VI-TERM

The Sequence Mismatch alarm is a virtual concatenated (VCAT) member alarm. (VCAT member circuits
are independent circuits that are concatenated from different time slots into a higher-rate signal.) The
alarm occurs when the expected sequence numbers of VCAT members do not match the received
sequence numbers.

Clear the SOM Alarm

Step 1 For the errored circuit, complete the “Delete a Circuit” procedure on page 2-244.

Step2  Recreate the circuit using the “Create Circuits and VT Tunnels” chapter of the Cisco ONS 15454
Procedure Guide.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

Cisco ONS 15454 Troubleshooting Guide, R6.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

I 238336 SSM-DUS

2.8.336 SSM-DUS

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Objects: TRUNK

The Synchronization Status (SSM) Message Quality Changed to Do Not Use (DUS) condition occurs
when the synchronization status message (SSM) quality level degrades to DUS or is manually changed
to DUS.

The signal is often manually changed to DUS to prevent timing loops from occurring. Sending a DUS
prevents the timing from being reused in a loop. The DUS signal can also be sent for line maintenance
testing.

SSM-DUS is an informational condition and does not require troubleshooting.

2.8.337 SSM-FAIL

Single Failure Default Severity: Minor (MN), Non-Service-Affecting (NSA); Double Failure
Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The SSM Failed alarm occurs when the synchronization status messaging received by the ONS 15454
fails. The problem is external to the ONS 15454. This alarm indicates that although the ONS 15454 is
set up to receive SSM, the timing source is not delivering valid SSM messages.

Clear the SSM-FAIL Alarm

Step 1
Step 2

Step 3

Verify that SSM is enabled on the external timing source.

If timing is enabled, use an optical test set to determine that the external timing source is delivering SSM.
For specific procedures to use the test set equipment, consult the manufacturer.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.338 SSM-LNC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.339 SSM-OFF

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The SSM Off condition applies to references used for timing the node. It occurs when the SSM for the
reference has been turned off. The node is set up to receive SSM, but the timing source is not delivering
SSM messages.

Clear the SSM-OFF Condition

Step 1 Complete the “Clear the SSM-FAIL Alarm” procedure on page 2-204.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.340 SSM-PRC

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.341 SSM-PRS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Primary Reference Source (PRS) Traceable condition occurs when the SSM transmission level
is changed to Stratum 1 Traceable.

~

Note  SSM-PRS is an informational condition and does not require troubleshooting.

2.8.342 SSM-RES

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Objects: BITS, DS1, E1, NE-SREF, OCN

The SSM Reserved (RES) For Network Synchronization Use condition occurs when the synchronization
message quality level is changed to RES.

S

Note  SSM-RES is an informational condition and does not require troubleshooting.
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2.8.343 SSM-SDN-TN

The SSM-SDN-TN condition is not used in this platform in this release. It is reserved for future
development.

2.8.344 SSM-SETS

The SSM-SETS condition is not used in this platform in this release. It is reserved for future
development.

2.8.345 SSM-SMC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Objects: TRUNK

The SSM SONET Minimum Clock (SMC) Traceable condition occurs when the synchronization
message quality level changes to SMC. The login node does not use the clock because the node cannot
use any reference beneath its internal level, which is ST3.

~

Note  SSM-SMC is an informational condition and does not require troubleshooting.

2.8.346 SSM-ST2

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 2 (ST2) Traceable condition occurs when the synchronization message quality level
is changed to ST2.

~

Note  SSM-ST?2 is an informational condition and does not require troubleshooting.

2.8.347 SSM-ST3

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 3 (ST3) Traceable condition occurs when the synchronization message quality level
is changed to ST3.

~

Note  SSM-ST3 is an informational condition and does not require troubleshooting.
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2.8.348 SSM-ST3E

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 3E (ST3E) Traceable condition indicates that the synchronization message quality
level is changed to ST3E from a lower level of synchronization. SSM-ST3E is a Generation 2 SSM and
is used for Generation 1.

~

Note  SSM-ST3E is an informational condition and does not require troubleshooting.

2.8.349 SSM-ST4

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Stratum 4 (ST4) Traceable condition occurs when the synchronization message quality level
is lowered to ST4. The message quality is not used because it is below ST3.

~

Note  SSM-ST4 is an informational condition and does not require troubleshooting.

2.8.350 SSM-STU

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Synchronization Traceability Unknown (STU) condition occurs when the reporting node is
timed to a reference that does not support SSM, but the ONS 15454 has SSM support enabled. SSM-STU
can also occur if the timing source is sending out SSM messages but SSM is not enabled on the

ONS 15454.

Clear the SSM-STU Condition

Step 1 In node view, click the Provisioning > Timing > BITS Facilities tabs.
Step2  Complete one of the following depending upon the status of the Sync Messaging Enabled check box:
e If the Sync. Messaging Enabled check box for the BITS source is checked, uncheck the box.
e If the Sync. Messaging Enabled check box for the BITS source is not checked, check the box.
Step3  Click Apply.
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Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.351 SSM-TNC

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, NE-SREF, OCN
DWDM Logical Object: TRUNK

The SSM Transit Node Clock (TNC) Traceable condition occurs when the synchronization message
quality level is changed to TNC.

SSM-TNC is an informational condition and does not require troubleshooting.

2.8.352 SWMTXMOD-PROT

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Switching Matrix Module Failure on Protect Slot alarm is raised by the Slot 10 cross connect card
if this card is active (ACT). Any kind of cross-connect card can raise this alarm. (Two exceptions are
given in the following paragraph.) SWMTXMOD-PROT occurs when a logic component internal to the
Slot 10 cross connect is out of frame (OOF) with a traffic card in the system. In this case, the alarm is
raised against the traffic card slot.

The XC-VXC-10G card can raise this alarm (in Slot 10) whether itis ACT or standby (SBY). The XCVT
card can raise SWMTXMOD-PROT against itself if the cross-connect card is OOF with a second logic
component on the same cross connect card.

Clear the SWMTXMOD-PROT Alarm

Step 1

Step 2

Step 3

Step 4

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the Slot 10 card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242 for the Slot 10 cross-connect card.

Complete the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-240.

~

Note  After the active cross-connect card goes into standby mode, the original standby slot becomes
active. The former standby card ACT/SBY LED becomes green.
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Step 5

2.8.353 SWMTXMOD-WORK

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.353 SWMTXMOD-WORK

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: EQPT

The Switching Matrix Module Failure on Working Slot alarm is raised by the Slot 8 cross connect card
if this card is active (ACT). Any kind of cross-connect card can raise this alarm. (Two exceptions are
given in the following paragraph.) SWMTXMOD-WORK occurs when a logic component internal to the
Slot 8 cross connect is OOF with a traffic card in the system. In this case, the alarm is raised against the
traffic card slot.

The XC-VXC-10G card can raise this alarm (in Slot 8) whether it is ACT or standby (SBY). The XCVT
card can raise SWMTXMOD-WORK against itself if the cross-connect card is OOF with a second logic
component on the same cross connect card.

Clear the SWMTXMOD-WORK Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Complete the “Reset a Traffic Card in CTC” procedure on page 2-239 for the Slot 8 card. For the LED
behavior, see the “2.9.2 Typical Traffic Card LED Activity During Reset” section on page 2-229.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-242 for the Slot 8 cross-connect card.

Complete the “Side Switch the Active and Standby Cross-Connect Cards” procedure on page 2-240.

~

Note  After the active cross-connect card goes into standby mode, the original standby slot becomes
active. The former standby card ACT/SBY LED becomes green.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.354 SWTOPRI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Primary Reference condition occurs when the ONS 15454 switches to
the primary timing source (reference 1). The ONS 15454 uses three ranked timing references. The timing
references are typically two BITS-level or line-level sources and an internal reference.
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~

Note SWTOPRI is an informational condition and does not require troubleshooting.

2.8.355 SWTOSEC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Secondary Reference condition occurs when the ONS 15454 has
switched to a secondary timing source (reference 2).

Clear the SWTOSEC Condition

Step 1 To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-212.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.356 SWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Third Reference condition occurs when the ONS 15454 has switched to
a third timing source (reference 3).

Clear the SWTOTHIRD Condition

Step 1 To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-212 or the “SYNCSEC” alarm on page 2-212.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.357 SYNC-FREQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: BITS, DS1, E1, OCN
DWDM Logical Object: TRUNK

The Synchronization Reference Frequency Out of Bounds condition is reported against any reference
that is out of the bounds for valid references. The login node fails the reference and chooses another
internal or external reference to use.
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Clear the SYNC-FREQ Condition

Step 1

Step 2

Step 3

Use an optical test set to verify the timing frequency of the line or BITS timing source and ensure that
it falls within the proper frequency. For specific procedures to use the test set equipment, consult the
manufacturer.

For BITS, the proper timing frequency range is approximately —15 PPM to 15 PPM. For optical line
timing, the proper frequency range is approximately —16 PPM to 16 PPM.

If the reference source frequency is not outside of bounds, complete the “Physically Replace a Traffic
Card” procedure on page 2-242 for the TCC2/TCC2P.

S

Note It takes up to 30 minutes for the TCC2/TCC2P to transfer the system software to the newly
installed TCC2/TCC2P. Software transfer occurs in instances where different software versions
exist on the two cards. When the transfer completes, the active TCC2/TCC2P reboots and goes
into standby mode after approximately three minutes.

If the SYNC-FREQ condition continues to report after replacing the TCC2/TCC2P, log into the
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1 800 553-2447).

2.8.358 SYNCLOSS

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR
DWDM Logical Objects: FC, GE, ISC, TRUNK

The Loss of Synchronization on Data Interface alarm is raised on FC_MR-4 client ports and MXP cards
client or trunk ports when there is a loss of signal synchronization on the port. This alarm is demoted by
the SIGLOSS alarm.

Clear the SYNCLOSS Alarm

Step 1 Ensure that the data port connection at the near end of the SONET link is operational.
Step2  Verify fiber continuity to the port. To do this follow site practices.
Step3  View the physical port LED to determine whether the alarm has cleared:
e If the LED is green, the alarm has cleared.
e If the port LED is clear (that is, not illuminated green), the link is not connected and the alarm has
not cleared.
e [If the LED is red, this indicates that the fiber is pulled.
Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) to report a service-affecting problem.
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2.8.359 SYNCPRI

Default Severity: Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF
SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Primary Reference alarm occurs when the ONS 15454 loses the primary timing
source (reference 1). The ONS 15454 uses three ranked timing references. The timing references are
typically two BITS-level or line-level sources and an internal reference. If SYNCPRI occurs, the
ONS 15454 should switch to its secondary timing source (reference 2). Switching to the secondary
timing source also triggers the “SWTOSEC” alarm on page 2-210.

~

Note The SYNCPRI alarm will be escalated to Major (MJ), Service-Affecting if no other valid
references (SYNCSEC, SYNCTHIRD) are available. If any other reference are available
then SYNCPRI gets raised as Minor (MN), non service affecting.

Clear the SYNCPRI Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.
Step2  Verify the current configuration for REF-1 of the NE Reference.

Step3  If the primary timing reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure
on page 2-140.

Step4  If the primary reference clock is an incoming port on the ONS 15454, complete the “Clear the LOS
(OCN) Alarm” procedure on page 2-147.

Step5  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.360 SYNCSEC

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Secondary Reference alarm occurs when the ONS 15454 loses the secondary
timing source (reference 2). If SYNCSEC occurs, the ONS 15454 should switch to a third timing source
(reference 3) to obtain valid timing for the ONS 15454. Switching to a third timing source also triggers
the “SWTOTHIRD” alarm on page 2-210.

S,

Note The SYNCPRI alarm will be escalated to Major (MJ), Service-Affecting if no other valid
references (SYNCSEC, SYNCTHIRD) are available. If any other reference are available
then SYNCPRI gets raised as Minor (MN), non service affecting.

Clear the SYNCSEC Alarm

Step 1 In node view, click the Provisioning > Timing > General tabs.
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Step 2
Step 3

Step 4
Step 5

Step 6

2.8.361 SYNCTHIRD W

Verify the current configuration of REF-2 for the NE Reference.

If the secondary reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-140.

Verify that the BITS clock is operating properly.

If the secondary timing source is an incoming port on the ONS 15454, complete the “Clear the LOS
(OCN) Alarm” procedure on page 2-147.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.361 SYNCTHIRD

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Third Reference alarm occurs when the ONS 15454 loses the third timing source
(reference 3). If SYNCTHIRD occurs and the ONS 15454 uses an internal reference for source three,
the TCC2/TCC2P could have failed. The ONS 15454 often reports either the “FRNGSYNC” condition
on page 2-105 or the “HLDOVRSYNC” condition on page 2-116 after a SYNCTHIRD alarm.

S,

Note The SYNCPRI alarm will be escalated to Major (MJ), Service-Affecting if no other valid
references (SYNCSEC, SYNCTHIRD) are available. If any other reference are available
then SYNCPRI gets raised as Minor (MN), non service affecting.

Clear the SYNCTHIRD Alarm

Step 1
Step 2

Step 3

Step 4

A

In node view, click the Provisioning > Timing > General tabs.

Verify that the current configuration of REF-3 for the NE Reference. For more information about
references, refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual.

If the third timing source is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-140.

If the third timing source is an incoming port on the ONS 15454, complete the “Clear the LOS (OCN)
Alarm” procedure on page 2-147.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step5  If the third timing source uses the internal ONS 15454 timing, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-239.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.
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Step 6

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC

(1 800 553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-241. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Traffic
Card” procedure on page 2-242.

2.8.362 SYSBOOT

~

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: NE

The System Reboot alarm indicates that new software is booting on the TCC2/TCC2P. No action is
required. The alarm clears when all cards finish rebooting the new software. The reboot takes up to
30 minutes.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

SYSBOOT is an informational alarm. It only requires troubleshooting if it does not clear.

2.8.363 TEMP-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: NE

Temperature Reading Mismatch Between Control Cards is raised when the temperature readings on the
two TCC2/TCC2Ps are out of range of each other by more than some predefined difference (such as 5
degrees C). A message containing power monitoring and temperature information is exchanged between
the two TCC2/TCC2Ps, allowing the values to be compared. The temperature of each TCC2/TCC2P is
read from a system variable.

This condition can be caused by a clogged fan filter or by fan tray stoppage.

Clear the TEMP-MISM Condition

Step 1
Step 2

Step 3

Complete the “Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-247.

If the condition does not clear, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-248.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).
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2.8.364 TIM

28364 Tim W

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Object: OCN
DWDM Logical Object: TRUNK

The Section TIM alarm occurs when the expected JO section trace string does not match the received
section trace string. This occurs because the data being received is not correct, and the receiving port
could not be connected to the correct transmitter port.

If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed due to
a fibering misconnection, a TL1 routing change, or to someone entering an incorrect value in the Current
Transmit String field.

TIM occurs on a port that has previously been operating without alarms if someone switches optical
fibers that connect the ports. TIM is usually accompanied by other alarms, such as the “LOS (OCN)”
alarm on page 2-147 or the “UNEQ-P” alarm on page 2-223. If these alarms accompany a TIM alarm,
reattach or replace the original cables/fibers to clear the alarms. If a Transmit or Expected String was
changed, restore the original string.

Clear the TIM Alarm

Step 1

Ensure that the physical fibers are correctly configured and attached. To do this, consult site documents.
For more information about cabling the ONS 15454, refer to the “Install Cards and Fiber-Optic Cable”
chapter in the Cisco ONS 15454 Procedure Guide.

Step2  If the alarm does not clear, you can compare the JO expected and transmitted strings and, if necessary,

change them:

a. Log into the circuit source node and click the Circuits tab.

b. Select the circuit reporting the condition, then click Edit.

¢. In the Edit Circuit window, check the Show Detailed Circuit Map check box and click Apply.

d. On the detailed circuit map, right-click the source circuit port and choose Edit JO Path Trace (port)
from the shortcut menu.

e. Compare the Current Transmit String and the Current Expected String entries in the Edit JO Path
Trace dialog box.

f. If the strings differ, correct the Transmit or Expected strings and click Apply.

g. Click Close.

Step3  If the alarm does not clear, ensure that the signal has not been incorrectly routed. (Although the
ONS 15454 routes circuits automatically, the circuit route could have been changed using TL1.) If
necessary, manually correct the routing using TL1. For instructions, refer to the Cisco ONS SONET TLI
Reference Guide and the Cisco SONET TL1 Command Guide .

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem if necessary.
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2.8.365 TIM-MON

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Objects: OCN
DWDM Logical Object: TRUNK

The TIM Section Monitor TIM alarm is similar to the “TIM-P” alarm on page 2-216, but it applies to
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, and MXP_2.5G_10G cards when
they are configured in transparent mode. (In transparent termination mode, all SONET overhead bytes
are passed through from client ports to the trunk ports or from trunk ports to client ports.)

Note For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.

Clear the TIM-MON Alarm

Step1  Complete the “Clear the TIM-P Alarm” procedure on page 2-216.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).

2.8.366 TIM-P

Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Default Severity:
Minor (MN), Non-Service-Affecting (NSA) for STSMON

SONET Logical Objects: STSMON, STSTRM

The TIM Path alarm occurs when the expected path trace string does not match the received path trace
string. Path Trace Mode must be set to Manual or Auto for the TIM-P alarm to occur.

In manual mode at the Path Trace window, the user types the expected string into the Current Expected
String field for the receiving port. The string must match the string typed into the Transmit String field
for the sending port. If these fields do not match, the login node raises the TIM-P alarm. In Auto mode
on the receiving port, the card sets the expected string to the value of the received string. If the alarm
occurs on a port that has been operating with no alarms, the circuit path has changed or someone entered
a new incorrect value into the Current Transmit String field. Complete the following procedure to clear
either instance.

Clear the TIM-P Alarm

Step 1 Complete the “Clear the TIM Alarm” procedure on page 2-215. (The option will say “Edit J1 Path Trace”
rather than “Edit JO Path Trace.”)

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447). If the alarm applies to the STSTRM object,
it is Service-Affecting (SA).
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2.8.367 TIM-S

Note

28367 TiM-s W

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: EC1, OCN

The TIM for Section Overhead alarm occurs when there is a mismatch between the expected and
received JO section overhead strings in either Manual or Auto mode.

In manual mode at the DS3/EC1-48 card Section Trace window, the user enters the expected string into
the Current Expected String field for the receiving port. The string must match the string typed into the
Transmit String field for the sending port. If these fields do not match, the login node raises the TIM-S
alarm.

In Auto mode on the receiving port, the card sets the expected string to the value of the received string.
If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or
someone entered a new incorrect value into the Current Transmit String field. Complete the following
procedure to clear either problem.

TIM-S also occurs on a port that has previously been operating without alarms if someone switches the
cables or optical fibers that connect the ports. If TIM-S is enabled on the port, the “AIS-L” alarm on
page 2-32 can be raised downstream and the “RFI-L” alarm on page 2-184 can be raised upstream.

AIS-L and RFI-L are disabled or enabled in the Provisioning > EC1 > Section Trace tab Disable
AIS/RDI on TIM-S? check box.

Clear the TIM-S Alarm

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

2.8.368 TIM-V

Double-click the DS3/EC1-48 card to open the card view.

Click the Provisioning > EC1 > Section Trace tabs.

Choose the port from the Port pull-down.

In the Expected area, enter the correct string into the Current Expected String field.
Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447). If the alarm applies to the STSTRM object,
it is Service-Affecting (SA).

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: VI-TERM

The VT Path TIM alarm is raised on VT terminations when the J2 path trace is enabled and is
mismatched with the expected trace string.
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Clear the TIM-V Alarm

Step 1 Complete the “Clear the TIM Alarm” procedure on page 2-215.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) to report a service-affecting problem.

2.8.369 TPTFAIL (CE100T)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: CE100T

The Transport (TPT) Layer Failure alarm for the CE-100T-8 card indicates a break in the end-to-end
Ethernet link integrity feature of the ONS 15454 CE-100T-8 card. TPTFAIL indicates a far-end
condition and not a problem with the port reporting TPTFAIL. TPTFAIL may also occurs on local ports
with LCAS-enabled CE-100T-8 cards.

Fte For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the TPTFAIL (CE100T) Alarm

Step 1 Complete the “Clear the TPTFAIL (G1000) Alarm” procedure on page 2-219.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) to report a Service-Affecting (SA) problem.

2.8.370 TPTFAIL (FCMR)

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: FCMR

The Transport Fail alarm is raised against a local Fibre Channel (FC) port on an FC_MR-4 card when
the portreceives another SONET error such as AIS-P, LOP-P, UNEQ-P, PLM-P, TIM-P, LOM (for VCAT
only), or SQM (for VCAT only).

This TPTFAIL can be raised against Fibre Channel cards if the remote FC card port is down from
SIGLOSS or SYNCLOSS. In that case, the remote FC card port sends a PDI-P error code in the SONET
C2 byte and signals the local FC port transmitter to turn off (thus causing the local FC port to raise the
TPTFAIL alarm). A TPTFAIL can also be raised when a far-end receive fiber is pulled. This alarm can
be demoted when a facility loopback is placed on the FC_MR-4 port.
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2.8.371 TPTFAIL(G1000)

Clear the TPTFAIL (FCMR) Alarm

Step 1

Step 2

Find and clear any path alarms applying to the port. Refer to the correct section of this chapter for trouble
clearing instructions. Clearing the path alarm also clears the TPTFAIL.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.3711 TPTFAIL (G1000)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Object: G1000

The Transport Layer Failure alarm for the G-Series Ethernet card indicates a break in the end-to-end
Ethernet link integrity feature of the ONS 15454 G1000-4 cards. TPTFAIL indicates a far-end condition
and not a problem with the port reporting TPTFAIL.

The TPTFAIL alarm indicates a problem on either the SONET path or the remote Ethernet port that
prevents the complete end-to-end Ethernet path from working. If any SONET path alarms such as the
“AIS-P” alarm on page 2-33, the “LOP-P” alarm on page 2-137, the “PDI-P” alarm on page 2-174, or
the “UNEQ-P” alarm on page 2-223 exist on the SONET path used by the Ethernet port, the affected port
causes a TPTFAIL alarm. Also, if the far-end G1000-4 port Ethernet port is administratively disabled or
it is reporting the “CARLOSS (G1000)” alarm on page 2-56, the C2 byte in the SONET path overhead
indicates the “PDI-P” alarm on page 2-174, which in turn causes a TPTFAIL to be reported against the
near-end port.

When a TPTFAIL alarm occurs, the near-end port is automatically disabled (transmit laser turned off).
In turn, the laser shutoff can also cause the external Ethernet device attached at the near end to detect a
link down and turn off its transmitter. This also causes a CARLOSS alarm to occur on the reporting port.
In all cases, the source problem is either in the SONET path being used by the G1000-4 port or the far-
end G1000-4 port to which it is mapped.

An occurrence of TPTFAIL on an ONS 15454 G1000-4 port indicates either a problem with the SONET
path that the port is using or with the far-end G1000-4 port that is mapped to the port.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the TPTFAIL (G1000) Alarm

Step 1
Step 2

Clear any alarms being reported by the OC-N card on the G1000-4 circuit.

If no alarms are reported by the OC-N card, or if the “PDI-P” condition on page 2-174 is reported, the
problem could be on the far-end G1000-4 port. Clear any alarms, such as CARLOSS, reported against
the far-end port or card.
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.372 TPTFAIL (ML100T, ML1000, MLFX)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: ML100T, ML1000, MLFX

The TPT Layer Failure alarm for the ML-Series Ethernet card indicates a break in the end-to-end
packet-over-SONET (POS) link integrity feature of the ML-Series POS cards. TPTFAIL indicates a
far-end condition or misconfiguration of the POS port.

The TPTFAIL alarm indicates a problem on the SONET path, a problem on the remote POS port, or a
misconfiguration of the POS port that prevents the complete end-to-end POS path from working. If any
SONET path alarms such as the “AIS-P” condition on page 2-33, the “LOP-P” alarm on page 2-137, the
“PDI-P” condition on page 2-174, or the “UNEQ-P” alarm on page 2-223 exist on the circuit used by the
POS port, the affected port could report a TPTFAIL alarm. If the far-end ML POS port is
administratively disabled, it inserts an “AIS-P” condition on page 2-33 that is detected by the near-end
port. The near-end port could report TPTFAIL in this event. If the POS port is misconfigured at the
Cisco IOS CLI level, the misconfiguration causes the port to go down and report TPTFAIL.

For more information about the ML-Series Ethernet cards, refer to the Ethernet Card Software Feature
and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the TPTFAIL (ML100T, ML1000, MLFX) Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

If there are no SONET alarms reported against the POS port circuit, verify that both POS ports are
properly configured. Refer to the Ethernet Card Sofiware Feature and Configuration Guide for the
Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327 for configuration information.

If the “PLM-P” alarm on page 2-176 is the only one reported against the POS port circuit, verify that
both POS ports are properly configured. Refer to the Ethernet Card Software Feature and Configuration
Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327 for configuration
information.

If the “PDI-P” condition on page 2-174 is the only one reported against the POS port circuit and the
circuit is terminated by a G-Series card, determine whether a “CARLOSS (G1000)” alarm on page 2-56
is reported against the G-Series card, and if so, complete the “Clear the CARLOSS (G1000) Alarm”
procedure on page 2-57.

If the “AIS-P” alarm on page 2-33, the “LOP-P” alarm on page 2-137, or the “UNEQ-P” alarm on
page 2-223 is present, clear those alarms using the procedures in those sections.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |



| Chapter2 Alarm Troubleshooting

28373 TRMT H

2.8.3713 TRMT

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: DS1, E1

A Missing Transmitter alarm occurs when there is a transmit failure on the ONS 15454 DS-1 card
because of an internal hardware failure. The card must be replaced.

Clear the TRMT Alarm

Step 1 Complete the “Physically Replace a Traffic Card” procedure on page 2-242 for the reporting DS-1 card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.374 TRMT-MISS

Default Severity: Major (MJ), Service-Affecting (SA)

SONET Logical Objects: DS1, E1
A Facility Termination Equipment Transmitter Missing alarm occurs when the facility termination
equipment detects an incorrect amount of impedance on its backplane connector. Incorrect impedance is
detected when a transmit cable is missing on the DS-1 port or the backplane does not match the inserted

card. For example, an SMB connector or a BNC connector could be connected to a DS-1 card instead of
a DS-3 card.

~

Note  DS-Is are four-wire circuits and need a positive and negative connection for both transmit and receive.

Clear the TRMT-MISS Alarm

Step 1 Verify that the device attached to the DS-1 port is operational.

Step2  If the device is operational, verify that the cabling is securely connected.
Step3  If the cabling is secure, verify that the pinouts are correct.

Step4  If the pinouts are correct, replace the transmit cable.

Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.375 TX-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
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SONET Logical Objects: DS1, DS3, El

The (TX) Transmit Direction AIS condition is raised by the ONS 15454 backplane when it receives a
far-end DS-1 LOS.

Clear the TX-AIS Condition

Step1  Determine whether there are alarms on the downstream nodes and equipment, especially the “LOS
(OCN)” alarm on page 2-147, or OOS ports.

Step2  Clear the downstream alarms using the applicable procedures in this chapter.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.376 TX-LOF

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, E1
The Transmit Direction LOF condition is transmitted by the backplane when it receives a DS-1 TX-LOF.

This alarm is raised only at the transmit (egress) side.

Clear the TX-LOF Condition

Step1  Complete the “Clear the LOF (DS1) Alarm” procedure on page 2-132.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.377 TX-RAI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: DS1, DS3, El

The Transmit Direction RAI condition is transmitted by the backplane when it receives a DS-1 TX-AIS.
This alarm is raised only at the transmit side, but RAI is raised at both ends.

Clear the TX-RAI Condition

Step1  Complete the “Clear the TX-AIS Condition” procedure on page 2-222.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).
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2.8.378 UNC-WORD

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.379 UNEQ-P

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: STSMON, STSTRM

An SLMF UNEQ Path alarm occurs when the path does not have a valid sender. The UNEQ-P indicator
is carried in the C2 signal path byte in the SONET overhead. The source of the problem is the node that
is transmitting the signal into the node reporting the UNEQ-P.

The alarm could result from a PARTTAL circuit or an empty VT tunnel. UNEQ-P occurs in the node that
terminates a path.

Note Ifa newly created circuit has no signal, a UNEQ-P alarm is reported on the OC-N cards and the “AIS-P”
condition on page 2-33 is reported on the terminating cards. These alarms clear when the circuit carries
a signal.

A

Caution  Deleting a circuit affects traffic.

Clear the UNEQ-P Alarm

Step 1 In node view, choose Go to Network View from the View menu.
Step2  Right-click the alarm to display the Select Affected Circuits shortcut menu.
Step3  Click Select Affected Circuits.

Step4  When the affected circuits appear, look in the Type column for VTT, which indicates a VT tunnel circuit.
A VT tunnel with no VTs assigned could be the cause of an UNEQ-P alarm.

Step5  If the Type column does not contain VTT, there are no VT tunnels connected with the alarm. Go to
Step 7.

Step6  If the Type column does contain VTT, attempt to delete these rows:

~

Note  The node does not allow you to delete a valid VT tunnel or one with a valid VT circuit inside.

a. Click the VT tunnel circuit row to highlight it. Complete the “Delete a Circuit” procedure on
page 2-244.

b. If an error message dialog box appears, the VT tunnel is valid and not the cause of the alarm.
c. If any other rows contain VTT, repeat Step 6.
Step7  If all nodes in the ring appear in the CTC network view, determine whether the circuits are complete:
a. Click the Circuits tab.
b. Verify that PARTIAL is not listed in the Status column of any circuits.
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Step 8

Step 9

Step 10

Step 11

Step 12

A

Warning

A

Warning

A

Warning

A

If you find circuits listed as PARTIAL, use an optical test set to verify that these circuits are not working
circuits that continue to pass traffic. For specific procedures to use the test set equipment, consult the
manufacturer.

If the PARTIAL circuits are not needed or are not passing traffic, delete the PARTIAL circuits.
Complete the “Delete a Circuit” procedure on page 2-244.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide.

Log back in and verify that all circuits terminating in the reporting card are active:
a. Click the Circuits tab.
b. Verify that the Status column lists all circuits as active.

If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Caution

Step 13

Step 14

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the alarm does not clear, complete the “Physically Replace a Traffic Card” procedure on page 2-242
for the OC-N and electrical cards.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.380 UNEQ-V

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: VI-MON, VI-TERM
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>

Warning

>

Warning

A

2.8.381 UNREACHABLE-TARGET-POWER W

An SLMF UNEQ VT alarm indicates that the node is receiving SONET path overhead with Bits 5, 6,
and 7 of the V5 overhead byte all set to zeroes. The source of the problem is not the node raising the
alarm, but the node transmitting the VT signal to it. The V in UNEQ-V indicates that the failure has
occurred at the VT layer.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
Clear the UNEQ-V Alarm
Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-223.
Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.8.381 UNREACHABLE-TARGET-POWER

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the

Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.382 UT-COMM-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the

Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R6.0 gy



Chapter2  Alarm Troubleshooting |

Il 238383 UT-FAIL

2.8.383 UT-FAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.384 VCG-DEG

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: VCG

The VCAT Group Degraded alarm is a VCAT group alarm. (VCATSs are groups of independent circuits
that are concatenated from different time slots into higher-rate signals.) The alarm occurs when one
member circuit carried by the ML-Series Ethernet card is down. This alarm is accompanied by the
“O0U-TPT” alarm on page 2-171. It only occurs when a Critical (CR) alarm, such as LOS, causes a
signal loss.

Fte For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the VCG-DEG Condition

Step1  Look for and clear any Critical (CR) alarms that apply to the errored card, such as the “LOS (2R)” alarm
on page 2-140 or “LOS (OTS)” alarm on page 2-148.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.385 VCG-DOWN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: VCG

The VCAT Group Down alarm is a VCAT group alarm. (VCATSs are groups of independent circuits that
are concatenated from different time slots into higher-rate signals.) The alarm occurs when both member
circuits carried by the ML-Series Ethernet card are down. This alarm occurs in conjunction with another
Critical (CR) alarm, such as the “LOS (2R)” alarm on page 2-140.

Fte For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the VCG-DOWN Condition

Step 1 Complete the “Clear the VCG-DEG Condition” procedure on page 2-226.
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2.8.386 VOA-HDEG

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.386 VOA-HDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.387 VOA-HFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.388 VOA-LDEG

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.389 VOA-LFAIL

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.

2.8.390 VOLT-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Object: PWR

The Power Monitoring Mismatch Between Control Cards alarm is raised against the shelf when the
power voltages of both TCC2/TCC2Ps are out of range of each other by more than 5 VDC.

Clear the VOLT-MISM Condition

Step1  Check the incoming voltage level to the shelf using a voltmeter. Follow site practices or refer to the
“Install the Shelf and Backplane Cable” chapter in the Cisco ONS 15454 Procedure Guide for power
installation procedures.

Step2  Correct any incoming voltage issues.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).
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2.8.391 WKSWPR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN, STSMON, VI-MON
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Working Switched To Protection condition occurs when a line experiences the “LOS (OCN)” alarm
on page 2-147, the “SD (DS1, DS3)” condition on page 2-190, or the “SD (TRUNK)” condition on
page 2-193.

This condition is also raised when you use the FORCE SPAN, FORCE RING or MANUAL SPAN
command at the network level. WKSWPR is visible on the network view Alarms, Conditions, and
History tabs.

Clear the WKSWPR Condition

Step 1 Complete the “Clear the LOS (OCN) Alarm” procedure on page 2-147.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.8.392 WTR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
SONET Logical Objects: EQPT, OCN, STSMON, VI-MON
DWDM Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK

The Wait To Restore condition occurs when the “WKSWPR” condition on page 2-228 is raised, but the
wait-to-restore time has not expired, meaning that the active protect path cannot revert to the working
path. The condition clears when the timer expires and traffic switches back to the working path.

A

Caution  DS-1 traffic loss can occur on a DS-1 with 1:N protection if a DS-1 card is reset with the protect card in
the WTR state.

~

Note  WTR is an informational condition and does not require troubleshooting.

2.8.393 WVL-MISMATCH

For information about this alarm or condition, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 DWDM Troubleshooting Guide. This guide discusses all DWDM alarms.
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2.9 Traffic Card LED Activity

ONS 15454 traffic card LED behavior patterns are listed in the following sections. These sections give
behavior for card insertion, reset, and side-switch.

2.9.1 Typical Traffic Card LED Activity After Insertion

When a non-DWDM card is inserted, the following LED activities occur:

1. The red FAIL LED turns on and remains illuminated for 20 to 30 seconds.
The red FAIL LED blinks for 35 to 45 seconds.

All LEDs blink once and turn off for 5 to 10 seconds.

The ACT or ACT/SBY LED turns on. The SF LED can persist until all card ports connect to their
far-end counterparts and a signal is present.

& w0 D

2.9.2 Typical Traffic Card LED Activity During Reset

While a non-DWDM card resets, the following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.

2. The white LED with the letters “LDG” appears on the reset card in CTC.
3. The green ACT LED appears in CTC.

2.9.3 Typical Card LED State After Successful Reset

When a non-DWDM card successfully resets, the following LED states are present:
e If you are looking at the physical ONS 15454, the ACT/SBY LED is illuminated.

e If you are looking at node view of the ONS 15454, the current standby card has an amber LED
depiction with the initials “SBY,” and this has replaced the white “LDG” depiction on the card in
CTC.

e Ifyouare looking at node view of the ONS 15454, the current active card has a green LED depiction
with the initials “ACT,” and this has replaced the white “LDG” depiction on the card in CTC.

2.9.4 Typical Cross-Connect LED Activity During Side Switch

While an XC10G card is switched in CTC from active (ACT) to standby (SBY) or from SBY to ACT,
the following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.
2. The standby card yellow SBY LED becomes a green ACT LED, indicating it is now active.
3. The active card green ACT LED becomes a yellow SBY LED, indicating it is now standby.
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2.10 Frequently Used Alarm Troubleshooting Procedures

This section gives common procedures that are frequently used when troubleshooting alarms. Most of
these procedures are summarized versions of fuller procedures existing elsewhere in the ONS 15454
documentation. They are included in this chapter for the user’s convenience. For further information,
please refer to the Cisco ONS 15454 Procedure Guide.

2.10.1 Node and Ring ldentification, Change, Visibility, and Termination

The following procedures relate how to identify or change BLSR names and node IDs, and how to verify
visibility from other nodes.

Identify a BLSR Ring Name or Node ID Number

Step1  Log into a node on the network.
Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Stepd  From the Ring Name column, record the ring name, or in the Nodes column, record the Node IDs in the
BLSR. The Node IDs are the numbers in parentheses next to the node name.

Change a BLSR Ring Name

Step 1 Log into a node on the network.

Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Step4  Highlight the ring and click Edit.

Step 5 In the BLSR window, enter the new name in the Ring Name field.
Step6  Click Apply.

Step7  Click Yes in the Changing Ring Name dialog box.

Change a BLSR Node ID Number

Step 1 Log into a node on the network.

Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Step4  Highlight the ring and click Edit.

Step5 In the BLSR window, right-click the node on the ring map.
Step6  Select Set Node ID from the shortcut menu.
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2.10.2 Protection Switching, Lock Initiation, and Clearing

Step7 In the Edit Node ID dialog box, enter the new ID. The Node ID is the number in parentheses after the
Node Name.

Step8  Click OK.

Verify Node Visibility for Other Nodes

Step 1 Log into a node on the network.

Step2  In node view, click the Provisioning > BLSR tabs.
Step3  Highlight a BLSR.

Stepd  Click Ring Map.

Step5 In the BLSR Ring Map window, verify that each node in the ring appears on the ring map with a node
ID and IP address.

Step6  Click Close.

2.10.2 Protection Switching, Lock Initiation, and Clearing

The following sections give instructions for port, ring, and span switching and switch-clearing
commands, as well as lock-ons and lockouts.

Initiate a 1+1 Protection Port Force Switch Command

This procedure switches 1+1 protection group traffic from one port in the group to the other using a
Force switch.

A

Caution  The Force command overrides normal protective switching mechanisms. Applying this command
incorrectly can cause traffic outages.

A

Caution  Traffic is not protected during a Force protection switch.

~

Note A Force command switches traffic on a working path even if the path has signal degrade (SD) or signal
fail (SF) conditions. A Force switch does not switch traffic on a protect path. A Force switch preempts
a Manual switch.

Step 1 In node view, click the Maintenance > Protection tabs.
Step2  In the Protection Groups area, select the protection group with the port you want to switch.

Step3  In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
Protect/Standby port, click this port.
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Step 4
Step 5
Step 6

In the Switch Commands area, click Force.
Click Yes in the Confirm Force Operation dialog box.

If the switch is successful, the group says “Force to working” in the Selected Groups area.

Initiate a 1+1 Manual Switch Command

~

Note

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

This procedure switches 1+1 protection group traffic from one port in the group to the other using a
Manual switch.

A Manual command switches traffic if the path has an error rate less than the signal degrade. A Manual
switch is preempted by a Force switch.

In node view, click the Maintenance > Protection tabs.
In the Protection Groups area, select the protection group with the port you want to switch.

In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
protect/standby port, click this port.

In the Switch Commands area, click Manual.
Click Yes in the Confirm Force Operation dialog box.

If the switch is successful, the group now says “Manual to working” in the Selected Groups area.

Clear a 1+1 Force or Manual Switch Command

~

Note

Note

Step 1
Step 2
Step 3
Step 4
Step 5

If the 1+1 protection group is configured as revertive, clearing a Force switch to protect (or working)
moves traffic back to the working port. In revertive operation, the traffic always switches back to
working. There is no revert to the protect. If ports are not configured as revertive, clearing a Force switch
to protect does not move traffic back.

If the Force Switch was user-initiated, the reversion occurs immediately when the clear command is
issued. The five-minute WTR period is not needed in this case. If the Force was system-initiated, allow
the five-minute waiting period (during WTR) before the reversion occurs.

In node view, click the Maintenance > Protection tabs.

In the Protection Groups area, choose the protection group containing the port you want to clear.
In the Selected Group area, choose the port you want to clear.

In the Switching Commands area, click Clear.

Click Yes in the Confirmation Dialog box.
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The Force switch is cleared. Traffic immediately reverts to the working port if the group was configured
for revertive switching.

Initiate a Lock-On Command

~

Note  For 1:1 and 1:N electrical protection groups, working or protect cards can be placed in the Lock On state.
For a 1+1 optical protection group, only the working port can be placed in the Lock On state.

Step 1 In node view, click the Maintenance > Protection tabs.
Step2  In the Protection Groups list, click the protection group where you want to apply a lock-on.

Step3  If you determine that the protect card is in standby mode and you want to apply the lock-on to the protect
card, make the protect card active if necessary:

a. In the Selected Group list, click the protect card.

b. In the Switch Commands area, click Force.
Step4  In the Selected Group list, click the active card where you want to lock traffic.
Step 5 In the Inhibit Switching area, click Lock On.
Step6  Click Yes in the confirmation dialog box.

Initiate a Card or Port Lockout Command

S

Note  For 1:1 or I:N electrical protection groups, working or protect cards can be placed in the Lock Out state.
For a 1+1 optical protection group, only the protect port can be placed in the Lock Out state.

Step 1 In node view, click the Maintenance > Protection tabs.

Step2  In the Protection Groups list, click the protection group that contains the card you want to lockout.
Step3  In the Selected Group list, click the card where you want to lock out traffic.

Step 4 In the Inhibit Switching area, click Lock Out.

Step5  Click Yes in the confirmation dialog box.

The lockout has been applied and traffic is switched to the opposite card.

Clear a Lock-On or Lockout Command

Step 1 In node view, click the Maintenance > Protection tabs.
Step2 In the Protection Groups list, click the protection group that contains the card you want to clear.

Step3  In the Selected Group list, click the card you want to clear.
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Step 4
Step 5

In the Inhibit Switching area, click Unlock.
Click Yes in the confirmation dialog box.

The lock-on or lockout is cleared.

Initiate a 1:1 Card Switch Command

~

Note

Step 1
Step 2
Step 3
Step 4

The Switch command only works on the Active card, whether it is working or protect. It does not work
on the Standby card.

In node view, click the Maintenance > Protection tabs.

Click the protection group that contains the card you want to switch.
Under Selected Group, click the active card.

Next to Switch Commands, click Switch.

The working slot should change to Working/Active and the protect slot should change to
Protect/Standby.

Initiate a Force Switch for All Circuits on a Path Protection Span

A

This procedure forces all circuits in a path protection from the working span to the protect. It is used to
remove traffic from a card that originates or terminates path protection circuits.

Caution

A

The Force command overrides normal protective switching mechanisms. Applying this command
incorrectly can cause traffic outages.

Caution

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7
Step 8

Traffic is not protected during a Force protection switch.

Log into a node on the network.
In node view, choose Go to Network View from the View menu.
Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Click the Perform UPSR span switching field.
Choose Force Switch Away from the drop-down list.
Click Apply.

In the Confirm UPSR Switch dialog box, click Yes.
In the Protection Switch Result dialog box, click OK.
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In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do
not switch.

Initiate a Manual Switch for All Circuits on a Path Protection Span

A

This procedure manually switches all circuits in a path protection from the working span to the protect.
It is used to remove traffic from a card that originates or terminates path protection circuits.

Caution

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6
Step 7

The Manual command does not override normal protective switching mechanisms.

Log into a node on the network.
Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Click the Perform UPSR span switching field.
Choose Manual from the drop-down list.

Click Apply.

In the Confirm UPSR Switch dialog box, click Yes.
In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Manual. Unprotected circuits do
not switch.

Initiate a Lockout for All Circuits on a Protect Path Protection Span

A

This procedure prevents all circuits in a path protection working span from switching to the protect span.
It is used to keep traffic off cards that originate or terminate path protection circuits.

Caution  The Lock Out of Protect command does not override normal protective switching mechanisms.
Step1  Log into a node on the network. If you are already logged in, continue with Step 2.
Step2  Right-click a network span and choose Circuits.
The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.
Step3  Click the Perform UPSR span switching field.
Stepd  Choose Lock Out of Protect from the drop-down list.
Step5  Click Apply.
Step 6 In the Confirm UPSR Switch dialog box, click Yes.
Step 7 In the Protection Switch Result dialog box, click OK.
Cisco ONS 15454 Troubleshooting Guide, R6.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

I 2.10.2 Protection Switching, Lock Initiation, and Clearing

In the Circuits on Span dialog box, the switch state for all circuits is FORCE. Unprotected circuits do
not switch.

Clear an External Switching Command on a Path Protection Span

~

Note

Step 1
Step 2

Step 3

If the ports terminating a span are configured as revertive, clearing a Force switch on a protect port
moves traffic back to the working port. If ports are not configured as revertive, clearing a Force switch
does not move traffic back.

Log into a node on the network. If you are already logged in, continue with Step 2.
Right-click a network span and choose Circuits.

The Circuits on Span dialog box shows the path protection circuits, including circuit names, locations,
and a color code showing which circuits are active on the span.

Initiate a Force switch for all circuits on the span:

a. Click the Perform UPSR span switching field.

b. Choose Clear from the drop-down list.

c¢. Click Apply.

d. In the Confirm UPSR Switch dialog box, click Yes.

e. In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the switch state for all circuits is Clear. Unprotected circuits do
not switch.

Initiate a Force Ring Switch on a BLSR

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Log into a node on the network. If you are already logged in, continue with Step 2.

From the View menu choose Go to Network View.

In network view, click the Provisioning > BLSR tabs.

Click the row of the BLSR you are switching, then click Edit.

Right-click a BLSR node west port and choose Set West Protection Operation.

In the Set West Protection Operation dialog box, choose Force Ring from the drop-down list.
Click OK.

Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

Initiate a Force Span Switch on a Four-Fiber BLSR

Step 1

Log into a node on the network.
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Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

2.10.2 Protection Switching, Lock Initiation, and Clearing

From the View menu choose Go to Network View.

In network view, click the Provisioning > BLSR tabs.

Click the row of the BLSR you are switching, then click Edit.

Right-click a BLSR node west port and choose Set West Protection Operation.

In the Set West Protection Operation dialog box, choose Force Span from the drop-down list.
Click OK.

Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

Initiate a Manual Span Switch on a BLSR

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

From the View menu, choose Go to Network View.
Click the Provisioning > BLSR tabs.
Choose the BLSR and click Edit.

Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Manual Span from the drop-down list.

Click OK.
Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate a Manual Ring Switch on a BLSR

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

From the View menu, choose Go to Network View.
Click the Provisioning > BLSR tabs.
Choose the BLSR and click Edit.

Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Manual Ring from the drop-down list.

Click OK.
Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate a Lockout on a BLSR Protect Span

Step 1 From the View menu choose Go to Network View.
Step2  Click the Provisioning > BLSR tabs.
Cisco ONS 15454 Troubleshooting Guide, R6.0
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Step3  Choose the BLSR and click Edit.

Step4  Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

Step5  In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Lockout Protect Span from the drop-down list.

Step6  Click OK.
Step7  Click Yes in the two Confirm BLSR Operation dialog boxes.

Initiate an Exercise Ring Switch on a BLSR

Step1  Log into a node on the network.

Step2  Click View > Go to Network View.

Step3  Click the Provisioning > BL.SR tabs.

Step4  Click the row of the BLSR you are exercising, then click Edit.

Step5  Right-click the west port of a node and choose Set West Protection Operation.

Step6  In the Set West Protection Operation dialog box, choose Exercise Ring from the drop-down list.
Step7  Click OK.

Step8  Click Yes in the Confirm BLSR Operation dialog box.

Initiate an Exercise Ring Switch on a Four Fiber BLSR

Step1  Log into a node on the network.

Step2  From the View menu, choose Go to Network View.

Step3  Click the Provisioning > BLSR tabs.

Step4  Click the row of the BLSR you are exercising, then click Edit.

Step5  Right-click the west port of a node and choose Set West Protection Operation.

Step6  In the Set West Protection Operation dialog box, choose Exercise Span from the drop-down list.
Step7  Click OK.

Step8  Click Yes in the Confirm BLSR Operation dialog box.

Clear a BLSR External Switching Command

Step 1 Log into a node on the network.
Step2  From the View menu, choose Go to Network View.
Step3  Click the Provisioning > BLSR tabs.
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Step 4
Step 5

Step 6
Step 7
Step 8

2.10.3 CTC Card Resetting and Switching 1l

Click the BLSR you want to clear.

Right-click the west port of the BLSR node where you invoked the switch and choose Set West
Protection Operation.

In the Set West Protection Operation dialog box, choose Clear from the drop-down list.
Click OK.
Click Yes in the Confirm BLSR Operation dialog box.

2.10.3 CTC Card Resetting and Switching

A

This section gives instructions for resetting traffic cards, TCC2/TCC2Ps, and cross-connect cards.

Caution

For TXP and MXP cards placed in a Y-cable protection group, do not perform a software reset on both
cards simultaneously. Doing so will cause a traffic hit of more than one minute. For more information
about Y-cable protection groups, refer to the Cisco ONS 15454 DWDM Installation and Operations
Guide.

Resetting the active card in a Y-cable group will cause a traffic outage if the standby card is down for
any reason.

When an AIC-I card is rest in CTC, any subsequent user client operations (such as CTC or TL1 activity)
is paused for approximately 5-10 seconds. The reset does not cause any conditions to be raised.

For more information about MXP and TXP cards, refer to the Cisco ONS 15454 DWDM Installation and
Operations Guide.

Reset a Traffic Card in CTC

Step 1
Step 2
Step 3
Step 4

Log into a node on the network. If you are already logged in, continue with Step 2.

In node view, position the cursor over the optical or electrical traffic card slot reporting the alarm.
Right-click the card. Choose Reset Card from the shortcut menu.

Click Yes in the Resetting Card dialog box.

Reset an Active TCC2/TCC2P Card and Activate the Standby Card

A

Caution

Resetting an active TCC2/TCC2P can be service-affecting.

| November 2009

Cisco ONS 15454 Troubleshooting Guide, R6.0 gy



Chapter2  Alarm Troubleshooting |

I 2.10.3 CTC Card Resetting and Switching

~

Note

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change
you made to avoid losing any changes to the database.

Log into a node on the network. If you are already logged in, continue with Step 2.
Identify the active TCC2/TCC2P:

If you are looking at the physical ONS 15454 shelf, the ACT/SBY LED of the active card is green. The
ACT/STBLY LED of the standby card is amber.

Right-click the active TCC2/TCC2P in CTC.
Choose Reset Card from the shortcut menu.
Click Yes in the Confirmation Dialog box.

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. For LED
appearance, see the “2.9.3 Typical Card LED State After Successful Reset” section on page 2-229.

Double-click the node and ensure that the reset TCC2/TCC2P is in standby mode and that the other
TCC2/TCC2P is active. Verify the following:

e If you are looking at the physical ONS 15454 shelf, the ACT/SBY LED of the active card is green.
The ACT/STBLY LED of the standby card is amber.

e No new alarms appear in the Alarms window in CTC.

Side Switch the Active and Standby Cross-Connect Cards

A

Caution

Step 1

Step 2
Step 3

Step 4
Step 5
Step 6

The cross-connect card side switch is usually service-affecting.

Log into a node on the network. For instructions regarding how to log into a node, refer Cisco ONS 15454
Procedure Guide, Release 8.0. If you are already logged in, continue with Step 2.

Display node view.
Determine the active or standby XC10G card.
The ACT/SBY LED of the active card is green. The ACT/SBY LED of the standby card is amber.

~

Note  You can also position the cursor over the card graphic to display a popup identifying the card as
active or standby.

In node view, click the Maintenance > Cross-Connect > Cards tabs.
Click Switch.

Click Yes in the Confirm Switch dialog box. See the “2.9.4 Typical Cross-Connect LED Activity During
Side Switch” section on page 2-229 for LED information.
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Note  During a maintenance side switch or soft reset of an active XC10G card, the 1+1 protection
group might display a protection switch. To disallow the protection switch from being displayed,
the protection group should be locked at the node where XC switch or soft reset of an active XC
switch is in progress.

A

Caution  Active cross connect (XC10G/XCVT) cards should not be physically removed.

The following rules must be followed for removing an Active Cross Connect Card (XC10G/XCVT):

If the active cross connect has to be removed, perform an XCVT/XC10G side switch to change the status
of the card from active to standby and then remove the cross connect card once it goes back to standby.

OR

Perform a lockout on all circuits that originate from the node whose active cross connect card has to be
removed (performing a lockout on all spans will also accomplish the same goal).

2.10.4 Physical Card Reseating, Resetting, and Replacement

A

This section gives instructions for physically reseating and replacing TCC2/TCC2P, cross-connect, and
traffic cards.

Caution

Do not physically replace a card without first making provisions to switch or move traffic to a different
card or circuit. General procedures for this are located in the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231. In-depth traffic switching procedures and information
can be found in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card

A

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

A

Do not perform this action without the supervision and direction of Cisco TAC (1 800 553-2447).

Caution

~

Note

The TCC2/TCC2P reseat could be service-affecting. Refer to the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231 for traffic-switching procedures.

Before you reset the TCC2/TCC2P, you should wait at least 60 seconds after the last provisioning change
you made to avoid losing any changes to the database.
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~

Note

Step 1

Step 2

Step 3
Step 4

When a standby TCC2/TCC2P card is removed and reinserted (reseated), all three fan lights could
momentarily turn on, indicating that the fans have also reset.

Log into a node on the network.

Ensure that the TCC2/TCC2P you want to reseat is in standby mode. A standby card has an amber
ACT/SBY (Active/Standby) LED illuminated.

When the TCC2/TCC2P is in standby mode, unlatch both the top and bottom ejectors on the
TCC2/TCC2P.

Physically pull the card at least partly out of the slot until the lighted LEDs turn off.
Wait 30 seconds. Reinsert the card and close the ejectors.

>
Note  The TCC2/TCC2P requires several minutes to reboot and display the amber standby LED after

rebooting. Refer to the Cisco ONS 15454 Reference Manual for more information about LED
behavior during a card reboot.

Remove and Reinsert (Reseat) Any Card

A

Caution

Step 1
Step 2
Step 3
Step 4

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Open the card ejectors.
Slide the card halfway out of the slot along the guide rails.
Slide the card all the way back into the slot along the guide rails.

Close the ejectors.

Physically Replace a Traffic Card

A

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.10.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-231 for commonly used traffic-switching procedures.

When you replace a card with the identical type of card, you do not need to make any changes to the
database.
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Step1  Open the card ejectors.

Step2  Slide the card out of the slot.

Step3  Open the ejectors on the replacement card.

Step4  Slide the replacement card into the slot along the guide rails.

Step5  Close the ejectors.

Physically Replace an In-Service Cross-Connect Card

A

Caution  The cross-connect reseat could be service-affecting. Refer to the “2.10.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-231 for traffic-switching procedures prior to completing this
procedure.

~

Note  This procedure is placed in the chapter as a quick guide for the user’s convenience. A more detailed
procedure is located in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

When you replace a card with the identical type of card, you do not need to make any changes to the
database.

Step 1 Determine the active cross-connect card (XCVT/XC10G/XC-VXC-10G). The ACT/SBY LED of the
active card is green. The ACT/SBY LED of the standby card is amber.

~

Note  You can also place the cursor over the card graphic to display a popup identifying the card as
active or standby.

Step2  Switch the active cross-connect card to standby:
a. In the node view, click the Maintenance > Cross-Connect tabs.
b. Under Cross Connect Cards, choose Switch.
¢. Click Yes in the Confirm Switch dialog box.

~

Note  After the active cross-connect card becomes standby, the original standby slot becomes active.
This causes the ACT/SBY LED to become green on the former standby card.

Step3  Physically remove the new standby cross-connect card from the ONS 15454.

~

Note  An improper removal IMPROPRMVL) alarm is raised when a card reseat is performed, unless
the card is first deleted in Cisco Transport Controller (CTC). The alarm clears after the card is
replaced.

Step4d  Insert the replacement cross-connect card into the empty slot.
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The replacement card boots up and becomes ready for service after approximately one minute.

2.10.5 Generic Signal and Circuit Procedures

This section gives instructions for verify BER thresholds, deleting circuits, provisioning SDCC
terminations, and clearing loopbacks.

Verify the Signal BER Threshold Level

Step 1 Log into a node on the network.
Step2  In node view, double-click the card reporting the alarm to open the card view.
Step3  Click the Provisioning > Line tabs.

Step4  Under the SD BER (or SF BER) column in the Provisioning window, verify that the cell entry is
consistent with the originally provisioned threshold. The default setting is 1E-7.

Step5  If the entry is consistent with the original provisioning, go back to your original procedure.

Step6  If the entry is not consistent with what the system was originally provisioned for, click the cell to reveal
the range of choices and click the original entry.

Step7  Click Apply.

Delete a Circuit

Step1  Log into a node on the network.

Step 2 In node view, click the Circuits tab.

Step3  Click the circuit row to highlight it and click Delete.
Stepd  Click Yes in the Delete Circuits dialog box.

Verify or Create Node Section DCC Terminations

~

Note  Portions of this procedure are different for ONS 15454 DWDM nodes.

Step 1 Log into a node on the network.
Step2 In node view, click the Provisioning > Comm Channels > SDCC tab.

Step3  View the Port column entries to see where terminations are present for a node. If terminations are
missing, proceed to Step 4.

Step 4 If necessary, create a DCC termination:

a. Click Create.
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b. In the Create SDCC Terminations dialog box, click the ports where you want to create the DCC
termination. To select more than one port, press the Shift key.

c. In the port state area, click the Set to IS radio button.
d. Verify that the Disable OSPF on Link check box is unchecked.
e. Click OK.

Clear an OC-N Card Facility or Terminal Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > Loopback > Port tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

In the Admin State column, determine whether any port row shows a state other than IS.

If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.

Click Apply.

Clear an OC-N Card Cross-Connect (XC) Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.
Click the Maintenance > Loopback > SONET STS tabs.
Uncheck the XC Loopback check box.

Click Apply.

Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit

Step 1 Log into a node on the network.

Step2  Double-click the reporting card in CTC to open the card view.

Step3  Click the Maintenance > DS3 tabs or the Maintenance > DS1 tabs.

Step4  In the Loopback Type column, determine whether any port row shows a state other than None.

Step5 If a row contains another state besides None, click in the column cell to display the drop-down list and

select None.

Step6  In the Admin State column, determine whether any port row shows a state other than IS.

Step7  If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.
| November 2009
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Step 8

Click Apply.

Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

This procedure does not apply to DS3XM-6 or DS3XM-12 cards.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > Loopback tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

In the Admin State column, determine whether any port row shows a state other than IS.

If a row shows a state other than IS, click in the column cell to display the drop-down list and select IS.

Click Apply.

Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Step 8

Log into a node on the network.

Double-click the reporting card in CTC to open the card view.

Click the Maintenance > Loopback tabs.

In the Loopback Type column, determine whether any port row shows a state other than None.

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

In the Admin State column, determine whether any port row shows an admin state other than IS, for
example, OOS,MT.

If a row shows an admin state other than IS, click in the column cell to display the drop-down list and
select IS.

Click Apply.
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2.10.6 Air Filter and Fan Procedures

This section gives instructions for cleaning or replacing the air filter and reseating or replacing the fan
tray assembly.

Inspect, Clean, and Replace the Reusable Air Filter

A

Warning

A

To complete this task, you need a vacuum cleaner or detergent and water faucet, a spare filter, and a
pinned hex key.

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Although the filter works if it is installed with either side facing up, Cisco recommends that you install
it with the metal bracing facing up to preserve the surface of the filter.

Caution

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6

Step 7

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell,
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later
versions of the ONS 15454 use a reusable air filter.

If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being
careful not to dislodge any dust that could have collected on the filter. If the filter is installed beneath
the fan tray and not in the external filter brackets, open and remove the front door assembly by
completing the following steps:

a. Open the front door of the shelf assembly by completing the following substeps.(If it is already open
or if the shelf assembly does not have a front door, continue with Step 3.)

¢ Open the front door lock.
e Press the door button to release the latch.
e Swing the door open.

b. Remove the front door by completing the following substeps (optional):
e Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.
e Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.
e Secure the dangling end of the ground strap to the door or chassis with tape.

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that could have
collected on the filter.

Visually inspect the air filter material for dirt and dust.
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Step 8

Step 9

A

If the reusable air filter has a concentration of dirt and dust, either vacuum or wash the air filter. Prior to
washing the air filter, replace the dirty air filter with a clean air filter and also reinsert the fan-tray
assembly. Wash the dirty air filter under a faucet with a light detergent.

Spare ONS 15454 filters should be kept in stock for this purpose.

a~

Note  Cleaning should take place outside the operating environment to avoid releasing dirt and dust
near the equipment.

If you washed the filter, allow it to completely air dry for at least eight hours.

Caution

Step 10

Step 11

A

Do not put a damp filter back in the ONS 15454.

If the air filter should be installed in the external filter brackets, slide the air filter all the way to the back
of the brackets to complete the procedure.

If the filter should be installed beneath the fan-tray assembly, remove the fan-tray assembly and slide the
air filter into the recessed compartment at the bottom of the shelf assembly. Put the front edge of the air
filter flush against the front edge of the recessed compartment. Push the fan tray back into the shelf
assembly.

Caution

Step 12

Step 13
Step 14

If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and
readjust the position of the reusable filter until the fan tray fits correctly.

~

Note  On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly
inserted.

To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray
assembly is activated and displays node information.

Rotate the retractable handles back into their compartments.

Replace the door and reattach the ground strap.

Remove and Reinsert a Fan-Tray Assembly

Step 1

Step 2
Step 3

Use the retractable handles embedded in the front of the fan-tray assembly to pull it forward several
inches.

Push the fan-tray assembly firmly back into the ONS 15454.

Close the retractable handles.
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Replace the Fan-Tray Assembly

A

Caution

A

The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that does not
allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution

A

Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or
the connectors on the backplane.

Caution

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities.

Open the front door of the shelf assembly by completing the following steps. If the shelf assembly does
not have a front door, continue with Step 3.

a. Open the front door lock.

b. Press the door button to release the latch.

¢. Swing the door open.

Remove the front door (optional):

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.
b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.
¢. Secure the dangling end of the ground strap to the door or chassis with tape.

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Fold out the retractable handles at the outside edges of the fan tray.

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket, you can slide
the existing air filter out of the bracket and replace it at anytime. For more information on the fan-tray
air filter, see the “Inspect, Clean, and Replace the Reusable Air Filter” section on page 2-247.

Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into
the corresponding receptacle on the backplane.

To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is
activated.
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Step10 If you replace the door, be sure to reattach the ground strap.

2.10.7 Interface Procedures

This section includes instructions for replacing an EIA and an AIP.

Replace the Electrical Interface Assembly

~

Note  You need a #2 Phillips screwdriver. If you use high-density BNC EIAs, you also need a BNC insertion
and removal tool.

Step 1 To remove the lower backplane cover, loosen the five screws that secure it to the ONS 15454 and pull it
away from the shelf assembly.

Step2  Loosen the nine perimeter screws that hold the backplane sheet metal cover or EIA in place. Do not
remove the interior screws.

If you are removing an AMP Champ EIA, remove the fastening plate before proceeding. To remove the
fastening plate, loosen the two thumbscrews.

Step3  If a backplane cover is attached to the ONS 15454, lift the panel by the bottom to remove it from the
shelf assembly and store the panel for later use.

Step4  If an EIA is attached to the ONS 15454, lift the EIA handles and gently pull it away from the backplane.

~

Note  Attach backplane sheet metal covers whenever EIAs are not installed.

Step5  Line up the connectors on the new EIA with the mating connectors on the backplane.

Step6  Gently push the EIA until both sets of connectors fit together snugly.

Step7  Replace the nine perimeter screws that you removed while removing the backplane cover.
Step8  If you are installing an AMP Champ EIA, attach the fastening plate with the two thumbscrews.
Step9  Reattach the lower backplane cover.

Replace the Alarm Interface Panel

A

Caution Do not use a 2A AIP with a 5A fan-tray assembly; doing so causes a blown fuse on the AIP.

A

Caution  If any nodes in an Ethernet circuit are not using Software R4.0 or later, there is a risk of Ethernet traffic
disruptions. Contact Cisco TAC at 1 800 553-2447 when prompted to do so in the procedure.
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Perform this procedure during a maintenance window. Resetting the active TCC2/TCC2P can cause a
service disruption of less then 50 ms to OC-N or DS-N traffic. Resetting the active TCC2/TCC2P can
cause a service disruption of 3 to 5 minutes on all Ethernet traffic due to spanning tree reconvergence if
any nodes in the Ethernet circuit are not using Software R4.0 or later.

Caution

A

Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and
result in a loss of data. For assistance with AIP replacement contact Cisco TAC (1 800 553-2447).

Caution

Step 1

Step 2

Step 3

Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

This procedure replaces an existing AIP with a new AIP on an in-service node without affecting traffic.
Ethernet circuits that traverse nodes with a software release prior to R4.0 is affected.

You need a #2 Phillips screwdriver.

Ensure that all nodes in the affected network are running the same software version before replacing the
AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each
node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade
document for procedures. No hardware should be changed or circuit repair performed until after the
software upgrade is complete. If you do not need to upgrade software or have completed the software
upgrade, proceed to Step 2.

Record the MAC address of the old AIP:

a. Log into the node where you are replacing the AIP. For login procedures, refer to the “Connect the
PC and Log into the GUI” chapter in the Cisco ONS 15454 Procedure Guide.

b. In node view, click the Provisioning > Network > General tabs.
¢. Record the MAC address.

Call Cisco TAC (1 800 553-2447) for assistance in replacing the AIP and maintaining the original MAC
address.

Unscrew the five screws that hold the lower backplane cover in place.

Grip the lower backplane cover and gently pull it away from the backplane.
Unscrew the two screws that hold the AIP cover in place.

Grip the cover and gently pull away from the backplane.

~

Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.

Grip the AIP and gently pull it away from the backplane.

Disconnect the fan-tray assembly power cable from the AIP.
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Step 10

A

Set the old AIP aside for return to Cisco.

Caution

A

The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP,
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149)
shelves and earlier use the 2A AIP (P/N: 73-5262-01).

Caution

Step 11
Step 12
Step 13
Step 14
Step 15

A

Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD
(P/N: 800-24848) shelf; doing so causes a blown fuse on the AIP.

Attach the fan-tray assembly power cable to the new AIP.

Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.
Replace the AIP cover over the AIP and secure the cover with the two screws.

Replace the lower backplane cover and secure the cover with the five screws.

In node view, click the Provisioning > Network tabs.

Caution

Step 16

Step 17

Step 18
Step 19

Step 20

Step 21
Step 22

Step 23

Step 24

Cisco recommends TCC2/TCC2P resets be performed in a maintenance window to avoid any potential
service disruptions.

Reset the standby TCC2/TCC2P:
a. Right-click the standby TCC2/TCC2P and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears
on the card in CTC.The reset takes approximately five minutes. Do not perform any other steps until
the reset is complete.

Reset the active TCC2/TCC2P:
a. Right click the active TCC2/TCC2P and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a Ldg indication appears on the card
in CTC. The reset takes approximately five minutes and CTC loses its connection with the node.

From the File drop-down list, choose Exit to exit the CTC session.

Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down
list.

Record the new MAC address:

a. In node view, click the Provisioning > Network > General tabs.

b. Record the MAC address.

In node view, click the Circuits tab. Note that all circuits listed are PARTIAL.

In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box
appears.

Read the instructions in the Circuit Repair dialog box. If all the steps in the dialog box have been
completed, click Next. Ensure that you have the old and new MAC addresses.

The Node MAC Addresses dialog box appears. Complete the following steps:

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.
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b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 2.
c. Click Next.
Step25 The Repair Circuits dialog box appears. Read the information in the dialog box and click Finish.

The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes or more
depending on the number of circuits provisioned on it.

When the circuit repair is complete, the Circuits Repaired dialog box appears.
Step26 Click OK.

Step 27 In the node view of the new node, click the Circuits tab. Note that all circuits listed are DISCOVERED.
If all circuits listed do not have a DISCOVERED status, call the Cisco TAC (1 800 553-2447) to open a
Return Material Authorization (RMA).

Cisco ONS 15454 Troubleshooting Guide, R6.0
| November 2009 .m



Chapter2  Alarm Troubleshooting |

I 2107 Interface Procedures

Cisco ONS 15454 Troubleshooting Guide, R6.0
m‘ November 2009 |



	Alarm Troubleshooting
	2.1 Alarm Indexes by Default Severity
	2.1.1 Critical Alarms (CR)
	2.1.2 Major Alarms (MJ)
	2.1.3 Minor Alarms (MN)
	2.1.4 NA Conditions
	2.1.5 NR Conditions

	2.2 Alarms and Conditions Listed By Alphabetical Entry
	2.3 Alarm Logical Objects
	2.4 Alarm List by Logical Object Type
	2.5 DS3-12 E Line Alarms
	2.6 Trouble Notifications
	2.6.1 Alarm Characteristics
	2.6.2 Condition Characteristics
	2.6.3 Severities
	2.6.4 Alarm Hierarchy
	2.6.5 Service Effect
	2.6.6 States

	2.7 Safety Summary
	2.8 Alarm Procedures
	2.8.1 AIS
	Clear the AIS Condition

	2.8.2 AIS-L
	Clear the AIS-L Condition

	2.8.3 AIS-P
	Clear the AIS-P Condition

	2.8.4 AIS-V
	Clear the AIS-V Condition

	2.8.5 ALS
	2.8.6 AMPLI-INIT
	2.8.7 APC-CORRECTION-SKIPPED
	2.8.8 APC-DISABLED
	2.8.9 APC-END
	2.8.10 APC-OUT-OF-RANGE
	2.8.11 APSB
	2.8.12 APSCDFLTK
	Clear the APSCDFLTK Alarm

	2.8.13 APSC-IMP
	Clear the APSC-IMP Alarm

	2.8.14 APSCINCON
	Clear the APSCINCON Alarm

	2.8.15 APSCM
	Clear the APSCM Alarm

	2.8.16 APSCNMIS
	Clear the APSCNMIS Alarm

	2.8.17 APSIMP
	Clear the APSIMP Alarm

	2.8.18 APS-INV-PRIM
	2.8.19 APSMM
	Clear the APSMM Alarm

	2.8.20 APS-PRIM-FAC
	Clear the APS-PRIM-FAC Condition

	2.8.21 APS-PRIM-SEC-MISM
	Clear the APS-PRIM-SEC-MISM Alarm

	2.8.22 AS-CMD
	Clear the AS-CMD Condition

	2.8.23 AS-MT
	Clear the AS-MT Condition

	2.8.24 AS-MT-OOG
	2.8.25 AUD-LOG-LOSS
	Clear the AUD-LOG-LOSS Condition

	2.8.26 AUD-LOG-LOW
	2.8.27 AU-LOF
	2.8.28 AUTOLSROFF
	Clear the AUTOLSROFF Alarm

	2.8.29 AUTORESET
	Clear the AUTORESET Alarm

	2.8.30 AUTOSW-AIS
	Clear the AUTOSW-AIS Condition

	2.8.31 AUTOSW-LOP (STSMON)
	Clear the AUTOSW-LOP (STSMON) Condition

	2.8.32 AUTOSW-LOP (VT-MON)
	Clear the AUTOSW-LOP (VT-MON) Condition

	2.8.33 AUTOSW-PDI
	Clear the AUTOSW-PDI Condition

	2.8.34 AUTOSW-SDBER
	Clear the AUTOSW-SDBER Condition

	2.8.35 AUTOSW-SFBER
	Clear the AUTOSW-SFBER Condition

	2.8.36 AUTOSW-UNEQ (STSMON)
	Clear the AUTOSW-UNEQ (STSMON) Condition

	2.8.37 AWG-DEG
	2.8.38 AWG-FAIL
	2.8.39 AWG-OVERTEMP
	2.8.40 AWG-WARM-UP
	2.8.41 BAT-FAIL
	Clear the BAT-FAIL Alarm

	2.8.42 BKUPMEMP
	Clear the BKUPMEMP Alarm

	2.8.43 BLSROSYNC
	Clear the BLSROSYNC Alarm

	2.8.44 BLSR-SW-VER-MISM
	Clear the BLSR-SW-VER-MISM Alarm

	2.8.45 BPV
	Clear the BPV Alarm

	2.8.46 CARLOSS (CE100T)
	Clear the CARLOSS (CE100T) Alarm

	2.8.47 CARLOSS (E100T, E1000F)
	Clear the CARLOSS (E100T, E1000F) Alarm

	2.8.48 CARLOSS (EQPT)
	Clear the CARLOSS (EQPT) Alarm

	2.8.49 CARLOSS (FC)
	2.8.50 CARLOSS (G1000)
	Clear the CARLOSS (G1000) Alarm

	2.8.51 CARLOSS (GE)
	2.8.52 CARLOSS (ISC)
	2.8.53 CARLOSS (ML100T, ML1000, MLFX)
	Clear the CARLOSS (ML100T, ML1000, MLFX) Alarm

	2.8.54 CARLOSS (TRUNK)
	2.8.55 CASETEMP-DEG
	2.8.56 CLDRESTART
	Clear the CLDRESTART Condition

	2.8.57 COMIOXC
	Clear the COMIOXC Alarm

	2.8.58 COMM-FAIL
	Clear the COMM-FAIL Alarm

	2.8.59 CONTBUS-A-18
	Clear the CONTBUS-A-18 Alarm

	2.8.60 CONTBUS-B-18
	Clear the CONTBUS-B-18 Alarm

	2.8.61 CONTBUS-DISABLED
	Clear the CONTBUS-DISABLED Alarm

	2.8.62 CONTBUS-IO-A
	Clear the CONTBUS-IO-A Alarm

	2.8.63 CONTBUS-IO-B
	Clear the CONTBUS-IO-B Alarm

	2.8.64 CTNEQPT-MISMATCH
	Clear the CTNEQPT-MISMATCH Condition

	2.8.65 CTNEQPT-PBPROT
	Clear the CTNEQPT-PBPROT Alarm

	2.8.66 CTNEQPT-PBWORK
	Clear the CTNEQPT-PBWORK Alarm

	2.8.67 DATAFLT
	Clear the DATAFLT Alarm

	2.8.68 DBOSYNC
	Clear the DBOSYNC Alarm

	2.8.69 DS3-MISM
	Clear the DS3-MISM Condition

	2.8.70 DSP-COMM-FAIL
	2.8.71 DSP-FAIL
	2.8.72 DUP-IPADDR
	Clear the DUP-IPADDR Alarm

	2.8.73 DUP-NODENAME
	Clear the DUP-NODENAME Alarm

	2.8.74 EHIBATVG
	Clear the EHIBATVG Alarm

	2.8.75 ELWBATVG
	Clear the ELWBATVG Alarm

	2.8.76 ENCAP-MISMATCH-P
	Clear the ENCAP-MISMATCH-P Alarm

	2.8.77 EOC
	Clear the EOC Alarm

	2.8.78 EOC-L
	Clear the EOC-L Alarm

	2.8.79 EQPT
	Clear the EQPT Alarm

	2.8.80 EQPT-DIAG
	Clear the EQPT-DIAG Alarm

	2.8.81 EQPT-MISS
	Clear the EQPT-MISS Alarm

	2.8.82 ERFI-P-CONN
	Clear the ERFI-P-CONN Condition

	2.8.83 ERFI-P-PAYLD
	Clear the ERFI-P-PAYLD Condition

	2.8.84 ERFI-P-SRVR
	Clear the ERFI-P-SRVR Condition

	2.8.85 ERROR-CONFIG
	Clear the ERROR-CONFIG Alarm

	2.8.86 ETH-LINKLOSS
	Clear the ETH-LINKLOSS Condition

	2.8.87 E-W-MISMATCH
	Clear the E-W-MISMATCH Alarm with a Physical Switch
	Clear the E-W-MISMATCH Alarm in CTC

	2.8.88 EXCCOL
	Clear the EXCCOL Alarm

	2.8.89 EXERCISE-RING-FAIL
	Clear the EXERCISE-RING-FAIL Condition

	2.8.90 EXERCISE-SPAN-FAIL
	Clear the EXERCISE-SPAN-FAIL Condition

	2.8.91 EXT
	Clear the EXT Alarm

	2.8.92 EXTRA-TRAF-PREEMPT
	Clear the EXTRA-TRAF-PREEMPT Alarm

	2.8.93 FAILTOSW
	Clear the FAILTOSW Condition

	2.8.94 FAILTOSW-PATH
	Clear the FAILTOSW-PATH Condition in a Path Protection Configuration

	2.8.95 FAILTOSWR
	Clear the FAILTOSWR Condition in a BLSR Configuration

	2.8.96 FAILTOSWS
	Clear the FAILTOSWS Condition

	2.8.97 FAN
	Clear the FAN Alarm

	2.8.98 FC-NO-CREDITS
	Clear the FC-NO-CREDITS Alarm

	2.8.99 FE-AIS
	Clear the FE-AIS Condition

	2.8.100 FEC-MISM
	2.8.101 FE-DS1-MULTLOS
	Clear the FE-DS1-MULTLOS Condition

	2.8.102 FE-DS1-NSA
	Clear the FE-DS1-NSA Condition

	2.8.103 FE-DS1-SA
	Clear the FE-DS1-SA Condition

	2.8.104 FE-DS1-SNGLLOS
	Clear the FE-DS1-SNGLLOS Condition

	2.8.105 FE-DS3-NSA
	Clear the FE-DS3-NSA Condition

	2.8.106 FE-DS3-SA
	Clear the FE-DS3-SA Condition

	2.8.107 FE-EQPT-NSA
	Clear the FE-EQPT-NSA Condition

	2.8.108 FE-FRCDWKSWBK-SPAN
	Clear the FE-FRCDWKSWBK-SPAN Condition

	2.8.109 FE-FRCDWKSWPR-RING
	Clear the FE-FRCDWKSWPR-RING Condition

	2.8.110 FE-FRCDWKSWPR-SPAN
	Clear the FE-FRCDWKSWPR-SPAN Condition

	2.8.111 FE-IDLE
	Clear the FE-IDLE Condition

	2.8.112 FE-LOCKOUTOFPR-SPAN
	Clear the FE-LOCKOUTOFPR-SPAN Condition

	2.8.113 FE-LOF
	Clear the FE-LOF Condition

	2.8.114 FE-LOS
	Clear the FE-LOS Condition

	2.8.115 FE-MANWKSWBK-SPAN
	Clear the FE-MANWKSWBK-SPAN Condition

	2.8.116 FE-MANWKSWPR-RING
	Clear the FE-MANWKSWPR-RING Condition

	2.8.117 FE-MANWKSWPR-SPAN
	Clear the FE-MANWKSWPR-SPAN Condition

	2.8.118 FEPRLF
	Clear the FEPRLF Alarm on a Four-Fiber BLSR

	2.8.119 FIBERTEMP-DEG
	2.8.120 FORCED-REQ
	Clear the FORCED-REQ Condition

	2.8.121 FORCED-REQ-RING
	Clear the FORCED-REQ-RING Condition

	2.8.122 FORCED-REQ-SPAN
	Clear the FORCED-REQ-SPAN Condition

	2.8.123 FRCDSWTOINT
	2.8.124 FRCDSWTOPRI
	2.8.125 FRCDSWTOSEC
	2.8.126 FRCDSWTOTHIRD
	2.8.127 FRNGSYNC
	Clear the FRNGSYNC Condition

	2.8.128 FSTSYNC
	2.8.129 FULLPASSTHR-BI
	Clear the FULLPASSTHR-BI Condition

	2.8.130 GAIN-HDEG
	2.8.131 GAIN-HFAIL
	2.8.132 GAIN-LDEG
	2.8.133 GAIN-LFAIL
	2.8.134 GCC-EOC
	2.8.135 GE-OOSYNC
	2.8.136 GFP-CSF
	Clear the GFP-CSF Alarm

	2.8.137 GFP-DE-MISMATCH
	Clear the GFP-DE-MISMATCH Alarm

	2.8.138 GFP-EX-MISMATCH
	Clear the GFP-EX-MISMATCH Alarm

	2.8.139 GFP-LFD
	Clear the GFP-LFD Alarm

	2.8.140 GFP-NO-BUFFERS
	Clear the GFP-NO-BUFFERS Alarm

	2.8.141 GFP-UP-MISMATCH
	Clear the GFP-UP-MISMATCH Alarm

	2.8.142 HELLO
	Clear the HELLO Alarm

	2.8.143 HIBATVG
	Clear the HIBATVG Alarm

	2.8.144 HI-CCVOLT
	Clear the HI-CCVOLT Condition

	2.8.145 HI-LASERBIAS
	Clear the HI-LASERBIAS Alarm

	2.8.146 HI-LASERTEMP
	Clear the HI-LASERTEMP Alarm

	2.8.147 HI-RXPOWER
	Clear the HI-RXPOWER Alarm

	2.8.148 HITEMP
	Clear the HITEMP Alarm

	2.8.149 HI-TXPOWER
	Clear the HI-TXPOWER Alarm

	2.8.150 HLDOVRSYNC
	Clear the HLDOVRSYNC Condition

	2.8.151 I-HITEMP
	Clear the I-HITEMP Alarm

	2.8.152 IMPROPRMVL
	Clear the IMPROPRMVL Alarm

	2.8.153 INC-ISD
	2.8.154 INHSWPR
	Clear the INHSWPR Condition

	2.8.155 INHSWWKG
	Clear the INHSWWKG Condition

	2.8.156 INTRUSION-PSWD
	Clear the INTRUSION-PSWD Condition

	2.8.157 INVMACADR
	Clear the INVMACADR Alarm

	2.8.158 IOSCFGCOPY
	2.8.159 ISIS-ADJ-FAIL
	Clear the ISIS-ADJ-FAIL Alarm

	2.8.160 KB-PASSTHR
	Clear the KB-PASSTHR Condition

	2.8.161 KBYTE-APS-CHANNEL-FAILURE
	Clear the KBYTE-APS-CHANNEL-FAILURE Alarm

	2.8.162 LAN-POL-REV
	Clear the LAN-POL-REV Condition

	2.8.163 LASER-APR
	2.8.164 LASERBIAS-DEG
	2.8.165 LASERBIAS-FAIL
	2.8.166 LASEREOL
	Clear the LASEREOL Alarm

	2.8.167 LASERTEMP-DEG
	2.8.168 LCAS-CRC
	Clear the LCAS-CRC Condition

	2.8.169 LCAS-RX-FAIL
	Clear the LCAS-RX-FAIL Condition

	2.8.170 LCAS-TX-ADD
	2.8.171 LCAS-TX-DNU
	2.8.172 LKOUTPR-S
	Clear the LKOUTPR-S Condition

	2.8.173 LOA
	Clear the LOA Alarm

	2.8.174 LOCKOUT-REQ
	Clear the LOCKOUT-REQ Condition

	2.8.175 LOF (BITS)
	Clear the LOF (BITS) Alarm

	2.8.176 LOF (DS1)
	Clear the LOF (DS1) Alarm

	2.8.177 LOF (DS3)
	Clear the LOF (DS3) Alarm

	2.8.178 LOF (E1)
	Clear the LOF (E1) Alarm

	2.8.179 LOF (EC1)
	Clear the LOF (EC1) Alarm

	2.8.180 LOF (OCN)
	Clear the LOF (OCN) Alarm

	2.8.181 LOF (STSTRM)
	Clear the LOF (STSTRM) Alarm

	2.8.182 LOF (TRUNK)
	2.8.183 LO-LASERBIAS
	Clear the LO-LASERBIAS Alarm

	2.8.184 LO-LASERTEMP
	Clear the LO-LASERTEMP Alarm

	2.8.185 LOM
	Clear the LOM Alarm

	2.8.186 LOP-P
	Clear the LOP-P Alarm

	2.8.187 LOP-V
	Clear the LOP-V Alarm

	2.8.188 LO-RXPOWER
	Clear the LO-RXPOWER Alarm

	2.8.189 LOS (2R)
	2.8.190 LOS (BITS)
	Clear the LOS (BITS) Alarm

	2.8.191 LOS (DS1)
	Clear the LOS (DS1) Alarm

	2.8.192 LOS (DS3)
	Clear the LOS (DS3) Alarm

	2.8.193 LOS (E1)
	Clear the LOS (E1) Alarm

	2.8.194 LOS (EC1)
	Clear the LOS (EC1) Alarm

	2.8.195 LOS (ESCON)
	2.8.196 LOS (FUDC)
	Clear the LOS (FUDC) Alarm

	2.8.197 LOS (ISC)
	2.8.198 LOS (MSUDC)
	2.8.199 LOS (OCN)
	Clear the LOS (OCN) Alarm

	2.8.200 LOS (OTS)
	2.8.201 LOS (TRUNK)
	2.8.202 LOS-O
	2.8.203 LOS-P
	2.8.204 LO-TXPOWER
	Clear the LO-TXPOWER Alarm

	2.8.205 LPBKCRS
	Clear the LPBKCRS Condition

	2.8.206 LPBKDS1FEAC-CMD
	2.8.207 LPBKDS3FEAC
	Clear the LPBKDS3FEAC Condition

	2.8.208 LPBKDS3FEAC-CMD
	2.8.209 LPBKFACILITY (CE100T)
	Clear the LPBKFACILITY (CE100T) Condition

	2.8.210 LPBKFACILITY (DS1, DS3)
	Clear the LPBKFACILITY (DS1, DS3) Condition

	2.8.211 LPBKFACILITY (E1)
	Clear the LPBKFACILITY (E1) Condition

	2.8.212 LPBKFACILITY (EC1)
	Clear the LPBKFACILITY (EC1) Condition

	2.8.213 LPBKFACILITY (ESCON)
	2.8.214 LPBKFACILITY (FC)
	2.8.215 LPBKFACILITY (FCMR)
	Clear the LPBKFACILITY (FCMR) Condition

	2.8.216 LPBKFACILITY (G1000)
	Clear the LPBKFACILITY (G1000) Condition

	2.8.217 LPBKFACILITY (GE)
	2.8.218 LPBKFACILITY (ISC)
	2.8.219 LPBKFACILITY (OCN)
	Clear the LPBKFACILITY (OCN) Condition

	2.8.220 LPBKFACILITY (TRUNK)
	2.8.221 LPBKTERMINAL (CE100T)
	Clear the LPBKTERMINAL (CE100T) Condition

	2.8.222 LPBKTERMINAL (DS1, DS3)
	Clear the LPBKTERMINAL (DS1, DS3) Condition

	2.8.223 LPBKTERMINAL (E1)
	Clear the LPBKTERMINAL (E1) Condition

	2.8.224 LPBKTERMINAL (EC1)
	Clear the LPBKTERMINAL (EC1) Condition

	2.8.225 LPBKTERMINAL (ESCON)
	2.8.226 LPBKTERMINAL (FC)
	2.8.227 LPBKTERMINAL (FCMR)
	Clear the LPBKTERMINAL (FCMR) Condition

	2.8.228 LPBKTERMINAL (G1000)
	Clear the LPBKTERMINAL (G1000) Condition

	2.8.229 LPBKTERMINAL (GE)
	2.8.230 LPBKTERMINAL (ISC)
	2.8.231 LPBKTERMINAL (OCN)
	Clear the LPBKTERMINAL (OCN) Condition

	2.8.232 LPBKTERMINAL (TRUNK)
	2.8.233 LWBATVG
	Clear the LWBATVG Alarm

	2.8.234 MAN-REQ
	Clear the MAN-REQ Condition

	2.8.235 MANRESET
	2.8.236 MANSWTOINT
	2.8.237 MANSWTOPRI
	2.8.238 MANSWTOSEC
	2.8.239 MANSWTOTHIRD
	2.8.240 MANUAL-REQ-RING
	Clear the MANUAL-REQ-RING Condition

	2.8.241 MANUAL-REQ-SPAN
	Clear the MANUAL-REQ-SPAN Condition

	2.8.242 MEA (AIP)
	Clear the MEA (AIP) Alarm

	2.8.243 MEA (BIC)
	Clear the MEA (BIC) Alarm

	2.8.244 MEA (EQPT)
	Clear the MEA (EQPT) Alarm

	2.8.245 MEA (FAN)
	Clear the MEA (FAN) Alarm

	2.8.246 MEA (PPM)
	2.8.247 MEM-GONE
	2.8.248 MEM-LOW
	2.8.249 MFGMEM
	Clear the MFGMEM Alarm

	2.8.250 NO-CONFIG
	Clear the NO-CONFIG Condition

	2.8.251 NOT-AUTHENTICATED
	2.8.252 OCHNC-INC
	2.8.253 ODUK-1-AIS-PM
	2.8.254 ODUK-2-AIS-PM
	2.8.255 ODUK-3-AIS-PM
	2.8.256 ODUK-4-AIS-PM
	2.8.257 ODUK-AIS-PM
	2.8.258 ODUK-BDI-PM
	2.8.259 ODUK-LCK-PM
	2.8.260 ODUK-OCI-PM
	2.8.261 ODUK-SD-PM
	2.8.262 ODUK-SF-PM
	2.8.263 ODUK-TIM-PM
	2.8.264 OOU-TPT
	Clear the OOT-TPT Condition

	2.8.265 OPEN-SLOT
	Clear the OPEN-SLOT Condition

	2.8.266 OPTNTWMIS
	2.8.267 OPWR-HDEG
	2.8.268 OPWR-HFAIL
	2.8.269 OPWR-LDEG
	2.8.270 OPWR-LFAIL
	2.8.271 OSRION
	2.8.272 OTUK-AIS
	2.8.273 OTUK-BDI
	2.8.274 OTUK-IAE
	2.8.275 OTUK-LOF
	2.8.276 OTUK-SD
	2.8.277 OTUK-SF
	2.8.278 OTUK-TIM
	2.8.279 OUT-OF-SYNC
	2.8.280 PARAM-MISM
	2.8.281 PDI-P
	Clear the PDI-P Condition

	2.8.282 PEER-NORESPONSE
	Clear the PEER-NORESPONSE Alarm

	2.8.283 PLM-P
	Clear the PLM-P Alarm

	2.8.284 PLM-V
	Clear the PLM-V Alarm

	2.8.285 PORT-ADD-PWR-DEG-HI
	2.8.286 PORT-ADD-PWR-DEG-LOW
	2.8.287 PORT-ADD-PWR-FAIL-HIGH
	2.8.288 PORT-ADD-PWR-FAIL-LOW
	2.8.289 PORT-FAIL
	2.8.290 PORT-MISMATCH
	Clear the PORT-MISMATCH Alarm

	2.8.291 PRC-DUPID
	Clear the PRC-DUPID Alarm

	2.8.292 PROTNA
	Clear the PROTNA Alarm

	2.8.293 PROV-MISMATCH
	2.8.294 PTIM
	2.8.295 PWR-FAIL-A
	Clear the PWR-FAIL-A Alarm

	2.8.296 PWR-FAIL-B
	Clear the PWR-FAIL-B Alarm

	2.8.297 PWR-FAIL-RET-A
	Clear the PWR-FAIL-RET-A Alarm

	2.8.298 PWR-FAIL-RET-B
	Clear the PWR-FAIL-RET-A Alarm

	2.8.299 RAI
	Clear the RAI Condition

	2.8.300 RCVR-MISS
	Clear the RCVR-MISS Alarm

	2.8.301 RFI
	2.8.302 RFI-L
	Clear the RFI-L Condition

	2.8.303 RFI-P
	Clear the RFI-P Condition

	2.8.304 RFI-V
	Clear the RFI-V Condition

	2.8.305 RING-ID-MIS
	Clear the RING-ID-MIS Alarm

	2.8.306 RING-MISMATCH
	Clear the RING-MISMATCH Alarm

	2.8.307 RING-SW-EAST
	2.8.308 RING-SW-WEST
	2.8.309 ROLL
	2.8.310 ROLL-PEND
	2.8.311 RPRW
	Clear the RPRW Condition

	2.8.312 RUNCFG-SAVENEED
	2.8.313 SD (DS1, DS3)
	Clear the SD (DS1, DS3) Condition

	2.8.314 SD (E1)
	Clear the SD (E1) Condition

	2.8.315 SD (TRUNK)
	2.8.316 SD-L
	Clear the SD-L Condition

	2.8.317 SD-P
	Clear the SD-P Condition

	2.8.318 SD-V
	Clear the SD-V Condition

	2.8.319 SF (DS1, DS3)
	Clear the SF (DS1, DS3) Condition

	2.8.320 SF (E1)
	Clear the SF (E1) Condition

	2.8.321 SF (TRUNK)
	2.8.322 SF-L
	Clear the SF-L Condition

	2.8.323 SF-P
	Clear the SF-P Condition

	2.8.324 SFTWDOWN
	2.8.325 SF-V
	Clear the SF-V Condition

	2.8.326 SH-INS-LOSS-VAR-DEG-HIGH
	2.8.327 SH-INS-LOSS-VAR-DEG-LOW
	2.8.328 SHUTTER-OPEN
	2.8.329 SIGLOSS
	Clear the SIGLOSS Alarm

	2.8.330 SNTP-HOST
	Clear the SNTP-HOST Alarm

	2.8.331 SPAN-SW-EAST
	2.8.332 SPAN-SW-WEST
	2.8.333 SQUELCH
	Clear the SQUELCH Condition

	2.8.334 SQUELCHED
	Clear the SQUELCHED Condition

	2.8.335 SQM
	Clear the SQM Alarm

	2.8.336 SSM-DUS
	2.8.337 SSM-FAIL
	Clear the SSM-FAIL Alarm

	2.8.338 SSM-LNC
	2.8.339 SSM-OFF
	Clear the SSM-OFF Condition

	2.8.340 SSM-PRC
	2.8.341 SSM-PRS
	2.8.342 SSM-RES
	2.8.343 SSM-SDN-TN
	2.8.344 SSM-SETS
	2.8.345 SSM-SMC
	2.8.346 SSM-ST2
	2.8.347 SSM-ST3
	2.8.348 SSM-ST3E
	2.8.349 SSM-ST4
	2.8.350 SSM-STU
	Clear the SSM-STU Condition

	2.8.351 SSM-TNC
	2.8.352 SWMTXMOD-PROT
	Clear the SWMTXMOD-PROT Alarm

	2.8.353 SWMTXMOD-WORK
	Clear the SWMTXMOD-WORK Alarm

	2.8.354 SWTOPRI
	2.8.355 SWTOSEC
	Clear the SWTOSEC Condition

	2.8.356 SWTOTHIRD
	Clear the SWTOTHIRD Condition

	2.8.357 SYNC-FREQ
	Clear the SYNC-FREQ Condition

	2.8.358 SYNCLOSS
	Clear the SYNCLOSS Alarm

	2.8.359 SYNCPRI
	Clear the SYNCPRI Alarm

	2.8.360 SYNCSEC
	Clear the SYNCSEC Alarm

	2.8.361 SYNCTHIRD
	Clear the SYNCTHIRD Alarm

	2.8.362 SYSBOOT
	2.8.363 TEMP-MISM
	Clear the TEMP-MISM Condition

	2.8.364 TIM
	Clear the TIM Alarm

	2.8.365 TIM-MON
	Clear the TIM-MON Alarm

	2.8.366 TIM-P
	Clear the TIM-P Alarm

	2.8.367 TIM-S
	Clear the TIM-S Alarm

	2.8.368 TIM-V
	Clear the TIM-V Alarm

	2.8.369 TPTFAIL (CE100T)
	Clear the TPTFAIL (CE100T) Alarm

	2.8.370 TPTFAIL (FCMR)
	Clear the TPTFAIL (FCMR) Alarm

	2.8.371 TPTFAIL (G1000)
	Clear the TPTFAIL (G1000) Alarm

	2.8.372 TPTFAIL (ML100T, ML1000, MLFX)
	Clear the TPTFAIL (ML100T, ML1000, MLFX) Alarm

	2.8.373 TRMT
	Clear the TRMT Alarm

	2.8.374 TRMT-MISS
	Clear the TRMT-MISS Alarm

	2.8.375 TX-AIS
	Clear the TX-AIS Condition

	2.8.376 TX-LOF
	Clear the TX-LOF Condition

	2.8.377 TX-RAI
	Clear the TX-RAI Condition

	2.8.378 UNC-WORD
	2.8.379 UNEQ-P
	Clear the UNEQ-P Alarm

	2.8.380 UNEQ-V
	Clear the UNEQ-V Alarm

	2.8.381 UNREACHABLE-TARGET-POWER
	2.8.382 UT-COMM-FAIL
	2.8.383 UT-FAIL
	2.8.384 VCG-DEG
	Clear the VCG-DEG Condition

	2.8.385 VCG-DOWN
	Clear the VCG-DOWN Condition

	2.8.386 VOA-HDEG
	2.8.387 VOA-HFAIL
	2.8.388 VOA-LDEG
	2.8.389 VOA-LFAIL
	2.8.390 VOLT-MISM
	Clear the VOLT-MISM Condition

	2.8.391 WKSWPR
	Clear the WKSWPR Condition

	2.8.392 WTR
	2.8.393 WVL-MISMATCH

	2.9 Traffic Card LED Activity
	2.9.1 Typical Traffic Card LED Activity After Insertion
	2.9.2 Typical Traffic Card LED Activity During Reset
	2.9.3 Typical Card LED State After Successful Reset
	2.9.4 Typical Cross-Connect LED Activity During Side Switch

	2.10 Frequently Used Alarm Troubleshooting Procedures
	2.10.1 Node and Ring Identification, Change, Visibility, and Termination
	Identify a BLSR Ring Name or Node ID Number
	Change a BLSR Ring Name
	Change a BLSR Node ID Number
	Verify Node Visibility for Other Nodes

	2.10.2 Protection Switching, Lock Initiation, and Clearing
	Initiate a 1+1 Protection Port Force Switch Command
	Initiate a 1+1 Manual Switch Command
	Clear a 1+1 Force or Manual Switch Command
	Initiate a Lock-On Command
	Initiate a Card or Port Lockout Command
	Clear a Lock-On or Lockout Command
	Initiate a 1:1 Card Switch Command
	Initiate a Force Switch for All Circuits on a Path Protection Span
	Initiate a Manual Switch for All Circuits on a Path Protection Span
	Initiate a Lockout for All Circuits on a Protect Path Protection Span
	Clear an External Switching Command on a Path Protection Span
	Initiate a Force Ring Switch on a BLSR
	Initiate a Force Span Switch on a Four-Fiber BLSR
	Initiate a Manual Span Switch on a BLSR
	Initiate a Manual Ring Switch on a BLSR
	Initiate a Lockout on a BLSR Protect Span
	Initiate an Exercise Ring Switch on a BLSR
	Initiate an Exercise Ring Switch on a Four Fiber BLSR
	Clear a BLSR External Switching Command

	2.10.3 CTC Card Resetting and Switching
	Reset a Traffic Card in CTC
	Reset an Active TCC2/TCC2P Card and Activate the Standby Card
	Side Switch the Active and Standby Cross-Connect Cards

	2.10.4 Physical Card Reseating, Resetting, and Replacement
	Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card
	Remove and Reinsert (Reseat) Any Card
	Physically Replace a Traffic Card
	Physically Replace an In-Service Cross-Connect Card

	2.10.5 Generic Signal and Circuit Procedures
	Verify the Signal BER Threshold Level
	Delete a Circuit
	Verify or Create Node Section DCC Terminations
	Clear an OC-N Card Facility or Terminal Loopback Circuit
	Clear an OC-N Card Cross-Connect (XC) Loopback Circuit
	Clear a DS3XM-6, DS3XM-12, or DS3E-12 Card Loopback Circuit
	Clear Other Electrical Card, CE-100T-8, or Ethernet Card Loopbacks
	Clear an MXP, TXP, or FC_MR-4 Card Loopback Circuit

	2.10.6 Air Filter and Fan Procedures
	Inspect, Clean, and Replace the Reusable Air Filter
	Remove and Reinsert a Fan-Tray Assembly
	Replace the Fan-Tray Assembly

	2.10.7 Interface Procedures
	Replace the Electrical Interface Assembly
	Replace the Alarm Interface Panel




